
Avaya Contact Center Select Advanced 
Administration

Release 7.1
Issue 03.08

April 2024



© 2015-2024, Avaya LLC
All Rights Reserved.

Notice
While reasonable efforts have been made to ensure that the 
information in this document is complete and accurate at the time 
of printing, Avaya assumes no liability for any errors. Avaya reserves 
the right to make changes and corrections to the information in this 
document without the obligation to notify any person or organization 
of such changes.
Documentation disclaimer
“Documentation” means information published in varying media 
which may include product information, subscription or service 
descriptions, operating instructions and performance specifications 
that are generally made available to users of products. 
Documentation does not include marketing materials. Avaya shall 
not be responsible for any modifications, additions, or deletions 
to the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya. End user agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against 
all claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End user.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not 
necessarily endorse the products, services, or information described 
or offered within them. Avaya does not guarantee that these links will 
work all the time and has no control over the availability of the linked 
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software. 
Please refer to your agreement with Avaya to establish the terms of 
the limited warranty. In addition, Avaya’s standard warranty language 
as well as information regarding support for this product while under 
warranty is available to Avaya customers and other parties through 
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link 
“Warranty & Product Lifecycle” or such successor site as designated 
by Avaya. Please note that if the product(s) was purchased from an 
authorized Avaya channel partner outside of the United States and 
Canada, the warranty is provided by said Avaya Channel Partner and 
not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that 
You acquire from either Avaya or an authorized Avaya Channel 
Partner (as applicable) and which is described further in Hosted SAS 
or other service description documentation regarding the applicable 
hosted service. If You purchase a Hosted Service subscription, 
the foregoing limited warranty may not apply but You may be 
entitled to support services in connection with the Hosted Service 
as described further in your service description documents for the 
applicable Hosted Service. Contact Avaya or Avaya Channel Partner 
(as applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN 
AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR 
AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS 
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE 
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO 
UNDER THE LINK “Avaya Terms of Use for Hosted Services” 
OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND 
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE 
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON 
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE 
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY 
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. 
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A 
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT 
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE 

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, 
OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF 
USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE 
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.
Licenses
The Global Software License Terms (“Software License Terms”) 
are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya. 
These Software License Terms are applicable to anyone who 
installs, downloads, and/or uses Software and/or Documentation. By 
installing, downloading or using the Software, or authorizing others to 
do so, the end user agrees that the Software License Terms create 
a binding contract between them and Avaya. In case the end user is 
accepting these Software License Terms on behalf of a company or 
other legal entity, the end user represents that it has the authority to 
bind such entity to these Software License Terms.
Copyright
Except where expressly stated otherwise, no use should be made 
of materials on this site, the Documentation, Software, Hosted 
Service, or hardware provided by Avaya. All content on this site, the 
documentation, Hosted Service, and the product provided by Avaya 
including the selection, arrangement and design of the content is 
owned either by Avaya or its licensors and is protected by copyright 
and other intellectual property laws including the sui generis rights 
relating to the protection of databases. You may not modify, copy, 
reproduce, republish, upload, post, transmit or distribute in any way 
any content, in whole or in part, including any code and software 
unless expressly authorized by Avaya. Unauthorized reproduction, 
transmission, dissemination, storage, or use without the express 
written consent of Avaya can be a criminal, as well as a civil offense 
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine. 
Each product has its own ordering code and license types. Unless 
otherwise stated, each Instance of a product must be separately 
licensed and ordered. For example, if the end user customer or 
Avaya Channel Partner would like to install two Instances of the 
same type of products, then two products of that type must be 
ordered.
Third Party Components
The following applies only if the H.264 (AVC) codec is distributed 
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A 
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, 
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL 
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR 
EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA 
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE 
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND 
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) 
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
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Compliance with Laws
You acknowledge and agree that it is Your responsibility to comply 
with any applicable laws and regulations, including, but not limited 
to laws and regulations related to call recording, data privacy, 
intellectual property, trade secret, fraud, and music performance 
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not a 
corporate employee, agent, subcontractor, or is not working on your 
company's behalf). Be aware that there can be a risk of Toll Fraud 
associated with your system and that, if Toll Fraud occurs, it can 
result in substantial additional charges for your telecommunications 
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You 
need technical assistance or support, please contact your Avaya 
Sales Representative.
Security Vulnerabilities
Information about Avaya’s security support policies can be 
found in the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled 
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided 
by Avaya are the registered or unregistered Marks of Avaya, its 
affiliates, its licensors, its suppliers, or other third parties. Users 
are not permitted to use such Marks without prior written consent 
from Avaya or such third party which may own the Mark. Nothing 
contained in this site, the Documentation, Hosted Service(s) and 
product(s) should be construed as granting, by implication, estoppel, 
or otherwise, any license or right in and to the Marks without the 
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.
Downloading Documentation
For the most current versions of Documentation, see the Avaya 
Support website: https://support.avaya.com, or such successor site 
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for 
Product or Cloud Service notices and articles, or to report a 
problem with your Avaya Product or Cloud Service. For a list of 
support telephone numbers and contact addresses, go to the Avaya 
Support website: https://support.avaya.com (or such successor site 
as designated by Avaya), scroll to the bottom of the page, and select 
Contact Avaya Support.
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https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com
https://support.avaya.com
https://support.avaya.com


Contents

Chapter 1: Introduction..........................................................................................................  15
Purpose................................................................................................................................ 15
Intended audience................................................................................................................. 15
Related resources.................................................................................................................  15

Avaya Contact Center Select documentation.....................................................................  15
Viewing Avaya Mentor videos........................................................................................... 18

Support................................................................................................................................  18
Chapter 2: Changes in this release.......................................................................................  20

Features...............................................................................................................................  20
Ability to store encryption keys in a shared location............................................................  21
Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports 
Microsoft Windows 11......................................................................................................  21
Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports 
Microsoft Windows Server 2019.......................................................................................  21
Avaya Workspaces configuration......................................................................................  22
Avaya-standard Grace Period........................................................................................... 22
Avaya Workspaces supports HTTPS................................................................................. 22
CCMA Password Policy configuration for human and programmatic accounts......................  22
Contact Center Manager Administration supported in Microsoft Edge with IE mode..............  22
Contact Center supports OAuth 2.0 and MS Graph for Emails............................................  22
Credentials for Basic and OAuth 2.0 authentication of mailboxes........................................  23
Customer Journey configuration.......................................................................................  23
Customizing processing for customers with restricted flag................................................... 23
Enhancement of the Email Templates feature....................................................................  23
External server for uploading Avaya Workspaces logs........................................................ 23
Functionality to restore the Avaya Workspaces default layout and deleted widgets...............  24
Handling customer information.........................................................................................  24
Inline images for emails and signatures............................................................................. 24
Multimedia Data Management utility access......................................................................  24
Unsent email monitoring..................................................................................................  24
Java keystore is no longer required to store certificates for Email Manager..........................  24
Avaya Workspaces features for Release 7.1.2.2................................................................  25
Avaya Workspaces log settings in the CCMM Administration utility......................................  26

Other changes......................................................................................................................  26
Interoperability with the latest WebLM releases.................................................................. 26
VMware support..............................................................................................................  26
End of support for Internet Explorer..................................................................................  26
Windows operating system support................................................................................... 27
Supported IP Office versions............................................................................................  27
Avaya Aura® Media Server interoperability......................................................................... 27

April 2024 Avaya Contact Center Select Advanced Administration 4
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Chapter 3: Contact Center Multimedia fundamentals.........................................................  28
Email contact type.................................................................................................................  28

Email rule groups............................................................................................................  30
Recipient mailboxes........................................................................................................  31
Inbound email settings.....................................................................................................  31
Outbound email settings..................................................................................................  31
Character encoding for outgoing email messages..............................................................  32
Asian email.....................................................................................................................  32
Email traffic reports.......................................................................................................... 33
Extended Email Capacity.................................................................................................  33
Supervisor approval of email messages............................................................................  34
Agent Desktop................................................................................................................  35

CCMM Dashboard utility........................................................................................................  36
CCMM Contacts monitoring.............................................................................................  36
Troubleshooting contact routing errors..............................................................................  36
CCMM unsent emails monitoring......................................................................................  37

SMS text messages, faxes, scanned documents, and voicemail attachments............................. 39
Mailbox configuration....................................................................................................... 40
Traffic reports.................................................................................................................. 40
Agent Desktop................................................................................................................  41

Outbound contact type........................................................................................................... 41
Outbound Campaign Management Tool............................................................................  42
Campaign Scheduler.......................................................................................................  43
Agent Desktop................................................................................................................  43
Contact Center Manager Administration............................................................................  43

Web services........................................................................................................................  44
Web communications............................................................................................................  44

Chapter 4: General configuration.......................................................................................... 45
Configuring browser security settings......................................................................................  45
Starting CCMM Administration utility.......................................................................................  46
Configuring the reporting credentials....................................................................................... 47
Adding administrators............................................................................................................  48
Removing administrators.......................................................................................................  49
Configuring office hours.........................................................................................................  49
Configuring holidays..............................................................................................................  50
Applying office hours.............................................................................................................  51
Viewing real-time traffic reports by contact............................................................................... 52
Configuring the displayed date for traffic reports....................................................................... 52
Adding a Java keystore certificate for TLS LDAP connections...................................................  53
Configuring a directory LDAP server.......................................................................................  54
Configuring a Phonebook LDAP server...................................................................................  55

Chapter 5: Agent Desktop configuration.............................................................................. 57
Adding a friendly name for a web chat agent...........................................................................  57

April 2024 Avaya Contact Center Select Advanced Administration 5
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Controlling access to email message text................................................................................  58
Configuring supervisor approval for email messages on a per agent basis.................................  58
Creating or changing custom fields in Agent Desktop...............................................................  59
Deleting a custom field in Agent Desktop................................................................................. 60
Creating or changing a closed reason.....................................................................................  60
Configuring default closed reasons.........................................................................................  61
Deleting a closed reason........................................................................................................ 61
Configuring Shortcut keys for Agent Desktop...........................................................................  62
Configuring basic screen pops................................................................................................ 63
Configuring Advanced screen pop applications........................................................................  66
Configuring Advanced screen pop filters.................................................................................  66
Configuring Advanced Screen pops........................................................................................  68
Configuring Common Settings................................................................................................  71

Variable definitions..........................................................................................................  71
Configuring Enterprise Mode Site List for Agent Desktop....................................................  88

Configuring IIS to support MDB database file attachments in email messages............................ 89
Chapter 6: Avaya Workspaces configuration....................................................................... 91

Configuring Avaya Workspaces general settings......................................................................  92
Variable definitions..........................................................................................................  93

Configuring the Avaya Workspaces administrator..................................................................... 95
Logging in to Avaya Workspaces as an administrator...............................................................  95
Configuring email confirmation...............................................................................................  97
Using the Avaya Workspaces compressed layout....................................................................  97
Configuring agent toast notifications.......................................................................................  98
Configuring the Start Work button behavior.............................................................................  98
Importing email templates to the CCMM database...................................................................  99
Configuring the Avaya Workspaces layout and widgets..........................................................  100
Resetting the Avaya Workspaces layout................................................................................ 101
Restoring deleted widgets....................................................................................................  101
Enabling agent security for Avaya Workspaces......................................................................  102
Configuring Customer Journey for Voice and Video channels.................................................. 103

Chapter 7: Email configuration............................................................................................ 105
Configuring the email server names......................................................................................  106
Adding an email server........................................................................................................  107
Deleting an email server......................................................................................................  109
Configuring skillsets for email...............................................................................................  109
Creating or changing a recipient mailbox...............................................................................  110
Creating or changing an alias for a recipient mailbox..............................................................  112
Deleting a recipient mailbox.................................................................................................. 114
Updating the system default rule...........................................................................................  115
Updating the system delivery failure rule................................................................................ 116
Creating or changing a keyword group..................................................................................  118
Deleting a keyword from a keyword group.............................................................................  120

April 2024 Avaya Contact Center Select Advanced Administration 6
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Deleting a keyword group..................................................................................................... 120
Creating or changing prepared responses.............................................................................  121
Deleting prepared responses................................................................................................ 123
Removing attachments from prepared responses..................................................................  124
Promoting suggested responses........................................................................................... 124
Creating or changing a sender group....................................................................................  125
Deleting a sender group....................................................................................................... 126
Deleting a sender from a sender group.................................................................................  127
Creating or changing rules...................................................................................................  127
Enabling a rule....................................................................................................................  130
Disabling a rule...................................................................................................................  131
Deleting a rule..................................................................................................................... 131
Creating or changing rule groups..........................................................................................  132
Configuring supervisor approval for email messages on a per skillset basis.............................  133
Configuring auto-rejection of email messages from all skillsets that use approval hierarchy.......  135
Configuring the email settings..............................................................................................  136
Changing the character encoding for outgoing and incoming email.......................................... 137
Enabling customer details logging for emails.........................................................................  138
Selecting the outgoing email address....................................................................................  139
Barring email addresses......................................................................................................  140
Deleting a barred email address...........................................................................................  140
Configuring Microsoft Exchange 2013, 2016, and 2019 to send outgoing emails......................  141
Adding a certificate for use with TLS email connections..........................................................  142
Configuring the TLS email connection for Microsoft Exchange 2013, 2016, and 2019...............  143
Enabling SMTP Authentication on your email server..............................................................  144
Determining if SMTP Authentication is enabled...................................................................... 145
Enabling Extended Email Capacity.......................................................................................  147
Disabling Extended Email Capacity....................................................................................... 147

Chapter 8: Web communications configuration................................................................  149
Prerequisites for Web communications configuration.............................................................. 150
Assigning a development Web server name..........................................................................  150
Configuring welcome messages and text chat labels..............................................................  151
Configuring Enterprise Web Chat settings.............................................................................  154
Configuring Web communications agent timers...................................................................... 155
Saving Web communications chat session details.................................................................. 156
Configuring the Web communications chat session limits.......................................................  157
Configuring customer notification log..................................................................................... 157
Enabling Web Communications transfer to a skillset............................................................... 158
Creating automatic phrases.................................................................................................. 158
Deleting an automatic phrase...............................................................................................  159
Creating a page push URL...................................................................................................  159
Deleting a page push URL...................................................................................................  160
Creating Web On Hold URLs groups..................................................................................... 161

April 2024 Avaya Contact Center Select Advanced Administration 7
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Deleting a URL from a Web On Hold URL group.................................................................... 162
Deleting a Web On Hold URLs group....................................................................................  162
Creating Web On Hold comfort groups..................................................................................  163
Changing the sequence of messages in a Web On Hold comfort group...................................  164
Deleting a message from a Web On Hold comfort group......................................................... 164
Deleting a Web On Hold comfort group.................................................................................  165
Creating web communications comfort groups.......................................................................  165
Changing the sequence of messages in a Web communications comfort group........................ 166
Deleting a message from a Web communications comfort group.............................................  167
Deleting a web communications comfort group......................................................................  168
Configuring Web On Hold comfort groups for a web communications skillset...........................  168
Removing a Web On Hold comfort group for a web communications skillset............................  169
Configuring web communications comfort groups for a Web communications skillset................ 169
Removing a web communications comfort group from a web communications skillset............... 170
Configuring intrinsics for agent-supervisor observe and barge-in.............................................  171

Chapter 9: Outbound configuration....................................................................................  173
Prerequisites for Outbound configuration............................................................................... 173
Configuring a route point for an Outbound skillset..................................................................  173

Chapter 10: Mailbox credential configuration.................................................................... 175
Basic authentication............................................................................................................  175

Creating credentials for Basic authentication...................................................................  175
OAuth 2.0 authentication...................................................................................................... 176

Creating an Azure application for the Email Manager.......................................................  177
Creating client credentials with a certificate.....................................................................  178
Creating client credentials with a client secret..................................................................  179

Editing credentials...............................................................................................................  181
Deleting credentials.............................................................................................................  181

Chapter 11: Voicemail configuration...................................................................................  182
Prerequisites for voicemail configuration...............................................................................  182
Configuring a route point for a voicemail skillset.....................................................................  182
Adding a voicemail server....................................................................................................  183
Updating a voicemail server.................................................................................................  183
Deleting a voicemail server..................................................................................................  184
Adding a voice mail mailbox.................................................................................................  184
Updating a voicemail mailbox...............................................................................................  186
Deleting a voicemail mailbox................................................................................................  187
Updating the voicemail system default rule............................................................................  187
Updating the voicemail system delivery failure rule................................................................. 188

Chapter 12: Scanned document configuration..................................................................  191
Prerequisites for scanned document configuration.................................................................  191
Configuring a route point for a scanned document skillset....................................................... 191
Adding a document imaging server.......................................................................................  192
Updating a document imaging server....................................................................................  193

April 2024 Avaya Contact Center Select Advanced Administration 8
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Deleting a document imaging server.....................................................................................  193
Adding a scanned document mailbox....................................................................................  194
Updating a scanned document mailbox.................................................................................  195
Deleting a scanned document mailbox..................................................................................  195
Configuring a scanned document reply mailbox.....................................................................  196
Deleting a scanned document reply mailbox..........................................................................  197
Updating the scanned documents system default rule............................................................  198
Updating the scanned documents system delivery failure rule.................................................  199

Chapter 13: Fax configuration.............................................................................................  200
Prerequisites for fax configuration......................................................................................... 200
Configuring a route point for a fax skillset..............................................................................  200
Adding a fax server.............................................................................................................. 201
Updating a fax server........................................................................................................... 201
Deleting a fax server............................................................................................................ 202
Adding a fax mailbox...........................................................................................................  202
Updating a fax mailbox........................................................................................................  204
Deleting a fax mailbox.........................................................................................................  205
Configuring a fax reply mailbox............................................................................................. 205
Deleting a fax reply mailbox.................................................................................................  206
Updating the fax system default rule.....................................................................................  207
Updating the fax system delivery failure rule..........................................................................  208

Chapter 14: Short Message Service configuration............................................................ 209
Prerequisites for SMS configuration......................................................................................  209
Configuring a route point for an SMS skillset.......................................................................... 209
Adding an SMS Gateway.....................................................................................................  210
Updating an SMS Gateway..................................................................................................  211
Deleting an SMS Gateway.................................................................................................... 211
Adding a SMS mailbox......................................................................................................... 212
Updating an SMS mailbox.................................................................................................... 213
Deleting an SMS mailbox.....................................................................................................  214
Configuring an SMS reply mailbox........................................................................................  214
Deleting an SMS reply mailbox.............................................................................................  215
Updating the SMS system default rule................................................................................... 216
Updating the SMS system delivery failure rule.......................................................................  217

Chapter 15: Data Management - cleanup and purging...................................................... 219
Starting the Multimedia Data Management Administration utility..............................................  223
Creating an Outbound Campaigns cleanup rule.....................................................................  224
Creating an Email Rules cleanup rule...................................................................................  225
Creating a Skillsets cleanup rule...........................................................................................  226
Creating a Closed Reason cleanup rule................................................................................  226
Creating a Customers cleanup rule.......................................................................................  227
Creating a new scheduled cleanup task................................................................................  228
Enabling OFFLINE database purging....................................................................................  230

April 2024 Avaya Contact Center Select Advanced Administration 9
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Restoring an archive from a previous Release.......................................................................  231
Restoring contacts cleared by a scheduled task.....................................................................  231

Chapter 16: Data Management - customer privacy...........................................................  233
Generating a customer information file..................................................................................  233
Deleting customer history..................................................................................................... 234

Chapter 17: Orchestration Designer example flow applications...................................... 236
Installing Orchestration Designer..........................................................................................  236
Opening Orchestration Designer........................................................................................... 237
Configuring a flow application to provide estimated wait time information.................................  240
Configuring a flow application to provide position in queue information....................................  247
Configuring a flow application to provide a queuing customer with the option to leave a 
voicemail............................................................................................................................  253

Chapter 18: Avaya Aura® Media Server media configuration...........................................  265
Logging in to Avaya Aura® Media Server Element Manager....................................................  267
Configuring a HTTP proxy for external music source access...................................................  268
Configuring a streaming music source................................................................................... 269

Chapter 19: Avaya Contact Center Select Server Configuration.....................................  270
Changing the local settings configuration............................................................................... 270
Changing the licensed features configuration......................................................................... 271
Changing the IP Office network data.....................................................................................  272
Changing the Local Subscriber data.....................................................................................  273

Chapter 20: REST API configuration................................................................................... 275
Adding a new environment...................................................................................................  276
Creating and testing REST requests.....................................................................................  276
Uploading a trusted endpoint certificate................................................................................. 278
Updating a REST request....................................................................................................  279
Deleting a REST request.....................................................................................................  280
Updating an environment.....................................................................................................  280
Deleting an environment......................................................................................................  280

Chapter 21: Avaya Contact Center Select routine maintenance......................................  282
Backing up the Contact Center databases.............................................................................  282
Configuring the overdue backup notification..........................................................................  285
Creating a backup location for scheduled backups.................................................................  285
Scheduling a backup of the Contact Center server databases ................................................  286
Restoring the Avaya Contact Center Select Release 7.x databases......................................... 288
Logging in to Avaya Aura® Media Server Element Manager....................................................  289
Creating a backup destination for Avaya Aura® Media Server ................................................. 290
Backing up the Avaya Aura® Media Server database.............................................................. 291
Recovering a scheduled backup...........................................................................................  291
Restoring the Avaya Aura® Media Server database ...............................................................  292
Backing up the Avaya Aura® Media Server software appliance database.................................  293
Uploading a backup file to an Avaya Aura® Media Server software appliance...........................  294
Restoring data from the local folder on an Avaya Aura® Media Server software appliance ........  294

April 2024 Avaya Contact Center Select Advanced Administration 10
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Chapter 22: Simple Network Management Protocol administration................................ 296
Configuring Windows SNMP Service....................................................................................  296
Selecting CCMS events to be forwarded...............................................................................  297
Selecting CCMA, LM, CCT, and CCMM events to be forwarded..............................................  297
Configuring the NMS...........................................................................................................  299

Chapter 23: Licensing administration................................................................................. 300
Resetting the grace period...................................................................................................  300
Updating the license file.......................................................................................................  301
Changing the licensing information for Contact Center...........................................................  301
Configuring a remote Avaya WebLM server........................................................................... 302
Configuring Avaya WebLM centralized licensing....................................................................  303
Checking the Host ID of the Local WebLM............................................................................. 303
License expiration...............................................................................................................  304

Chapter 24: Dialed number identification services configuration...................................  305
Configuring DNIS on IP Office..............................................................................................  305

Chapter 25: Secure SIP and CTI communication configuration....................................... 307
Secure SIP and CTI Communication configuration procedures................................................ 309
Creating a new security store...............................................................................................  312
Copying the Certificate Signing Request file..........................................................................  313
Adding certificate files to the security store............................................................................  314
Exporting a root certificate from the security store..................................................................  315
Adding the ACCS CA root certificate to the IP Office trusted store...........................................  316
Enabling IP Office SIP link certificate validation...................................................................... 317
Configuring the IP Office TLS port for SIP communication......................................................  318
Enabling IP Office CTI link certificate validation...................................................................... 319
Configuring the optional IP Office Secondary Server..............................................................  321
Exporting the default CA root certificate from IP Office............................................................ 321
Generating the default signed certificate................................................................................ 323
Obtaining security certificates for IP Office............................................................................. 324
Installing the signed certificate in IP Office............................................................................. 324
Adding the IP Office CA root certificate to the ACCS security store.......................................... 326
Installing certificates across IP Office SCN............................................................................  327
Configuring Avaya Contact Center Select SIP TLS details......................................................  329
Configuring Avaya Contact Center Select CTI TLS details......................................................  331
Verifying TLS communication...............................................................................................  332

Chapter 26: Administering security....................................................................................  334
Exporting a root certificate from the security store..................................................................  336
Applying the root certificate to a Contact Center client............................................................  337
Importing the Contact Center root certificate into Avaya Aura® MS..........................................  338
Creating an offline store.......................................................................................................  338
Switching between the active and offline security stores.........................................................  340
Making an offline store active...............................................................................................  340
Turning on Web Services security......................................................................................... 341

April 2024 Avaya Contact Center Select Advanced Administration 11
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Configuring the minimum TLS version................................................................................... 342
Changing the data synchronization user account to match Web Services security settings........  343
Turning off Web Services security.........................................................................................  344
Scheduling a security store inspection task............................................................................ 344
Configuring SMTP server details..........................................................................................  346
Modifying a scheduled security store inspection task..............................................................  347
Verifying the scheduled security store inspection task............................................................. 348
Removing a scheduled security store inspection task ............................................................  349
Examining a certificate file in the security store......................................................................  349
Removing a certificate file from the security store................................................................... 350
Disabling Server Message Block signing in the server local group policy.................................. 350
Backing up the security store................................................................................................ 351
Deleting the security store.................................................................................................... 352

Chapter 27: CCMA Password Policy................................................................................... 353
Enabling Advanced Security mode for CCMA Password Policy...............................................  354
Advanced Security mode configuration.................................................................................  354

Configuring password rules for human accounts..............................................................  355
Configuring password rules for programmatic accounts....................................................  356

Chapter 28: Database encryption administration..............................................................  358
Creating and activating an encryption key.............................................................................  359
Encrypting the Contact Center database...............................................................................  360
Decrypting the Contact Center database...............................................................................  361

Chapter 29: Agent Desktop client software installation using Remote Desktop 
Services.................................................................................................................................  362

Agent Desktop client software installation using Remote Desktop Services prerequisites..........  362
Publishing Agent Desktop client software using Remote Desktop Services..............................  363

Chapter 30: Publishing ACCS client software in a Citrix deployment............................. 365
Prerequisites....................................................................................................................... 365
Configuring the client OS setting for Citrix deployments..........................................................  365
Publishing Agent Desktop client software on a Citrix server....................................................  366
Publishing Contact Center Manager Administration on a Citrix server as content......................  371
Publishing Contact Center Manager Administration on a Citrix server as an installed 
application..........................................................................................................................  373
Installing the ActiveX Controls on the Citrix server.................................................................. 375

Chapter 31: Language support fundamentals...................................................................  377
Language levels..................................................................................................................  378
Language family compatibility............................................................................................... 379
Configuring the operating system language...........................................................................  380
Setting the system locale.....................................................................................................  381
Enabling a localized language .............................................................................................  381
Accessing CCMA web client with local language.................................................................... 382

Chapter 32: Common procedures.......................................................................................  384

April 2024 Avaya Contact Center Select Advanced Administration 12
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Starting or stopping Contact Center applications....................................................................  384
Appendix A: Server name or IP address change - hardware appliance or DVD install.  385

Avaya Contact Center Select server name change................................................................. 385
Avaya Contact Center Select server name change prerequisites.......................................  386
Turning off Web Services security...................................................................................  386
Stopping Avaya Contact Center Select............................................................................ 387
Changing the server name in the operating system..........................................................  387
Updating the HOSTS file on the Avaya Contact Center Select server................................  388
Verifying the server name change................................................................................... 388
Synchronizing the operating system name with the Avaya Contact Center Select server 
name............................................................................................................................ 389
Changing the server name for Enterprise Web Chat.........................................................  390
Configuring Enterprise Web Chat settings.......................................................................  390
Configuring the external Web Communications server ..................................................... 391
Updating the HOSTS file for clients................................................................................. 392
Updating client browsers and shared folders.................................................................... 392
Reinstalling Agent Desktop............................................................................................  393

Avaya Contact Center Select server IP address change.........................................................  393
Stopping Avaya Contact Center Select............................................................................ 393
Changing the contact center subnet IP address of the Avaya Contact Center Select server. 394
Verifying the server IP address change...........................................................................  394
Synchronizing the operating system IP address with the Avaya Contact Center Select 
server IP address..........................................................................................................  395
Updating the Avaya Aura® Media Server IP Interface Assignment.....................................  395
Updating the HOSTS file for clients................................................................................. 396

Appendix B: Server name or IP address change - software appliance...........................  398
Avaya Contact Center Select server name change................................................................. 398

Avaya Contact Center Select server name change prerequisites.......................................  399
Turning off Web Services security...................................................................................  399
Stopping Avaya Contact Center Select............................................................................ 400
Changing the server name in the operating system..........................................................  400
Updating the HOSTS file on the Avaya Contact Center Select server................................  401
Verifying the server name change................................................................................... 401
Synchronizing the operating system name with the Avaya Contact Center Select server 
name............................................................................................................................ 402
Configuring Avaya Aura® Media Server name resolution................................................... 403
Configuring the external Web Communications server ..................................................... 403
Updating the HOSTS file for clients................................................................................. 403
Updating client browsers and shared folders.................................................................... 404
Reinstalling Agent Desktop............................................................................................  405

Avaya Contact Center Select server IP address change.........................................................  405
Stopping Avaya Contact Center Select............................................................................ 405
Changing the contact center subnet IP address of the Avaya Contact Center Select server. 406

April 2024 Avaya Contact Center Select Advanced Administration 13
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Verifying the server IP address change...........................................................................  406
Synchronizing the operating system IP address with the Avaya Contact Center Select 
server IP address..........................................................................................................  407
Configuring Avaya Aura® Media Server name resolution................................................... 407
Updating Avaya Aura® Media Server trusted node IP addresses.......................................  408
Updating the HOSTS file for clients................................................................................. 408

Avaya Aura® Media Server name change..............................................................................  409
Changing the name of the Avaya Aura® Media Server on Linux......................................... 409
Updating the Avaya Aura® Media Server details in CCMA................................................. 410

Avaya Aura® Media Server IP address change....................................................................... 411
Changing the Avaya Aura® Media Server IP address on Linux........................................... 411
Updating the Avaya Aura® Media Server details in CCMA................................................. 412

April 2024 Avaya Contact Center Select Advanced Administration 14
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Chapter 1: Introduction

Purpose
This guide describes the advanced configuration tasks that administrators of the Avaya Contact 
Center Select server can perform.

Intended audience
This guide is for personnel who perform management tasks on the Avaya Contact Center Select 
server.

Related resources

Avaya Contact Center Select documentation
The following table lists the documents related to Avaya Contact Center Select. Download the 
documents from the Avaya Support website at https://support.avaya.com.

Title Document purpose Audience
Overview
Avaya Contact Center Select 
Solution Description

This document provides a technical 
description of Avaya Contact Center 
Select. It describes the product 
features, specifications, licensing, and 
interoperability with other supported 
products.

Customers and sales, 
services, and support 
personnel

Avaya Contact Center Select 
Documentation Catalog

This document describes available Avaya 
Contact Center Select documentation 
resources and indicates the type of 
information in each document.

Customers and sales, 
services, and support 
personnel

Table continues…
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Title Document purpose Audience
Contact Center Performance 
Management Data Dictionary

This document contains reference tables 
that describe the statistics and data in the 
historical and real-time reports generated in 
Contact Center.

System 
administrators and 
contact center 
supervisors

Implementing
Deploying Avaya Contact Center 
Select DVD

This document contains information 
about Avaya Contact Center Select 
DVD installation, initial configuration, 
and verification. This document contains 
information about maintaining and 
troubleshooting the Avaya Contact Center 
Select server.

Implementation 
personnel

Deploying Avaya Contact Center 
Select Software Appliance

This document contains information 
about Avaya Contact Center Select 
Software Appliance (VMware) preparation, 
deployment, initial configuration, and 
verification. This document contains 
information about maintaining and 
troubleshooting the software appliance.

Implementation 
personnel

Deploying Avaya Contact Center 
Select Hardware Appliance

This document contains information about 
Avaya Contact Center Select Hardware 
Appliance (physical server) installation, 
initial configuration, and verification. This 
document contains information about 
maintaining and troubleshooting the 
hardware appliance.

Implementation 
personnel

Deploying Avaya Contact Center 
Select on Microsoft Azure

This document contains information about 
deploying Avaya Contact Center Select 
using an ISO image on Microsoft Azure.

Implementation 
personnel

Avaya Contact Center Select 
Business Continuity

This document contains information about 
deploying Avaya Contact Center Select 
Business Continuity.

Implementation 
personnel

Upgrading and Patching Avaya 
Contact Center Select

This document contains information about 
upgrading and patching Avaya Contact 
Center Select.

Implementation 
personnel 
and system 
administrators

Administering
Administering Avaya Contact Center 
Select

This document contains information and 
procedures to configure the users, skillsets, 
and contact center configuration data. 
This document contains information about 
creating Avaya Contact Center Select real-
time and historical reports.

System 
administrators and 
contact center 
supervisors

Table continues…
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Title Document purpose Audience
Avaya Contact Center Select 
Advanced Administration

This document contains information about 
managing the Avaya Contact Center 
Select server, licensing, and multimedia 
configuration.

System 
administrators

Using Contact Center Orchestration 
Designer

This document contains information and 
procedures to configure script and 
flow applications in Contact Center 
Orchestration Designer.

System 
administrators

Maintaining
Contact Center Event Codes This document contains a list of 

errors in the Contact Center suite and 
recommendations to resolve them.

This document is a Microsoft Excel 
spreadsheet.

System 
administrators and 
support personnel

Using
Using Agent Desktop for Avaya 
Contact Center Select 

This document provides information and 
procedures for agents who use the Agent 
Desktop application to accept, manage, 
and close contacts of all media types in 
Contact Center.

Contact center 
agents and 
supervisors

Using the Contact Center Agent 
Browser application

This document provides information and 
procedures for agents who use the Agent 
Browser application to log on to Contact 
Center and perform basic tasks.

Contact center 
agents

Using Avaya Workspaces for AACC 
and ACCS

This document describes the tasks that 
Contact Center agents can perform using 
Avaya Workspaces.

Contact center 
agents and 
supervisors

Release Notes
Avaya Contact Center Select 
Release Notes

The Release Notes contain information 
about known issues, patches, and 
workarounds.

System 
administrators and 
support personnel

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

2. To log in, click Sign In at the top of the screen and then enter your login credentials when 
prompted.

3. Click Product Support > Documents.

4. In Search Product, start typing the product name and then select the appropriate product 
from the list displayed.

5. In Select Release, select the appropriate release number.

Related resources
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This field is not available if there is only one release for the product.

6. (Optional) In Enter Keyword, type keywords for your search.

7. From the Select Content Type list, select one or more content types.

For example, if you only want to see user guides, click User Guides in the Select Content 
Type list.

8. Click  to display the search results.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on 
the Avaya-run channel on YouTube.

• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of 
the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Select 
Content Type.

- In Search, type the product name. On the Search Results page, click Clear All and select 
Video in the Select Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do 
one of the following:

- Enter a keyword or keywords in the Search Channel to search for a specific product or 
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available. For 
example, Contact Centers.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date 
documentation, product notices, and knowledge articles. You can also search for release notes, 
downloads, and resolutions to issues. Use the online service request system to create a service 
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request. Chat with live agents to get answers to questions, or request an agent to connect you to a 
support team if an issue requires additional expertise.

Support
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Chapter 2: Changes in this release

The following sections describe the new features and changes in Avaya Contact Center Select 
Release 7.1.x advanced administration.

Features
New features in the Release 7.1 base build
See the following sections for information about new features in the Release 7.1 base build:

• Avaya Workspaces configuration on page 22
• Customizing processing for customers with restricted flag on page 23
• Handling customers information on page 24
• Unsent email monitoring on page 24

New features in Release 7.1 Service Pack 1
There are no new features in Release 7.1 Service Pack 1.

New features in Release 7.1 Service Pack 2
See the following section for information about new features in Release 7.1 Service Pack 2: 
HTTPS support on page 22

New features in Release 7.1 Service Pack 3
For information about new features in Release 7.1 Service Pack 3, see Inline images for emails 
and signatures on page 24.

New features in Release 7.1 Feature Pack 1
See the following sections for information about new features in Release 7.1 Feature Pack 1:

• Ability to store encryption keys in a shared location on page 21
• Customer Journey configuration on page 23
• Enhancement of the Email Templates feature on page 23
• External server for uploading Avaya Workspaces logs on page 23
• Multimedia Data Management utility access on page 24
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New features in Release 7.1 Feature Pack 2
See the following sections for information about new features in Release 7.1 Feature Pack 2:

• Avaya-standard Grace Period on page 22
• CCMA Password Policy configuration for human and programmatic accounts on page 22
• Contact Center Manager Administration supported in Microsoft Edge with IE mode on 

page 22
• Contact Center supports OAuth 2.0 and MS Graph for Emails on page 22
• Credentials for Basic and OAuth 2.0 authentication of mailboxes on page 23
• Functionality to restore the Avaya Workspaces default layout and deleted widgets on 

page 24
• Java keystore is no longer required to store certificates for Email Manager on page 24

New features in Release 7.1 Feature Pack 2 Post GA Patches
See the following sections for information about new features in the Release 7.1 Feature Pack 2 
Post GA Patches:

• Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports 
Microsoft Windows 11 on page 21

• Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports 
Microsoft Windows Server 2019 on page 21

New features in Release 7.1.2 Service Pack 2
Release 7.1.2.2 introduces new Avaya Workspaces features. See the following sections for more 
information about new features in this release:

• Avaya Workspaces features for Release 7.1.2.2 on page 25
• Avaya Workspaces log settings in the CCMM Administration utility on page 26

Ability to store encryption keys in a shared location
From Release 7.1 Feature Pack 1, Contact Center allows using shared locations for saving keys 
for database encryption/decryption. When saving an encryption key in a shared folder, Security 
Manager displays a dialog box where you must enter credentials of a shared location.

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA 
Patches supports Microsoft Windows 11

From Release 7.1 Feature Pack 2 Post GA Patches, Avaya Contact Center Select supports 
Microsoft Windows 11 for Avaya Agent Desktop, Contact Center Manager Administration, Contact 
Center Multimedia Administration, and Communication Control Toolkit.

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA 
Patches supports Microsoft Windows Server 2019

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports the Microsoft 
Windows Server 2019 operating system. Customers that upgrade to Avaya Contact Center Select 

Features

April 2024 Avaya Contact Center Select Advanced Administration 21
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Release 7.1 Feature Pack 2 Post GA Patches and want to use Windows Server 2019 must 
perform a fresh installation on a new Microsoft Windows Server 2019. For more information about 
restoring the database to the new server, see Upgrading and Patching Avaya Contact Center 
Select.

Avaya Workspaces configuration
From Release 7.1 you can configure Avaya Workspaces using the Contact Center Multimedia 
Administration utility.

Avaya-standard Grace Period
From Release 7.1 Feature Pack 2, Contact Center supports Avaya-standard Grace Period — a 
30-day period that enables Contact Center to function when a temporary license expires.

Avaya Workspaces supports HTTPS
From Release 7.1, Service Pack 2, Avaya Workspaces supports HTTPS for secure 
communication.

CCMA Password Policy configuration for human and 
programmatic accounts

From Release 7.1 Feature Pack 2, Contact Center provides the ability to configure CCMA 
Password Policy. Password Policy is a set of rules that CCMA uses to validate passwords for 
CCMA accounts. You can select one of the CCMA Password Policy modes: Basic Security mode 
and Advanced Security mode. You can either use default Basic Security mode with fixed password 
rules, or enable Advanced Security mode, which allows you to customize your Password Policy 
for human and programmatic accounts. When creating or updating a CCMA user, you can view 
current CCMA password rules.

Contact Center Manager Administration supported in Microsoft 
Edge with IE mode

From Release 7.1 Feature Pack 2, you can access Contact Center Manager Administration using 
Microsoft Edge with Internet Explorer (IE) mode.

Contact Center supports OAuth 2.0 and MS Graph for Emails
From Release 7.1 Feature Pack 2, to comply with the Microsoft Office365 changes, Contact 
Center introduces support for OAuth 2.0 authentication and Microsoft Graph (MS Graph) for 
Emails. If you use Microsoft Office365 as an Email server, you must configure OAuth 2.0 
authentication for the Contact Center Email Manager to enable operation between the Email 
Manager and Microsoft Office365. To enable OAuth 2.0 authentication for Emails, you must create 
a Microsoft Azure application that acts on behalf of the Email Manager and then configure client 
credentials with a certificate or secret using the Contact Center Multimedia Administration utility.

Changes in this release
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Credentials for Basic and OAuth 2.0 authentication of mailboxes
From Release 7.1 Feature Pack 2, Contact Center supports credentials for Basic and OAuth 
2.0 authentication of mailboxes. You can create credentials using the new Credentials tab of the 
E-mail section in the Contact Center Multimedia Administration utility.

Basic authentication applies to POP3, IMAP or SMTP servers and uses a password as 
credentials. You can use Basic authentication for Email, Social Networking, Voicemail, Fax, 
Scanned Documents, and Text Messaging (SMS) mailboxes. When you upgrade to Contact 
Center Release 7.1 Feature Pack 2, passwords of existing mailboxes automatically migrate to 
credentials with the default name Basic_auth_1, Basic_auth_2 , and so on. You can rename 
credentials if you want.

OAuth 2.0 authentication applies to the Microsoft Office365 (MS Graph) server. You can configure 
the OAuth 2.0 Client Credentials grant type with a certificate or a client secret.

You can view the list of all migrated and new credentials in the Credentials Configuration table 
located at CCMM Administration > E-mail > Credentials.You can assign the same credentials to 
several mailboxes. You cannot delete credentials assigned to a mailbox.

Customer Journey configuration
From Release 7.1 Feature Pack 1, Avaya Workspaces supports the Customer Journey widget, 
which is available for Voice, Video, Chat, Email and Outbound contact types.
By default, the Customer Journey widget displays Email and Chat interactions. To configure 
Customer Journey for Voice and Video channels, you must enable Contact Summary statistics 
collection in the Configuration component of Contact Center Manager Administration and 
configure the Voice History server in the Contact Center Multimedia Administration utility.

Customizing processing for customers with restricted flag
Agents using Agent Desktop can set a restricted flag to a customer to prevent unsolicited emails 
and calls. From Release 7.1, in the Contact Center Multimedia Administration utility, you can 
customize processing of the customers with restricted flag. You can select from the following 
options: ignore, block or display a warning.

Enhancement of the Email Templates feature
From Release 7.1 Feature Pack 1, you can import email templates files from Agent Desktop to 
Avaya Workspaces. Agents can use the imported email templates when creating email messages 
in Avaya Workspaces.

External server for uploading Avaya Workspaces logs
From Release 7.1 Feature Pack 1, you can use an external server for uploading Avaya 
Workspaces log files. You can add the server URI using the Workspaces Configuration section 
of the Contact Center Multimedia Administration utility.

Features
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Functionality to restore the Avaya Workspaces default layout and 
deleted widgets

From Release 7.1 Feature Pack 2, you can use the new CCMM functionality to reset the Avaya 
Workspaces layout to the default version and restore all widgets deleted from Layout Manager.

Handling customer information
You can use the Multimedia Data Management utility to generate a customer information file or 
delete customer history upon request. From Release 7.1 the Multimedia Data Management utility 
allows searching for a customer by phone number and deleting customer information from the 
Voice database.

Inline images for emails and signatures
From Release 7.1 Service Pack 3, Avaya Workspaces supports adding inline images to emails 
and signatures. You can add one or several images to the email body to make the information 
easily accessible to customers. You can also increase brand awareness by adding a company 
logo to your signature.

Multimedia Data Management utility access
From Release 7.1 Feature Pack 1, you must access the Multimedia Data Management utility using 
CCMA. The Multimedia Data Management utility is no longer available from the Windows start 
menu.

Unsent email monitoring
From Release 7.1, you can use the Contact Center Multimedia Dashboard utility to view the 
number of unsent emails, analyze why emails were not sent, and manage unsent emails. The 
spike detection feature provides automatic monitoring of unsent messages and generates alarms 
when the number of unsent emails exceeds the defined threshold. You can configure spike 
detection values, such as the number of days and the percentage of unsent emails.

Java keystore is no longer required to store certificates for Email 
Manager

In Release 7.1 Feature Pack 2, Email Manager can use certificates from the Contact Center 
security store instead of the default Java keystore. You can now add certificates for use 
with TLS email connections to the Contact Center security store using the Security Manager 
functionality. This feature also ensures that certificates are not lost after upgrades. To prevent loss 
of certificates, before upgrading to Release 7.1 Feature Pack 2, add your current certificates to the 
Contact Center security store.

Changes in this release
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Avaya Workspaces features for Release 7.1.2.2
Release 7.1.2.2 introduces the following Avaya Workspaces features for Avaya Aura® Contact 
Center (AACC) and Avaya Contact Center Select (ACCS). For more information about Avaya 
Workspaces features, see Using Avaya Workspaces for AACC and ACCS.

Consult, transfer, and conference options for web chat
You can consult with another agent during a chat interaction. Messages between agents are 
whispered so the customer does not see them.
If the other agent agrees, you can do one of the following when ending the consultation:

• Transfer the web chat to the other agent.
• Start a conference.

Observe web chat
A supervisor can observe a chat interaction from the My Agents widget.

Whisper coaching during web chat
While observing a chat interaction, the supervisor can start coaching. During the coaching 
session, the supervisor can whisper guidance to the agent. The customer does not see whispered 
messages.

Barge in to web chat
A supervisor can barge in to the chat interaction and communicate with the customer directly.

Email approval
A supervisor can approve or reject an email and add review comments. The agent can edit the 
email and add comments if it is rejected.

Reschedule email
You can postpone work on an email and reschedule it for a later time. This is a useful option if you 
need more time to gather information before completing the email.

Email transfer enhancements and new forwarding option
Previously, you could only transfer an email interaction to a skillset. Now, you can also transfer the 
email to another agent. In addition, you can also forward an email to any email address.

Multiple keyword search
You can use multiple keywords when searching through email templates and suggested content.

Customer history view
Customer history information for all contact types (voice and multimedia) is now displayed 
together in the same table.

Features
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Avaya Workspaces log settings in the CCMM Administration 
utility

In Release 7.1.2.2, you can use the new Workspaces Logs area to enable data privacy and 
download permissions for Avaya Workspaces logs. You can access the Workspaces Logs area 
from Workspaces Configuration > General Settings in the Contact Center Multimedia (CCMM) 
Administration utility.

Other changes
Outdated interoperability information from previous 7.1.x releases has been removed to prevent 
confusion.

Other changes in Release 7.1.2 Service Pack 2
The following sections outline interoperability and other changes in Release 7.1.2.2:

• Interoperability with the latest WebLM releases on page 26
• VMware support on page 26
• End of support for Internet Explorer on page 26
• Windows operating system support on page 27
• Supported IP Office versions on page 27
• Avaya Aura Media Server interoperability on page 27

Interoperability with the latest WebLM releases
In Release 7.1.2.2, the latest versions of WebLM 8.1.3.x and 10.1.x are supported.

VMware support
Contact Center Release 7.1.2.2 supports ESXi 7.0 and 8.0 Update 2. Earlier VMware versions, 
including 6.5 and 6.7, are no longer supported.

See the VMware website for general lifecycle policy information.

End of support for Internet Explorer
Microsoft ended support for the Internet Explorer (IE) web browser in June 2022.
Many Contact Center applications, such as Contact Center Manager Administration (CCMA), 
Contact Center Multimedia (CCMM), and Communication Control Toolkit (CCT) require the IE 
engine. To run these applications, you must use Microsoft Edge in IE mode. If you are using 
Windows 10, IE can be disabled but cannot be removed from your computer. With Windows 11, 
you do not need to install the IE browser because Edge already includes the IE engine.

Changes in this release
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Windows operating system support
The following Microsoft operating systems are no longer supported:

• Windows 7 and 8.1

• Windows Server 2012 R2 and earlier versions

See the Microsoft website for lifecycle policy information.

Supported IP Office versions
In Release 7.1.2.2, Avaya Contact Center Select supports IP Office Release 10.1, 11.1.2, and 
11.1.3.x.

Avaya Aura® Media Server interoperability
Contact Center now supports Avaya Aura® Media Server Release 10.1.x. Release 8.0.x is also 
supported.

Other changes
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Chapter 3: Contact Center Multimedia 
fundamentals

Use the Contact Center Multimedia (CCMM) Administration utility to allow Contact Center to accept 
a variety of contact types and route them to agents. The contact types that an agent can handle are 
determined by the skillsets to which the agent is assigned.

Contact types routed using Avaya Contact Center Select include the following:

• voice contacts

• email messages

• Short Message Service (SMS) text messages

• faxed documents

• scanned documents

• voice mail messages

• outbound contacts

• Web communications contacts

Contact Center License Manager licenses each contact type. You must have the appropriate license 
in your contact center to enable routing for each contact type.

Important:

To start the CCMM Administration utility, you must first log on to Contact Center Manager 
Administration (CCMA). You must log on to CCMA from a Web browser on the Avaya Contact 
Center Select server to access the CCMM Administration utility.

Email contact type
Use email messages to communicate with clients by using an email provider such as Microsoft 
Exchange. The following figure shows the life cycle of an email contact from the time it is received 
by the email server until it is routed to an agent.

April 2024 Avaya Contact Center Select Advanced Administration 28
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Figure 1: Email contact life cycle

You can route email contacts by using rule groups based on specific information you configure 
for the contacts. The Email Manager routes incoming contacts based on the address where the 
contact is received, the text is in the email message, or who sent it. The email message is 
assigned to a skillset with a priority and then to an agent who can handle the contact based on the 
received criteria.

The email contact type has several components:

• Email rule groups on page 30

• Recipient mailboxes on page 31

• Inbound email settings on page 31

You must configure email settings for email messages leaving your contact center as a campaign 
or in response to customer email messages.

• Outbound email settings on page 31

• Character encoding for outgoing email messages on page 32

You can configure the email message contact type for international languages, see Asian email on 
page 32.

Email contact type
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You can view real-time traffic reports for your email messages. Configure the date and time for 
which you want to review the email traffic in your contact center. See Email traffic reports on 
page 33.

You can enable the Extended Email Capacity feature if you require the email backlog capacity to 
be more than 20 000. The Extended Email Capacity feature increases the email backlog capacity 
to 100 000 contacts. For more information, see Extended Email Capacity on page 33.

You can configure the Supervisor Email Approval feature so that supervisors can approve email 
messages before they reach the customers.

Note:

The approval process applies to email contacts only and does not apply to other contact types 
such as Fax, Scanned Documents, and SMS.

Based on your quality assurance requirements, regulatory requirements or agent training 
requirements, some or all of the email messages can be sent for supervisor approval. You can 
configure email messages targeted for supervisor approval on a per skillset basis or per agent 
basis. For more information, see Supervisor approval of email messages on page 34.

Agents handle email messages using Agent Desktop. For more information about Agent Desktop, 
see Agent Desktop on page 35.

Email rule groups
Rules determine how a multimedia contact is routed based on information about the email 
message (input) and configurations in your contact center.

A basic rule considers the first recipient address of the contact and can assign a skillset. You 
can further enhance the routing by searching for specific keywords in the body of an email or by 
looking at who sent the message. However, you cannot apply the keyword search for the HTML 
email format.

Rule groups are collections of rules that evaluate the incoming email and route the contact 
according to the best match or the first match. You can also enhance the routing by selecting 
additional output details for your contact center, such as automatic responses. By default, one rule 
group is supplied that contains the default rule for routing an email contact to a specific skillset 
with a priority.

Example
In this example scenario, a magazine advertises an investment strategy. Customers can learn 
more about the investment by sending an email with “Good Investing” in the subject line to a 
specific address. Create a rule to search incoming email messages for “Good Investing”. If the 
email subject line contains this text, then a brochure is sent to the customer. No interaction from 
an agent is required. The rule group “investments” is applied to the recipient mailbox where the 
email message is sent.
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Recipient mailboxes
Contact Center Multimedia polls specific recipient mailboxes on the email server based on a list 
of mailboxes defined in the Multimedia Administrator recipients list. The email retrieved from these 
mailboxes is routed based on defined rules applied to either a mail store or an alias. You must 
ensure that enabled email addresses configured in your Email Manager are already configured on 
your corporate email server.

The recipient mailbox has a default rule group assigned to handle the email messages, but you 
can assign a custom rule group to the recipient.

Recipient mailboxes also receive messages from other contact types. Voicemail contacts attach 
a .wav file. Faxes and scanned documents attach a .tiff file to an email message handled by the 
Email Manager. An SMS text message also uses the Email Manager to route text messages.

Inbound email settings
Perform this optional configuration if you are licensed for email contacts.

You can configure the following optional email settings:

• How frequently you scan the email server for new messages

• Location for storing attachments

• Text searched when you use keywords for rules

Email attachment files
In the Contact Center Multimedia configuration, the default location of the shared inbound email 
attachment folder is <Drive>:\Avaya\Contact Center\Email Attachments\Inbound. In 
this path, <Drive> is the database drive.

The shared folder path length and the attachment file name length cannot exceed 145 characters. 
The default inbound shared folder contains 49 characters. Therefore, attachment names can 
contain up to 96 characters.

Outbound email settings
Configure outbound email mailbox settings to identify who responds to the email message from 
the customer. For outgoing email, you can change the character encoding of the message to 
display the email message with the correct characters.

The response can contain the email address to which the customer sent the original email 
message or a general corporate email address configured for each skillset. Agent-initiated 
messages are always sent from an email address associated with a skillset.

If you manage emails on behalf of an external source, email messages must be relayed through 
the email server, not forwarded to another party. Sending email messages preserves the original 
To address that is used for email rule administration and outgoing email addresses.

Email contact type
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Email attachment files
In the Contact Center Multimedia configuration, the default location of the shared outbound email 
attachment folder is <Drive>:\Avaya\Contact Center\Email Attachments\Outbound. 
In this path, <Drive> is the database drive.

The shared folder path length and the attachment file name length cannot exceed 145 characters. 
The default outbound shared folder contains 50 characters. Therefore, attachment names can 
contain up to 95 characters.

Character encoding for outgoing email messages
The Contact Center Multimedia Email Manager replies to an email message using the same 
characters as the inbound email. For example, if an email arrives to the contact center with Latin-1 
encoding, the reply from the Agent Desktop or the automatic response is sent in Latin-1. The 
customer email client can understand the format of the message sent from the contact center.

If the customer sends an email message in English and receives either an agent response or 
an automatic response in another character set, you cannot tell if the customer email client can 
decode the new character set. Avaya recommends that if you use an automatic response, you use 
rules to search for words in the expected languages (for example, Japanese or English) to ensure 
that the response sent matches the language of the inbound email.

If the original email is encoded with the Latin-1 character set (ISO-8859-1), you can choose to 
reply in Latin-9 character set (ISO-8859-15) to provide support for the Euro Currency Symbol. The 
Euro Currency Symbol is not included in the Latin-1 character set, instead, it is represented by a 
question mark (?). Not all recipients understand the Latin-9 character set, and the reply email can 
be perceived as a blank email. Avaya recommends that only contact centers in Europe use Latin-9 
encoding.

Asian email
Internationalized domain names (IDN) can include characters from East Asian languages. Using 
characters from East Asian languages is dangerous because this can be used by phishing sites. 
Phishing is a way of attempting to acquire information such as names, passwords, and credit card 
details by misrepresenting a malicious website as a legitimate website.

Phishing email messages contain links to malicious websites that look similar to legitimate 
business websites. For example, the IDN of a phishing site can achieve this by replacing Latin 
1 characters with East Asian characters that are visually similar or identical.

The World Wide Web Consortium uses punycode to implement IDNs. Punycode is an ASCII 
equivalent to the domain name. Normally, the client (Web browser or email client) accepts the 
IDN in native characters and converts it to punycode; for example, xn--jp-cd2fp15c@xn--fsq.com. 
The receiving client identifies the sender as being a punycode string and interprets the native 
characters.

Contact Center Multimedia supports IDNs. You or a customer can enter a punycode email 
address. The receiving client can render the native characters.
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Email traffic reports
Reports appear in the CCMM Administration utility to show the current status of the email traffic. 
The following reports are displayed when you select Email in the left column of the Multimedia 
Administrator application. You can choose the report date and the skillsets represented in all 
displayed real-time reports.

• Email (New Vs. Closed): Shows the number of contacts in a new and closed state against 
the time for the selected date and skillsets. You can use this report to monitor the incoming 
and closing rate for email and to determine if the traffic levels are adequately managed. 
The number of new contacts is defined as those with an arrival time since midnight on the 
selected date. The number of closed contacts is defined as those with a close time since 
midnight on the selected date.

• Email Progress: Shows the number of contacts in a new or closed state on a defined date to 
determine the traffic levels for that date.

• Email Closed Contacts Queue Time: Shows the average time an email contact spends in the 
queue while the contact center is open. The queue time is defined as the time between when 
the contact arrives in the contact center and the time the contact is presented to an agent 
less the time that the contact center is closed. This report shows only closed contacts for the 
selected date and reflects only a partial summary of the service level achieved for the date.

Extended Email Capacity
The Extended Email Capacity feature increases the email backlog capacity to 100 000 contacts. 
Contact centers that have large email volumes can use the Extended Email Capacity feature 
to pull email messages that are present in the CCMM database. Agents can then view email 
contacts in the CCMM database and search or extract these contacts, while on a voice call with a 
customer.

The Email Scheduler Service is a Contact Center Multimedia (CCMM) service that monitors 
the Real-time Statistics Multicast (RSM) stream and multimedia database for skillset statistics 
corresponding to email skillsets. This service gathers the following information:

• The skillsets in service.

• The number of available agents. The CCMM database provides the number of in-service 
agents.

• The number of queued contacts. RSM provides information about the Calls Waiting statistics.

The Email Scheduler Service uses this information to ensure that sufficient contacts are queued 
on each skillset.

Note:

Generally, the system queues two contacts per logged in agent on a skillset. However, in 
certain circumstances the actual amount of contacts queued can be more.

By default, the Extended Email Capacity feature is disabled. If you require the email backlog 
capacity to be more than 20 000, you must enable this feature.

Email contact type
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If the Extended Email Capacity feature is disabled, Email Manager performs nightly checks on the 
number of email messages that have a New status in the multimedia database. If the number 
of email messages that have the New status is more than 10 000 in a standalone CCMM 
configuration and 3 000 in a co-resident configuration, Email Manager sends an email to the 
administrator to enable the Extended Email Capacity feature. You can configure the distribution 
list for this email in the Multimedia Dashboard. Email Manager uses the address assigned to the 
EM_Default_Skillset as the From Address. If you do not configure this address, Email Manager 
sends the notification to a dummy address, which triggers a delivery failure notification. The 
delivery failure notification then routes to an agent. The text of the email is set up as a prepared 
response with a default System Message.

On the Multimedia Dashboard, you can see whether the Extended Email Capacity feature is 
enabled. If the Extended Email Capacity feature is disabled, and the number of New email 
contacts in the CCMM database is more than 2 000, the dashboard displays a warning in amber. 
If the number of New email contacts in the CCMM database is more than 3 000, the dashboard 
displays a warning in red.

Supervisor approval of email messages
Before an email message reaches a customer, supervisors can approve or reject email messages 
that agents send to customers.
The approval process applies only to email contacts. The approval process does not apply to 
other contact types such as Fax, Scanned Documents, and SMS.

Configuration of Supervisor approval of email messages
Based on your requirements, the system can send some or all of the email messages to 
supervisors for approval before the system sends the email messages to a customer.
Quality assurance or Regulatory requirements: You can configure contacts that the system sends 
to supervisors for approval on a per skillset basis, which means that a percentage (0-100) of 
email messages sent from a skillset requires approval from supervisors. For more information, see 
Configuring supervisor approval for email messages on a per skillset basis on page 133.

Important:
For approval of agent email messages, you must configure an approval skillset to which the 
system sends the agent email messages.

Agent training: You can also configure contacts that the system sends to supervisors for approval 
on a per agent basis, which means that a percentage (0-100) of the email messages sent by 
particular agents require approval from supervisors.
For example, you can configure that 100% of the email messages that new agents send require 
approval from supervisors and 50% of the email messages that agents who have been in the 
contact center for over six months send require approval from supervisors. For more information, 
see Configuring supervisor approval for email messages on a per agent basis on page 58.
Agents can pull contacts for approval. You must restrict this by configuring skillset partitions.
Agents cannot request approval of email messages. You cannot configure keywords to trigger the 
approval process.
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You can configure up to five levels of approval from supervisors before email messages reach 
customers. The system sends email messages through a hierarchy of supervisors before the 
system grants the final approval.
You can also configure the system to automatically reject email messages from all skillsets based 
on keyword groups. For more information, see Configuring auto-rejection of email messages from 
all skillsets that use approval hierarchy on page 135.

Flow of email messages through Agent Desktop
Agent Desktop handles the flow of email messages as follows:

• When an agent sends an email message, the system marks the email message for approval 
and returns the email message to a predetermined skillset in the queue for approval.
Supervisors who review the email message that the agent sends to the customer must be 
assigned to the approval skillset.
Agents can belong to the skillset that approves email messages. Therefore, you must 
configure the approval process in a way that restricts agents from approving email 
messages.

• If the supervisor approves the email message, the system marks the email message to 
be sent to the customer or returns the email message to the queue if the email message 
requires further approval. If the email message requires further approval, the system targets 
the email message to the next approval skillset in the hierarchy.

• If the supervisor rejects the email message, the system marks the email message as rejected 
and returns the email message to the queue targeted to the previous skillset. The email 
message flows through the rejection hierarchy till the email message reaches the originator 
for redrafting. The supervisor must add review comments so that the originator can redraft 
the email message.
Only the originator of the email message can edit or redraft the email message. Supervisors 
at all levels can only add review comments.

The system does not move email messages through the approval hierarchy in the following 
situations:

• You delete a skillset that is part of the supervisor approval chain and the contact is already in 
queue waiting for that skillset to come into service

• You delete the original agent and a supervisor rejects the email message
• You delete the supervisor who must approve the email message

In order to handle such contacts, agents must use Agent Desktop to pull contacts.

Agent Desktop
Agents use Agent Desktop to process email contacts. When an email message arrives at the 
contact center, it is routed to Agent Desktop, and agents can perform the following activities:

• Accept or reject an email message.

• Review and update customer information.

• Create a reply.

Email contact type
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• Transfer the contact to an agent, skillset, or expert.

• Select a prepared response to send to the customer contact.

• Select an activity code to record the result of the customer contact.

CCMM Dashboard utility
Use the CCMM Dashboard utility to perform the following tasks:

• Monitor the number of contacts for optimum performance.
• Troubleshoot contact routing errors.
• Detect and analyze unsent emails.

CCMM Contacts monitoring
You can use the CCMM Dashboard utility to monitor the number and state of contacts in the 
Contact Center database. On the CCMM Dashboard, the CCMM Contacts by Type section 
displays the type, state, and number of contacts in the Contact Center database.
The CCMM Contacts by Type section has the following columns:

• Type — the contact type name is displayed in this column, for example, EMail, Outbound, 
Scanned Document.

• New — the contact is currently in a queue, the new contact has not yet been assigned to an 
agent.

• Open — the contact is currently presented to an agent, the agent is handling this open 
contact.

• Closed — the contact was handled and is now finished.
• Waiting — the waiting state is used when the Extended Email Capacity feature is enabled. 

Contacts that are not added to a queue and/or moved to the New state are in the Waiting 
state.

The CCMM Contacts by Type section has a row labelled Total, which displays the total number of 
contacts in each of the above columns.
You can use this information to monitor the number of contacts for optimum performance.

Troubleshooting contact routing errors
About this task
You can use the CCMM Dashboard utility to troubleshoot contact routing errors.

Before you begin
When an email contact is presented to an agent, use the left panel of Avaya Agent Desktop to get 
the email contact ID number.
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Procedure
1. On CCMM Dashboard, click Routing Search.

The Contact Routing Search screen is displayed.

2. On the Contact Routing Search screen, in the contact ID box, type the contact ID number 
of the email contact.

3. Click Search.

Result
When the search completes, the Contact Details, Association, Rule Details, and Rule Group 
Associated Email Addresses sections display routing information about the email content:

• The Contact Details section contains the general information about found contact.
• The Association section contains the information about To Address associated with any 

special Rule Group or System Default Rule.
• The Rule Details section shows the rule applied to found contact and skillset name which 

was used according with this rule.
• The Rule Group Associated Email Addresses section shows what email addresses are 

applied for the rule used for found contact.

CCMM unsent emails monitoring
In the CCMM Dashboard utility you can:

• See the number of unsent emails.
• Analyze why emails were not sent.
• Manage unsent emails.

The following options are available to filter unsent emails:
• Day— shows the hourly breakdown of emails unsent within the last 24 hours.
• Month — shows the daily breakdown of all emails unsent within the last month.

On the Data window, you see the following information about unsent emails:

Column Description
Time Time periods when emails failed to be sent:

• One hour for the Day filter.

• One day for the Month filter.
Barred Address Number of emails unsent due to barred addresses. See Barring email 

addresses on page 140 and Deleting a barred email address on 
page 140 to learn how to manage barred addresses.

Waiting in Queue Number of unsent emails currently being processed for sending.
Software Exception Number of unsent emails unsent due to software errors.

Table continues…

CCMM Dashboard utility
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Column Description
Lost Records Number o unsent emails with unknown status.
Waiting Too Long Number of unsent emails waiting in queue more than 2 days.

To manage unsent emails, you can perform the following actions:
• Resend emails to return the emails to the queue for resending.
• Mark as Not A Problem to delete the emails from the list of unsent emails.
• Get List Of ContactID to see the list of contact IDs for all unsent emails. Use the contact ID 

to get detailed information on the contact using Agent Desktop. See Using Agent Desktop for 
Avaya Contact Center Select .

Spike detection
Spike detection generates an alarm when the number of unsent emails exceeds the defined 
threshold. It is required to detect and troubleshoot errors. The spike detection process launches 
automatically during CCMM startup and at midnight.
When the percentage of unsent emails for the last several days exceeds the defined threshold:

• CCMM Dashboard shows the red X icon for Unsent outgoing emails line.
• An event with ID 4095 is displayed in Windows Event Log.

Managing unsent emails
About this task
Use this procedure to see the number of unsent emails and to manage them as required.

Procedure
1. On CCMM Dashboard, click Unsent emails.

The Unsent outgoing emails screen appears.

2. Choose one of the following filters:

• Click Day to see unsent emails within the last 24 hours.

• Click Month to see unsent emails within the last month.

The Data for the day or the Data for the month screen appears accordingly.

3. Right-click the number of emails you want to manage and choose one of the following 
options from the list:

• Resend emails to return the emails back to the queue for resending.

• Mark as Not A Problem to delete the emails from the list of unsent emails.

• Get List Of ContactID to show the list of contact IDs for all unsent emails.
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Configuring spike detection
About this task
If the percentage of unsent emails exceeds the defined threshold within the configured number of 
days, the CCMM Dashboard generates an alarm. By default, the number of days value is set to 2 
and the threshold value is set to 5%. Use this procedure to change the default settings.

Procedure
1. Navigate to Avaya\Contact Center\Multimedia Server\Server 

Applications\EMAIL and open the mailservice.properties file.

2. For the mail.alimentum.spike.days parameter, change the default number of days 
for mail spike detection to the required value.

For example, mail.alimentum.spike.days=3.

3. For the mail.alimentum.spike.threshold parameter, change the default threshold 
for spike detection to the required value.

For example, mail.alimentum.spike.threshold=7.

SMS text messages, faxes, scanned documents, and 
voicemail attachments

SMS is a standard communications protocol for the exchange of short text messages between 
mobile phone devices. SMS messages are forwarded by an SMS gateway to an email address.

A fax is a document sent over a phone line. Faxes are forwarded by a fax server to an email 
address as a .tiff attachment.

A scanned document is an electronic version of a printed page or document. Scanned documents 
are forwarded by a document imaging server to an email address as a .tiff attachment.

A voicemail is a spoken message, such as a message on an answering machine. Voicemail 
messages are forwarded by a voicemail server to an email address as a .wav attachment.

For each type of contact, you can configure the routing of the specified contact and assign a 
priority to the contact. See Mailbox configuration on page 40.

You can view traffic report summaries for each type of contact. See Traffic reports on page 40.

Use the Agent Desktop to open and reply to SMS, faxes, scanned documents, and voicemail 
contacts. See Agent Desktop on page 41.

For each contact type, the Email Manager retrieves the message or attachment and queues it 
to the default or defined skillset with the assigned priority. For faxes and voicemail attachments, 
Email Manager enables the caller ID to be extracted to facilitate replies or callbacks.

SMS text messages, faxes, scanned documents, and voicemail attachments
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Figure 2: Contacts attached to email cycle

Mailbox configuration
You can configure the following properties for the contacts:

• POP3 or IMAP Server (for receiving email messages)

• recipient mailbox

• password for access to the mailbox

• skillset and priority

• sender address, either full sender address or Calling Line ID (CLID)

• reply address for skillset

• SMTP Server (for sending email messages)

• sending mailbox

Traffic reports
Reports appear in the CCMM Administration utility to show the current status of the contact type 
traffic. The following reports appear when you select the contact type in the left column of the 
Multimedia Administrator application. You can choose the report date and the skillsets represented 
in all displayed real-time reports.

• The New Vs. Closed report shows the number of contacts in a new and closed state against 
the time for the selected date and skillsets. You can use this report to monitor the incoming 
and closing rate for contacts of a particular type and to determine if the traffic levels are 
adequately managed. The number of new contacts is defined as those with an arrival time 
since midnight on the selected date. The number of closed contacts is defined as those with 
a close time since midnight on that date.

• The Progress report shows the number of contacts in a new or closed state on a defined date 
to determine the traffic levels for the selected date.

• The Closed Contacts Queue Time report shows the average time a contact spends in the 
queue while the contact center is open. The queue time is defined as the time between when 
the contact arrives in the contact center and the time the contact is presented to an agent 
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less the time that the contact center is closed. This report shows only closed contacts for the 
selected date, and reflects only a partial summary of the service level achieved for the date.

Agent Desktop
Agents use Agent Desktop to process SMS, faxes, scanned documents, and voicemail contacts. 
When one of these contacts arrives at the contact center, CCMM routes it to a skillset, and agents 
can perform the following activities:

• Accept or reject the contact.

• Review and update customer information.

• Create a reply.

• Select a prepared response to send to the customer.

• Select a activity code to record the result of the customer contact.

Outbound contact type
The outbound contact type is an outgoing call made by agents to customers for sales or 
marketing.

The following figure shows how outbound contacts interact with Contact Center Manager 
Administration, Contact Center Multimedia, and Contact Center Manager Server.

Outbound contact type
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Figure 3: Outbound contact type routing

Contact Center Outbound consists of several components:

• Outbound Campaign Management Tool on page 42

• Campaign Scheduler on page 43

• Agent Desktop on page 43

• Contact Center Manager Administration on page 43

Outbound Campaign Management Tool
Use the Outbound Campaign Management Tool in Contact Center Manager Administration to 
create, modify, and monitor outbound campaigns.

A contact center administrator or supervisor can use the Outbound Campaign Management Tool 
to create and monitor outbound campaigns. The Outbound Campaign Management Tool provides 
the following main functions:

• Define a campaign.

• Import call data.
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• Create disposition codes.
• Review outbound call data.
• Create and preview optional agent scripts.
• Review campaign progress.

Campaign Scheduler
This Contact Center Multimedia server component determines when to queue contacts to the 
Contact Center Manager Server. The Campaign Scheduler monitors the status of each campaign 
and performs the following actions:

• Assigns the campaign status to running and queues contacts to Contact Center Manager 
Server when the campaign start time or daily start time occurs.

• Assigns the campaign status to nonrunning and removes contacts from Contact Center 
Manager Server when the daily end time occurs.

• Assigns the campaign status to expired and removes contacts from Contact Center Manager 
Server when the daily end time occurs.

• Assigns the campaign status to completed when all contacts are processed.

The Campaign Scheduler queues outbound contacts at the rate required to maintain 5 outbound 
contacts waiting for each logged in agent on each outbound skillset.

The Campaign Scheduler also queues rescheduled outbound contacts falling due within the next 
15 minutes. Therefore the Real Time Display (RTD) for the skillset can show more than 5 times 
the number of staffed agents, depending on rescheduled outbound contacts falling due within the 
next 15 minute period.

The RTD can display less than 5 times the number of staffed agents, where there are not enough 
outbound contacts, which fall within the configured dialing hours based on customer time zone, 
waiting in outbound campaigns.

Agent Desktop
Agents use Agent Desktop to process outbound contacts. When a campaign runs, outbound 
contacts are routed to Agent Desktop, and agents can perform the following activities:

• Accept or reject an outbound contact.
• Review and update customer information.
• Make the outbound voice call.
• Follow an agent script and record customers answers and comments.
• Select a disposition code to record the result of the call.

Contact Center Manager Administration
Use Real-Time Reporting and Historical Reporting in Contact Center Manager Administration to 
create and run real-time and historical reports for outbound contacts.

Outbound contact type

April 2024 Avaya Contact Center Select Advanced Administration 43
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Real-Time Reporting displays real-time and up-to-date statistics information regarding a 
campaign, such as the number of waiting contacts, the number of answered contacts, or the 
average answer delay.

Web services
The Open Queue Open Interface delivers existing Open Queue functions to third-party 
applications that use a Web service. Third-party applications can add and remove contacts of 
a specific type in Contact Center.

For more information, see the SDK documentation.

Web communications
Contact Center provides two services for web chat: Web Communications text chat and Enterprise 
Web Chat (EWC). EWC supports integration with Agent Desktop on a Voice and Multimedia 
Contact Server with or without AAMS, or with a standalone Multimedia Contact Server, on a 
Unified Communications solution. EWC is a licensed feature, and requires a Web Chat SDK 
license.

Use the Web Communications Manager to communicate with customers over the Internet. 
Agents and customers directly communicate in real time by conducting a two-way conversation 
by exchanging text messages using JavaScript- and frame-compliant Web browsers. The Web 
Communications Manager provides the following functions:

• intelligent routing of customer communications to the agent who has the subject knowledge 
to respond

• an Agent Desktop interface for agents to respond efficiently to customers

• easy referencing of the thread of conversation between the customer and the agent in a text 
chat session

• an optional customer-centered multimedia presentation to the customer’s browser while the 
customer waits for an agent

• push Web pages to the other party during conversations for discussions

• the ability for agents to accept and work on multiple contacts

• the ability for agents to transfer Web Communications contacts to other agents

You must configure the skillset and configure the Web server to configure the Web 
Communications Manager.

Contact Center Multimedia fundamentals

April 2024 Avaya Contact Center Select Advanced Administration 44
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Chapter 4: General configuration

The Contact Center Multimedia server supports multimedia contacts. To manage the multimedia 
contacts, you must configure general administrator settings and global routing options.

Configuring browser security settings
About this task
Use Microsoft Edge in Internet Explorer mode to access Contact Center Manager Administration.

Procedure
1. In your Microsoft Edge browser, navigate to More Tools > Internet Options.

The browser displays the Internet Properties window.

2. On the Security tab, click the Trusted sites option.

3. Click Custom level.
4. In the Security Settings - Trusted Sites Zone window, under the .NET Framework-reliant 

components heading, click Enable for the following:

• Run components not signed with Authenticode
• Run components signed with Authenticode

5. Under the ActiveX controls and plug-ins heading, click Enable for the following:

• Automatic prompting for ActiveX controls
• Run ActiveX Controls and plug-ins
• Script ActiveX Controls marked safe for scripting

6. Under the Downloads heading, click Enable for the following:

• Automatic prompting for file downloads
• File download

7. Under the Miscellaneous heading, click Enable for the following:

• Allow script-initiated windows without size or position constraints
• Allow websites to open windows without address or status bars
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8. In the Reset custom settings area, select Medium-low from the Reset to: list.

9. Click Reset.
10. In the Warning dialog box, click Yes to confirm.

11. Click OK.

12. If you enabled ActiveX options, click Yes to confirm your selection when prompted.

13. Click Trusted Sites.

14. Click Sites.

15. Clear the Require server verification {https:} for all sites in this zone check box.

16. In the Add this website to the zone field, type the server name (not the IP address) for 
your Avaya Contact Center Select server.

17. Click Add.

18. Click Close to return to the Internet Options window.

19. Click the Privacy tab.

20. In the Pop-up Blocker area, select the Turn on Pop-up Blocker check box.

21. Click Settings.

22. On the Pop-up Blocker Settings window, in the Address of website to allow field, type the 
Avaya Contact Center Select server URL.

The default URL is https://<server name>. Alternatively, if you turned off Web 
Services security, type http://<server name>, where <server name> is the name of 
the Avaya Contact Center Select server.

23. Click Add.

24. Click Close.

25. On the Internet Options window, click the Advanced tab.

26. Under Browsing, clear the Reuse windows for launching shortcuts check box.

27. Click OK to close the Internet Options window.

28. Restart the browser to activate your changes.

Starting CCMM Administration utility
About this task
Use this procedure to enable the CCMM Administration utility in CCMA to commission and 
maintain multimedia resources.

General configuration
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Before you begin
• To access CCMA in the Microsoft Edge browser, enable Internet Explorer mode in Edge.
• Ensure that you have administrator login credentials.

Procedure
1. In your browser, type the URL of the Contact Center server.

For example, type https://<server name>. If you turned off Web Services security, 
type http://<server name>, where <server name> is the computer name of the 
Contact Center server.

2. Press Enter.

The browser displays the CCMA interface.

3. In the User ID field, type your username.

4. In the Password field, type your password.

5. Click Log In.

CCMA displays the Launchpad area.

6. In the Launchpad area, click Multimedia.

7. In the navigation pane, select the CCMM server to administer.

CCMA displays the Multimedia Administration area.

8. Click Install prerequisite software.

The software requires some time to install.

9. Click Launch Multimedia Client.
10. In the File Download dialog box, click Run.

If you see an Application Run Security warning or a SmartScreen Filter warning message, 
confirm that the publisher is set to Avaya.

Configuring the reporting credentials
About this task
Configure the password for the mmReport user. The mmReport user is configured in the 
Multimedia database to pass data and reporting information to Contact Center Manager 
Administration to generate real-time and historical reports, and integrated reporting.
If you change the password in the Contact Center Multimedia Administrator application, you must 
update the Contact Center Multimedia password in Contact Center Manager Administration.

Configuring the reporting credentials
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click General Settings.

4. In the Reporting Credentials section, under Reporting Account Password Reset, select 
the account ID for the reporting. The default account is mmReport.

5. Click Set Password to use the default password. The default password is assigned to new 
agents.

OR

Type the new password in the New Password and Confirm Password boxes.

The password must fulfill the following complexity criteria:

• Must be between 8 to 20 characters
• Must contain a number
• Must contain at least one uppercase letter and at least one lowercase letter
• Must not contain spaces
• Must not contain any of these characters: \ & : < > |

6. Click Save.

Adding administrators
About this task
Add administrators for the Contact Center Multimedia server to control access to configuration 
components in your contact center. For example, one administrator account can provide access to 
configure the predictive support tool or some Web services.

Procedure
1. Open the Multimedia Administration utility. See Starting the CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Administrator Settings.

4. Click New.

5. In the General Identification Details section, type the last name, the first name, and the 
user name of the Administrator.

6. In the Contact Details section, add information about how to contact the Administrator, 
such as the phone number, fax number, and email address.

General configuration
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7. In the Password section type and confirm your password.

The password must fulfill the following complexity criteria:

• Must be between 8 to 20 characters
• Must contain a number
• Must contain at least one uppercase letter and at least one lowercase letter
• Must not contain spaces
• Must not contain any of these characters: \ & : < > |

8. Click Save.

Removing administrators
About this task
Remove an administrator account that you no longer require in your contact center.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Administrator Settings.

4. Select the administrator account to remove.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the decision.

Configuring office hours
Before you begin

• Know the office hours of the contact center.

About this task
Configure the days and hours that your contact center is open each week.
Configuring the office hours is important to determine accurate queued time for contacts that can 
have a delayed response such as email, voicemail, SMS, scanned documents, and faxes. For 
example, if a contact is received on Friday and processed on Monday and you configure the office 
hours to show the contact center is closed over the weekend, the queue time for the contact only 
includes the time the contact center is open.

Removing administrators
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You can use the office hour calendar in email rules. The email rules can send a specific response 
if the office is closed.
The office hour calendar uses sliders to indicate closed times for your contact center. The Start 
Closed Period slider is a blue triangle ( ). The End Closed Period slider is a red triangle ( ). Each 
closed period is shown in red with a Start Closed Period and End Closed Period at the beginning 
and end of the closed office hours.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Office hours.

4. Under Template, type the name of a calendar to configure.

5. Configure holidays for the office hour template.

6. Beside a day of the week, click .

7. For the day you select, move the Start Closed Period  and End Closed Period  sliders to 
define a period when the contact center is closed.

Open hours for the contact center are shown by the green bars. Closed hours are in red.

8. Repeat step 6 on page 50 and step 7 on page 50 for every day of the week.

9. Click Save.

Configuring holidays
Before you begin

• Identify the closed days of the contact center.

About this task
Configure the days and times that your contact center is open for holidays.
Configuring the office hours is important to determine accurate service levels for contacts that can 
have a delayed response such as email, voicemail, SMS, scanned documents, and faxes. For 
example, if a contact is received on a holiday, the queue time for the contact includes only the time 
the contact center is open.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Office hours.
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4. Under Template, type the name of a calendar to configure.

5. In the holiday box, under Name, type the name of a public holiday.

6. Select the Holiday Date for the holiday and specify the time for the holiday. You can 
choose from All Day or a specify Start time and End time.

7. Click Save.

Applying office hours
Before you begin

• Create a calendar template with office hours or holidays. See Configuring office hours on 
page 49 or Configuring holidays on page 50.

About this task
Apply a designated calendar showing open and closed hours of the contact center controlled by 
the Contact Center Multimedia server.
The designated calendar is used in email settings for the contact center.
You can respond to email messages by selecting the office hours calendar to send automatic 
messages to incoming email contacts. You can select which rule group to apply the global office 
hours to. For more information, see Creating or changing rules on page 127.
You can also configure a calendar for each skillset in your contact center. For more information 
about configuring office hours for a skillset, see Configuring skillsets for email on page 109.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. In the left pane, click General Settings.

4. Under Office Hours, select the Out of office hours treatment is enabled check box to 
automatically send an out-of-office type message to the customer when the contact center 
is closed.

5. Select the calendar you want to use to determine the business hours for your contact 
center.

6. Select the automatic response for the out of office hours notice.

7. Click Save.

Applying office hours
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Viewing real-time traffic reports by contact
About this task
For email, voicemail, fax, SMS, and scanned documents, you can view traffic reports for each 
contact type.
The following reports are displayed when you click View Reports in the left pane of the Contact 
Center Multimedia application. You can choose the report date and the skillsets represented in all 
displayed real-time reports.

• The New Vs. Closed report shows the number of contacts in a new and closed state against 
the time for the selected date and skillsets.

• The Progress report shows the number of contacts in a new or closed state on a defined date 
to determine the traffic levels for that date.

• The Closed Contacts Queue Time report shows the average time a contact spends in queue 
while the contact center is open.

You can change the time for the displayed traffic reports. See Configuring the displayed date for 
traffic reports on page 52.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select a media type that supports traffic report views.

Examples of media types include text messaging (SMS), email, fax, scanned documents, 
and voicemail.

3. Click View Reports.

Configuring the displayed date for traffic reports
About this task
For email, voicemail, fax, SMS, and scanned documents, you can view traffic reports for each 
contact type. You can choose a date and specify the skillsets for each media type.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select a media type that supports traffic report views.

Examples of media types include text messaging (SMS), email, fax, scanned documents, 
and voicemail.

3. Click View Reports.

General configuration
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4. In the bottom left corner of the report view, in the Report Date list, select the date for which 
to view traffic for your contact center.

5. To display all skillsets, select the Select All Skillsets check box.

Alternatively, you can specify the skillsets to view. The skillsets must be valid for the 
contact type you are reviewing.

6. Click Update.

Adding a Java keystore certificate for TLS LDAP 
connections

About this task
Contact Center Multimedia supports TLS to protect data. You must add a directory LDAP server 
certificate for TLS LDAP connections. Otherwise, the CCMM Phonebook cannot communicate 
securely with the directory LDAP server.
Email Manager can use certificates from the Contact Center security store. However, you must 
use this procedure for LDAP, which requires certificates from the Java keystore. By default, major 
certification authorities, such as Verisign, are trusted.
If the required Java keystore certificates are missing, the CCMM Phonebook log might display an 
error such as the following:
javax.net.ssl.SSLHandshakeException: PKIX path building failed: 
sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid 
certification path to requested target

Before you begin
Use a false connection on the fallback. If you set fallback to false, a secure connection cannot be 
established and the operation fails. If you set the fallback to true, the connection is insecure during 
a failure.

Procedure
1. Copy the certificate file into the C:\Program Files (x86)\Zulu\zulu-8–

jre\lib\security directory.

2. From the Start menu, navigate to Command Prompt.
3. Run the following CD command to change to the Java security certificates directory:

CD “C:\Program Files (x86)\Zulu\zulu-8–jre\lib\security”
4. Run the following command:

keytool -importcert -alias <mycacert> -file <mycacert>.cer -keystore cacerts

In this command, <mycacert> is the name of your certificate file.

5. When Java keytool prompts you for a keystore password, type changeit as the default 
installation password for the JRE trust keystore.

Adding a Java keystore certificate for TLS LDAP connections
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After printing the certificate details, Java keytool prompts you to trust this certificate.

6. Type yes and then press Enter to update the keystore.

7. Type the keystore password changeit.

8. Restart the LDAP service.

9. (Optional) To change the default password for security reasons, type the following 
command and enter a new password:
keytool -storepasswd -new changeit -keystore
C:\Program Files (x86)\Zulu\zulu-8–jre\lib\security\cacerts

Related links
Adding a certificate for use with TLS email connections on page 142

Configuring a directory LDAP server
About this task
The LDAP server contains databases of customer addresses and other information to use in 
Agent Desktop. Agents can select recipients from the Directory LDAP list when composing an 
email message.

Before you begin
Ensure that you add the directory LDAP certificate for use with TLS LDAP connections. For more 
information, see Adding a Java keystore certificate for TLS LDAP connections on page 53.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click General Administration.

3. Click Server Settings.

4. Select Directory LDAP Server.
5. Click Edit.
6. Select Anonymous Logon to enable the administrator to log on to the LDAP server 

without providing a username or domain.

7. Select Enable Address Book Retrieval to enable directory lookup.

8. In the User field, type the username of the LDAP administrator in the format domain 
name\username.

9. In the Password field, type the password for the LDAP server administrator.

10. In the Polling Interval field, type the polling interval, in hours, for the interval between polls 
for email server lookup.
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11. In the Search Base field, specify the preciseness of the LDAP search.

For example, avoid searching for all users in a large enterprise of tens of thousands of 
people. Instead, use a more restrictive search base, such as searching for names in the 
local workgroup.

12. Click Edit Server to change the properties of the directory LDAP server.

13. In the Server Name field, type the server name for the email server that you use to get 
email addresses.

The default port number for the LDAP server is 389.

14. In the Server Port field, type the port number for the server.

15. Select Use TLS if you want Agent Desktop to communicate securely with the directory 
LDAP server.

The server specified must support TLS.

16. Click Save.

17. Click Test to test the connection to the LDAP server.

18. Click Save.

Configuring a Phonebook LDAP server
About this task
Configure a Phonebook LDAP server to provide agents with a list of contacts during a voice call or 
while working on an email contact.

Before you begin
• Configure the directory LDAP server. For more information, see Configuring an LDAP 

server on page 54.

Important:
To retrieve contacts from the LDAP server, select the Enable Address Book Retrieval 
check box.

• Ensure that you add the directory LDAP certificate for use with TLS LDAP connections. 
For more information, see Adding a Java keystore certificate for TLS LDAP connections on 
page 53.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click Agent Desktop Configuration.

3. On the Agent Desktop General Settings page, click Advanced.

Configuring a Phonebook LDAP server
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4. On the Advanced Settings page, enable the Contact Center LDAP Phone Book check 
box.

5. Click Save.

6. Click Yes.

7. Click OK.

8. In the left pane, select General Administration.

9. Click Server Settings.

10. Click New.

11. In the Server Type list, select the Phonebook LDAP Server option.

12. In the User field, type the username for the administrator of the Phonebook LDAP server in 
the format domain name\username.

13. In the Password field, type the password for the administrator of the Phonebook LDAP 
server.

14. In the Polling Interval field, type the polling interval, in hours, for the interval between polls 
for email server lookup.

15. In the Search Base field, specify the precision of the Phonebook LDAP search.

For example, avoid searching for all users in a large enterprise of tens of thousands of 
people. Instead, use a more restrictive search base, such as searching for names in the 
local workgroup.

16. Click Edit Server to change the properties of the Phonebook LDAP server.

17. In the Server Name field, type the server name.

18. In the Server Port field, type the port number for the server.

19. Select Use TLS if you want Agent Desktop to communicate securely with the Phonebook 
LDAP server.

The server specified must support TLS.

20. Click Save.

21. Click Test to test the username, password, and search base by connecting to the 
configured server to retrieve contacts.

22. Click Save.
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Chapter 5: Agent Desktop configuration

The Contact Center Multimedia Administrator application includes settings that you use to configure 
properties for Agent Desktop. These settings allow agents to access database information and work 
with contacts.

Perform the procedures in this chapter to configure the Agent Desktop settings.

If your Contact Center uses Enterprise Web Chat (EWC), agents handling Web Communications 
contacts do not use Agent Desktop. These agents use a custom desktop that you develop using an 
SDK. The SDK documentation specifies the configuration file through which you configure settings 
for the custom desktop.

Adding a friendly name for a web chat agent
About this task
Contact Center administrators can add a friendly name or nickname for a web chat agent.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Agent Settings.

4. In Edit Single Agent Settings, in the Friendly name field, type the friendly name for the 
web chat agent.

The rules for the friendly name are similar to the rules for first name, which are as follows:

• Can have a maximum of 30 characters

• Can have white spaces

• Cannot have the following characters: "!""#$%&*+/:;<=>?@[\]^`{|}~"

5. Click Save.

Next steps
Administrators must also choose the label that gets displayed in agents’ responses to text chat 
messages with the contact. Administrators can also choose that the friendly name is displayed 
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in welcome messages. For more information, see Configuring welcome messages and text chat 
labels on page 151.

Controlling access to email message text
About this task
Agents, by default, cannot edit text in an email message. You can either enable particular agents 
or enable all agents to delete text from email messages that enter the contact center.
For example, select this feature so agents can delete credit card information from an email 
message to protect confidential customer information.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Agent Settings.
4. Select the Enable E-mail Text Deletion For All Agents check box, to enable all agents to 

delete text from email messages.

OR

Click the agent, and under Delete Enabled, click the Yes option, to enable that agent to 
delete text from email messages.

5. Click Save.

Configuring supervisor approval for email messages on a 
per agent basis

About this task
Supervisors can approve email messages before the email messages reach the customers.

Note:
The approval process applies to email contacts only. The approval process does not apply to 
other contact types such as Fax, Scanned Documents, and SMS.

The approver of the email messages is the supervisor assigned to the approval skillset of the 
contacts that the agent handles.
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Note:
Agents can pull contacts for approval. Restrict agents from pulling contacts for approval by 
configuring skillset partitions.

You can configure the system to send email messages to supervisors for their approval on a 
per agent basis or per skillset basis. For more information, see Supervisor approval of email 
messages on page 34 and Configuring supervisor approval for email messages on a per skillset 
basis on page 133.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Agent Settings.

4. From the right pane, select an agent.

5. Under Edit Agent Settings in the Email Approval Ratio field, type the percentage of email 
messages that require supervisor approval for the agent.

The approval ratio must be whole numbers ranging from 0 to 100.

6. Click Save.

Creating or changing custom fields in Agent Desktop
About this task
You can add a custom field to the Agent Desktop for multimedia contacts that pertains to your 
contact center. For example, if your customers subscribe to a magazine, you can view information 
about each customer's subscription expiry date.
The value entered by the contact center agent for each customer appears in the custom field, the 
same as any other customer-entered information such as email address or phone numbers.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Resources.

4. In the first blank row under Current Custom Fields, type the name of a custom field.

OR

Click on an existing field to change the label.

5. Press Tab to save your changes.
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Deleting a custom field in Agent Desktop
About this task
Delete a custom field from the Agent Desktop when it is not required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Resources.

4. Under Current Custom Fields, select a custom field.

5. Press Delete on your keyboard.

The system displays a Warning dialog box.

6. Click Yes to confirm the decision.

Creating or changing a closed reason
About this task
Indicate a reason for closing a contact.
If one or more closed reasons are configured, then the agent must choose a closed reason to 
close the contact; otherwise, the agent need select no reason.
You can choose a default closed reason for each type of contact. See Configuring default closed 
reasons on page 61.
You can also assign a default closed reason to each contact type. The default reason is selected 
in the Agent Desktop application. The agent can choose another closed reason when closing a 
contact.

Important:
You cannot modify a default closed reason code.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Resources.

4. Under Closed Reason, type a name for the Closed Reason.

5. Under the Type box, select All or the type of contact for each closed reason.
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6. Press Tab to save your changes.

Configuring default closed reasons
Before you begin

• Create a closed reason. See Creating or changing a closed reason on page 60.

About this task
You can specify a default closed reason for each contact type (email, fax, SMS, Web 
communications, scanned document, and voicemail) in the contact center. A contact is 
automatically assigned the default closed reason code unless an agent changes it when the 
contact is closed.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Default Closed Reasons.

4. In the E-mail drop-down box, select the configured closed reason to apply to email 
message contacts by default.

5. In the Fax drop-down box, select the configured closed reason to apply to email message 
contacts by default.

6. In the SMS drop-down box, select the configured closed reason to apply to SMS message 
contacts by default.

7. In the Web Comms drop-down box, select the configured closed reason to apply to Web 
communications contacts by default.

8. In the Scanned Doc drop-down box, select the configured closed reason to apply to 
scanned documents contacts by default.

9. In the Voice Mail drop-down box, select the configured closed reason to apply to voicemail 
contacts by default.

10. Click Save.

Deleting a closed reason
About this task
Delete a closed reason if you do not want the reason to appear in the Agent Desktop application. 
You cannot delete a default closed reason code.
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Important:
You can delete only one row at a time.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Resources.

4. Select a closed reason from the list.

5. Press Delete on your keyboard.

The system displays a Warning dialog box.

6. Click Yes to confirm the decision.

Configuring Shortcut keys for Agent Desktop
About this task
You can configure shortcut keys that agents can use in Agent Desktop. Agents can use shortcut 
keys to perform common tasks in Agent Desktop more efficiently.
In the CCMM Administration utility, you can map shortcut keys to a list of activities that agents 
perform on Agent Desktop. The default keys are already specified in the CCMM Administration 
utility. However, you can choose to change the default keys as you see fit for operational reasons.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Shortcut Keys.

The system displays the list of shortcut keys, which are mapped to specific activities that 
agents perform on Agent Desktop.

4. Update the shortcut keys as required.

Shortcut keys have the format of Ctrl + (Optional) additional modifier + an alphanumeric 
character.

The (Optional) additional modifier is either Shift or Alt. The alphanumeric character is in the 
range [A-Z] or [0–9].

For example, the shortcut key for Login / Logout is Ctrl + Shift + L.
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Note:

If you select NONE in the additional modifier field and NONE in the alphanumeric field 
of a shortcut key for a task, then the shortcut key for that task is disabled. This means 
that agents cannot use the shortcut key to perform this task on Agent Desktop.

For example, if we select CTRL + NONE + NONE for Login / Logout, then the shortcut 
key for Login / Logout is disabled. The agents cannot use shortcut keys to login to or 
logout from Agent Desktop.

5. Click Save.

The system displays a Warning dialog box.

6. Click Yes to confirm the change.

Configuring basic screen pops
About this task
Use the Basic Screenpop page to configure application shortcuts and intrinsics.

Note:
These settings apply to both Agent Desktop and Avaya Workspaces.

Agent Desktop starts these applications when it displays an alert (Launch State: Alerting) for a 
work item or when an agent accepts a work item (Launch State: Active). When the agent opens 
the contact, the system displays the intrinsics for an open contact in Agent Desktop.
You can select one intrinsic that Contact Center sends as a parameter to the configured basic 
screen pop applications.
By default, the screen pop intrinsics list includes the standard intrinsics present on any call that 
Contact Center handles. You can add any other intrinsic to this list, and select the intrinsic. The 
intrinsic must already exist as a variable in Orchestration Designer, and must be populated so that 
the screen pop can use the intrinsic.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Basic Screenpops.

4. Click the General settings tab.

The settings under the Global Screenpop settings and the Basic Screenpop settings 
sections are applicable to both Basic and Advanced screen pops. However, you can 
override the Basic Screenpop settings when you configure Advanced screen pops. For 
more information, see Configuring Advanced Screen pops on page 68.
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5. Select the Allow Agents select Screen Pop(s) check box to allow agents to choose the 
applications the agents require while using Agent Desktop.

6. Select the Auto Expand AAAD on Work Item Answer check box to expand the Agent 
Desktop application when an agent responds to a work item.

7. Select the Launch Screen Pop on Incoming Personal Calls check box to open screen 
pops during personal calls.

8. Select the Launch Screen Pop on Outgoing Personal Calls check box to open screen 
pops during personal outbound calls.

9. Select the Launch Screenpop on Consultation received check box to automatically 
open screen pops on the consulted agent’s desktop after a contact consult or transfer 
starts.

10. Select the Launch Screenpop on Consultation initiating check box to automatically 
open screen pops on the Agent Desktop of the agent who initiates the consult. The screen 
pop is displayed when the consult is initiated.

11. Select the Close Screenpop when Consult/Transfer is Completed to automatically 
close screen pops after a contact consult or transfer is complete.

12. Select the Display Screenpops when Observe check box to automatically open screen 
pops after a voice or Web Communications contact is observed.

13. Select the Launch Screen Pop in a tab inside AAAD check box to open the screen pop 
application within Agent Desktop.

Only Web-based applications can open within Agent Desktop.

14. Select the Auto Close Screenpop tab(s) on Work Item Release check box to 
automatically close the screen pop tab on the Agent Desktop when an agent releases 
a contact.

15. From the Launch State drop-down list, select the event to open Basic screen pops. You 
can select one of the following:

• Active: The screen pop application opens when an agent answers a contact.

• Alerting: The screen pop application opens when Agent Desktop displays an alert for a 
work item.

Note:

You can configure a maximum of 20 basic screen pops. However, you can configure 
up to five screen pops only to open on Agent Desktop for each event.

16. Click the General Intrinsics tab.

17. Under Screen Pop Intrinsics, configure the intrinsics used to display data to the agent.

You can configure only one intrinsic to “force launch”. This intrinsic is used for all Basic 
screen pops.
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Note:

For consults or transfers, Contact Center provides the Skillset intrinsic only on Email 
and Web Communications contacts, and not on Voice contacts.

18. Click Add to add more intrinsics.

Note:

The name of the intrinsic you add in the Multimedia Administration utility must match 
the corresponding variable name in Orchestration Designer. The names are case-
sensitive.

19. Click Contact Screen Pop Intrinsics to set different intrinsics for the configured contact 
types.

You can select only one intrinsic for each contact type.

20. Click Personal Call Screen Pop Intrinsics to assign Inbound and Outbound intrinsics.

21. Click the Basic Screenpop (Shortcuts) tab.

Use the Basic Screenpop (Shortcuts) tab to configure Basic screen pops. Basic screen 
pops consist of four parts:

• Name: The Name field contains the name of the screen pop.

• Path: The Path field contains the command that Agent Desktop uses to open the screen 
pop.

• Always on screenpop check box: The Always on screenpop check box defines the 
basic screen pop shortcuts that are launched as screen pops. Agent Desktop can 
launch only five screen pop shortcuts.

• Event: The Event field reflects the launch state that you set in the General settings 
tab. The Event field cannot be edited.

22. (Optional) Click Add to add more applications.

23. Select the Always on screenpop check box to choose the applications that open on client 
computers when Agent Desktop displays the screen pop.

Text applications such as Notepad, or search engines such as Google can open 
automatically. You can add other applications, but you must ensure that the applications 
are installed on all clients.

24. Click the Basic Filters (Launch Types) tab.

25. Under the Filter screenpops by Contact Types list, select the contact types. All Basic 
screen pops open based on the selected contact types.

26. Click Save.
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Configuring Advanced screen pop applications
About this task
When configuring an Advanced screen pop, you must select an application that you want Agent 
Desktop to open. This procedure outlines the steps for configuring an Advanced application.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Advanced Screenpops.

The system displays the Advanced Screenpop Settings page.

4. Click the Advanced Applications tab.

The system displays the Applications grid that contains the existing applications.

5. Click New to create a new application.

The system displays the Create/Edit Application section at the bottom of the page.

6. Type the name of the application in the Name field.

7. Type the location of the application in the Path field.

The path information can contain parameters.

Note:

You can assign a maximum of five parameters to each application.

8. To prevent mistakes when you type a parameter, click the Insert Parameter button to 
insert a parameter within a path.

9. Click Save.

The system displays the new application under the Applications grid.

Configuring Advanced screen pop filters
About this task
When you are configuring Advanced screen pops, you can optionally select a filter for that 
Advanced screen pop. A filter defines additional conditions that must be met before an Advanced 
screen pop opens. These conditions match the contact intrinsic values with the predefined values. 
This procedure outlines the steps for configuring an Advanced filter.
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Advanced Screenpops.

The system displays the Advanced Screenpop Settings page.

4. Click the Advanced Filters tab.

The system displays the Filters grid that contains the existing filters.

5. Click New to create a new filter.

The system displays the Create/Edit Filter section at the bottom of the page.

6. Type the name of the filter in the Name field.

7. From the Intrinsic Type field, select an intrinsic whose value is compared against a set of 
applicable values.

Note:

The method of defining these applicable values depends on the intrinsic type you 
select. If you select an intrinsic of type Skillset, CDN, or DNIS, you must select the 
applicable values from a list. Otherwise, you must type an instrinsic value to match 
against the applicable values in a text box under the Intrinsic Values section and click 
Add >.

Agent Desktop opens screen pops based on the intrinsic type.

8. From the Contact Types list , select the contact types to which the filter is applicable.

Note:

If you select the intrinsic type as Skillset, the list of applicable values to compare 
against changes according to the contact types selected or deselected.

9. If you select an intrinsic of type Skillset, CDN, or DNIS, select the applicable values from 
the list of values the system displays under the Intrinsic Values section.

Or

Type an instrinsic value to match against the applicable values in a text box under the 
Intrinsic Values section and click Add >.

Contact Center Manager Server (CCMS) retrieves the intrinsic values if the intrinsic types 
are Skillset, CDN, and DNIS. You must correctly configure the intrinsic values in CCMS for 
this functionality to work.

Note:

If you add an intrinsic, the intrinsic must already exist as a variable in Orchestration 
Designer and must be populated so that the screenpop can use the intrinsic.
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10. Click Save.

The system displays the new filter under the Filters grid.

Configuring Advanced Screen pops
About this task
Use Advanced Screen pops to configure individual screen pops to open on specific intrinsic 
triggers and filters.

Note:
These settings apply to both Agent Desktop and Avaya Workspaces.

Advanced Screen pops provide administrators with greater range and flexibility with respect to 
conditions and triggers for opening a specific screen pop. However, administrators must configure 
the screen pop application to open based on one intrinsic. For example, configure a Web page 
(application) to open when you receive a contact with skillset EM_Ramdom_Skillset (intrinsic).
A maximum of five screen pops can launch on Agent Desktop for each event. The order of 
opening the screen pops is as follows:

1. All Basic Screen pops that match the configured contact type, event, and intrinsic.
2. Advanced Screen pops that match the configured contact type, event, and filter. Advanced 

Screen pops open in an ascending order based on the screen pops configured on the 
Advanced Screenpop Settings page.

Note:
The Advanced Screenpops wizard displays the Screenpop Summary section at the bottom of 
each screen. Screenpop Summary summarizes the actions that a user performs to configure 
a screen pop. You can use Screenpop Summary as a reference when you are configuring 
screen pops.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Agent Desktop Configuration.

3. Click Advanced Screenpops.

The system displays the Advanced Screenpop Settings page.

4. Click the Advanced Screenpops tab.

The system displays the Advanced Screenpops grid that contains the existing screen 
pops. Select a screen pop and then click the up arrow ( ^ ) button or the down arrow ( v ) 
button to change the order of the screen pops. This affects the order in which the screen 
pops are evaluated for launch.

5. Click New to create a new screen pop.
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The system displays Step 1 of 7 — Name page of the New Screenpop wizard.

6. Type the name of the screen pop in the Screenpop Name field.

Screen pop names must be unique.

7. Click Next.

The system displays Step 2 of 7 — Contact Types page of the New Screenpop wizard.

8. From the Contact Types list, select the contact types. The screen pop opens based on the 
selected contact types.

9. Click Next.

The system displays Step 3 of 7 — Launch Event page of the New Screenpop wizard.

10. From the Launch Event drop-down list, select the event to open the screen pop. You can 
select one of the following:

• Active: The screen pop application opens when an agent answers a contact.

• Alerting: The screen pop application opens when Agent Desktop displays an alert for a 
work item.

Note:

A maximum of five screen pops can launch on Agent Desktop for each event.

11. Click Next.

The system displays Step 4 of 7 — Application page of the New Screenpop wizard.

12. From the Application Name drop-down list, select the application that opens on client 
computers when Agent Desktop displays the screen pop.

Or

Click the Add ( + ) icon to add a new screen pop application. For more information, see 
Configuring Advanced screen pop applications on page 66.

Or

Select an existing application from the drop-down list and click Edit to edit an existing 
screen pop application.

Note:

Editing an existing application is supported only when the application is not in use.

Text applications such as Notepad, or search engines such as Google can start 
automatically. You can add other applications, but you must ensure that the applications 
are installed on all clients.

13. Click Next.

The system displays Step 5 of 7 — Customise Application page of the New Screenpop 
wizard.

Configuring Advanced Screen pops

April 2024 Avaya Contact Center Select Advanced Administration 69
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


14. From the Parameter drop-down list, select a parameter that is present in the path.

The number of parameters depends on the number of placeholders configured in the 
application on page Step 4 of 7 — Application.

Note:

You can set up to a maximum of five parameters for each screen pop application.

15. From the Intrinsic drop-down list, select an intrinsic value that replaces the parameter 
placeholder at runtime.

16. Click Set.

The system displays the parameter and the corresponding intrinsic value under the 
Parameters section.

Note:

You must assign intrinsic values for all parameters present in the path.

17. Click Next.

The system displays Step 6 of 7 — Filter page of the New Screenpop wizard.

18. (Optional) From the Filter drop-down list, select the filter for the screen pop.

Or

Click the Add ( + ) to add a new filter. For more information, see Configuring Advanced 
screen pop filters on page 66.

Click Edit to edit an existing filter.

Note:

If you select a filter, Agent Desktop displays the screen pop only if matched conditions 
between the filter and the created screen pop are met.

Only the filters containing all the contact types that you select from the Contact Types 
list on page Step 2 of 7 — Contact Types are available.

If you select an existing filter, the system displays the filter conditions under the Selected 
Filter Conditions section. The Selected Filter Conditions section displays the intrinsic name 
and the corresponding values under the Match Values section.

19. Click Next.

The system displays Step 7 of 7 — Presentation Options page of the New Screenpop 
wizard.

The presentation options are set to the global settings that you configured for Basic screen 
pops. However, for Advanced screen pops you can change these settings for each screen 
pop. For more information about global settings, see Configuring basic screen pops on 
page 63.
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20. Select the Launch Screen Pop in a tab inside AAAD check box to open the screen pop 
application within Agent Desktop.

Only Web-based applications can open within Agent Desktop.

21. Select the Auto Close Screen Pop tab(s) on Work Item Release check box to 
automatically close the screen pop tab on Agent Desktop once an agent releases a 
contact.

22. Click Finish.

The system displays the Saved dialog box.

23. Click OK.

The system displays the new screen pop under the Advanced Screenpops grid.

Configuring Common Settings
About this task
The Common Settings page contains configuration settings that you can customize for Agent 
Desktop.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Agent Desktop Configuration.

3. Click Common Settings.

4. Find the required settings in the list and update them. You can also use the Search bar to 
search for settings.

5. Click Save.

Variable definitions
System settings
Name Description
Platform The type of platform that your contact center uses.

Select SIP.
Switch type The type of switch that you use in your contact center for voice contacts. 

Select IP Office.
Enable Hot Desking This setting applies to AACC only.

Table continues…
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Name Description
Hot Desking – Prompt for 
workstation

This setting applies to AACC only.

New Contact Presentation – 
Bring to front

You can configure Agent Desktop to alert the agent when a new contact 
arrives.

Select the New Contact Presentation – Bring to front check box to 
make Agent Desktop move to the front upon arrival of a new contact. If 
Bring to front is disabled while Give focus is enabled, the Agent Desktop 
makes a warning sound and the toolbar flashes, but it is not brought to 
the front.

Note:

Changes you make to Agent Desktop configuration take effect only 
when agents restart Agent Desktop.

New Contact Presentation – 
Give focus

You can configure Agent Desktop to alert the agent when a new contact 
arrives.

Select the New Contact Presentation – Give focus check box to make 
the Agent Desktop window active when it moves to the front. The New 
Contact Presentation – Bring to front check box must be selected for 
the New Contact Presentation – Give focus check box to be enabled.

Note:

Changes you make to Agent Desktop configuration take effect only 
when agents restart Agent Desktop.

Maximum Open Duration Amount of time that you want a multimedia contact to remain open on a 
desktop. The active contact timer does not apply to Web communications.

In the Maximum Open Duration box, type the maximum amount of time 
you want multimedia contacts to remain active in hours and minutes. The 
minimum is 10 minutes and the maximum is 12 hours.

When this time expires, the contact remains open for a maximum of one 
more hour. Agent Desktop force closes the contact when the additional 
hour expires.Agent Desktop warns the user when the contact has 60 
minutes, 30 minutes, and 5 minutes left before force closing the contact.

Bring Agent Desktop to Front 
When Max Open Duration 
Exceeded

Select the Bring Agent Desktop to Front when Max Open Duration 
Exceeded check box to automatically bring Agent Desktop to the front 
of the windows desktop when the contact is open for longer than the 
Maximum Open Duration.

Enable Agent Skillset 
Partitioning

Agents, by default, see all contacts in the contact center. Select the 
Enable Agent Skillset Partitioning check box to show agents only the 
contacts assigned to the agent's skillsets. Partitioning changes take effect 
after an agent logs out and logs in again.

These settings apply to both Agent Desktop and Avaya Workspaces.

Table continues…
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Name Description
Apply Agent Skillset 
Partitioning to Transfers

Select the Apply Agent Skillset Partitioning to Transfers check box 
to apply partitioning rules when an agent transfers a multimedia contact. 
To enable this feature, you must first select the Enable Agent Skillset 
Partitioning check box.

These settings apply to both Agent Desktop and Avaya Workspaces.
Auto Sign On to CCMM Select the Auto Sign On to CCMM check box so that agents do not need 

to login separately to CCMM when logging on to Agent Desktop.

General features
Name Description
Enable Keyboard Shortcuts Select the Enable Keyboard Shortcuts check box to allow agents to use 

shortcut keys on Agent Desktop.

Note:

By default, Enable Keyboard Shortcuts is selected in the CCMM 
Administration utility.

Enable Agent Desktop 
System Tray Icon

Select the Enable Agent Desktop System Tray Icon check box to allow 
agents to add the Agent Desktop system tray icon to the Windows system 
tray.

Enable Agent Desktop 
Dashboard

Select the Enable Agent Desktop Dashboard check box to allow agents 
to collect and upload log files or videos to the CCMM server. Agents can 
also use the Dashboard to check the connectivity of Agent Desktop with 
the Contact Center servers.

Note:

By default, Enable Agent Desktop Dashboard is selected in the 
CCMM Administration utility.

Enable Agent Desktop 
Preference Retention

Select the Enable Agent Desktop Preference Retention check box to 
retain Agent Desktop preferences of agents when agents log out of Agent 
Desktop and log back into Agent Desktop.

Enable Localization Select the Enable Localization check box to turn on localization of Agent 
Desktop when a supported locale is detected on the client PC.

Allow Agent Desktop Panel 
Swap

Select the Allow Agent Desktop Panel Swap check box to allow agents 
to move the left pane of Agent Desktop to the right side of Agent Desktop 
and vice-versa.

Disallow Duplicate Login Select the Disallow Duplicate Login check box to prevent Agent 
Desktop from opening if the specified user ID is already logged into 
Contact Center from a different location.

Open Queue Contact 
Processing

Select the Open Queue Contact Processing check box to use Contact 
Center Multimedia to route multimedia contacts to agents by using the 
existing scripting and skillset routing features available for calls.

You must install and license the Open Queue feature for Agent Desktop 
and configure Open Queue on the Communication Control Toolkit server.
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Name Description
Close Multiple Contacts Select the type of user that can close multiple contacts simultaneously 

from search results. You can select one of the following options:

• Supervisor to allow supervisors to close multiple contacts.

• Agent to allow agents to close multiple contacts. This is the default 
option.

• None to prohibit closing multiple contacts to all users.

These settings apply to both Agent Desktop and Avaya Workspaces.
Enable Web Reporting Select the Enable web reporting check box to enable Contact 

Centerreporting on peer-to-peer Instant Messaging (IM). If an agent 
initiates an IM while active on a Contact Center, Contact Center reports 
on this activity.

Customize processing for 
customers with restricted flag

To comply with General Data Protection Regulation (GDPR), agents 
using Agent Desktop can set a restricted flag to a customer to prevent 
unsolicited emails and calls. Agent Desktop automatically detects when 
an agent attempts to contact a customer with a restricted flag and 
displays a warning message or blocks the contact attempt.

Select one of the following options to customize processing of customers 
with a restricted flag in Agent Desktop:

• IGNORE to allow agents to ignore a restricted flag and contact 
customers with a restricted flag set.

• BLOCK to stop agents from contacting customers with a restricted flag.

• WARNING to display a confirmation window on Agent Desktop when an 
agent contacts customers with a restricted flag.

Enable IE mode Agent Desktop uses the Microsoft Edge browser as a rendering engine 
to display web content. To display sites that are compatible only with 
Internet Explorer, enable the Internet Explorer (IE) mode on your browser 
for Agent Desktop.

Select the Enable IE mode check box to allow Agent Desktop open sites 
with IE mode.

After you enable this feature, use the Enterprise Mode Site List Manager 
tool to configure the list of sites that you want Agent Desktop to open with 
IE mode. For more information, see Configuring Enterprise Mode Site List 
for Agent Desktop on page 88.

Display preferences
Name Description
Display Not Ready reason text 
only

Select the Display Not Ready Reason Text Only check box to display 
only not ready reason text.

Display Agent Login Duration Select the Display Agent Login Duration check box to display the time 
that the agent is logged into Agent Desktop.
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Name Description
Display System Defined 
Contact Center Codes

Select the Display System Defined Contact Center Codes check 
box so that Agent Desktop displays system-defined Not Ready Reason 
Codes and After Call Work Item codes.

Contact Center Code Display 
Preference

Select how Agent Desktop displays Contact Center codes. You can 
choose from the following:

• Code to display codes based on the code number.

• Text to display codes based on the code text.

• Both to display codes based on both the code number and the code 
text.

Note:

You can select Contact Center Code Display Preference only if 
you select the Display System Defined Contact Center Codes 
check box.

Display Agent Time in Not 
Ready State

Select the Display Agent Time in Not Ready State check box to display 
a timer on Agent Desktop that displays the duration the agent is in the 
Not Ready state.

Display Previous Login Time Select the Display Previous Login Time check box so that Agent 
Desktop displays the previous login time for the currently logged in agent. 
The login time displayed is the time of the CCT server and not the local 
time of the agent.

Show CCMM Contact ID in 
Workitem

Select the Show CCMM Contact ID in Workitem check box to display 
the Contact ID for multimedia contacts for the Workitem present on Agent 
Desktop.

Display Caller's Friendly 
Name

Select the Display Caller's Friendly Name check box to enable a 
friendly name display on Agent Desktop for DN calls. When this is 
enabled, when one contact center agent receives a call from another 
contact center agent, the name of the calling agent (as configured in 
CCMA) displays on the Agent Desktop of the called agent.

Note:

Both agents must be configured in CCMA for the friendly name to be 
displayed on Agent Desktop.

Use call attached data for 
skillset information

This setting applies to AACC only.

POM Custom fields sort order This setting applies to AACC only.
Clear Previous Phone 
Number

Select the Clear Previous Phone Number check box to clear the 
number of the previous voice contact present on Agent Desktop.

Clear Previous E-mail 
Address

Select the Clear Previous E-mail Address check box to clear the email 
address of the previous email contact present on Agent Desktop.
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Name Description
Contact Lookup Priority Enter the order by which the system performs the caller name lookup. 

You can select one of the following options:

• Custom contacts so that the system performs caller name lookup from 
within the agent’s custom contacts.

• LDAP contacts so that the system performs caller name lookup from 
within LDAP contacts.

• Intrinsics / Call property so that the system performs caller name 
lookup by using the name taken from either an intrinsic property or a 
property on the call object.

When a name matches the number on the incoming call, Agent Desktop 
displays that name on the user interface.

Default tab When you select this option, the agent receives a new contact. You can 
select one of the following options:

• Details

• History

• CI Details

• Review

Notification/Message boxes
Name Description
Prompt User for Login Details Select the Prompt User for Login Details check box to automatically 

prompt agents to enter their credentials when Agent Desktop opens.

If you do not select Prompt User for Login Details, Agent Desktop tries 
to log in the agent using the current windows user credentials. If this login 
fails, Agent Desktop prompts the user to enter a set of credentials.

Suppress Browser Script 
Errors

Select the Suppress Browser Script Errors check box to suppress 
browser script errors.

Suppress OS not supported 
popup

Select the Suppress OS not supported popup check box to support 
Agent Desktop on Citrix. This is required for desktop virtualization.

Suppress OS softphone not 
supported popup

Select the Suppress OS softphone not supported popup check box 
to suppress a warning message that the softphone process is not 
supported on the Operating System on which Agent Desktop is running. 
By default, the Suppress OS softphone not supported popup option is 
not selected.

Display Softphone Out Of 
Service Message on Start-up

Select the Display Softphone Out Of Service Message on Start-up 
check box to display a message box alerting agents that the CTI Link to 
the softphone is out of service while starting Agent Desktop in applicable 
configurations.

The system also displays a message box to alert the agent that the 
softphone is now in service, after agents log using My Computer mode.
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Name Description
Pop Up Notification – Closes 
After Time

Select the Pop Up Notification – Closes After Time check box so that 
the pop-up messages related to Teleworker Status on Agent Desktop 
disappear automatically after a certain configured time.

Pop Up Notification – Display 
Time

Enter the length of time, in milliseconds, that the Teleworker Status pop-
up messages stay visible on Agent Desktop.

Display AutoConnect 
message if unable to connect 
to original server

Select the Display AutoConnect message if unable to connect to 
original server check box to suppress the error that appears on Agent 
Desktop after an RGN switchover.

Voice
Name Description
Logoff Terminal State This setting applies to AACC only.
Replace + with trunk access 
code

Select the Replace + with trunk access code check box so that 
Agent Desktop Phonebook adds a trunk access code before dialing any 
number. Therefore, agents do not need to manually add a leading digit to 
call externally or forward a call using Phonebook.

By default, Replace + with trunk access code is selected.
Enable one click copy of caller 
line ID

Select the Enable one click copy of caller line ID check box to allow 
agents to use the Copy CLID button on the Agent Desktop toolbar 
to copy the Calling Line Identification (CLID) number of a customer to 
the clipboard. Agent Desktop displays the name of the caller using the 
contacts directory integration.

Highlight DN Call During 
Transfer

Determines which leg of the call has focus in Agent Desktop during a 
supervised transfer scenario, the original customer leg or the DN leg to 
the transfer party.

Select the Highlight DN Call During Transfer check box to focus the DN 
leg to the transfer party in Agent Desktop during a supervised transfer 
scenario.

Put Call on Hold During 
Transfer for the Phonebook

Select the Put Call on Hold During Transfer for the Phonebook check 
box to place the customer call on hold when an agent initiates a call 
transfer, using the Phonebook on Agent Desktop.

Put Call on Hold During 
Transfer/Conference for the 
Enter Value

Select the Put Call on Hold During Transfer/Conference for the Enter 
Value check box to place the customer call on hold when an agent 
initiates a call transfer or conference by entering the number in Agent 
Desktop.

Autostart Quality of Service 
Window service

Select the Autostart Quality of Service Window Service check box so 
that the Quality of Service (QoS) service automatically starts.

Note:

This is only applicable to Avaya Aura® environments, where 
embedded softphone is used in My Computer mode.

Encoding Page of CCT 
Attached Data

This setting applies to AACC only.
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Emails
Name Description
Show agent comments for 
external transfer

Select the Show agent comments for external transfer check box so 
that agent comments are added to an email that is transferred externally. 
By default, the Show agent comments for external transfer option is 
not selected.

Force Send Emails Select the Force Send Emails check box to provide agents with the 
option to override an email address validation failure and send an email 
message even when the system detects an invalid email address.

Mandatory Comments for 
Email Approval

Select the Mandatory Comments for Email Approval check box to 
make review comments mandatory when supervisors approve or reject 
an email message.

Insert Line Break Before Auto 
Response

Select the Insert Line Break Before Auto Response check box to add a 
blank line before an auto response is sent to the customer.

Maximum Number of E-mail 
Recipients

Enter the maximum number of people to whom an agent can send an 
email message. The default value is 30.

Maximum Number of Agent 
Initiated E-mails

Enter the maximum number of email messages that an agent can initiate. 
The default value is 5.

Show All Email Skillsets Select the Show All Email Skillsets check box so that agents can see 
all the skillsets configured in Contact Center when they are initiating an 
outgoing email.

If you do not select the Show All Email Skillsets check box, agents see 
only the email skillsets to which they are currently assigned.

Instant messages
Name Description
IM provider If you use peer-to-peer Instant Messaging (IM) with any supported 

Microsoft instant messaging server in your solution, select Lync 2010 / 
Lync 2013. Otherwise, select None.

IM Consult Reporting on Voice 
Contacts

Enable or disable the reporting of IM or Multimedia consults by agents on 
voice contacts.

Close IM Popout Window 
Automatically When Session 
Has Ended

Select the Close IM Popout Window Automatically When Session 
Has Ended check box to close the IM popout window automatically when 
the agent completes the IM contact on Agent Desktop.

Note:

Close IM Popout Window Automatically When Session Has 
Ended is applicable only to contact centers that have IM 
enabled and by default this check box is selected in the CCMM 
Administration utility.
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Name Description
Decline Personal IM 
Automatically When Agent 
Busy on Contact

Select the Decline Personal IM Automatically When Agent Busy On 
Contact check box to refuse personal IM messages automatically when 
the agent is busy with a contact on Agent Desktop.

Note:

Decline Personal IM Automatically When Agent Busy On 
Contact is applicable only to contact centers that have IM 
enabled and by default this check box is selected in the CCMM 
Administration utility.

Maximum Roster Size Enter the maximum number of IM contacts that agents can add to the My 
Contacts list in Agent Desktop. The default value is 150 contacts.

Avaya Aura Presence Delay 
Factor

Enter the delay, in milliseconds, between releasing an IM connection 
and the corresponding CCT contact. This is required if the IM wrap-up 
message is not being delivered to customers.

Number of Personal IM’s 
Allowed To Go Ready

Enter the maximum number of open IM's an individual agent is allowed 
before the agent is not allowed to go ready. The number of personal IM's 
an agent is allowed open on Agent Desktop at one time cannot exceed 
the number configured in this field.

Web communications
Name Description
Web Communications/IM Tab 
Blink Duration

Enter the time, in seconds, for which Web Communications or IM Tab 
must blink on Agent Desktop. The default value is 5 seconds.

Show Web Communications 
System Prompts

Select the Show Web Communications System Prompts check box to 
display a message when an agent pushes a page to a customer. This 
message precedes the page push URL.

Taskbar Alert on New Web 
Communication Message

Select the Taskbar Alert on New Web Communication Message 
check box to configure a taskbar alert, when a new web communication 
message arrives on Agent Desktop.

Append Selected Auto Phrase 
to Existing Text

Select the Append Selected Auto Phrase to Existing Text check box 
so that agents can add an automatic phrase to an existing chat message, 
IM message, or email message.

Phonebook/Call Log
Name Description
Contact Center LDAP 
Phonebook

Select the Contact Center LDAP Phonebook check box to provide 
agents with a list of other agents, whom they can consult, during a voice 
call or an email contact.

LDAP Phonebook Unique Key Enter the LDAP attribute that Agent Desktop uses to uniquely identify 
any entries that agents search for in the LDAP server. The default value 
is objectGUID, which is the default Microsoft Active Directory unique 
identifier.
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Name Description
LDAP Phonebook Display 
Name

Enter the LDAP attribute that Agent Desktop uses as the primary display 
field in Phonebook.

Log Call History Select the Log Call History check box so that calls made by agents 
are logged. Agents can view the call history in the Call History tab of 
Phonebook in Agent Desktop.

Allow Erasing of Call History Select the Allow Erasing of Call History check box so that agents can 
erase the call history from the Call History tab of Phonebook in Agent 
Desktop.

Maximum Number of Calls to 
Log

Enter the maximum number of calls that Agent Desktop can log.

Maximum Number of Speed 
Dials

Enter the maximum number of contacts that agents can add to their 
speed dial list in Phonebook.

Maximum Number of 
Favorites

Enter the maximum number of contacts that agents can add as favorites 
in Phonebook.

History
Name Description
Voice History Port Enter the port number on CCMS that Agent Desktop connects to for 

retrieving the voice history information.

Voice history information contains details of previous voice calls to the 
Contact Center from the dialed number of the currently active contact.

Note:

The default port is 443 with the security feature on which is the 
default value. In case you have disabled the security feature, the 
default port is 80. You cannot change the value of the port.

Display Customer History on 
Voice Contact

Select the Display Customer History on Voice Contact check box to 
display Customer History for Voice contacts on Agent Desktop.

Contact Center Multimedia searches for Customer History of previous 
contacts based on the calling line ID for Voice contacts.

Display Customer History on 
Personal Calls

Select the Display Customer History on Personal Calls check box to 
display customer history for voice contacts on personal calls on Agent 
Desktop.

Voice Contact Identifier for 
Customer History

Select either AD_CLID or SIP_FROM_ADDRESS to look up the Contact 
Center Multimedia database that contains customer history for the 
originator of the incoming voice call. In order to search the database you 
must also enable the Voice Contact Search parameter.
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Name Description
Display Voice Calls in 
Customer History

Select the Display Voice Calls in Customer History check box to 
display previous voice calls for the originator of the current active contact 
in Agent Desktop. Enable these settings to lookup the Contact Center 
Manager Server database for Voice Contact history.

Enable Contact Summary Data generation in Contact Center Manager 
Administration, to ensure that individual contact history data is created in 
the Contact Center Manager Server database.

Reason codes
Name Description
Default Not Ready Reason 
Code when Rejecting a 
Contact

Enter the default Not Ready Reason code that the system sends when an 
agent is forced into the Not Ready state after rejecting a contact.

If the Default Not Ready Reason Code when Rejecting a Contact field 
is blank the agent is forced into the Not Ready state with a Reject Contact 
Default Code (000).

Default Not Ready Reason 
Code when Pulling a Contact

Enter the default Not Ready Reason code that the system sends when an 
agent is forced into the Not Ready state after pulling a contact.

If the Default Not Ready Reason Code when Pulling a Contact field 
is blank the agent is forced into the Not Ready state with a Pull Mode 
Default Code (0000).

Default Not Ready Reason 
Code After Max Open 
Duration

Enter the default Not Ready Reason code that the system sends when an 
agent is forced into the Not Ready state when a contact is open for longer 
than the Maximum Open Duration and the contact is recycled.

The CCMM Administration utility does not allow the Default Not Ready 
Reason Code After Max Open Duration field to be left blank. By default, 
the agent is forced into the Not Ready state with a MaxOpen Default 
Code (000).

Force all agents to use a 
not ready reason code when 
going not ready

Select the Force all agents to use a not ready reason code when 
going not ready check box to force agents and supervisor/agents to 
enter a Not Ready reason code when agents change their status to Not 
Ready.

Audio
Name Description
Audible Alert Settings Select the type of alert Agent Desktop plays when contacts are presented 

to agents. There are four options:

• NONE. No alert is played.

• BEEP. The computer’s internal sound card is played as the alert.

• WAV. A .wav audio file is played as the alert.

• BOTH. Both the WAV and BEEP settings work.
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Name Description
Play Alert on Voice Select the Play Alert on Voice check box to ensure an alert is played 

when voice contacts are presented to agents.
Play Alert on CCMM Select the Play Alert on CCMM check box to ensure an alert is played 

when multimedia contacts are presented to agents.
Source of WAV Select MM. This determines that the .wav file played is a CCMM .wav file.
Number of Rings on Voice 
Alert

Enter the number of times the agent phone rings when a voice contact 
alerts on Agent Desktop. By default, the agent phone rings 5 times when 
a voice contact alerts on Agent Desktop

Number of Alert Tones for 
Multiple Contacts

Enter the number of alert tones that can be defined for Multimedia 
contacts. The default value is 5.

Enable Advanced Audio 
Controls for Softphone

Select the Enable Advanced Audio Controls for Softphone check box 
to allow an agent to control Receive Gain and Transmit Gain, which 
allows agents to change the audio level of the incoming and outgoing 
speech path when Agent Desktop is in the My Computer mode.

Attachments
Name Description
Maximum Attachment Upload 
Size

In the Maximum Attachment Upload Size box, enter the maximum 
attachment upload size in kilobytes. The maximum file size set for 
attachments also applies to inline attachments.

Attachment Upload Timeout Enter the time in seconds after which the Communication Control Toolkit 
server session expires during uploading an attachment.

Supported attachment Configure the supported file extensions that agents can attach to emails 
in the Supported attachment field. To configure file extensions, perform 
one of the following:

• To add a new extension, type the file extension in the field and click 
Add.

You can add file extensions in the following format: Word documents 
(*.doc;*.docx), Text files (*.txt). Type All files *.* 
to allow adding all types of file extensions. Separate each file extension 
with a semicolon (;).

• To remove a file extension, select the file extension from the Current 
supported file extensions field and click Remove.

Observe/Barge-in
Name Description
Number of Simultaneous Web 
Communications Observe/
Barge-in Contacts

Enter the maximum number of Web Communications contacts that a 
supervisor can observe or barge-in on simultaneously.
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Name Description
Web Communications 
Observe/Barge-in Refresh 
Rate

Enter the time, in seconds, at which the multimedia intrinsics and 
chat summary refreshes for each Web Communications contact in the 
Supervisor Observe: Contact list on Agent Desktop.

Number of Messages 
to Display in Web 
Communications Observe/
Barge-in Summary

Enter the number of messages to display in the chat summary for 
the selected Web Communications contact in the Supervisor Observe: 
Contact list on Agent Desktop.

Agent Desktop displays the newest messages first in the list. 
For example, if this value is 5 and a supervisor selects a Web 
Communications contact containing 6 messages, then the summary 
displays messages from 2 to 6.

Supervisor Observe window 
refresh delay

Enter the time in seconds between an agent answering a new contact 
and the supervisor control refreshing to display this contact. The default 
value is 1 second.

Barge-in Wait Time Enter the time in seconds between a Supervisor initiating an observe and 
having the ability to initiate a barge-in on the same contact. The default 
value is 5 seconds.

Contact Type That Can Be 
Observed

Select the contact types that agent supervisors can observe. You can 
select Web Communications .

Observe Agent Initiated 
Contact Center Calls

Select the Observe Agent Initiated Contact Center Calls check box 
to allow supervisors to use the Observe function to listen in on an agent-
initiated voice contact.

If you clear the Observe Agent Initiated Contact Center Calls check 
box:

• Agent Desktop does not display agent-initiated calls to supervisors.

• Avaya Workspaces displays agent-initiated calls in the My Agents 
widget, but the Observe button is disabled.

Notify an Agent if a Contact is 
being Observed/Barged-In On

Select the Notify an Agent if a Contact is being Observed/Barged-In 
On check box, so that Agent Desktop displays an icon on a work item 
when a supervisor/agent observes, whisper coaches, or barges-in on a 
call.

Display Observable Contacts 
of Logged Out Agents

Select the Display Observable Contacts of Logged Out Agents check 
box to allow supervisor/agents to see non-skillset calls of agents who are 
logged out of Agent Desktop. Supervisor/agents can see agent calls only 
where the agent uses CCT to log on to the desk phone.

Display Supervisor Observe 
Color Coding

Select the Display Supervisor Observe Color Coding check box, so 
that Agent Desktop uses color coding on the Supervisor Observe dialog 
to distinguish between skillset, non-skillset, observed, barged-in, and 
whisper coached calls and contacts.

Signature
Note:
These settings apply to both Agent Desktop and Avaya Workspaces, except for Maximum 
number of images allowed per agent, which applies only to Avaya Workspaces.

Configuring Common Settings

April 2024 Avaya Contact Center Select Advanced Administration 83
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Name Description
Maximum signature image file 
size

Enter a number that specifies the maximum file size for images that 
agents can add when creating a signature in Agent Desktop and Avaya 
Workspaces. Administrators can specify a value between 1 and 50 KB.

Maximum number of images 
allowed per signature

Enter a number that specifies the maximum number of images that 
agents can add when creating a signature in Agent Desktop and Avaya 
Workspaces. Administrators can specify a value between 0 and 3. The 
default value is 3.

Maximum number of 
images allowed per agent 
(Workspaces only)

Enter a number that specifies the maximum number of images that 
agents can add to the image pool of Avaya Workspaces. Administrators 
can specify a value between 0 and 12. The default value is 12.

Maximum number of 
characters per email signature

Enter a number that specifies the maximum number of characters that 
agents can add when creating a signature in Agent Desktop and Avaya 
Workspaces. Administrators can specify a value between 0 and 2000. 
The default value is 2000.

Web statistics
Name Description
Enable web statistics Select the Enable web statistics check box to allow agents and 

supervisors to view a real-time statistics for call handling, skillset data, 
and state information on Agent Desktop.

Agent web statistics Enable Agent Web Statistics on Agent Desktop, so that agents and 
supervisors can use Agent Desktop to view statistics for call handling, 
skillset data, and state information on Agent Desktop.

Web statistics ticker duration Enter the time, in seconds, for which the Web Statistics ticker displays for 
each skillset.

Note:

By default, the Web Statistics ticker displays for 10 seconds for each 
skillset on Agent Desktop.

Web Statistics Refresh 
Interval

Enter the time in seconds after which the Web Statistics information 
refreshes.

Note:

By default, the Web Statistics information refreshes every 60 
seconds.

Web Statistics Exception Limit Enter the number of Contact Center Web Statistics (CCWS) connection 
exceptions allowed before the system disables the statistics feature.

Note:

If you enter zero in the Web Statistics Exception Limit field, the 
statistics feature is never disabled.

Use secure web statistics Select the Use secure web statistics check box to secure 
communication with the Contact Center Web Statistics (CCWS) server.
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Logging
Name Description
IM logging Select the IM Logging check box to capture IM/Presence server log 

messages in Agent Desktop log files.
Web Statistics Logging Select the Web Statistics Logging check box so that Agent Desktop log 

files capture log messages relating to the Web Statistics feature.

Note:

Web Statistics Logging generates logging inside Agent Desktop 
only.

Web Communications 
Logging

Select the Web Communications Logging check box so that Agent 
Desktop log files capture log messages for the Web Communications 
server.

Note:

Web Communications Logging generates logging inside Agent 
Desktop only.

CCT Logging level Select the logging level that Agent Desktop log files capture for CCT. You 
can choose from the following:

• Off

• Verbose

Note:

CCT Logging Level generates logging inside Agent Desktop only.
Reason Code Logging Select the Reason Code Logging check box so that Agent Desktop log 

files capture log messages for reason codes that agents enter during a 
contact.

Note:

Reason Code Logging generates logging inside Agent Desktop 
only.

Method Entry and Exit 
Logging

Select the Method Entry and Exit Logging check box to enable 
additional Agent Desktop logging for troubleshooting purposes.

Callback
Note:
These settings apply to both Agent Desktop and Avaya Workspaces, except for Callback 
trunk access code, which applies only to Agent Desktop.

Name Description
Callback minimum time Callback time is a range of minutes to days the system to wait before 

reoffering a pending contact to agents. Agents can delay the contact 
or place the contact into pending state because they are waiting for 
additional information to complete the contact.

Table continues…
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Name Description
Callback maximum time In the Callback minimum time box, enter the minimum callback time in 

minutes. The minimum value is 2 minutes.

In the Callback maximum time box, enter the maximum callback time in 
days. The maximum value is 200 days.

The actual time value appears by default in the Agent Desktop and Avaya 
Workspaces applications when the agent reschedules the contact.

These settings apply to both Agent Desktop and Avaya Workspaces.
Callback trunk access code Callback trunk access enables you to schedule callbacks with customers 

who requested callbacks.

In the Callback trunk access code, enter the trunk access number to 
ensure that you create a callback to the customer you work with.

Pulling
Name Description
Pull Contact On Same Skillset 
Only

Select the Pull Contact On Same Skillset Only check box so that 
agents can pull contacts only from the skillsets that the agents are 
currently assigned to.

Show Original Action When 
Pulling MM Contact

Select the Show Original Action When Pulling MM Contact check box 
so that Agent Desktop displays the original action when pulling a contact.

If you do not select the Show Original Action When Pulling MM 
Contact check box then Agent Desktop displays the most recent action 
when pulling a contact.

An example of an original action is an email message that is sent by a 
customer. The most recent action is an agent’s reply to the original email 
message.

Home page
Note:
These settings apply to both Agent Desktop and Avaya Workspaces. The Home Page in 
Agent Desktop refers to the Welcome Page in Avaya Workspaces.
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Name Description
Home Page Enabled Select the Home Page Enabled check box if you want Agent Desktop to 

display the Home Page and Avaya Workspaces to display the Welcome 
Page.

If you enable the Home Page feature:

• Agent Desktop displays the Home Page button on the Agent Desktop 
toolbar.

Agents can use the Home Page button to reopen the Agent Desktop 
Home Page. The Agent Desktop Home Page displays a screen pop 
that contains a web page that you configure to open when an agent 
starts Agent Desktop.

• The Avaya Workspaces Welcome Page displays the configured web 
page.

When you clear the Home Page Enabled check box, the Welcome 
Page displays the empty page with the Welcome page URL not 
configured message.

Home Page URL Type the URL of the web page that the Agent Desktop Home Page and 
the Avaya Workspaces Welcome Page display.

Note:

When configuring the web page URL for Avaya Workspaces, 
ensure that you type the http:// or https:// prefix. The Avaya 
Workspaces Welcome Page displays the configured web page only 
if the web page URL contains a prefix.

Home Page Name Type the name of the web page that the Agent Desktop Home Page and 
the Avaya Workspaces Welcome Page display.

Limits/Min-Max values
Name Description
Teleworker Recovery Button – 
Click Delay

Enter the time in milliseconds that sets the Click Delay time. The 
Click Delay time limits how quickly Agent Desktop registers clicks to 
the Teleworker Recovery Button. When agents click on the Teleworker 
Recovery Button on Agent Desktop, Contact Center attempts to reinitiate 
the nail-up call.

Force Logout Delay Enter the time, in seconds, the system displays the You've Been 
Logged Out alert before shutting down Agent Desktop, after a 
supervisor remotely logs an agent out of Contact Center from the Contact 
Center Manager Administration (CCMA) user interface.

Note:

By default, the system displays the You've Been Logged Out 
alert for 60 seconds.
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Name Description
Critical level of free virtual 
memory

Enter the minimum amount of free RAM in MB that must be present on a 
client PC. If the free RAM drops below the level specified, Agent Desktop 
displays a warning message. By default, the minimum amount of free 
RAM is set at 250 MB.

Maximum dashboard zip file 
size

Use these settings to limit the size of the zip file saved when collecting 
log files using the Agent Desktop dashboard.

In the Maximum dashboard zip file size box, enter the maximum file 
size of logs an agent can zip in Dashboard window in kilobytes.

Custom contacts
Name Description
Allow custom contacts Select the Allow Custom Contacts check box so that agents can add 

custom contacts to Phonebook in Agent Desktop.

Custom contacts are personal contacts of the agents and are not present 
in the LDAP directory.

Maximum number of custom 
contacts

Enter the maximum number of custom contacts that agents can add to 
Phonebook in Agent Desktop.

Configuring Enterprise Mode Site List for Agent Desktop
About this task
Use this procedure to use the Enterprise Mode Site List Manager tool to configure a site list.
When you add the URL of a website in the site list, Agent Desktop uses the Microsoft Edge web 
browser with the Internet Explorer mode to display that website and its entire domain.
For example, if you add the https://yoursite.com/page URL in the site list, Agent Desktop 
displays the entire yoursite.com domain in the browser.

You can do the following actions:
• Add each site manually or add an available site list from an XML file.
• Save a site list as an XML file.
• Import or export a site list in a .emie or a .emie2 format.

Procedure
1. Open the Contact Center Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the navigation pane, select Agent Desktop Configuration.

3. Click Common Settings.

4. Select the Enable IE mode check box.

5. Click the Open IE Mode Manager button.
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The Open IE Mode Manager button is active only if you select the Enable IE mode check 
box.

6. To add a new site to the site list, click Add.

7. In the Add new website dialog box, type the URL of the website for Agent Desktop to 
open with the Internet Explorer mode.

You can add websites with or without the prefix www.

8. (Optional) In the Notes about URL field, type a comment about the website if required.

To edit your comment, you can select a website from the list and click the Edit button.

9. Click Save.

The site list displays the URL of the website.

10. (Optional) To use the other options, click File and click one of the following:

• Delete: Removes a website from the site list.

• Clear list: Removes all websites from the site list.

• Bulk add from file: Adds a URLs from an XML file to the site list.

• Save to XML: Saves your site list as an XML file.

• Import: Imports a site list from a .emie or a .emie2 file.

• Export: Exports your site list as a file in the .emie or the .emie2 format.

Configuring IIS to support MDB database file attachments 
in email messages

About this task
Configure Internet Information Services (IIS) to support Microsoft Access MDB files as 
attachments in Agent Desktop email messages. By default, IIS filters MDB file attachments.

Procedure
1. Log on to the CCMM server with administrative privileges.

2. On the Desktop, select Administrative Tools.

3. Select Internet Information Services (IIS) Manager.
4. In the left pane, navigate to the Default Web Site.

5. In the middle pane, in the IIS section, select Request Filtering.

6. From the File Name Extensions list, right-click .mdb and select Remove.

7. On the Confirm Remove message box, click Yes.
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8. From the main Internet Information Services (IIS) Manager menu, select File > Exit.
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Chapter 6: Avaya Workspaces 
configuration

Configure Avaya Workspaces using the Workspaces Configuration section of the Contact Center 
Multimedia Administration utility. In Workspaces Configuration, you can configure general settings, 
add an administrator user, as well as enable Agent Security for Avaya Workspaces. You can also 
import email templates from Agent Desktop to Avaya Workspaces.

Some Agent Desktop configuration settings in Contact Center Multimedia Administration are also 
applicable for Avaya Workspaces. When you change these settings for Agent Desktop, note that the 
same changes apply to Avaya Workspaces. These settings are:

• Configuring basic screen pops on page 63

• Configuring Advanced Screen pops on page 68

• Signature on page 84

• Home Page on page 87

• Enable Agent Skillset Partitioning on page 72

• Apply Agent Skillset Partitioning to Transfers on page 73

• Close Multiple Contacts on page 74

• Observe Agent Initiated Contact Center Calls on page 83

• Callback on page 85

Avaya Workspaces also provides the Widget Framework feature for administrators to:

• Customize the layout and functioning of Avaya Workspaces in a contact center.

• Access Widget APIs to create customized Avaya Workspaces.

To use the Widget Framework feature, you must create an administrator user role in the Contact 
Center Multimedia Administration utility and log on to Avaya Workspaces by using the administrator 
user credentials. On the Avaya Workspaces administrator interface, you can use Widget Framework 
tools to customize or create widgets for Avaya Workspaces.

Note:

For more information about Widget Framework, click the Overview button on the Avaya 
Workspaces administrator interface and see Widget Framework Developer Documentation.

Related links
Configuring Avaya Workspaces general settings on page 92
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Configuring the Avaya Workspaces administrator on page 95
Logging in to Avaya Workspaces as an administrator on page 95
Configuring email confirmation on page 97
Using the Avaya Workspaces compressed layout on page 97
Configuring agent toast notifications on page 98
Configuring the Start Work button behavior on page 98
Importing email templates to the CCMM database on page 99
Configuring the Avaya Workspaces layout and widgets on page 100
Resetting the Avaya Workspaces layout on page 101
Restoring deleted widgets on page 101
Enabling agent security for Avaya Workspaces on page 102
Configuring Customer Journey for Voice and Video channels on page 103

Configuring Avaya Workspaces general settings
About this task
From the Contact Center Multimedia Administration utility, you can access the General Settings 
tab for Avaya Workspaces.

Procedure
1. Open the Contact Center Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click Workspaces Configuration > General Settings.

3. In the Cluster Settings area, do the following:

a. In the Workspaces Cluster IP/FQDN field, type the IP address or FQDN of the Avaya 
Workspaces cluster.

b. In the Workspaces Cluster Port field, type the port number for the Avaya 
Workspaces cluster.

4. In the Domain Settings area, do the following:

a. In the Domain Server IP field, type the IP address of the Workspaces LDAP server.

b. In the Domain Server Port field, type the port number for the LDAP server.

c. Select the Use Secure Connection check box to use a secure TLS connection for 
the LDAP server.

5. In the Agent Security area, configure a secure HTTPS connection for Avaya Workspaces.

For more information, see Enabling agent security for Avaya Workspaces on page 102.
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6. In the Workspaces Administration area, do the following:

a. In the Admin Username field, type the administrator account name in the format 
username@domainname.

For more information, see Configuring the Avaya Workspaces administrator on 
page 95.

b. In the Widget Library URI field, type the Avaya Workspaces Widget Library address.

c. In the Log Upload URI field, type the address of the external server for uploading 
Avaya Workspaces log files.

7. In the Authentication area, under Token expiration timeout, set the time for token expiry 
in hours and minutes.

8. In the Workspaces Logs area, use the following check boxes to manage client log settings:

• Enable Data Privacy: This check box is enabled by default. When enabled, customer 
information is not added to the logs generated in Avaya Workspaces.

• Enable Download Capability: This check box is disabled by default. When this option 
is enabled, Avaya Workspaces users can download logs.

9. Click Save.

Related links
Avaya Workspaces configuration on page 91
Variable definitions on page 93

Variable definitions
Name Description
Cluster Settings This section contains the following:

• Workspaces Cluster IP/FQDN. An IP Address or 
an FQDN to access the Avaya Workspaces multi-
node cluster.

In a single-node deployment, you must enter an 
IP Address or an FQDN of the Avaya Workspaces 
node.

Important:

Depending on these settings, you must use 
either an IP Address, or an FQDN to access 
Avaya Workspaces.

• Workspaces Cluster Port. A port to connect to 
the Rest API (31796). This field is prepopulated.

Table continues…
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Name Description
Domain Settings Use this section to configure the Domain Settings. 

Avaya Workspaces uses LDAP authentication for 
administrator or user login.

This section contains the following:

• Domain Server IP. An IP Address of the 
Workspaces LDAP server.

• Domain Server Port. The port number of the 
Workspaces LDAP server.

• Use Secure Connection. Select this check box 
if you want to use secure TLS connection for the 
Workspaces LDAP server.

Agent Security Use this section to enable and configure secure 
HTTPS connection for Avaya Workspaces.

This section contains the following:

• Enable Agent Security. Select this check box 
to use secure HTTPS communication for Avaya 
Workspaces.

• Hostname. A hostname you use to access Avaya 
Workspaces.

• Load Certificate. Use this button to browse to a 
desired directory and load an HTTPS certificate 
file.

• Load Key. Use this button to browse to a desired 
directory and load a key file.

For more information, see Enabling agent security 
for Avaya Workspaces on page 102.

Workspaces Administration Use this section to configure the Avaya Workspaces 
administrator, the Widget Library URI and the Log 
Upload URI.

This section contains the following:

• Admin Username. A name of the Avaya 
Workspaces administrator. For more information, 
see Configuring the Avaya Workspaces 
administrator on page 95.

• Widget Library URI. The address of the Avaya 
Workspaces Widget Library.

• Log Upload URI. The address of the external 
server for uploading Avaya Workspaces log files.

Table continues…
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Name Description
Authentication Use this section to configure the token expiration 

timeout.

Under Token expiration timeout, set the time of 
token expiry in hours and minutes.

Related links
Configuring Avaya Workspaces general settings on page 92

Configuring the Avaya Workspaces administrator
About this task
Use this procedure to configure an administrator user for Avaya Workspaces. Administrators can 
customize the layout and functioning of Avaya Workspaces, as well as access Widget API to 
create a customized Avaya Workspaces.

Before you begin
Create a domain user that you want to use as an Avaya Workspaces administrator. The Avaya 
Workspaces administrator user is a domain user with no special privileges.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click Workspaces Configuration.

3. Click Server Settings.

4. In the Workspaces Administrator Username field, type the name of the domain user that 
you want to use as an Avaya Workspaces administrator.

Enter the name of the administrator account in the format username@domainname. 
Ensure that the domain name you enter matches the domain name in Active Directory.

5. Click Save.

Related links
Avaya Workspaces configuration on page 91

Logging in to Avaya Workspaces as an administrator
About this task
Use this procedure to log in to Avaya Workspaces as an administrator.

Configuring the Avaya Workspaces administrator
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You can access Avaya Workspaces through a web browser using the cluster IP address (cluster 
virtual IP) or FQDN of the Avaya Workspaces cluster.

Important:
If you enter an IP address in Cluster settings, you must access Avaya Workspaces using the 
cluster IP address.
If you enter an FQDN in cluster settings, you must access Avaya Workspaces using the 
FQDN.
Using an FQDN for accessing Avaya Workspaces when an IP address is configured in cluster 
settings, and vice versa, can cause incorrect operation of widgets.

Avaya Workspaces supports both HTTP and HTTPS. You can enable the HTTPS connection 
for Avaya Workspaces in the Contact Center Manager Administration application. For more 
information, see Enabling agent security for Avaya Workspaces on page 102.
Depending on the configuration, you can use one of the following URL formats to access Avaya 
Workspaces:

• http://<CLUSTER_VIRTUAL_IP>:31380/services/UnifiedAgentController/
workspaces/

• http://<FQDN>:31380/services/UnifiedAgentController/workspaces/
• https://<CLUSTER_VIRTUAL_IP>:31390/services/UnifiedAgentController/
workspaces/

• https://<FQDN>:31390/services/UnifiedAgentController/workspaces/
Note that the port number changes to 31390 when you use HTTPS.

Procedure
1. Access Avaya Workspaces by typing the URL into your web browser.

2. On the Login page, in the Username field, enter your administrator username and domain 
name in the format username@domainname.

3. In the Password field, enter your password.

4. Click Sign in.

The Activate Agent screen is displayed.

5. From the Profile drop-down list, select AdminProfile.

6. Click Activate.

You are now logged in as an administrator and can customize Avaya Workspaces.
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Configuring email confirmation
About this task
Use the following procedure to enable email confirmation for all agents before sending an email. 
When you enable email confirmation, Avaya Workspaces displays a confirmation dialog box when 
agents attempt to send an email. This setting applies to all agents.

Procedure
1. Log on to Avaya Workspaces as an administrator user.

2. On the Avaya Workspaces administrator interface, click the Admin Settings button.

3. Select the Confirm Before Sending Email check box.

Related links
Avaya Workspaces configuration on page 91

Using the Avaya Workspaces compressed layout
About this task
Use the following procedure to enable the compressed layout of the Avaya Workspaces interface. 
The compressed layout setting applies to all agents. When you enable compressed layout, the 
interaction area on the Avaya Workspaces interface is minimized, which allows more space for 
additional widgets.
Avaya recommends only using the compressed layout for voice-only agents.

Procedure
1. Log on to Avaya Workspaces as an administrator.

2. On the Avaya Workspaces administrator interface, on the left sidebar, click the Layout 
icon.

The Layout Manager screen appears.

3. On the Layouts tab, next to the required layout, click the Edit layout icon.

4. On the Layout Configuration tab, select the Use compressed Workspaces check box.

5. Click Save Changes.

Related links
Avaya Workspaces configuration on page 91
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Configuring agent toast notifications
About this task
Use the following procedure to configure the type of toast notifications agents see on Avaya 
Workspaces. This setting applies to all agents. The following are the types of toast notifications 
available:

• Information: These notifications display general updates, including supervisor broadcast 
messages.

• Warnings: These notifications display general Avaya Workspaces warnings.
• Errors: These notifications display critical Avaya Workspaces errors that can impact 

functionality.

Procedure
1. Log in to Avaya Workspaces as an administrator.

See Logging in to Avaya Workspaces as an administrator on page 95.

2. On the Avaya Workspaces administrator interface, click the Admin Settings button.

3. Under Agent Toast Notifications, depending on your preferences select the Information, 
Warnings, or Errors check boxes.

4. (Optional) To change the default time for showing toast notifications, select the Override 
default time for showing toast notifications check box and select the time value from 
the list.

Related links
Avaya Workspaces configuration on page 91

Configuring the Start Work button behavior
About this task
When an agent starts work in Avaya Workspaces, the agent state is set to ready by default. Use 
the following procedure if you want to allow agents to start work in either the ready or not ready 
state. This setting applies to all agents.

Procedure
1. Log on to Avaya Workspaces as an administrator user.

2. On the Avaya Workspaces administrator interface, click the Admin Settings button.

3. Select the Allow Agents the choice to Start Work in a Not Ready or a Ready state 
check box.

Related links
Avaya Workspaces configuration on page 91
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Importing email templates to the CCMM database
About this task
To use the email templates on Avaya Workspaces, you must first import the email template files to 
the CCMM database from the Agent Desktop templates folder. You can upload all email template 
files using the Email Templates feature. Avaya Workspaces supports .txt and .html files.
Use the following procedure to import email template files.

Procedure
1. Open the Contact Center Multimedia Administration utility.

See Starting CCMM Administration utility on page 46.

2. On the left pane, click Workspaces Configuration.

3. Click Email Templates.

CCMM Administration displays the Workspaces Email Templates page.

At the first launch, there are no email templates in the CCMM database.

4. On the bottom of the page, click Import.
5. Select the root Agent Desktop templates folder and click OK.

The Workspaces Email Templates displays all folders containing email template files as a 
tree. Different icons represent folders, plain text files and HTML files.

6. Select a template file to see the preview on the preview pane.

The preview pane displays how the email template looks on Avaya Workspaces. You can 
view both plain text and HTML versions of the selected email template.

7. Click Save to upload all email templates to the CCMM database.

8. (Optional) On the warning message, click Yes if you want to overwrite the existing Avaya 
Workspaces email templates.

The warning popup is only displayed if the CCMM database already contains email 
template files.

The progress bar along the bottom of the page indicates the save is in progress.

Result
When the saving process completes, the icons in the tree change to represent the Email Template 
groups. The imported email templates are now available for agents using Avaya Workspaces.

Next steps
Add the Email Templates widget to the Avaya Workspaces layout. For more information, see 
Configuring the Avaya Workspaces layout and widgets on page 100.

Related links
Avaya Workspaces configuration on page 91
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Configuring the Avaya Workspaces layout and widgets
About this task
Use Layout Manager to customize your Avaya Workspaces by changing the layout and adding 
widgets.
You can always reset the Avaya Workspaces layout to the default version. See Resetting the 
Avaya Workspaces layout on page 101.
If you have deleted widgets from Layout Manager, you can restore them. See Restoring deleted 
widgets on page 101.

Procedure
1. Log in to Avaya Workspaces as an administrator.

See Logging in to Avaya Workspaces as an administrator on page 95.

2. On the Avaya Workspaces administrator interface, on the left sidebar, click the Layout 
icon.

The Layout Manager screen appears.

3. On the Layouts tab, next to the required layout, click the Edit layout icon.

4. On the Customize Layout tab, select the layout for the Home Page and different interaction 
types.

5. On the Customize Sidebar tab, next to the required sidebar tab, click one of the following:

• Default Tab: To set the tab as default.

• Clone Tab: To make a copy of the existing tab.

• Remove Tab: To delete a tab from the sidebar. You cannot delete the core tabs.

6. To edit an existing tab, do the following:

a. Next to the required tab, click Edit, or click the required tab name.

b. On the Configuration tab, select the layout type and the required widgets.

7. To create a new tab, do the following:

a. Click Add New Sidebar Tab.

b. On the Configuration tab, enter the required sidebar options, select the layout type 
and the required widgets.

8. Click Save Changes.

Result
The updated layout is now available on Avaya Workspaces.

Related links
Avaya Workspaces configuration on page 91
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Resetting the Avaya Workspaces layout
About this task
Use this procedure if you want to restore the default version of the Avaya Workspaces layout.

Procedure
1. Open the Contact Center Multimedia Administration utility. See Starting CCMM 

Administration utility on page 46.

2. In the left pane, click Workspaces Configuration.

3. Click General Settings.

4. Click Reset Workspaces Layout.
5. Click Save.

Result
When agents re-login to Avaya Workspaces, the application displays the default layout.

Related links
Avaya Workspaces configuration on page 91

Restoring deleted widgets
About this task
Use this procedure if you want to restore widgets you have deleted from Layout Manager.

Procedure
1. Open the Contact Center Multimedia Administration utility. See Starting CCMM 

Administration utility on page 46.

2. In the left pane, click Workspaces Configuration.

3. Click General Settings.

4. Click Restore Widgets.

5. Click Save.

Result
All widgets are now available in Layout Manager.

Related links
Avaya Workspaces configuration on page 91
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Enabling agent security for Avaya Workspaces
About this task
Avaya Workspaces supports HTTPS for secure communication. Use this procedure to enable 
agent security and configure agents accessing Avaya Workspaces using HTTPS.
When agent security is enabled, agents must use one of the following URL formats to access 
Avaya Workspaces:

• https://<CLUSTER_VIRTUAL_IP>:31390/services/UnifiedAgentController/
workspaces/

• https://<FQDN>:31390/services/UnifiedAgentController/workspaces/
When using the HTTPS URL with the IP address, you must create a security certificate with the 
cluster virtual IP address of Avaya Workspaces.
When using the HTTPS URL with the FQDN, you must create a security certificate with the FQDN 
of Avaya Workspaces.
Note that the port number changes to 31390 when you use HTTPS.

Before you begin
Obtain a security certificate and associated key file from a trusted Certificate Authority (CA).

Procedure
1. Open the Contact Center Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click Workspaces Configuration > General Settings.

3. On the Edit Workspaces Settings window, in the Agent Security area, select the Enable 
Agent Security check box.

4. Click Load Certificate, browse to the appropriate directory and select the HTTPS 
certificate file.

If you want to use the HTTPS URL with the cluster virtual IP address to access Avaya 
Workspaces, you must load a certificate created with the cluster virtual IP address.

If you want to use the HTTPS URL with the FQDN to access Avaya Workspaces, you must 
load a certificate created with the FQDN.

5. Click Load Key, browse to the appropriate directory and select the key file.

6. In the Hostname field, enter the hostname you want to use to access Avaya Workspaces.

For example, type the FQDN of the Avaya Workspaces cluster.

Important:

Ensure that this hostname matches the hostname used when creating the security 
certificate. You must also ensure that all Avaya Workspaces client computers can 
resolve this hostname to the IP address of the Avaya Workspaces cluster.
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7. Click Save.

After saving the agent security changes, wait at least five minutes for the changes to take 
effect. Do not change any agent security settings within this five-minute period. If your 
HTTPS certificate has expired and you want to upload a new one, you must disable agent 
security by clearing the Enable Agent Security check box and wait for five minutes. After 
that, repeat the process of enabling agent security.

Configuring Customer Journey for Voice and Video 
channels

About this task
By default, the Customer Journey widget displays Email and Chat interactions. To configure 
Customer Journey for Voice and Video channels, you must enable the Contact Summary 
statistics collection in the Configuration component of Contact Center Manager Administration 
and configure the Voice History server in the Contact Center Multimedia Administration utility.
Use this procedure to configure Customer Journey for Voice and Video interactions.

Procedure
1. Start Microsoft Edge in Internet Explorer mode.

2. In the browser address bar, type the URL of the Contact Center server.

For example, type https://<server name>, or, if you turned off Web Services security, 
type http://<server name>, where <server name> is the computer name of the 
Contact Center server.

3. Press Enter.

4. On the login page, in the User ID field, type an administrator username.

5. In the Password field, type the password.

6. Click Log In.

7. On the CCMA launchpad, click the Configuration component.

8. In the left pane, expand the server you want to configure.

9. Click Historical Statistics.

10. In the Collect the following statistics table, select the Contact Summary check box.

11. Click Submit.
12. On the menu, click Launchpad > Back to Launchpad.

13. Click the Multimedia component to start the Contact Center Multimedia Administration 
utility.

For more information, see Starting CCMM Administration utility on page 46.
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14. In the left pane, click General Administration.

15. Click Server Settings.

16. Select Reporting Server (P2P IMs and Voice history).
17. Click Edit.
18. In the Hostname field, type the hostname of the Contact Center Manager Server.

19. In the Port field, type the port number.

The default port number is 443.

20. Click Save.

Related links
Avaya Workspaces configuration on page 91
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Chapter 7: Email configuration

This chapter describes how to set up your contact center with the optional configurations for routing 
email contacts to fulfill your customer requirements.

When you commission your contact center, you configure the email server, a default email skillset, 
and a default recipient with at least one rule group. The default settings ensure email messages go 
only to an agent with the ability to handle email messages. You can customize your contact center 
with additional skillsets, rule groups and email servers.

To further enhance your customer service, you can configure routing tools to use in rule groups. 
Use keyword groups and sender groups to decide how to route contacts. Configure which skillset 
and priority the email contact is assigned to based on the input for routing contacts. Use automatic 
suggestions for the agent to reply quickly to an email or automatic responses to send a reply to 
the customer without agent interaction. You can close the contact immediately after the automatic 
response. This chapter describes how to configure all optional routing tools.

You can configure outbound email settings, such as which skillset to use as a reply address and a 
list of email addresses that must not receive automatic responses. For each skillset you use to route 
contacts, you can have a signature with your corporate branding or special information based on the 
skillset.

Other types of contacts generate email messages that are routed using the inbound and outbound 
email options.

Reports appear in the Contact Center Multimedia Administration utility to show the current status 
of the email traffic. The following reports appear when you select email and View Reports in the 
left column of the Contact Center Multimedia application. You can choose the report date and the 
skillsets represented in all displayed real-time reports.

• Email (New Vs. Closed) shows the number of contacts in a new and closed state against the 
time for the selected date and skillsets.

• Email Progress shows the number of contacts in a new or closed state on a defined date to 
determine the traffic levels for that date.

• Email Closed Contacts Queue Time shows the average time an email contact spends in queue 
while the contact center is open.

You can configure general email settings to minimize space and format special characters for other 
languages.
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Configuring the email server names
About this task
Configure the email server names to identify the inbound server (POP3 or IMAP) for email 
messages received by the contact center and the outbound server (SMTP) for email messages 
sent by the contact center.
If you configured the email servers during installation and the names of the inbound and outbound 
email servers remain unchanged, you can skip this procedure.
You can configure secondary inbound and outbound email servers. If a primary email server fails, 
the email retrieved during the failure is duplicated in the Multimedia database when you restore 
the primary server.
Avaya recommends that you use POP3 as the inbound protocol to receive email messages.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select General Administration.

3. Click Server Settings.

4. Under Edit Current Servers select Inbound Mail Server.
5. Click Edit.
6. In the Primary Hostname field, type the name of the server that receives email messages.

7. In the Inbound Protocol field, select the protocol that is used for receiving email 
messages. You can choose one of the following:

• IMAP
• POP3

8. In the Encryption field, select the security protocol that is used for receiving email 
messages. You can choose one of the following:

• Clear Text (Default)

• TLS
• STARTTLS

9. In the Port Number field, type the port number for the email server.

10. If you have a backup email server, in the Secondary Hostname field, provide a hostname 
for the backup server.

11. Click Save.

12. Under Edit Current Servers, select Outbound SMTP Server.
13. Click Edit.
14. In the Primary Hostname field, type the name of the server that sends email messages.
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15. In the SMTP Authentication field, select the SMTP authentication, if required, for your 
outbound email server.

16. In the Encryption field, select the security protocol that is used for sending email 
messages. You can choose one of the following:

• Clear Text (Default)

• TLS
• STARTTLS

17. In the Port Number field, type the port number for the email server.

18. If you have a backup email server, in the Secondary Hostname field, provide a hostname 
for the backup server.

19. Click Save.

Variable definitions
Name Description
Port Number Port number for the email server.
Primary Hostname The name of the server that receives email 

messages.
Secondary Hostname Name of a secondary email server, if one is 

available in your contact center.

Adding an email server
About this task
Add or update the email server for your Contact Center Multimedia server so you can poll multiple 
email servers in your contact center for email messages to be routed. You can retrieve email 
messages for the contact center if you are licensed to use the email feature.
If you select TLS or STARTTLS as the encryption type for incoming or outgoing mail, you must 
add a valid certificate on the Contact Center Multimedia server. For more information, see Adding 
a certificate for use with TLS email connections on page 142.
Avaya recommends that you use POP3 as the inbound protocol to receive email messages.

Important:
• Contact Center Multimedia supports adding a maximum of five POP3 or IMAP servers as 

inbound email servers, and five SMTP servers as outbound email servers. You can have 
a mix of email servers that have POP3 or IMAP protocols for receiving email messages, 
and the SMTP protocol for sending email messages with a mix of TLS, STARTTLS, and 
no security channels.

Adding an email server
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• From Release 7.1 Feature Pack 2, the Microsoft Office 365 server is presented in the 
Server Settings table by default and adding Microsoft Office 365 as an email server is not 
required. You cannot delete or edit the Microsoft Office 365 server.

Procedure
1. Open the Multimedia Administration utility, as described in Starting CCMM Administration 

utility on page 46.

2. In the left pane, select General Administration.

3. Click Server Settings.

4. Under Edit Current Servers, click New.

5. Select Inbound Mail Server to add a new inbound email server.

6. In the Primary Hostname field, type the name of the server that receives email messages.

7. In the Inbound Protocol field, select one of the following protocols for receiving email 
messages:

• IMAP
• POP3

8. In the Encryption field, select one of the following security protocols for receiving email 
messages:

• Clear Text (Default)

• TLS
• STARTTLS

9. In the Port Number field, type the port number for the email server.

10. If you have a backup email server, in the Secondary Hostname field, provide a hostname 
for the backup server.

11. Click Save.

12. Under Edit Current Servers, click New.

13. Select Outbound SMTP Server to add a new outbound email server.

14. Click Edit.
15. In the Primary Hostname field, type the name of the server that sends email messages.

16. In the SMTP Authentication field, select the SMTP authentication, if required, for your 
outbound email server.

17. In the Encryption field, select one of the following security protocols for sending email 
messages:

• Clear Text (Default)

• TLS
• STARTTLS
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18. In the Port Number field, type the port number for the email server.

19. If you have a backup email server, in the Secondary Hostname field, provide a hostname 
for the backup server.

20. Click Save.

Deleting an email server
About this task
Delete an email server or other nonessential server if the server is no longer required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Server Settings.

4. Select the sever to delete.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Configuring skillsets for email
Before you begin

• If required, configure an office hour template. See Configuring office hours on page 49 and 
Configuring holidays on page 50.

About this task
Configure a route point for each skillset, to use the skillsets in rules. A route point is a location on 
the open queue that enables incoming calls to be queued and run through a script on the Contact 
Center Manager Server.
An automatic signature is text automatically added at the bottom of an outgoing message. For 
example, you can encourage customers to visit your customer support website by adding the URL 
and other promotional information to every message. You can also use the automatic signature to 
add disclaimer text to messages.
You can also apply an office hours template for your skillset. If agents in a different time zone or 
different department have a different set of office hours, you can apply an office hour template 
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that is different from the global office hours schedule configured in general email settings to this 
skillset.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Skillset Settings.

4. Select a skillset for which to assign a route point.

5. Click Edit.
6. From the Route Point list, select the route point to assign to the skillset.

7. Under Office Hours, choose an office hour template that gives the office hours particular 
to the selected skillset.

8. If applicable, in the Auto Signature box, type the signature to assign to the skillset.

9. Click Save.

Creating or changing a recipient mailbox
Before you begin

• Ensure that any enabled email address you want to configure in the Email Manager is 
already configured on your corporate email server.

About this task
Create a recipient email box to ensure that at least one email box is configured for your contact 
center. You must configure one recipient to commission the server. You can create additional 
mailboxes to have the Contact Center Manager Server poll a mailbox on the email server and 
handle contacts based on the recipient address.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Recipient Addresses.

4. Click New.

OR

Select a recipient address, and click Edit.
5. If you select New, select Mail Store from the Mailbox Type list.
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6. Under Mailbox Details, in the Mailbox field, type the SMTP mailbox name.

7. In the Domain field, type the domain for your email server.

8. In the Display Name field, type the name to appear in the email From address.

9. Under Authentication, from the Credentials list, select the required credentials.

10. In the Inbound Server field, select the hostname of your server along with the respective 
security protocol.

11. In the Inbound Mail Threshold field, type the maximum number of email messages to be 
retrieved from the mailbox every scan interval.

You can enter a different value for this variable for each mailbox.

12. In the Outbound SMTP Server field, select the hostname of your SMTP server.

13. In the Rule Group field, select the name of the Rule Group to assign to the recipient 
mailbox.

14. Click Save.

Variable definitions
Name Description
Display Name The name to appear in the email From address.

For example, Sales Department.
Domain The domain name for the email server.
Mailbox The name of a mailbox on the email server.

If the Contact Center Multimedia server is in the 
same domain as the email server, in the Mailbox 
Name box, type the address, and in the E-mail 
Domain box, type the domain name.

If the Contact Center Multimedia server is not in 
the same domain as the email server, and you are 
using Windows 2000, in the Mailbox Name box, 
type the address in the format domain\user.

If the Contact Center Multimedia server is not in the 
same domain as the email server, and you use a 
version of Windows later than Windows 2000, in the 
Mailbox Name box, type the address in the format 
user@domain.

Important:

Mailbox names are case-sensitive. You must 
type the mailbox name exactly as it appears on 
your server.

Table continues…
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Name Description
Username The username used to access the mailbox on the 

email server.
Credentials A password or client credentials used to access the 

mailbox on the email server.

Use password for POP3 or IMAP servers with Basic 
authentication.

Use client credentials for the Microsoft Office365 
(MS Graph) server with OAuth 2.0 authentication.

Inbound Mail Threshold The maximum number of email messages to be 
retrieved from the mailbox every scan interval.

You can enter a different value for this variable for 
each mailbox. The default value is 10.

Rule Group The name of the rule group that applies to this 
recipient mailbox. Configure rule group properties 
in the Contact Center Multimedia Administrator.

Inbound Server The name of the email server, POP3, IMAP or 
Microsoft Office365 (MS Graph), that handles email 
messages coming into the contact center.

Outbound (SMTP) Server The name of the email server that delivers email 
messages that leave the contact center.

Creating or changing an alias for a recipient mailbox
Before you begin

• Ensure that any enabled email address you want to configure in the Email Manager is 
already configured on your corporate email server.

• Configure a mail store recipient mailbox. See Creating or changing a recipient mailbox on 
page 110.

About this task
Create an alias, or another name, for the recipient email box.
For example, the mailbox general@magscripts.com can have the aliases 
carz@magsubscriptions.com and planez@magsubscriptions.com. Email messages addressed to 
either alias are forwarded to the general@magscripts.com mailbox. The Email Manager routes the 
email messages according to the alias-based rules.
Aliases can be useful to filter email messages. For example, you can define an alias for a short 
promotional period after which email messages that arrive at that alias are discarded.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.
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2. In the left pane, click E-mail.
3. Click Recipient Addresses.

4. Click New.

OR

Select the alias and click Edit.
5. In the Mailbox Type list, select Alias.

6. Under Mailbox Details, in the Mailbox box, type the SMTP mailbox name.

7. In the Domain box, type the domain for your email server.

8. In the Display Name box, type the name of the alias set up on the email server.

9. In the Rule Group box, select the name of the Rule Group to assign to the alias for the 
recipient mailbox.

10. In the Outbound SMTP Server box, ensure that the hostname of your SMTP server 
appears.

11. Select the Use alternative username for SMTP Authentication check box if you 
configure an inbox as an alias.

If SMTP authentication is enabled on your email server, and you use aliases, log on to the 
SMTP server with a different user name.

12. In the Username box, type the username of the mail store recipient address.

13. From the Credentials list, select the required credentials.

14. Click Save.

Variable definitions
Name Description
Alias An alias is an address that forwards all email 

messages it receives to another email account.
Display Name The name to appear in the email From address.

For example, Sales Department.
Domain The domain name for the email server.

Table continues…

Creating or changing an alias for a recipient mailbox
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Name Description
Mailbox The name of a mailbox on the email server.

If the Contact Center Multimedia server is in the 
same domain as the email server, in the Mailbox 
Name box, type the address, and in the E-mail 
Domain box, type the domain name.

If the Contact Center Multimedia server is not in 
the same domain as the email server, and you are 
using Windows 2000, in the Mailbox Name box, 
type the address in the format domain\user.

If the Contact Center Multimedia server is not in the 
same domain as the email server, and you use a 
version of Windows later than Windows 2000, in the 
Mailbox Name box, type the address in the format 
user@domain.

Important:

Mailbox names are case-sensitive. You must 
type the mailbox name exactly as it appears on 
your server.

Username The username used to access the mailbox on the 
email server.

Credentials A password or client credentials used to access the 
mailbox on the email server.

Use password for POP3 or IMAP servers with Basic 
authentication.

Use client credentials for the Microsoft Office365 
(MS Graph) server with OAuth 2.0 authentication.

Rule Group The name of the rule group that applies to this 
recipient mailbox. Configure rule group properties 
in Contact Center Multimedia Administrator.

Outbound (SMTP) Server The name of the email server that delivers email 
messages that leave the contact center.

Deleting a recipient mailbox
Before you begin

• Before you delete a mailbox, you must ensure that no email messages are sent to the inbox 
and no aliases are directed to that mailbox.

• Avaya recommends that you archive all contacts associated with a recipient before you 
delete the recipient.
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About this task
Delete a recipient mailbox from your system if you no longer require it to monitor email. Removing 
extra mailboxes saves space in your database.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Recipient Addresses.

4. Select the address from the recipient list that you want to delete.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion of the recipient mailbox.

Updating the system default rule
Before you begin

• Ensure that you know the default settings for the system delivery failure rule:
- use the email default skillset, EM_Default_Skillset
- use no automatic response
- assign priority 3

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, EM_Default_Skillset is used.
- If you delete EM_Default_Skillset, the system stops processing email messages.

• Configure the route points for the skillset you assign to the system default rule. For more 
information, see Configuring skillsets for email on page 109.

About this task
Update the system default rule to ensure that an email arriving at each configured recipient 
mailbox is assigned a skillset and can be routed.
When you create a recipient mailbox, the system default rule is copied as the last regular rule into 
the list of rules for the recipient mailbox.
The automatic signature is text appended to each email message sent from the contact center in 
addition to the agent message. The text in the automatic signature contains corporate disclaimer 
information and must be in fixed-width font. The automatic signature appears in an email message 
after any personal signature, which is configured in the Agent Desktop application.

Updating the system default rule
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The system default rule is used in every rule group configured in Contact Center Multimedia.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click System Rules.

4. Under System Default Rule, from the Skillset list, select a skillset name.

5. To change the automatic response settings, under Auto Responses, select another 
automatic response from the list.

6. To change the priority, under Priority, select a different priority for the contact.

7. Click Save.

Variable definitions
Name Description
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route contacts.

Auto Response A message sent to a customer with no agent 
interaction.

An automatic response can be an intelligent 
response, such as a sales promotion flyer, or an 
acknowledgement, such as, “Thank you for your 
email. We will respond to you within three days.”

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
10.

For example, a call with priority 1 is handled before 
a call with priority 10.

Updating the system delivery failure rule
Before you begin

• Ensure that you are licensed to handle email messages.
• Ensure that you know the default settings for the system delivery failure rule:

- use the email default skillset, EM_Default _Skillset
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- use keyword group delivery failure keywords
- assign priority 10 (lowest)

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, EM_Default_Skillset is used.
- If you delete EM_Default_Skillset, the system stops processing email messages.

• Configure the route point for the skillset you plan to assign to the system delivery failure rule. 
See Configuring skillsets for email on page 109.

About this task
Update the system delivery failure rule to ensure that any email message that contains particular 
phrases such as undeliverable, returned mail, unknown recipient, delivery failure, or delivery 
report is deleted and not assigned to an agent.
When you create a recipient mailbox, the system delivery failure rule is copied as the first regular 
rule into the list of rules for the recipient mailbox.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click System Rules.

4. Under System Delivery Failure Rule, from the Skillset list, select a skillset name.

5. To change the keyword group, under Keyword Group, select an existing keyword group 
from the list.

6. To change the priority, under Priority, select a different priority for the contact.

7. Select the Will close contact check box to have the rule to close the contact.

8. Click Save.

Variable definitions
Name Description
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route outbound 
contacts.

Table continues…

Updating the system delivery failure rule
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Name Description
Keyword group A list of words that you can search in an email 

message. Keyword groups associate keywords and 
expressions considered important by the contact 
center to be handled in a particular way.

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
10.

For example, a call with priority 1 is handled before 
a call with priority 10.

Will close contact Select the check box to close the email contact after 
the system delivery failure rule determines that the 
contact is not appropriate for the contact center. 
Clear the check box to leave the email contact open 
for review.

Creating or changing a keyword group
About this task
You must assign at least one keyword to a keyword group before you can save the keyword 
group.
The keyword search in an email message is not case-sensitive. For example, if you add the word 
John, the Email Manager also matches JOHN and john.
The Keyword box supports the Unicode UTF-8 character set.
You can specify a spelling accuracy in the keyword group.
Keyword groups support only asterisks (*) and question marks (?) as wildcard characters. The 
asterisk (*) represents multiple characters. For example, t* specifies a list of all the words that start 
with t. The question mark (?) represents a single character. For example, p?t specifies all three 
letter words that start with p and end with t.
A keyword does not support the following characters: +-!(){}[]^"~:\&&||#$@€/><,.‘;=%£&¬|`'“. If you 
use any of these characters in your keywords, you receive an error message stating that the 
keyword contains invalid characters.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Keyword Groups.

4. Click New or Edit.
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5. Under Keyword Group, in the Group Name box, type a unique name for the keyword 
group.

6. In the Keyword box, type a word or a group of words related to the keyword group you 
create.

7. Optional: To allow close misspellings of the word, select the Allow spelling inaccuracies 
check box.

The system displays the following levels of accuracy:

• Low (greater than 70% accuracy)
• Medium (greater than 80% accuracy)
• High (greater than 90% accuracy)

8. Optional: Select the required level of accuracy.

9. Click >.

The keyword or expression is added to the list, and the keyword group is created.

10. Repeat step 6 on page 119 through step 9 on page 119 to add more keywords to the list.

11. Click Save.

Variable definitions
Name Description
Name Name of the keyword group. The name must be 

unique and less than 64 characters.
Keyword A word, or string of characters, used to search the 

email message for particular text to determine the 
routing of the contact. A maximum of 50 keywords 
can be in each keyword group.

Allow spelling inaccuracies Select the check box to allow small inaccuracies in 
spelling of words.

Specify to allow a spelling inaccuracy of 70%, 80%, 
or 90% in the keyword list.

For example, to allow charles, charlie, and charley 
in the search for the keyword charlie, you can select 
a low (70%) degree of accuracy because 2 of the 
7 characters or 71% of the characters are correct. 
Inaccuracies of 80% or 90% do not allow the error.
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Deleting a keyword from a keyword group
About this task
Remove a keyword from a keyword group. The remaining keywords and phrases in the keyword 
group remain active for rules.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Keyword Groups.

4. Select a keyword group from the Keyword Groups list.

5. Click Edit.
6. In the Keywords in Group list, select the keyword.

7. Click Remove.

The system displays a Warning dialog box.

8. Click Yes to confirm the deletion.

9. Click Save.

Deleting a keyword group
About this task
Delete a keyword group. After you remove the keyword group, you cannot use it in any rule. In 
certain scenarios, rules that use the deleted keyword group do not route the contact as expected.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Keyword Groups.

4. Select a keyword group from the Keyword Groups list.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.
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Creating or changing prepared responses
About this task
There are three types of prepared responses; auto response, chat history header, and auto 
suggestion.
You can use automatic responses to automatically send responses to a sender without agent 
intervention. Chat history headers provide email headers for sending chat history to a customer. 
Suggested responses give agents template text for common responses, which they can review 
and edit and send as a response. The body of a prepared response is limited to 3900 characters. 
This limit includes hidden characters such as HTML tags.
You must add a suggested response to a rule group, to make it available to agents on Agent 
Desktop. To send prepared chat history headers, you must configure a header on each WC 
skillset.
Prepared responses support both standard and inline attachments. You can add inline 
attachments such as company logos to the responses. You can include only images as inline 
attachments. The formats supported are .gif, .bmp, .jpg, and .png.
Agents can also place inline attachments (only as images) in email messages.
Inline attachments display complete information within the body of the email. This makes the 
information easily accessible to customers, even without explicitly opening the attachment. For 
example, adding a company logo, as an inline image, increases brand awareness.
Examples of prepared responses include the following:

• provide the customer with their Web logon ID and password (password reminder automatic 
response)

• inform a customer if your office is closed (out-of-office automatic response)
• acknowledge the receipt of an email contact (automatic response, or an automatic 

acknowledgement)
• include standard content on a web chat history email
• provide specific information in response to rule inputs (suggested response)

Configuring prepared responses for a rule is optional.
You can create categories for the prepared responses. The categories enhance the ability of the 
agent to search through the prepared responses on Agent Desktop.
A password reminder and an out-of-hours automatic response are configured by default. You 
cannot delete the default automatic responses.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Prepared Responses.

4. In the Prepared Responses table, click New Response.

OR
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In the Prepared Responses table, select a response, for editing that particular prepared 
response.

5. In the Name box, type or edit the name of the prepared response.

6. In the Type box, select the type of response.

7. In the Subject box, type or edit the subject of the response email message.

8. In the Body box, type or edit the message to include in the response.

Use the formatting bar described below to apply formats to your email message.

9. (Optional) Click the Image icon to add images or inline images to the response.

The system displays the Insert Image dialog box.

10. (Optional) Beside the Attachment box, click Add to add attachments to the response.

The system displays the Attachment dialog box.

11. (Optional) Choose a category for the prepared response to make it easier for agents to 
navigate on Agent Desktop.

12. Click Save.

Variable definitions
Name Description
Name The name of the automatic response. The name 

must be unique.
Type The type of prepared response.

Auto-Response is a reply that Contact Center 
Multimedia can send automatically when it receives 
an email message.

Chat History Header provides common headers for 
Web Chat history emails. You must configure this 
response on each WC skillset for which you want to 
use this response.

Auto-Suggest is a template that agents can use to 
provide common responses to customers. You must 
add a suggested response to a rule group, to make 
it available to agents.

Subject The subject of the prepared response used as an 
email message.

Table continues…
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Name Description
Body The body of the prepared response. The body 

is limited to 3900 characters. The body can 
include attachments, formatting, and variables for a 
customer. To access the variables for the content, 
insert a placeholder by right-clicking the content and 
selecting the placeholder from the menu.

Categories The category for the prepared response. Specifying 
the category makes it easier for agents to find 
automatic suggestions on Agent Desktop.

Attachments The attachment is stored on the Contact Center 
Multimedia server for later use.

Image Inline images are seen directly within the message 
body. The inline image file size limit is the same 
as the current limit set for attachments in Agent 
Desktop.

Browse Available only when you select Image. Browse to 
locate the inline image that you want to include in 
the email.

Image Address (URL) Type the url for the inline image that you want to 
include in the email.

Alternate text Type the alternative text for the image.

Alternate text is what the customer views if their 
email client cannot display the image.

Align Select the alignment of the image. The options are 
inline, left, and right.

Border Inserts a border around the image. For example, 
enter 2 to add a double-sized border around the 
image.

Margin Inserts a margin around the image.
Insert Image Insert the inline image.
Cancel Exit the Inline Attachments fields.

Deleting prepared responses
About this task
Delete the prepared responses that are no longer used by agents in your contact center.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.
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2. In the left pane, click E-mail.
3. Click Prepared Responses.

4. Select an existing prepared response.

5. Click Delete Response.

6. Click Yes to confirm the deletion.

Removing attachments from prepared responses
About this task
Remove attachments from a prepared response. The attachment file is stored on the Contact 
Center Multimedia server for later use.
To remove inline attachments, select the attachment and delete it from the body of the email.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left column, click E-mail.
3. Click Prepared Responses.

4. Select the prepared response from which you want to remove an attachment.

5. Select the attachment to delete.

6. Beside the Attachments box, click Delete.

The system displays a Warning dialog box.

7. Click Yes to confirm the deletion.

8. Click Save.

Promoting suggested responses
About this task
You can configure prepared responses for agents in the contact center. An agent can use a 
suggested response during the contact. Contact Center Multimedia tracks the number of times the 
suggestion is used. If one suggestion is used often, it is considered a strong reply, and then you 
can promote the suggestion to an automatic response.
Promoting the suggested responses ensures that the customer receives a correct response 
because the agent checks it. The agent can make small changes to the suggestion until it is 
acceptable to run as an automatic response.

Email configuration

April 2024 Avaya Contact Center Select Advanced Administration 124
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


You can promote the suggested responses to an automatic response based on the following 
criteria:

• rules where the suggestion is assigned
• number of contacts in the past 30, 60, 90 or 120 days
• list of all suggestions that are used by agents
• number of times the suggestion is used
• percent of total contacts where the suggestion is applied by agents

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Auto-Suggest Promotion.

4. Under Rules, select the rule for which to promote the suggestion.

5. In the Number of Contacts in past box, choose the length of time for which to see the 
contacts for the selected rule.

6. Under Auto Suggestions, review the list of suggested answers.

7. Select the suggestion to promote.

8. If you want to close the contacts with automatic suggestion, select the Will Close 
Contacts box.

9. Click Promote.

Creating or changing a sender group
About this task
You must place any sender addresses that you want to track in a sender group. You can use 
sender groups to route important sender email addresses to particular skillsets.
Using a sender group in a rule is optional.
Sender groups support asterisks (*) as wildcard characters when they are placed in the email 
address.
Avaya recommends that you have a maximum of 20 sender email addresses in one sender group.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
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3. Click Sender Groups.

4. Click New or Edit.
5. In the Name box type a unique name of the sender group.

6. In the Email Address box, type an email address.

7. If you know the user is in the contact database, start typing an email address, and then 
click Look up email.

Email addresses that match the characters appear in the list.

8. Click Add to insert the email address you looked up, or click Add Freeform to add your 
typed email address to the sender group.

This text box supports unicode language.

9. Repeat step 5 on page 126 through step 8 on page 126 to add sender addresses to this 
sender group.

10. Click Save.

Variable definitions
Name Description
Name The unique name for the sender group. The name 

must be less than 64 characters.
Email Address The email address to add to the sender group.
Addresses in Group A list of addresses in a group that are reviewed 

when the system applies a sender group to a rule. 
You can specify only 50 addresses for each group.

Deleting a sender group
Before you begin

• You must have a sender group. See Creating or changing a sender group on page 125.

About this task
Delete a sender group from your contact center if it is not required in the contact center.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Sender Groups.

4. Select the Sender Group you want to remove.
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5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Deleting a sender from a sender group
About this task
Remove a sender address from a sender group if it is no longer required. The remaining 
addresses in the sender group remain active for rules.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Sender Groups.

4. Select a sender group from the list.

5. Click Edit.
6. Under Addresses in Group box, select the email address from the list.

7. Click Remove.

The system displays a Warning dialog box.

8. Click Yes to confirm the deletion.

9. Click Save.

Creating or changing rules
Before you begin

• If you plan to use office hours for routing email messages, configure your office hours. See 
Configuring office hours on page 49.

• Configure at least one email skillset. See Configuring skillsets for email on page 109.
• Create keyword groups, if required. See Creating or changing a keyword group on page 118.
• Configure prepared responses (automatic responses or suggestions), if required for the rule. 

See Creating or changing prepared responses on page 121.

About this task
Create or change a rule to route your email contacts.
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A rule is a mechanism for routing email contacts. In your contact center, you receive email 
messages from the customer, as well as other contacts that are routed using the rules including 
SMS, Fax, scanned documents, and voicemail.
You can create a rule with one or more of the following routing options:

• determine who sent the email (sender groups)
• look for specific characters, words or phrases (keywords)

Rules can send an automatic response to a customer and thus requires no interaction by an 
agent.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Rule Groups.

4. Click New or select an existing Rule Group and click Edit.
5. Under Rules, click the plus sign (+) button.

OR

Select an existing rule.

6. Under Current Search Criteria, click New and choose the criterion to add to the rule.

7. Select the criterion from the Add New Criterion drop-down box

You can choose between Keyword Match and Sender Group.

8. Click Go.

9. Configure the keyword match or sender group to use.

10. Repeat step 5 on page 128 to step 7 on page 128 to select a maximum of five criteria for 
the rule.

11. Click OK.

12. Under Current Search Criteria, choose the weightage for each criterion.

The total weightage must add up to 100 percent.

13. Under Current Search Criteria Summary, click the blue text to view the details of each 
criterion you configure.

14. Click Next.
15. To select an automatic response for the rule, under Available Auto-Responses, select the 

configured automatic response, and then click >.

16. To select automatic suggestions for the rule, under Available Auto-Suggests, select the 
automatic suggestion you want to include, and then click >.
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To remove a suggestion, select the suggestion, and then click < to remove it from the rule 
list.

17. Click Next.
18. In the General Settings area, in the Name box, type a name for the rule.

19. In the Priority box, select the priority to assign to the contact.

20. In the Skillset box, select the skillset to apply for the rule.

21. If you want to apply the office hours to the email message, click Will use Office hours.

22. To close the contact, click Will Close Contact.
23. Click Save.

Variable definitions
Name Description
Current Search Criteria Select the criterion to configure for the rule.

Choose Keyword Match to select a keyword group 
that contains phrases or words to search.

Choose Sender Group to select an email address 
from which the email message is received.

Choose a maximum of five criteria for each rule.

Note:

If you select multiple keyword groups that 
include an ‘AND’ statement, CCMM detects 
matches only if all keywords are found in either 
the subject or body of the email message. 
CCMM detects no match if some keywords are 
included in the body and some keywords are 
included in the subject.

Available Auto Responses Select the automatic response that you can choose 
for the rule group. You can choose only one 
automatic response.

Automatic responses under Available Auto 
Responses show what you can choose. The 
Automatic responses in the right column show the 
configuration for this rule.

Table continues…
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Name Description
Available Auto Suggests Select the automatic suggestions that you can 

choose for the rule group. You can choose up 
to five automatic suggestions for future automatic 
suggestion promotion.

Automatic suggestions under Available Auto 
Suggestions show what you can select. The 
automatic suggestions in the right column show the 
configuration for this rule.

Name The name of the rule. The name must be unique 
and less than 64 characters.

Skillset Select the name of the skillset to route contacts.
Priority The priority given to a request for a skillset agent. 

The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
10.

Will use office hours Select the check box to use the office hours 
calendar to determine whether the contact center 
is open or closed.

Will close contact Select the check box to close the contact when the 
rule is applied to the contact.

Call Open Interface web service Select the check box to call a Web service.
Web Service Select the Web service associated with the rule.

Enabling a rule
About this task
Rules can be enabled within a rule group.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Rule Groups.

4. Select a disabled rule.

5. Under Rules, click the check mark (√) button.

6. Click Save.
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Disabling a rule
About this task
Rules can be disabled within a rule group. You can disable the rule functionality without deleting 
the rule.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Rule Groups.

4. Select an enabled rule.

5. Under Rules, click the cross ( X ) button.

6. Click Save.

Deleting a rule
Before you begin

• Create a rule.

About this task
Permanently delete a rule. After you delete the rule, you cannot use the rule for routing email 
messages.
You cannot delete the Default Rule.
If you permanently delete a rule, existing contacts for the rule can no longer be archived by 
rule and any Contacts by Rule reports no longer work. Avaya recommends that you archive all 
contacts associated with a rule before you delete the rule.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Rule Groups.

4. Under Rules, select the name of the rule to delete.

5. Click the minus sign (—) button.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.
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7. Click Save.

Creating or changing rule groups
About this task
Create rule groups to apply to the recipient mailboxes and aliases in your contact center.
A rule is a mechanism to route contacts based on who sent the email (sender groups), or 
on words or phrases (keywords). A rule can also send an automatic response and require no 
interaction by an agent.
A rule group is an ordered collection of rules that are reviewed and compared to the incoming 
email in a particular order. Contacts that best match or first match the rule are assigned to the 
skillset based on the rule that routes the contact. The rule group contains the default rule which 
routes the contact if no other rule in the rule group matches the email message.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Rule Groups.

4. Click New.

5. In the Name box, type the name of the new rule group.

OR

In the Rule Groups list, select the rule group to change.

6. Select the Matching Type for the rule group.

7. To add a new rule to the group, click the plus sign (+) button.

8. To remove a rule from the group, click the minus sign (—) button.

9. Configure the new rule using the input criteria, responses, and general settings.

10. To change the order of the rules in the group, select the rule, and then click the up arrow 
( ^ ) button and down arrow ( v ) button to change the order of the rules.

11. Click Save.
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Variable definitions
Name Description
Matching Type Choose the matching type.

For Best match, the system checks all rules in the 
rule group and routes the email message according 
to the rule with the highest percentage match.

For First match, the system checks one rule at a 
time, in the order of the rule group and routes the 
email message according to the rule that matches 
first.

Name Name of the rule group. The name of the rule group 
must be unique and less than 64 characters.

Configuring supervisor approval for email messages on a 
per skillset basis

Before you begin
If you want to use keyword groups to reject email messages automatically, configure keyword 
groups. See Creating or changing a keyword group on page 118.

About this task
Supervisors can approve email messages before the email messages reach the customers.

Note:
The approval process applies to email contacts only and does not apply to other contact types 
such as Fax, Scanned Documents, and SMS.

You can configure Contact Center to send email messages to supervisors for approval on a per 
skillset basis or per agent basis.
You can configure up to five levels of supervisor approval before Contact Center sends the email 
messages to the customer. Contact Center offers the email message to a hierarchy of supervisors 
before the final approval is granted.

Note:
Under the following conditions, a contact can get held up in the approval process:

• an administrator deletes a skillset that is part of the supervisor approval chain and the 
contact is already in queue waiting for that skillset to come into service

• an administrator deletes the original agent and a supervisor rejects the email message
• an administrator deletes the supervisor who needs to approve the email message

In such situations, an agent must pull the contact using Agent Desktop.
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For more information, see Supervisor approval of email messages on page 34 and Configuring 
supervisor approval for email messages on a per agent basis on page 58.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Supervisor Approvals.

4. Select a skillset under Supervisor Approvals.

5. Click Edit.
6. From the drop-down list, under Approval Hierarchy, select the skillset for which you need 

supervisors to approve email messages.

You can configure an approval hierarchy of up to five unique approval skillsets. You cannot 
configure a skillset to be approved by itself.

Note:

Agents can belong to the skillset that approves email messages. Therefore, you must 
configure the approval process in a way that restricts agents from approving email 
messages.

7. From the drop-down list, under Rejection Flow, select the rejection hierarchy for each 
approval level. You can select one of the following:

• Reject to original skillset
• Reject to current approval level –1. This hierarchy is the default setting. For example, 

Reject to approval level 1.

You must configure a rejection hierarchy for each approval level. The rejection hierarchy 
controls the flow of email messages through the levels of approval skillsets for a rejected 
email message. For example, you can decide to automatically send all rejected email 
messages, at any level, back to the originator.

8. In the Approval Ratio field, type the percentage of email messages that require supervisor 
approval for that skillset.

The approval ratio must be whole numbers ranging from 0 to 100.

9. (Optional) From the Auto-Rejection Keyword Group drop-down list, select a keyword 
group based on which the system automatically rejects the email messages for that 
skillset.

10. (Optional) To create a new keyword group, click the plus (+) button next to the Auto-
Rejection Keyword Group drop-down list. The system uses the new keyword group to 
automatically reject email messages for that skillset.

11. Click Save.
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Next steps
Optionally, you can configure Contact Center to auto-reject contacts on all the skillsets configured 
for supervisor approvals, based on a single keyword group. For more information, see Configuring 
auto-rejection of email messages from all skillsets that use approval hierarchy on page 135.

Configuring auto-rejection of email messages from all 
skillsets that use approval hierarchy

Before you begin
• Configure your keyword groups. See Creating or changing a keyword group on page 118.
• Configure supervisor approval on one or more skillsets.

About this task
If you have set up supervisor approval of email messages, you can configure Contact Center 
to use a keyword group to automatically reject email messages from all the skillsets that use 
approval hierarchy.
For example, you can configure a keyword group named Abusive, and then add a list of abusive 
words to the group. For all skillsets that use approval hierarchy, Contact Center automatically 
rejects email messages that contain words listed in the Abusive keyword group. This configuration 
does not affect skillsets that do not have an approval hierarchy.

Note:
Auto-rejection of email messages applies to the first approval level prior to the first review by a 
supervisor. After a supervisor reviews an email message, auto-rejection of email messages is 
not applicable.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Supervisor Approvals.

4. Under Global Settings, in the Auto-Rejection Keyword Group For All Skillsets drop-
down list, select a keyword group based on which Contact Center rejects email messages 
automatically.

5. Review the list of skillsets, and ensure that the skillsets to which you want the auto-
rejection keyword group to apply have an approval hierarchy.

6. Click Save.
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Configuring the email settings
About this task
Configure the following email settings for email messages entering and leaving your designated 
contact center mailboxes:

• how frequently you scan the email server for new messages
• the location in which attachments are stored
• automatic numbering of email messages
• which text is searched when you use keywords for rules

Default values are provided for required fields. You can change or accept the default values for the 
optional settings.

Procedure
1. Open the Multimedia Administration utility.

2. In the left pane, click E-mail.
3. Click General Settings.

4. To change the attachment file location from the file system to the database, select Store in 
the database.

5. To change the attachment file locations on the file system, under Attachment Files, type 
the new paths for the inbound and outbound URL and shared folders into the fields 
provided.

6. To configure a mailbox scan interval, under Mailbox Scan Interval, in the Interval box, 
type the time in minutes.

7. To include the customer ID or contact ID in a number for the outgoing email message 
numbering, under Message Properties, select the Customer ID check box, the Contact 
ID check box, or both.

8. To include the email message body in the keyword search, select the Include email body 
in keyword search check box.

9. Click Save.

Variable definitions
Name Description
Interval The interval between mailbox scans to check for 

new incoming email messages. You can specify 
minutes and seconds between each scan.

Store in the database Select the check box to save new attachments in 
the MULTIMEDIA database instead of on the file 
system.

Table continues…

Email configuration

April 2024 Avaya Contact Center Select Advanced Administration 136
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Name Description
Inbound Url The uniform resource locator (URL) that shows the 

location of the inbound email attachments.

When Web Services security is on, use https as 
the URL prefix. If you have turned off Web Services 
security, use http as the URL prefix.

Inbound Share The path of the shared folder on the Contact 
Center Multimedia server in which the inbound 
email attachments are stored.

Outbound Url The uniform resource locator (URL) that shows the 
location of the outbound email attachments.

When Web Services security is on, use https as 
the URL prefix. If you have turned off Web Services 
security, use http as the URL prefix.

Outbound Share The path of the shared folder on the Contact Center 
Multimedia server in which the outbound email 
attachments are stored.

Autonumber outgoing email Select the check box to number the email message 
automatically with either the customer ID, the 
contact ID, or both. The number appears in the 
subject of the message for identification.

Include email body in keyword search Select the check box to enable a keyword search 
in both the subject and the body of the email 
message.

Search for first characters Specify the number of characters in the content of 
the body of the email message that you search for 
keywords if you enabled the keyword search in the 
body of the email message.

Changing the character encoding for outgoing and 
incoming email

Before you begin
• Avaya recommends that only contact centers in Europe use Latin-9 encoding.

About this task
Change the character encoding of outgoing email to reply to an email message by using the same 
character set as the inbound email. For example, if an email arrives at the contact center with 
Latin-1 encoding, the reply from the Agent Desktop or the automatic response is sent in Latin-1. 
The customer email client can understand the format of the message sent from the contact center.
Use Latin-9 to provide support for the Euro currency symbol, as this character is not included 
in the Latin-1 character set. Outgoing email messages encoded in Latin-1 that include the Euro 
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symbol, deliver the symbol as a question mark. However, not all recipient clients understand 
Latin-9 and can receive what is perceived as a blank email message. Therefore, Avaya 
recommends that contact centers in Europe use the option for Latin-9 encoding while contact 
centers outside Europe avoid it.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click General Settings.

4. In the Encoding for agent initiated emails list, select the type of character encoding to 
use.

5. To use Latin-9 encoding for replies, under Customer Replies, select the Reply to Latin 1 
as Latin 9 check box.

6. Click Save.

7. On the Contact Center Multimedia server, on the Start screen click Administrative Tools   
> Services.

8. Right-click CCMM Email Manager.
9. Click Restart.

10. Close the Services window.

Enabling customer details logging for emails
About this task
To comply with General Data Protection Regulations (GDPR), the detailed customer logging is 
disabled and in the log file the customer addresses and email contents are replaced with the 
REDACTED inscription. However, the customer information can be revealed for troubleshooting 
purposes. Use the following procedure to enable the detailed customer logging and make the 
customer information visible in the log file.

Procedure
1. Open the Multimedia Administration utility. See Starting the CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click General Settings.

4. In the Logger Properties field, select the Detailed customer logging is enabled 
checkbox.

5. Click Save.
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6. Restart the Email Manager service.

Result
The customer information becomes visible for the upcoming emails. You can see the log file in the 
D:\Avaya\Logs\CCMM\CCMM_EmailManager_1.log directory.

Selecting the outgoing email address
Before you begin

• Configure the email mailbox from which to send outbound email messages. See Creating or 
changing a recipient mailbox on page 110.

About this task
You can send email messages from the email address to which the original message was sent or 
from a general email address in the contact center.
You can choose the response email address based on a skillset.

Note:
This procedure does not apply to automatic responses. Contact Center sends all automatic 
responses from the email address that the incoming email message was sent to.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Outgoing E-mail.
4. On the Skillset to Mailbox Mappings tab, select a skillset.

5. Click Edit.
6. In the Address box, select the address from which you want email messages sent from 

this skillset.

7. To send customer responses from an address specified for the skillset, click Send both 
Agent-Initiated Contacts and Customer Responses from this e-mail address.

8. To send customer responses from the address that the customer used, click Respond 
to Customer Contacts with the Recipient address of the original e-mail, and send 
Agent-Initiated Contacts from this address.

9. Click Save.
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Barring email addresses
About this task
Configure Contact Center Multimedia to block certain email addresses. When you bar an email 
address, automatic replies, and agent email messages are not sent to the barred address.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Outgoing E-mail.
4. Click the Barred Outgoing Addresses tab.

5. Click New.

OR

Select an existing barred email address, and then click Edit.
6. In the Address box, type the email address to block.

7. Click Save.

The address appears in the list of Barred Addresses.

Deleting a barred email address
Before you begin

• Ensure that removing a barred address does not violate local governing for do-not-call lists.

About this task
Remove a blocked email address from the barred email address list.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click Outgoing E-mail.
4. Click the Barred Outgoing Addresses tab.

5. Select a barred email address from the list provided.

6. Click Delete.

The system displays a Warning dialog box.
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7. Click Yes to confirm the deletion.

Configuring Microsoft Exchange 2013, 2016, and 2019 to 
send outgoing emails

About this task
Configure Microsoft Exchange to send outgoing email messages from Agent Desktop.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click General Administration.

3. Click Server Settings.

4. Select Outbound SMTP Server.
5. Click Edit.
6. From SMTP Authentication, select Base 64 Encoded Authentication.

7. Click Save.

8. Close the Contact Center Manager Administration window.

9. Log on to the Microsoft Exchange server.

10. Open the Exchange Admin Center.

11. Click Mail flow.

12. Click Receive connectors.

13. Double-click Default <Servername> and select Security.

14. Under Authentication, disable all authentication options except for the following:

• Basic Authentication

• Exchange Server Authentication

• Integrated Windows Authentication

15. Click Save.

16. Click Servers to view the list of servers.

17. Select the required server and then click Edit.
18. In the Properties window, select POP3 or IMAP4.

19. From Logon Method, select Basic authentication (Plain text).

This option does not require a TLS connection for the client to authenticate to the server.

Configuring Microsoft Exchange 2013, 2016, and 2019 to send outgoing emails
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20. Click Save.

21. Close the Exchange Admin Center.

22. On your Microsoft Exchange server, click Start  > Administrative Tools > Services.

23. In the Services window, right-click the Microsoft Exchange POP3 or IMAP4 icon and then 
select Restart.

24. Close the Services window.

Adding a certificate for use with TLS email connections
About this task
Enable TLS on the Email Manager. Contact Center Multimedia supports TLS to protect data 
traveling between the email server and the Contact Center Multimedia server.
Although SMTP is secure, when email traverses the internet, it becomes insecure. 
Implementations of secure SMTP vary, as does the port number. For more information about 
SMTP security, see the documentation for your email server.
If a valid certificate is not available, you might see the following error:
EmailManager.log file javax.net.ssl.SSLHandshakeException: Could not find trusted 
certificate.

This message indicates one of the following:
• The target email server TLS certificate is signed with a certificate from a signing authority that 

is not trusted.
• You are using a test certificate and must enable SMTP Authentication on your email server.

Note:
Contact Center supports monitored mailboxes distributed across several email servers.

Use Security Manager to add a certificate for TLS email connections to the Contact Center 
security store.

Before you begin
• Avaya recommends that you use a false connection on the fallback. If you set fallback to 

false, a secure connection cannot be established, and the operation fails. If you set the 
fallback to true, during a failure, the connection is insecure.

• Save the certificate files on the Contact Center server.

Procedure
1. Log in to the Contact Center server containing the security store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access window, type the security store password.

4. Click OK.
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5. On the Security Manager window, click the Add Certificate tab.

6. To add certificates automatically:

a. Select Add Certificates Automatically.

b. Click Browse.

c. Browse to the directory where you saved the certificate files and then click Select 
Directory.

Security Manager displays the certificates in the Certificates field.

d. Click Add all Certificates.

7. To add certificates manually:

a. Select Add Certificates Manually.

b. To manually add a CA root certificate, click Browse.

c. Browse to the CA root certificate and click Select File.

d. Click Add CA Certificate.

8. Restart the Email Manager service.

Configuring the TLS email connection for Microsoft 
Exchange 2013, 2016, and 2019

About this task
Configure a TLS email connection on Microsoft Exchange 2013, 2016, or 2019. A secure TLS 
connection is required for the client to authenticate to the server.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, click General Administration.

3. Click Server Settings.

4. Select Outbound SMTP Server.
5. Click Edit.
6. From SMTP Authentication, select Base 64 Encoded Authentication.

7. Click Save.

8. Close the Contact Center Manager Administration window.

9. Log on to the Microsoft Exchange server.

Configuring the TLS email connection for Microsoft Exchange 2013, 2016, and 2019
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10. Open the Exchange Admin Center.

11. Click Mail flow.

12. Click Receive connectors.

13. Double-click Default <Servername> and select Security.

14. Under Authentication, disable all authentication options except for the following:

• Transport Layer Security (TLS)

• Basic Authentication

• Exchange Server Authentication

• Integrated Windows Authentication

15. Click Save.

16. Click Servers to view the list of servers.

17. Select the required server and then click Edit.
18. In the Properties window, select IMAP4.

19. Under Logon Method, select Secure TLS connection.

20. Click Save.

21. Close the Exchange Admin Center.

22. On your Microsoft Exchange server, click Start  > Administrative Tools > Services.

23. In the Services window, right-click the Microsoft Exchange IMAP4 icon and select Restart.
24. Close the Services window.

Enabling SMTP Authentication on your email server
About this task
Enable SMTP authentication for Microsoft Exchange Server. SMTP Authentication is a mechanism 
to restrict non-authenticated clients from sending email messages outside your organization. 
Agents who want to send external email messages must provide their logon credentials to the 
email server before their email is relayed. Failure to authenticate leads to an immediate message 
from the email server indicating that sending the email is prohibited or a later non-delivery report 
email. Organizations generally implement SMTP authentication to prevent SPAM messages from 
being relayed through the networks. For more information, see the Microsoft Knowledge Base 
article Q197869.
SMTP authentication varies among email servers.

Procedure
1. Log on to the Microsoft Exchange Server with domain administrative privileges.
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2. Start the Microsoft Exchange Administrator program.

3. On the Configuration branch, double-click Internet Mail Service.

4. On the Routing tab, click Routing Restrictions.

5. Ensure you select the Only Hosts and Clients who successfully authenticate check 
box.

6. Restart the Microsoft Exchange Internet Mail Service.

Determining if SMTP Authentication is enabled
About this task
Use Telnet to verify whether the server response to the SMTP commands is enabled on an email 
server.
After a successful logon, you can send an email message using the MAIL, RCPT, and DATA 
commands.

Procedure
1. Start Telnet and connect to the IP Address or hostname of the mail server. Connect using 

the well-known port for SMTP (Port 25). Ensure that your Telnet application is enabling a 
local echo.

The following message appears:

220 SERVERNAME.DOMAIN.COM ESMTP Server (Microsoft
Exchange
Internet Mail Service 5.5.2650.21) ready

2. Type HELO.

3. Try to send an email message to an external address using the MAIL command:

MAIL FROM: anymailbox
250 OK - mail from <anymailbox>

4. Specify recipients using the RCPT command.

If SMTP Authentication is enabled, you see the following message:

RCPT TO: anyone@externaladdress.com
550 Relaying is prohibited

Otherwise, you receive the following message:

RCPT TO: anyone@externaladdress.com
250 OK - Recipient <anyone@externaladdress.com>

Determining if SMTP Authentication is enabled
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5. If you find that SMTP Authentication is not enabled, you can continue to send an email 
message using the DATA command:

DATA
354 Send data. End with CRLF.CRLF

6. Conclude the email message by typing <ENTER> . <ENTER>
The email message is sent.

250 OK
7. If the SMTP Authentication is enabled, you must reconnect to your email server.

8. Enter the EHLO command after you reconnect:

EHLO
250-SERVERNAME.DOMAIN.COM Hello [LocalMachineName]
250-XEXCH50
250-HELP
250-ETRN
250-DSN
250-SIZE 0
250-AUTH LOGIN
250 AUTH=LOGIN

9. Type the AUTH LOGIN command:

AUTH LOGIN
334 VXNlcm5hbWU6

10. Type your user name encoded using Base64.

A base64 encoded prompt for password appears:

AUTH LOGIN
334 VXNlcm5hbWU6
dGVzdA==
334 UGFzc3dvcmQ6
dGVzdA==
235 LOGIN authentication successful

Important:

dGVzdA== represents the word test when base64-encoded. The responses shown 
here are examples. Use the base64 representation of your user name and password 
that is specific to your email mailbox account.

11. Confirm the user name and password.
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Enabling Extended Email Capacity
Before you begin
Ensure that you configure your multicast IP address.

About this task
The Extended Email Capacity feature increases the email backlog capacity to 100 000. Enable the 
Extended Email Capacity feature if you want to increase the email backlog capacity to more than 
20 000.
While enabling the Extended Email Capacity feature, you can select the order in which the system 
queues the contacts, either by priority or by age.

Note:
After you enable the Extended Email Capacity feature, you can disable this feature only if the 
number of contacts in the Open or Waiting status is less than the Maximum Open Contacts 
Threshold. The Maximum Open Contacts Threshold is 3 000.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click General Settings.

4. Click Advanced.

The system displays the Advanced Email Configuration dialog box.

5. Select the Enable Extended E-mail Capacity check box.

6. In the E-mail Queue Preference field, select the order in which the system queues the 
contacts. You can queue the contacts in one of the following ways:

• By priority first, then age
• By age first, then priority

7. Click Save.

Disabling Extended Email Capacity
About this task
You can disable the Extended Email Capacity feature only if the number of contacts in the Open or 
Waiting status is less than the Maximum Open Contacts Threshold, which is 3 000.

Enabling Extended Email Capacity
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click E-mail.
3. Click General Settings.

4. Click Advanced.

The system displays the Advanced Email Configuration dialog box.

5. Clear the Enable Extended E-mail Capacity check box.

6. Click Save.
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Chapter 8: Web communications 
configuration

The Contact Center Multimedia server supports text-based conversations between the customer 
and the agent by using Web communications text chat or Enterprise Web Chat (EWC). When 
customers initiate a Web communications contact, a list of skillsets determines the appropriate topic 
for the contact.

EWC supports integration with Agent Desktop only with a standalone Multimedia server on a Unified 
Communications solution. EWC is a licensed feature, and requires a Web Chat SDK license.

Note:

If you are migrating from an existing Web Communications chat solution to the EWC chat 
solution, you must redevelop your custom interfaces to integrate with EWC.

Contact Center selects EWC as the web chat solution, if the following criteria are satisfied:

1. Agent have logged on to Agent Desktop.
2. Agents are assigned to a skillset for handling web communications.
3. Contact Center is licensed for EWC.

Before making any Web communications contacts, you must ensure the Web communications 
server or Enterprise Web Chat is configured.

Note:

Agent Desktop handling of web communications contacts is the same whether Contact Center 
uses Web Communications chat or EWC. You must enable Agent Desktop to handle EWC 
contacts using the CCMM Administration utility. By default the option is not enabled. You can 
enable the option only if your Contact Center has the EWC license.

To personalize the Web communications contacts, you can configure welcome messages for all 
contacts, and specialized messages for each skillset. You can also place labels in the text-based 
conversation to identify the text written by the customer and agent. You can also send a copy of the 
transcript of the Web communication contact to the customer when the contact is complete.

Timers control the length of time for alerts to indicate when the agent or customer stops responding 
in the Web communication contact.

To assist agents with Web communications contacts, you can use automatic phrases to configure 
text for agents to automatically insert in the text-based conversation. You can also configure page 
push URLs, a predefined URL that is commonly sent to customers. The automatic phrases and 
page push URLs save the agent typing time when communicating with the customer.
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The Web on hold URLs creates a list of Web pages that are sent to the customer’s desktop while 
they wait for an agent to respond to their initial contact.

A Web on hold comfort group creates a list of messages that are sent to the customer’s desktop, 
while the customer waits for an agent to respond, for a specified period of time to their initial contact, 
on a Web communications skillset.

A Web communications comfort group creates a list of messages that are sent to the customer's 
desktop while they wait for an agent to respond, for a specified period of time, either to their initial 
contact or during the communication, on a Web communications skillset.

An agent-supervisor can observe or participate in any currently active agent-customer Web 
communications chat session, provided the agent is under the supervision of that particular 
agent-supervisor. Agent-supervisors using Agent Desktop can see a display of all such applicable 
Web communications and Voice contacts currently active. This display also flags any Web 
communications contacts where certain intrinsic values exceed the defined threshold. If Contact 
Center uses the EWC solution then an agent-supervisor can send whisper messages to the agent. 
Whisper messages are not seen by the customer. Whisper messages are not supported in the Web 
Communications chat solution.

Note:

Web communications configuration procedures do not apply to voice-only contact centers. To 
enable this multimedia feature, obtain and configure a multimedia-enabled license.

Prerequisites for Web communications configuration
• Ensure that you have a license for Web communications.

• Additionally, if you are using Enterprise Web Chat (EWC), ensure that you have an EWC 
feature license.

Assigning a development Web server name
Before you begin

• Know the name of your development Web server and the production Web server.

About this task
Configure the external Web server name to identify the external Web server for Web contacts 
received by the contact center.
If you configured the external Web server during installation, and the name of the server remains 
the same, you can skip this procedure. If you move your external website from a test computer to 
the production server, you must configure the external Web server name.

Web communications configuration
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click General Administration.

3. Click Server Settings.

4. In the Server Settings dialog box, select External Web Server and click New.

5. In the Server Name box, type the name of the external Web server where you plan to 
install the sample Web customer interface and develop your custom website.

6. In the Server Port box, type the port number for the external Web server you use to 
develop your custom website.

7. Click Save.

Variable definitions
Name Description
Server Name The name of the external Web server on which you 

plan to install the sample Web customer interface 
and develop your custom website.

Server Port The port number for the external Web server for 
your custom website.

Configuring welcome messages and text chat labels
About this task
The welcome messages and text chat labels for a Web communications contacts have a welcome 
message for customers who initiate the contact, and labels for the agent and customers in the text 
conversation.
Configure a default welcome message that appears for all skillsets and welcome messages that 
apply for a single skillset. One welcome message appears for the customer. If the welcome 
message for the skillset appears, the global welcome message does not. The customer chooses 
the skillset when they initiate the contact.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Resources.

Configuring welcome messages and text chat labels
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4. In the Default Welcome Message box, type the message to appear at the beginning of 
every contact. The maximum size for this message is 255 characters.

5. In the Agent Label list, select the label to appear at the beginning of the agent contact list.

In the first box, choose from a list of automatic text such as Friendly Name, First Name, 
Last Name, or both First Name and Last Name. Use the second box to type custom text.

6. In the Customer Label box, type the text to appear at the beginning of the customer 
responses in the contact.

Note:

Customer Label is supported up to version xampp-win32-1.7.2 only.

7. To create a customer welcome message for a specific skillset, under Custom Welcome 
Messages, select a skillset.

8. Under Welcome Message, type the welcome message for the skillset.

9. Click Save.
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Variable definitions
Name Description
Agent Label The label that appears beside the text typed for the 

agent. Select one of the following items:

• First Name: The first name of the agent appears 
at the beginning of the agent responses in the 
contact (for example, Robert).

• First Name, Last Name: The first and last name of 
the agent appear at the beginning of the agent 
responses in the contact (for example, Robert 
Smith).

• Last Name, First Name: The last name of the 
agent, followed by the first name of the agent 
appears at the beginning of the agent responses 
in the contact (for example, Smith, Robert).

• Friendly Name: The friendly name or nickname of 
the agent appears at the beginning of the agent 
responses in the contact (for example, Rob).

The first name of the agent is the default value 
for Friendly Name. For example, if you have 
entered the first name of the agent as Fred 
in Contact Center Manager Administration, the 
default Friendly Name is set as Fred. You can 
modify the Friendly name using Contact Center 
Multimedia.

While upgrading to Contact Center 7.1, the default 
value is applied to any existing agents. The 
default values is also applied to any new agents 
who are added to the system after the upgrade.

You can also type custom text to appear at the 
beginning of the agent responses. The maximum 
size of the label is 255 characters.

Customer Label The text to appear at the beginning of the customer 
responses in the contact. The maximum size of the 
Customer Label is 255 characters.
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Configuring Enterprise Web Chat settings
Before you begin
Enterprise Web Chat (EWC) works only if Contact Center is deployed on Communication Manager 
with a Voice and Multimedia Contact Server with or without AAMS, or a standalone Multimedia 
Contact Server. You must also ensure that your Contact Center is licensed for EWC.

About this task
Configure the EWC server domain and optionally the Transcript Filtering Web Service, if your 
Contact Center uses Enterprise Web Chat (EWC).
Use the Transcript Filtering Web Service to modify EWC chat transcripts before the transcripts 
are saved to the Multimedia database. Creating filters is the responsibility of the customers and 
a sample filter is provided as part of the EWC SDK. You can configure EWC to use a transcript 
filter created by the customer. The transcript filter can be used to modify the transcript to mask 
sensitive data such as account details, credit card numbers, or personal identification numbers. 
The transcripts are associated with the customer record whose email sent the chat request.

Note:
• EWC filters out the < and > characters making these characters invisible to the other 

party in the chat. Therefore, in EWC chat messages, agents or customers must not use 
the < or > characters.

• EWC does not support the NIC Teaming feature.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. To enable your Agent Desktop to handle EWC contacts, click the Enable Enterprise Web 
Chat option.

By default the Enable Enterprise Web Chat option is not enabled. You can select the 
Enable Enterprise Web Chat option only if the EWC license is present.

5. In the External Web Server Domain box, type the domain name for the server hosting the 
customer-facing website for EWC.

6. (Optional) In the Transcript Filtering Web Service box, type the URL of a REST service 
used to filter customer chat transcripts.

The format of the URL of the REST service is either http://<uri> or https://<uri>, 
where <uri> is the service URI of the transcript filtering service.

For more information on Transcript Filtering Web Service, see the SDK documentation.

7. Click Save.
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Configuring Web communications agent timers
About this task
Configure the contact timers for Web communications conversations in your Contact Center.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. In the Keep Alive Time box, type the interval in minutes and seconds between heartbeat 
pulses that verify whether both ends of the Web communications contact are open.

5. In the Message Refresh box, type the refresh time for the Agent Desktop.

6. In the Desirable Response (Customer awaiting Agent) box, type the threshold for the 
agent to respond.

7. In the Desirable Response (Agent awaiting Customer) box, type the threshold for the 
customer to respond.

8. In the Consult Request Timeout box, type the length of time in seconds that a 
consultation is requested before it times out.

9. Select the Force Idle Customer Check check box so that the Agent Desktop alerts agents 
when a customer has not replied in a Web communications session, for a predefined 
period. The Agent Desktop also brings that web chat contact to the front.

10. In the Force Idle Customer Check Timeout box, type the time after which the Agent 
Desktop considers a customer in a web chat session idle, if a customer has not responded 
in a Web communications session.

11. Click Save.

Variable definitions
Name Description
Message Refresh The refresh time for the Agent Desktop.
Keep Alive Time The interval in minutes and seconds between 

heartbeat pulses that verify whether both ends of 
the Web communication contact are open.

Desirable Response (Agent awaiting Customer) The time after which the conversation indicator 
on the Agent Desktop changes color to indicate 
that the desirable time for an agent response is 
exceeded.

Table continues…
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Name Description
Desirable Response (Customer awaiting Agent) The time after which the conversation indicator 

on the Agent Desktop changes color to indicate 
that the desirable time for a customer response is 
exceeded.

Consult Request Timeout The time after which the consult request expires.
Force Idle Customer Check Select this check box to enable Agent Desktop to 

alert agents when a customer has not replied in 
a Web communications session, for a predefined 
period.

The Agent Desktop also brings that web chat 
contact to the front.

Force Idle Customer Check Timer The time after which the Agent Desktop considers a 
customer in a web chat session idle, if a customer 
has not responded in a Web communications 
session.

Saving Web communications chat session details
About this task
Configure the details you want to save for each Web communications chat session in your contact 
center.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. Select the Save Timestamp on Chat Message check box to enable the saving of a 
time-stamp with each chat message sent in a chat session.

5. Select the Save Chat History check box to enable the saving of chat session history. 
When enabled, the entire history of a chat session is saved.

Important:

The Save Timestamp on Chat Message and Save Chat History settings are not 
applicable to the Enterprise Web Chat (EWC) chat solution. Use the EWC Transcript 
Filtering Web Service feature to modify the EWC chat transcripts. See Configuring 
Enterprise Web Chat settings on page 154.

6. Click Save.
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Configuring the Web communications chat session limits
About this task
Configure limits for Web communications chat sessions. These limits restrict the number of 
concurrent sessions and scheduled callbacks that a customer can have. Setting these limits 
reduces the possibility of Denial of Service attacks through the Web communications interface.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. In the Concurrent Chats Limit per Customer box, type the maximum number of 
concurrent chat sessions each customer can create. Type a value between 1 and 10. 
The default value is 3, which is the value that Avaya recommends.

5. In the Requested Call-backs Limit per Customer box, type the maximum number of 
scheduled Web communication callbacks each customer can have. Type a value between 
1 and 10. The default value is 3, which is the value that Avaya recommends.

6. Click Save.

Configuring customer notification log
Before you begin

• Configure an outgoing email address to use to send the log file to the customer.

About this task
Configure the customer notification log information to prepare to send an email to the customer of 
the written conversation.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. Under Chat Conversation, select E-mail Chat Log to Customer.
5. Click Save.
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Enabling Web Communications transfer to a skillset
About this task
Configure the Web Communications (WC) transfer to a skillset feature to allow agents to transfer a 
WC contact to a skillset.

Note:
If you want to transfer a Web Communications contact, your contact center must be licensed 
to use the Multiplicity feature.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. Select the Enable Transfer To Skillset check box.

5. Click Save.

Creating automatic phrases
About this task
Configure automatic phrases by skillset. You can create a list of commonly-used phrases for 
agents to insert into theirweb communications contacts instead of typing individual responses.
You can select a single automatic phrase for all skillsets. If you choose all skillsets, the automatic 
phrase applies to all skillsets for web communications and instant messaging contacts.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Auto Phrases.

4. Under Edit Auto Phrases, select the skillset to add new phrases.

OR

Select All Skillsets to apply an automatic phrase for all skillsets.

5. Click Edit.
6. In the Previously Configured Auto Phrase box, review the phrase to decide whether you 

want to change it or to use it for other skillsets.
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This option is not available if you selected All Skillsets.

7. In the Name box, type a name to represent this automatic phrase.

8. In the Phrase Text box, type the text that is commonly used for the contacts based on the 
selected skillset.

9. Click Add.

10. Click Save.

Deleting an automatic phrase
About this task
Delete the automatic phrase to remove it from the list of automatic phrases available to the agents 
in the Agent Desktop.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Auto Phrases.

4. Under Edit Auto Phrases, select the skillset from which you want to remove the phrases.

OR

Select All Skillsets to remove phrases for use with all skillsets.

5. Click Edit.
6. In the Phrases in Group box, select the automatic phrase to delete.

7. Click Remove.

The system displays a Warning dialog box.

8. Click Yes to confirm the decision.

9. Click Save.

Creating a page push URL
About this task
In the Agent Desktop application, the agent can choose from a list of web pages for the skillset 
assigned to the web communication contact.
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Create the web pages that display in Agent Desktop. Ensure that the name of the page push URL 
is descriptive to assist agents in using Agent Desktop.
You can configure maximum 50 URLs.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Page Push Urls.

4. Under Edit Page Push URLs, select the skillset to add new URLs.

OR

Select All Skillsets.

5. Click Edit.
6. In the URL box, type the URL for the website to add to the list that displays in Agent 

Desktop.

7. In the Description box, type a description for the page push URL that describes the URL 
that the agent can push.

8. Click Add.

9. Click Save.

Deleting a page push URL
About this task
Delete a page push URL to remove it from the list of pages the agent can push to customers 
during a Web communications contact.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Page Push Urls.

4. Under Edit Page Push URLs, select the skillset to change the URLs.

OR

Select All Skillsets.

5. Click Edit.
6. In the URLs in Group box, select the URL to delete.
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7. Click Remove.

The system displays a Warning dialog box.

8. Click Yes to confirm the decision.

9. Click Save.

Creating Web On Hold URLs groups
About this task
Web On Hold URL groups is a sequence of URLs presented automatically to a customer's Web 
browser while the customer waits for an agent in the Web communications. You can define the 
time that each URL appears on the customer's Web browser.
Web On Hold URLs can include multimedia formats, such as video clips (Quick Time) or audio 
files (MPEG3). However, the customer browser must be able to play these formats. Customers are 
responsible for the plug-ins needed to run multimedia files.
You can add up to 50 URLs to a Web-on-hold group, but Avaya recommends that you use no 
more than 25 URLs in each Web-on-hold group.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold URLs tab.

5. Click New
6. In the Tag box, type a name for the new Web On Hold group.

7. In the Description box, type a description for the Web On Hold URL.

8. In the Hold Time box, type the number of seconds to display each URL in the customer's 
browser.

9. In the URL box, type the URL to display on the customer's Web browser.

10. Click Add.

11. Repeat step 6 on page 161 to step 11 on page 161 to add all URLs to the current Web on 
hold group.

12. Click Save.
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Deleting a URL from a Web On Hold URL group
About this task
Delete a URL from a Web on hold URL group if the URL is not available.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold Urls tab.

5. Click Edit.
6. Under Edit Web On Hold URL Group dialog box, in the URLs in Group box, select the 

URL to delete.

7. Click Remove.

The system displays a Warning dialog box.

8. Click Yes to confirm the decision.

9. Click Save.

Deleting a Web On Hold URLs group
About this task
Delete a Web-on-hold URLs group to avoid displaying the Web pages to the customer during Web 
communications contacts.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold Urls tab.

5. Select the Group to delete.

6. Click Delete.

The system displays a Warning dialog box.

7. Click Yes to confirm the deletion.
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Creating Web On Hold comfort groups
Before you begin

• Add the Web on hold comfort group to the Web communications skillset. For more 
information adding comfort groups to a Web communications skillset, see Configuring Web 
On Hold comfort groups for a Web communications skillset on page 168.

About this task
A Web on hold comfort group consists of a list of sequential messages that are sent to the 
customer’s desktop, while the customer waits for an agent to respond, for a specified period of 
time to their initial contact, on a Web communications skillset. You can also add variables to the 
Web on hold message text for a customer.
You can set the time for which messages display on the customer’s desktop.

Note:
Avaya recommends that you use no more than five messages in each Web on hold comfort 
group and one Web on hold comfort group for each Web communications skillset.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold Comforts Group tab.

5. Under Comfort Group, click New.

6. In the Name box, type a name for a new Web on hold comfort group.

7. In the Delay box, type the number of seconds to display each comfort message in the 
customer's desktop.

8. In the Message box, type the comfort message.

9. Optional: To insert a placeholder for accessing variables for the message, right-click in the 
Message box and select the placeholder from the menu.

10. Click Add.

11. Repeat step 9 and step 10 to add messages to the current Web on hold comfort group.

12. Under Group Messages, use the arrow keys to configure the sequence of messages.

13. Click Save.
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Changing the sequence of messages in a Web On Hold 
comfort group

Before you begin
• Set up a Web on hold comfort group that is associated with Web communications skillset.

About this task
Follow this procedure to change the sequence in which comfort messages in a Web on hold 
comfort group appear to customers.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold Comfort Groups tab.

5. Under Comfort Group, select the comfort group to change.

6. Click Edit.
7. Under Group Messages, use the arrow keys to configure the sequence of messages.

8. Click Save.

Deleting a message from a Web On Hold comfort group
Before you begin

• Set up a Web on hold comfort group that is associated with Web communications skillset.

About this task
Follow this procedure to delete a comfort message from a Web on hold comfort group, if you do 
not want to use a specific message in the comfort group.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold Comfort Groups tab.

5. Under Comfort Group, select the Group that contains the Message to delete.
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6. Click Edit.
7. Under Group Messages, select the Message to delete.

8. Under Edit Group, click Remove.

The system displays a Warning dialog box.

9. Click Yes to confirm the decision.

10. Click Save.

Deleting a Web On Hold comfort group
Before you begin

• Set up a Web on hold comfort group that is associated with Web communications skillset.
• Ensure that the Web on hold comfort group is unlinked from any other skillset before it is 

removed.

About this task
Follow this procedure to delete a Web on hold comfort group if you do not want to use a specific 
comfort group.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Web On Hold.

4. Click the On Hold Comfort Groups tab.

5. Under Comfort Group, select the Group to delete.

6. Click Delete.

The system displays a Warning dialog box.

7. Click Yes to confirm the deletion.

Creating web communications comfort groups
Before you begin
Add the web communications comfort group to the web communications skillset. For more 
information adding Web communications comfort groups to a web communications skillset, see 
Configuring Web communications comfort groups for a Web communications skillset on page 169.
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About this task
A web communications comfort group consists of a list of sequential messages that are sent to the 
customer's desktop while they wait for an agent to respond, for a specified period of time, either to 
their initial contact or during the communication, on a web communications skillset. You can also 
add variables to the web communications message text for a customer.
You can set the time for which messages display on the customer’s desktop.

Note:
Avaya recommends that you use no more than five messages in each web communications 
comfort group and one web communications comfort group for each web communications 
skillset.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Comfort Messages.

4. Under Comfort Group, click New.

5. In the Name box, type a name for a comfort group.

6. In the Delay box, type the number of seconds to display each comfort message in the 
customer's desktop.

7. In the Message box, type the comfort message.

8. (Optional) To insert a placeholder for accessing variables for the message, right-click in 
the Message box and select the placeholder from the menu.

9. Click Add.

10. Repeat step 8 on page 166 and step 9 on page 166 to add messages to the current web 
communications comfort group.

11. Under Group Messages, use the arrow keys to configure the sequence of messages.

12. Click Save.

Changing the sequence of messages in a Web 
communications comfort group

Before you begin
• Set up a Web communications comfort group that is associated with Web communications 

skillset.
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About this task
Follow this procedure to change the sequence in which comfort messages in a Web 
communications comfort group appear to customers.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Comfort Messages.

4. Under Comfort Group, select the comfort group to change.

5. Click Edit.
6. Under Group Messages, use the arrow keys to configure the sequence of messages.

7. Click Save.

Deleting a message from a Web communications comfort 
group

Before you begin
• Set up a Web communications comfort group that is associated with Web communications 

skillset.

About this task
Follow this procedure to delete a comfort message from a Web communications comfort group, if 
you do not want to use that message in a Web communications comfort group.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Comfort Messages.

4. Under Comfort Group, select the Group that contains the Message to delete.

5. Click Edit.
6. Under Group Messages, select the Message to delete.

7. Under Edit Group, click Remove.

The system displays a Warning dialog box.

8. Click Yes to confirm the decision.
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9. Click Save.

Deleting a web communications comfort group
Before you begin

• Set up a web communications comfort group associated with a web communications skillset.
• Ensure that the web communications comfort group is unlinked from any other skillset before 

it is removed.

About this task
Follow this procedure to delete a web communications comfort group that you no longer need.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Comfort Messages.

4. Under Comfort Group, select the Group to delete.

5. Click Delete.

6. In the Warning dialog box, click Yes to confirm.

Configuring Web On Hold comfort groups for a web 
communications skillset

Before you begin
• Set up the Web On Hold comfort group.

About this task
You must configure a Web On Hold comfort group on a web communications skillset to 
automatically send messages to the customer's desktop. These messages are sent to the 
customer while they wait for an agent to respond, for a specified period of time to their initial 
contact, on a web communication skillset.
For more information about Web On Hold comfort groups, see Creating Web On Hold comfort 
groups on page 163.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.
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2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. Select the skillset for which to assign a Web On Hold comfort group.

The skillset must have the prefix WC for web communications.

5. On the Edit Skillset window, from the On Hold Group list, select the group to assign to the 
web communications skillset.

6. Click Save.

Removing a Web On Hold comfort group for a web 
communications skillset

Before you begin
• The Web On Hold comfort group must be associated with the web communications skillset.

About this task
You can remove a Web On Hold comfort group from a web communications skillset, if the group 
has been deleted or if you do not want to use a specific Web On Hold comfort group.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. On the Edit Skillset window, in the On Hold Group list, select the group that you want to 
remove and click Unlink Group.

5. When prompted to confirm that you want to unlink the Web On Hold comfort group, click 
Yes.

Configuring web communications comfort groups for a 
Web communications skillset

Before you begin
• Set up the Web On Hold comfort group.
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About this task
You must configure a web communications comfort group on a web communications skillset 
to automatically send messages to the customer's desktop. These messages are sent to the 
customer while they wait for an agent to respond, for a specified period of time, either to their 
initial contact, or during the communication, on a Web Communications skillset.
For more information about web communications comfort groups, see Creating Web 
communications comfort groups on page 165.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. Select the skillset for which to assign a Web communications comfort group.

The skillset must have the prefix WC for web communications.

5. On the Edit Skillset window, from the Comfort Group list, select the group to assign to the 
web communications skillset.

6. Click Save.

Removing a web communications comfort group from a 
web communications skillset

Before you begin
• The web communications comfort group must be associated with the web communications 

skillset.

About this task
You can remove a web communications comfort group from a web communications skillset if the 
group has been deleted or if you do not want to use a specific web communications comfort 
group.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46.

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. On the Edit Skillset window, from the Comfort Group list, select the group that you want to 
remove and click Unlink Group.
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5. When prompted to confirm that you want to unlink the web communications comfort group, 
click Yes.

Configuring intrinsics for agent-supervisor observe and 
barge-in

About this task
An agent-supervisor can observe or barge-into any active incoming agent-customer Web 
Communications chat session of all agents under the supervision of the agent-supervisor. Agent 
Desktop displays active incoming Web Communications contacts and Voice contacts to agent-
supervisors.
Agent Desktop flags any Web Communications contacts where certain intrinsic values exceed the 
defined threshold.
Using the Multimedia Administration utility, you can set the threshold values for intrinsics. Some of 
the intrinsics are:

• Conversation Length (seconds)
• Seconds since last message out
• Seconds since last message in
• Number of Agent Messages
• Unanswered Messages

Using the Multimedia Administration utility, you can assign a priority from 1 to 5, 1 being the 
highest priority, to each of the intrinsics. The system uses the threshold and priority values 
assigned to sequence the Web Communications contacts in a list. Contacts which require urgent 
attention appear at the top of this list.

Important:
Each intrinsic type has a unique priority level. For example, Conversation Length and 
Customer Idle Time intrinsics cannot have the same priority level.

If the value set for the intrinsics exceeds the defined threshold, the system flags the contact as 
requiring attention. If the system flags more than one contact, then these contacts are sequenced 
based on a weightage. The system calculates this weightage using the priority of the intrinsic with 
exceeded thresholds. A higher weightage is given to intrinsics that have a higher priority.
For example, if contact A has exceeded the threshold for intrinsics of priority 1 and 2, and contact 
B has exceeded the threshold for intrinsics of priority 1 and 3, then contact A appears above 
contact B in the list.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.
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3. Click Intrinsic Settings.

4. Under Intrinsic Data, type a number of seconds or type a number in the Threshold box.

5. Under Intrinsic Data, select a number, from 1 to 5, in the Priority drop-down box.

Each intrinsic type has to have a unique priority level.

6. Click Save.
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Chapter 9: Outbound configuration

To create, monitor, and add data to an outbound campaign, use the Outbound Campaign 
Management Tool.

You must use the Multimedia Administration tool to configure how contacts are routed to a contact 
type using a skillset. Complete all other configuration for previewed outbound campaigns in the 
Outbound Configuration Management Tool. For more information, see Administering Avaya Contact 
Center Select.

Prerequisites for Outbound configuration
• Ensure that you are licensed for Outbound contacts in your contact center.

• Ensure that the Moving Window Skillset Multicast Rate is five seconds or greater. Configure 
the Moving Window Skillset Multicast Rate using the CCMS Multicast Address and Port 
Configuration tool.

• Ensure that the route points (CDN) are configured in Contact Center Manager Administration.

Configuring a route point for an Outbound skillset
About this task
Configure a route point for an outbound skillset to route outbound contacts to a particular direction. 
Skillsets are used to assign the contacts to agents.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. In the Skillset Settings dialog box, select the skillset for which to assign a route point.

The skillset must have the prefix OB for outbound.
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5. Under the Edit Skillset dialog box, in the Route Point list, select the route point to assign 
to the outbound skillset.

6. Click Save.

Variable definitions
Name Description
Route point A location in the open queue that enables incoming 

contacts to queue and run through a script on the 
Contact Center Manager Server.
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Chapter 10: Mailbox credential 
configuration

Contact Center uses credentials for mailbox authentication and supports two types of authentication:
• Basic authentication for POP3, IMAP or SMTP servers
• OAuth 2.0 authentication for the Microsoft Office 365 (MS Graph) server

Basic authentication
This is the default type of authentication.

Basic authentication applies to POP3, IMAP or SMTP servers and uses a password as 
credentials. You can use Basic authentication for Email, Social Networking, Voicemail, Fax, 
Scanned Documents, and Text Messaging (SMS) mailboxes. You can assign the same credentials 
to several mailboxes. You cannot delete credentials assigned to a mailbox.

For more information about configuring credentials for Basic authentication, see Creating 
credentials for Basic authentication on page 175.

Creating credentials for Basic authentication
About this task
Create credentials for Basic authentication of Email, Social Networking, Voicemail, Fax, Scanned 
Documents, and Text Messaging (SMS) mailboxes. Use these credentials for POP3, IMAP or 
SMTP servers.

Procedure
1. Open the Contact Center Multimedia Administration utility.

See Starting CCMM Administration utility on page 46.

2. In the left pane, click Email.
3. Click Credentials.

The Mailboxes Authentication Settings screen appears.

4. Click Add.
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5. In the Name field, type the name of the credentials.

6. From the Authentication Type list, select Basic.

7. In the Password field, type the password.

8. In the Confirm Password field, type the password again.

9. Click Save.

Result
The new credentials appear in the Credentials Configuration table. You can now use these 
credentials when creating mailboxes for Email, Social Networking, Voicemail, Fax, Scanned 
Documents, and Text Messaging (SMS).

OAuth 2.0 authentication
If you use Microsoft Office 365 as an Email server, configure OAuth 2.0 authentication for the 
Contact Center Email Manager to enable operation between the Email Manager and Microsoft 
Office 365.

To allow the Email Manager to interact with Microsoft Office 365, on Microsoft Azure Portal, you 
must create an application with all the required API permissions. This application interacts with the 
Microsoft Office 365 server on behalf of the Email Manager.

Unlike Basic authentication that uses a password as an authentication method, OAuth 2.0 uses 
an access token for this purpose. An access token is retrieved from the Microsoft Identity 
Platform using the Client Credentials grant with a certificate or secret. Client credentials are a 
data structure that stores parameters required to access the Microsoft Office 365 server. Using 
the Contact Center Multimedia Administration utility, you can configure the OAuth 2.0 Client 
Credentials grant type with a certificate or a client secret.

Using a certificate is a more secure authentication method than a client secret. Avaya 
recommends that you use certificates for your Contact Center.

A client secret is a string value your Azure application uses instead of a certificate to identify itself. 
A client secret is easier to configure and use, but it is less secure than a certificate.

You can assign the same credentials to several mailboxes. You cannot delete credentials 
assigned to a mailbox.

To enable OAuth 2.0 authentication for your Contact Center, perform the following tasks:

1. On the Microsoft Azure Administration Portal, create an application for the Email Manager 
as described in Creating an Azure application for the Email Manager on page 177.

2. From the Credentials tab in the Email section of the Contact Center Multimedia 
Administration utility, create one of the following:

• Client credentials with a certificate. See Creating client credentials with a certificate on 
page 178.
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• Client credentials with a secret. See Creating client credentials with a client secret on 
page 179.

3. Use the created client credentials when creating a recipient mailbox on the Microsoft Office 
365 server.

Creating an Azure application for the Email Manager
About this task
Create an application on Microsoft Azure Portal to configure the OAuth 2.0 Client Credentials 
grant type for your Contact Center. This application interacts with mailboxes on behalf of the Email 
Manager.
Contact Center supports using the OAuth 2.0 Client Credentials grant type with a certificate or 
client secret.
You must obtain the following Azure application details to configure client credentials for your 
Contact Center:

• Application (client) ID
• Directory (tenant) ID
• Client Secret - if you use the OAuth 2.0 Client Credentials grant type with a client secret

As you create the application, you can copy and save these details.

Before you begin
• Obtain an account on Microsoft Azure.
• Create Azure Active Directory for Contact Center.
• If you use the OAuth 2.0 Client Credentials grant type with a certificate, generate a Key Store 

p.12 file with a certificate and private key.

Procedure
1. Log on to the Azure Active Directory admin center.

2. Open your Contact Center Azure Active Directory.

3. In the Manage section, click App registrations.

4. In the App registrations window, click New registration.

The Register an application window is displayed.

5. In Name, type the name of the application.

6. In Supported account types, select Account in this organizational directory only.

7. Click Register.

The Azure Active Directory admin center displays the Overview pane with the application 
details.

8. In the Manage section, click Certificates & secrets.
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9. Do one of the following:

• To add a client secret, click New client secret, configure the client secret name and 
expiration time, and click Add.

• To upload a certificate, click Upload certificate, select the required .crt certificate file 
and click Save.

10. In the Manage section, click API permissions.

11. On the API permissions page, click Add a permission.

12. On the Request API permissions page, click Microsoft Graph.

13. Click Application permissions.

14. From the list, select Mail.
15. Select the Mail.ReadWrite and Mail.Send check boxes.

16. Click Add permissions.

The selected permissions are displayed in the Configured permissions list.

17. On the API permissions page, click Grant admin consent for your application.

18. In the confirmation dialog, click Yes.

Next steps
In the Contact Center Multimedia Administration utility, configure client credentials with a 
certificate or client secret.

Creating client credentials with a certificate
About this task
Create client credentials with a certificate for OAuth 2.0 authentication of Email recipient 
mailboxes.
Using a certificate is a more secure authentication method. Avaya recommends using client 
credentials with a certificate for your Contact Center.

Before you begin
• Ensure that you have a Microsoft Azure application for the Email Manager with all necessary 

API Permissions.
• Ensure that you have the Directory (tenant) ID and Application (client) ID details for your 

Microsoft Azure application. You can obtain these details from the application Overview page 
on the Azure Portal.

• Create a unique ID using a GUID generator tool.
• Generate a Key Store p.12 file with a certificate and private key.
• On the Azure Active Directory admin center, upload a certificate to the Certificates & Secrets 

area.
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Procedure
1. Open the Contact Center Multimedia Administration utility.

See Starting CCMM Administration utility on page 46.

2. In the left pane, click Email.
3. Click Credentials.

The Mailboxes Authentication Settings page is displayed.

4. In the Name field, type the name of the credentials.

5. From the Authentication Type list, select OAuth2.0.

6. From the OAuth2.0 Grant Type list, select Client Credentials with certificate.

7. In the Token URI field, enter the following address:
https://login.microsoftonline.com/<tenantID>/oauth2/v2.0/token

The <tenantID> value is the Directory (tenant) ID of your Microsoft 
Azure application. For example: https://login.microsoftonline.com/lc9elccd-
b679-4983-9a32-8c3cfa4d3cce/oauth2/v2.0/token

8. In the Client ID field, enter the Application (client) ID for your Microsoft Azure application.

9. In the GUID field, enter the unique ID.

10. In the Scopes field, type the following address:
https://graph.microsoft.com/.default

11. To add a certificate, click Load file.

12. Click Choose and navigate to the appropriate .p12 file.

13. In the Key Store password field, type the Key Store password.

14. In the Key alias field, type the Key alias.

15. Click Load.

Contact Center Multimedia Administration indicates that the Key Store .p12 file is loaded.

16. Click Save.

Result
The new client credentials are displayed in the Credentials Configuration table. You can now use 
these credentials when creating recipient mailboxes for Email.

Creating client credentials with a client secret
About this task
Create client credentials with a client secret for OAuth 2.0 authentication of Email recipient 
mailboxes.
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A client secret is a string value your Azure application uses instead of a certificate to identify itself. 
A client secret is easier to configure and use, but it is less secure than a certificate.
Use client credentials with a client secret for the Microsoft Office365 (MS Graph) server.

Before you begin
• Ensure that you have a Microsoft Azure application for the Email Manager with all necessary 

API Permissions.
• Ensure that you have the Directory (tenant) ID, Application (client) ID, and Client Secret for 

your Microsoft Azure application. You can obtain these details from the application Overview 
page on the Azure Portal.

Procedure
1. Open the Contact Center Multimedia Administration utility.

See Starting CCMM Administration utility on page 46.

2. In the left pane, click Email.
3. Click Credentials.

The Mailboxes Authentication Settings page is displayed.

4. Click Add.

5. In the Name field, type the name of the credentials.

6. From the Authentication Type list, select OAuth 2.0.

7. From the OAuth 2.0 Grant Type list, select Client Credentials.

8. In the Token URI field, type the following address:
https://login.microsoftonline.com/<tenantID>/oauth2/v2.0/token

The <tenantID> value is the Directory (tenant) ID of your Microsoft 
Azure application. For example: https://login.microsoftonline.com/lc9elccd-
b679-4983-9a32-8c3cfa4d3cce/oauth2/v2.0/token

9. In the Client ID field, type the Application (client) ID for your Microsoft Azure application.

10. In the Client Secret field, type the Client Secret value for your Microsoft Azure application.

11. In the Scopes field, type the following address:
https://graph.microsoft.com/.default

12. Click Save.

Result
The new client credentials are displayed in the Credentials Configuration table. You can now use 
these credentials when creating recipient mailboxes for Email.
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Editing credentials
About this task
You can edit the existing mailboxes credentials.
You cannot change the following attributes:

• Authentication Type
• OAuth2.0 Grant Type

Procedure
1. Open the Contact Center Multimedia Administration utility.

See Starting CCMM Administration utility on page 46.

2. In the left pane, click Email.
3. Click Credentials.

The Mailboxes Authentication Settings screen appears.

4. From the Credentials Configuration list, select the credentials that you want to edit.

5. Click Edit.
6. Make the required edits and click Save.

Deleting credentials
About this task
You can delete only those credentials that are not assigned to a mailbox.

Procedure
1. Open the Contact Center Multimedia Administration utility.

See Starting CCMM Administration utility on page 46.

2. In the left pane, click Email.
3. Click Credentials.

The Mailboxes Authentication Settings screen appears.

4. From the Credentials Configuration list, select the credentials that you want to delete.

5. Click Delete.

6. On the confirmation dialog, click Yes.
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Chapter 11: Voicemail configuration

This chapter contains the configuration steps for the voicemail recipient mailbox and routing 
voicemail contacts. Voicemail configuration procedures do not apply to voice-only contact centers. 
To enable this multimedia feature, obtain and configure a multimedia-enabled license.

In the contact center, the recipient mailboxes are polled for incoming voicemail messages. A 
voicemail server forwards voicemail messages to an email address. The Contact Center Multimedia 
Email Manager retrieves the voicemail (.wav) attachment and queues it to the appropriate skillset 
with an assigned priority. The caller ID is extracted to facilitate callbacks to the customer.

Reports are displayed in the Contact Center Multimedia Administration utility to show the current 
status of the voicemail traffic. You can view the following types of voicemail reports:

• The Voicemail (New Vs. Closed) report shows the number of contacts in a new and closed 
state against the time for the selected date and skillsets.

• The Voicemail Progress report shows the number of contacts in a new or closed state on a 
defined date to determine the traffic levels for that date.

• The Voicemail Closed Contacts Queue Time report shows the average time a voicemail 
contact spends in queue while the contact center is open.

You can choose the report date and the skillsets represented in all displayed real-time reports.

Prerequisites for voicemail configuration
Ensure that you are licensed for email contacts.

Configuring a route point for a voicemail skillset
About this task
Configure a route point for a voicemail skillset to route voicemail contacts to a particular agent. 
Skillsets are used to assign contacts to agents.

Procedure
1. Open the Multimedia Administration utility.
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For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. Select the skillset to assign a route point.

The skillset must have the prefix VM.

5. In the Route Point list, select the route point to assign to the voicemail skillset.

6. Click Save.

Variable definitions
Name Description
Route point A location in the open queue that enables incoming 

contacts to queue and run through a script on the 
Contact Center Manager Server.

Adding a voicemail server
About this task
Add the voicemail server for your Contact Center Multimedia server.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select Voice Mail.
3. Click Mailbox Configuration.

4. In the configuration window, click Add.

5. In the Voice Mail Server Hostname box, type the name of the new server.

6. In the Type box, select the type of server.

7. Click Save.

Updating a voicemail server
About this task
Update the voicemail server for your Contact Center Multimedia server.

Adding a voicemail server
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Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select Voice Mail.
3. Click Mailbox Configuration.

4. In the configuration window, click Edit.
5. Update your voicemail server properties as required.

6. Click Save.

Deleting a voicemail server
About this task
Delete the voicemail server for your Contact Center Multimedia server if it is no longer required.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select Voice Mail.
3. Click Mailbox Configuration.

4. In the configuration window, select the server you want to delete and then click Delete.

5. When prompted, click Yes to confirm that you want to delete the server.

6. Click Close.

Adding a voice mail mailbox
Before you begin

• Configure a skillset for a voice mail contact.

Important:
You must configure the voice mail server, the email server, and a recipient mailbox in Contact 
Center to receive voice mail messages in the contact center.

About this task
Add a voice mail mailbox to the multimedia configuration for receiving voice mail messages 
as .wav attachments.

Voicemail configuration
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Also, choose the skillset for the mailbox so that the voice mail message is routed to the agent who 
has the best skills to handle the specific contact.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Voice Mail.
3. Click Mailbox Configuration.

4. Click Add.

5. On the Mailbox tab, in the Inbound Server field, select the host name of your POP3 or 
IMAP server along with the respective security protocol.

6. In the Outbound Server field, select the host name of your SMTP server.

7. In the Mailbox field, type the mailbox name.

8. In the Domain field, type the mailbox domain.

9. In the Password and Confirm boxes, type and retype the password to access the 
mailbox.

10. In the Skillset field, choose a configured skillset for routing the voice mail contacts.

11. In the Contact Priority field, choose a priority for voice mail contacts received in this 
mailbox.

12. Click the Sender Address tab.

13. Select Use full sender address or Parse sender address for CLID.

14. If you select Parse sender address for CLID, then in the Leading Characters to 
Remove field, type the characters that you must not dial when making the outgoing 
callback.

15. Click Save.

Variable definitions
Name Description
Inbound Server The hostname of the email server that handles 

email messages that enter the contact center.
Outbound Server The hostname of the email server that delivers 

email messages that leave the contact center.
Mailbox Name of the mailbox on the email server that is 

polled for new incoming email messages.
Credentials Credentials used to access the mailbox on the 

email server.
Domain The domain name for the email server.

Table continues…

Adding a voice mail mailbox
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Name Description
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route voicemail 
contacts.

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
6.

For example, a call with priority 1 is handled before 
a call with priority 6.

Sender address Select Use full sender address or Parse the 
address for the Calling Line identification (CLID) to 
save for future contacts. The address in the format 
you select is stored with the contact for future 
communication with the customer.

Leading characters to remove If you select CLID to add the customer’s phone 
number into the contact information, type any 
leading characters or trunk numbers to remove from 
the current number.

Updating a voicemail mailbox
Before you begin
Add a voicemail mailbox.

About this task
Update the properties of the voicemail mailbox as required.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select Voice Mail.
3. Click Mailbox Configuration.

4. Select the mailbox to be edited.

5. Click Edit.
6. Update the mailbox settings as required.

7. Click Save.
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Deleting a voicemail mailbox
Before you begin
Add a voicemail mailbox.

About this task
You can delete a voicemail mailbox that is no longer required.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, select Voice Mail.
3. Click Mailbox Configuration.

4. Select the mailbox to be deleted.

5. Click Delete.

6. When prompted, click Yes to confirm.

Updating the voicemail system default rule
Before you begin

• Ensure that you know the default settings for the system delivery failure rule:
- Use the voicemail default skillset, VM_Default_Skillset
- Use no automatic response
- Assign priority 3

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, VM_Default_Skillset is used.

• Configure the route points for the skillset you assign to the system default rule. For more 
information, see Configuring a route point for a voicemail skillset on page 182.

About this task
Update the voicemail system default rule to ensure that email messages received with voicemail 
attachments are routed to an agent if no other rule associated with the recipient mailbox routes the 
email message.
The system default rule is used in every rule group configured in Contact Center Multimedia.

Deleting a voicemail mailbox
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Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, click Voice Mail.
3. Click Default Rules.

4. Under System Default Rule, from the Skillset list, select a skillset name to assign to the 
contact.

5. Under System Default Rule, from the Priority list, select the priority to assign to the 
contact.

6. Click Save.

Variable definitions
Name Description
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route contacts.

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
10.

For example, a call with priority 1 is handled before 
a call with priority 10.

Updating the voicemail system delivery failure rule
Before you begin

• Ensure that you are licensed to handle email messages.
• Ensure that you know the default settings for the system delivery failure rule:

- Use the voicemail default skillset, VM_Default _Skillset
- Use keyword group delivery failure keywords
- Assign priority 10 (lowest)

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
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- If you delete the skillset associated with the default rule, VM_Default_Skillset is used.
• Configure the route point for the skillset you plan to assign to the system delivery failure rule. 

See Configuring a route point for a voicemail skillset on page 182.

About this task
Update the voicemail system delivery failure rule to ensure that any email message that contains 
particular phrases such as undeliverable, returned mail, unknown recipient, delivery failure, or 
delivery report is deleted and not assigned to an agent.
When you create a recipient mailbox, the system delivery failure rule is copied as the first regular 
rule into the list of rules for the recipient mailbox.

Procedure
1. Open the Multimedia Administration utility.

For more information, see Starting CCMM Administration utility on page 46

2. In the left pane, click Voice Mail.
3. Click Default Rules.

4. Under System Delivery Failure Rule, from the Skillset list, select a skillset name to 
assign to the contact.

5. To change the keyword group, select the keyword group which contains the delivery failure 
keywords from the Keyword Group list under System Delivery Failure Rule.

6. To change the priority, under Priority, select the priority to assign to the contact from the 
Priority list under System Delivery Failure Rule.

7. To close contacts matching the delivery failure keywords, select the Will close contact 
check box.

8. Click Save.

Variable definitions
Name Description
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route outbound 
contacts.

Keyword group A list of words that you can search in an email 
message. Keyword groups associate keywords and 
expressions considered important by the contact 
center to be handled in a particular way.

Table continues…
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Name Description
Priority The priority given to a request for a skillset agent. 

The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
10.

For example, a call with priority 1 is handled before 
a call with priority 10.

Will close contact Select the check box to close the email contact after 
the system delivery failure rule determines that the 
contact is not appropriate for the contact center. 
Clear the check box to leave the email contact open 
for review.
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Chapter 12: Scanned document 
configuration

This chapter contains the configuration steps for the recipient mailbox that receives scanned 
documents.

In the contact center, the recipient mailboxes are polled for incoming scanned documents. A server 
forwards scanned documents to an email address. The Contact Center Multimedia Email Manager 
retrieves the scanned document as an attachment (.tiff) and queues it to the appropriate skillset with 
an assigned priority.

Reports appear in the Contact Center Multimedia Administration utility to show the current status 
of the contact type traffic. The following reports appear when you select Scanned Documents and 
View Reports in the left column of the Contact Center Multimedia application. You can choose the 
report date and the skillsets represented in all displayed real time reports.

• The Scanned Document (New Vs. Closed) report shows the number of contacts in a new and 
closed state against the time for the selected date and skillsets.

• The Scanned Document Progress report shows the number of contacts in a new or closed 
state on a defined date to determine the traffic levels for that date.

• The Scanned Document Closed Contacts Queue Time report shows the average time a 
contact spends in queue while the contact center is open.

Prerequisites for scanned document configuration
Ensure that you are licensed for email contacts.

Configuring a route point for a scanned document skillset
About this task
Configure a route point for a scanned document skillset to route the contact to a particular agent. 
Skillsets are used to assign the contacts to agents.
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. In the Skillset Settings dialog box, select the skillset to assign a route point.

The skillset must have the prefix SD.

5. Under the Edit Skillset dialog box, in the Route Point list, select the route point to assign 
to the scanned document skillset.

6. Click Save.

Variable definitions
Name Description
Route point A location in the open queue that enables incoming 

contacts to queue and run through a script on the 
Contact Center Manager Server.

Adding a document imaging server
About this task
Add the document imaging server for your Contact Center Multimedia server as per your 
requirement.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Documents.

3. Click Mailbox Configuration.

4. Click Document Imaging Server (image).

5. In the Document Imaging Server Configuration window, click Add.

6. In the Document Server Hostname box, type the name of the new server.

7. In the Type box, select the type of server.

8. Click Save.
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Updating a document imaging server
About this task
Update the document imaging server for your Contact Center Multimedia server as per your 
requirement.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Documents.

3. Click Mailbox Configuration.

4. Click Document Imaging Server (image).

5. In the Document Server Configuration window, select the server you are updating and click 
Edit.

6. Change the properties of your document imaging server.

7. Click Save.

Deleting a document imaging server
About this task
Delete the document imaging server for your Contact Center Multimedia server if it is no longer 
required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Documents.

3. Click Mailbox Configuration.

4. Click Document Imaging Server.
5. In the Document Server Configuration window, select the server that you want to and click 

Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

7. Click Close.
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Adding a scanned document mailbox
Before you begin

• Configure a skillset for a scanned document.

About this task
Add a scanned document mailbox to the multimedia configuration for receiving scanned 
documents as .tiff attachments.
Also, choose the skillset for the mailbox so that the scanned document is routed to the agent who 
has the optimal skillset to handle the specific contact.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Document.
3. Click Mailbox Configuration.

4. Click Add.

5. On the Mailbox tab, in the Inbound Server field, select the hostname of your POP3 or 
IMAP server along with the respective security protocol.

6. In the Outbound Server field, select the hostname of your SMTP server.

7. In the Mailbox field, type the mailbox name.

8. In the Domain field, type the mailbox domain.

9. In the Credentials field, from the list, select the required credentials.

10. In the Skillset field, choose a configured skillset for routing the contact.

11. In the Contact Priority field, choose a priority for contacts received in this mailbox.

12. Click Save.

Variable definitions
Name Description
Inbound Server The hostname of the email server that handles 

email messages entering the contact center.
Outbound Server The hostname of the email server that delivers 

email messages that leave the contact center.
Mailbox Name of the mailbox on the email server that is 

polled for new incoming email messages.
Domain The domain name for the email server.

Table continues…
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Name Description
Credentials Credentials used to access the mailbox on the 

email server.
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route contacts.

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
6.

For example, a call with priority 1 is handled before 
a call with priority 6.

Updating a scanned document mailbox
Before you begin

• Add a scanned document mailbox.

About this task
Update the properties of the scanned document mailbox, as per your requirements.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Document.
3. Click Mailbox Configuration.

4. Select the mailbox to be edited.

5. Click Edit.
6. Update the mailbox settings as required.

7. Click Save.

Deleting a scanned document mailbox
Before you begin

• Add a scanned document mailbox.

Updating a scanned document mailbox

April 2024 Avaya Contact Center Select Advanced Administration 195
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Important:
A scanned document mailbox cannot be deleted if it is currently assigned to a skillset

About this task
Delete a scanned document mailbox, if it is no longer required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Document.
3. Click Mailbox Configuration.

4. Select the mailbox to be deleted.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Configuring a scanned document reply mailbox
About this task
Configure the reply information to the scanned document received by your contact center.
Configure the outgoing mailbox properties with a signature related to the skillset for replying to 
scanned document.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Document.
3. Click Reply Configuration.

4. Under Skillsets, select a scanned document skillset for the mailbox configuration.

5. Under Mailbox, select a configured mailbox.

OR

Click New to create a new mailbox.

OR

Click Edit to edit an existing mailbox.

6. In the SMTP Server box, select the SMTP server to use for outgoing email messages.
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7. In the Mailbox box, specify the new mailbox or change the name of the existing mailbox.

8. In the Domain box, type the email server domain.

9. In the Credentials field, from the list, select the required credentials.

10. To use a different user name for the SMTP authentication, select the Use Alternative 
username for SMTP Authentication check box.

11. In the Username box, type the alternative user name.

12. Click Save.

Variable definitions
Name Description
SMTP Server The name of the email server that handles email 

messages leaving the contact center.
Mailbox Name of the mailbox on the email server polled for 

email messages.
Domain The domain name for the email server.
Credentials Credentials used to access the mailbox on the 

email server.
Use Alternative username for SMTP Authentication If SMTP authentication is required for your 

outbound email server, select the user name for the 
authentication.

Deleting a scanned document reply mailbox
About this task
Delete a scanned document reply mailbox, if it is no longer required.

Important:
A scanned document reply mailbox cannot be deleted if it is currently assigned to a skillset.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Scanned Document.
3. Click Reply Configuration.

4. Select the mailbox to be deleted.

5. Click Delete.

The system displays a Warning dialog box.

Deleting a scanned document reply mailbox
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6. Click Yes to confirm the deletion.

Updating the scanned documents system default rule
Before you begin

• Ensure that you know the default settings for the system delivery failure rule:
- use the scanned documents default skillset, SD_Default_Skillset
- use no automatic response
- assign priority 3

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, SD_Default_Skillset is used.

• Configure the route points for the skillset you assign to the system default rule. For more 
information, see Configuring a route point for a scanned document skillset on page 191.

About this task
Update the scanned documents system default rule to ensure that email messages received with 
scanned document attachments are routed to an agent if no other rule associated to the recipient 
mailbox routes the email message.
The system default rule is used in every rule group configured in Contact Center Multimedia.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Scanned Documents.

3. Click Default Rules.

4. Under System Default Rule, from the Skillset list, select a skillset name to assign to the 
contact.

5. Under System Default Rule, from the Priority list, select the priority to assign to the 
contact.

6. Click Save.
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Updating the scanned documents system delivery failure 
rule

Before you begin
• Ensure that you are licensed to handle email messages.
• Ensure that you know the default settings for the system delivery failure rule:

- use the scanned documents default skillset, SD_Default _Skillset
- use keyword group delivery failure keywords
- assign priority 10 (lowest)

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, SD_Default_Skillset is used.

• Configure the route point for the skillset you plan to assign to the system delivery failure rule. 
See Configuring a route point for a scanned document skillset on page 191.

About this task
Update the scanned documents system delivery failure rule to ensure that any email message 
that contains particular phrases such as undeliverable, returned mail, unknown recipient, delivery 
failure, or delivery report is deleted and not assigned to an agent.
When you create a recipient mailbox, the system delivery failure rule is copied as the first regular 
rule into list of rules for the recipient mailbox.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Scanned Documents.

3. Under System Delivery Failure Rule, from the Skillset list, select a skillset name to 
assign to the contact.

4. To change the keyword group, select the keyword group which contains the delivery failure 
keywords from the Keyword Group list under the System Delivery Failure Rule.

5. To change the priority, under Priority, select the priority to assign to the contact from the 
Priority list under the System Delivery Failure Rule.

6. To close contacts matching the delivery failure keywords, select the Will close contact 
check box.

7. Click Save.
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Chapter 13: Fax configuration

This chapter contains the configuration steps for the fax recipient mailbox.

In the contact center, the recipient mailboxes are polled for incoming fax messages. A fax server 
forwards messages to an email address. The Contact Center Multimedia Email Manager retrieves 
the fax attachment (.tiff) and queues it to the appropriate skillset with an assigned priority. The caller 
ID is extracted to facilitate callbacks to the customer.

Reports appear in the Contact Center Multimedia Administration utility to show the current status of 
the fax traffic. The following reports appear when you select Fax and View Reports in the left column 
of the Contact Center Multimedia application. You can choose the report date and the skillsets 
represented in all displayed real-time reports.

• The Fax (New Vs. Closed) report shows the number of contacts in a new and closed state 
against the time for the selected date and skillsets.

• The Fax Progress report shows the number of contacts in a new or closed state on a defined 
date to determine the traffic levels for that date.

• The Fax Closed Contacts Queue Time report shows the average time a contact spends in 
queue while the contact center is open.

Prerequisites for fax configuration
Ensure that you are licensed for email contacts.

Configuring a route point for a fax skillset
About this task
Configure a route point for a fax skillset to route fax contacts to a particular agent. Skillsets are 
used to assign the contacts to agents.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.
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2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. In the Skillset Settings dialog box, select the skillset to assign a route point.

The skillset must have the prefix FX.

5. Under the Edit Skillset dialog box, in the Route Point list, select the route point to assign 
to the fax skillset.

6. Click Save.

Variable definitions
Name Description
Route point A location in the open queue that enables incoming 

contacts to queue and run through a script on the 
Contact Center Manager Server.

Adding a fax server
About this task
Add the fax server for your Contact Center Multimedia server as per your requirement.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Mailbox Configuration.

4. Click Fax Server (image).

5. In the Fax Server Configuration window, click Add.

6. In the Fax Server Hostname box, type the name of the new server.

7. In the Type box, select the type of server.

8. Click Save.

Updating a fax server
About this task
Update the fax server for your Contact Center Multimedia server as per your requirement.
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Mailbox Configuration.

4. Click Fax Server (image).

5. In the Fax Server Configuration window, click Edit.
6. Change the properties of your fax server.

7. Click Save.

Deleting a fax server
About this task
Delete the fax server for your Contact Center Multimedia server if it is no longer required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Mailbox Configuration.

4. Click Fax Server.
5. In the Fax Server Configuration window, select the server that you want to and click 

Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

7. Click Close.

Adding a fax mailbox
Before you begin

• Configure a skillset for a fax contact.

About this task
Add a fax mailbox to the multimedia configuration for receiving fax messages as .tiff attachments.
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Also, choose the skillset for the mailbox so that the fax message is routed to the agent who has 
the optimal skillset to handle the specific contact.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Mailbox Configuration.

4. Click Add.

5. On the Mailbox tab, in the Inbound Server field, select the hostname of your POP3 or 
IMAP server along with the respective security protocol.

6. In the Outbound Server field, select the hostname of your SMTP server.

7. In the Mailbox field, type the mailbox name.

8. In the Domain field, type the mailbox domain.

9. In the Credentials field, from the list, select the required credentials.

10. In the Skillset field, choose a configured skillset for routing the contacts.

11. In the Contact Priority field, choose a priority for contacts received in this mailbox.

12. Click the Sender Address tab.

13. Select Use full sender address or Parse sender address for CLID.

14. If you select Parse sender address for CLID, in the Leading Characters to Remove 
field, type the characters that you must not dial when making the outgoing callback.

15. Click Save.

Variable definitions
Name Description
Inbound Server The hostname of the email server that handles 

email messages entering the contact center.
Outbound Server The hostname of the email server that delivers 

email messages that leave the contact center.
Mailbox Name of the mailbox on the email server that is 

polled for new incoming email messages.
Domain The domain name for the email server.
Credentials Credentials used to access the mailbox on the 

email server.

Table continues…
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Name Description
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route contacts.

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
6.

For example, a call with priority 1 is handled before 
a call with priority 6.

Sender address Select Use full sender address or Parse the 
address for the Calling Line identification (CLID) to 
save for future contacts. The address in the format 
you select is stored with the contact for future 
communication with the customer.

Leading characters to remove If you select a Calling Line Identification (CLID) to 
add the customer’s phone number into the contact 
information, type any leading characters or trunk 
numbers to remove from the current number.

Updating a fax mailbox
Before you begin

• Add a fax mailbox.

About this task
Update the properties of the fax mailbox, as per your requirements.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Mailbox Configuration.

4. Select the mailbox to be edited.

5. Click Edit.
6. Update the mailbox settings as required

7. Click Save.

Fax configuration
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Deleting a fax mailbox
Before you begin

• Add a fax mailbox.

Important:
A fax mailbox cannot be deleted if it is currently assigned to a skillset.

About this task
Delete a fax mailbox, if it is no longer required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Mailbox Configuration.

4. Select the mailbox to be deleted.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Configuring a fax reply mailbox
About this task
Configure the reply information for the fax message received by your contact center.
Configure the outgoing mailbox properties with a signature related to the skillset for replying to fax 
messages.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Reply Configuration.

4. Under Skillsets, select a fax skillset for the mailbox configuration.

5. Under Mailbox, do one of the following:

• Select a configured mailbox.

• Click New to create a new mailbox.
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• Click Edit to edit an existing mailbox.

6. In the SMTP Server box, select the SMTP server to use for outgoing email messages.

7. In the Mailbox box, specify the new mailbox or change the name of the existing mailbox.

8. In the Domain box, type the email server domain.

9. In the Credentials field, from the list, select the required credentials.

10. To use a different user name for the SMTP authentication, select the Use Alternative 
username for SMTP Authentication check box.

11. In the Username box, type the alternative username.

12. Click Save.

Variable definitions
Name Description
SMTP Server The name of the email server that handles email 

messages leaving the contact center.
Mailbox Name of the mailbox on the email server polled for 

email messages.
Domain The domain name for the email server.
Credentials Credentials used to access the mailbox on the 

email server.
Use Alternative username for SMTP Authentication If SMTP authentication is required for your 

outbound email server, select the user name for the 
authentication.

Deleting a fax reply mailbox
About this task
Delete a fax reply mailbox, if it is no longer required.

Important:
A fax reply mailbox cannot be deleted if it is currently assigned to a skillset.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Fax.

3. Click Reply Configuration.

4. Select the mailbox to be deleted.
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5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Updating the fax system default rule
Before you begin

• Ensure that you know the default settings for the system delivery failure rule:
- use the fax default skillset, FX_Default_Skillset
- use no automatic response
- assign priority 3

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, FX_Default_Skillset is used.

• Configure the route points for the skillset you assign to the system default rule. For more 
information, see Configuring a route point for a fax skillset on page 200.

About this task
Update the fax system default rule to ensure that email messages received with fax attachments 
are routed to an agent if no other rule associated to the recipient mailbox routes the email 
message.
The system default rule is used in every rule group configured in Contact Center Multimedia.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Fax.

3. Click Default Rules.

4. Under System Default Rule, from the Skillset list, select a skillset name to assign to the 
contact.

5. Under System Default Rule, from the Priority list, select the priority to assign to the 
contact.

6. Click Save.
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Updating the fax system delivery failure rule
Before you begin

• Ensure that you are licensed to handle email messages.
• Ensure that you know the default settings for the system delivery failure rule:

- use the fax default skillset, FX_Default _Skillset
- use keyword group delivery failure keywords
- assign priority 10 (lowest)

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, FX_Default_Skillset is used.

• Configure the route point for the skillset you plan to assign to the system delivery failure rule. 
See Configuring a route point for a fax skillset on page 200.

About this task
Update the fax system delivery failure rule to ensure that any email message that contains 
particular phrases such as undeliverable, returned mail, unknown recipient, delivery failure, or 
delivery report is deleted and not assigned to an agent.
When you create a recipient mailbox, the system delivery failure rule is copied as the first regular 
rule into list of rules for the recipient mailbox.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Fax.

3. Under System Delivery Failure Rule, from the Skillset list, select a skillset name to 
assign to the contact.

4. To change the keyword group, select the keyword group which contains the delivery failure 
keywords from the Keyword Group list under the System Delivery Failure Rule.

5. To change the priority, under Priority, select the priority to assign to the contact from the 
Priority list under the System Delivery Failure Rule.

6. To close contacts matching the delivery failure keywords, select the Will close contact 
check box.

7. Click Save.

Fax configuration

April 2024 Avaya Contact Center Select Advanced Administration 208
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Chapter 14: Short Message Service 
configuration

This chapter contains the configuration steps for the SMS recipient mailbox.

In the contact center, the recipient mailboxes are polled for incoming Short Message Service 
(SMS) messages. A server forwards the SMS messages to an email address. The Contact Center 
Multimedia Email Manager retrieves the text of the SMS and queues it to the appropriate skillset 
with an assigned priority. The caller ID is extracted to facilitate callbacks to the customer.

Reports appear in the Contact Center Multimedia Administration utility to show the current traffic 
status. The following reports appear when you select Text Messages (SMS) and View Reports in the 
left column of the Contact Center Multimedia application. You can choose the report date and the 
skillsets represented in all displayed real-time reports.

• The SMS (New Vs. Closed) report shows the number of contacts in a new and closed state 
against the time for the selected date and skillsets.

• The SMS Progress report shows the number of contacts in a new or closed state on a defined 
date to determine the traffic levels for that date.

• The SMS Closed Contacts Queue Time report shows the average time a contact spends in 
queue while the contact center is open.

Prerequisites for SMS configuration
Ensure that you are licensed for email contacts.

Configuring a route point for an SMS skillset
About this task
Configure a route point for an SMS skillset to route SMS contacts to an agent. Skillsets are used 
to assign the contacts to agents.
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select General Administration.

3. Click Skillset Settings.

4. In the Skillset Settings dialog box, select the skillset to assign a route point.

The skillset must have the prefix SM.

5. Under the Edit Skillset dialog box, in the Route Point list, select the route point to assign 
to the SMS skillset.

6. Click Save.

Variable definitions
Name Description
Route point A location in the open queue that enables incoming 

contacts to queue and run through a script on the 
Contact Center Manager Server.

Adding an SMS Gateway
About this task
Add the SMS server for your Contact Center Multimedia server as per your requirement.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Mailbox Configuration.

4. Click SMS Gateway (image).

5. In the SMS Gateway Configuration window, click Add.

6. In the SMS Gateway box, type the name of the new server.

7. Click Save.

Short Message Service configuration
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Updating an SMS Gateway
About this task
Update the SMS server for your Contact Center Multimedia server as per your requirement.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Mailbox Configuration.

4. Click SMS Gateway (image).

5. In the SMS Gateway Configuration window, click Edit.
6. Change the properties of your SMS server.

7. Click Save.

Deleting an SMS Gateway
About this task
Delete the SMS server for your Contact Center Multimedia server if it is no longer required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Mailbox Configuration.

4. Click SMS Gateway (image).

5. In the SMS Gateway Configuration window, select the SMS gateway you are deleting and 
click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

7. Click Close.

Updating an SMS Gateway
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Adding a SMS mailbox
Before you begin

• Configure a skillset for a SMS contact.

About this task
Add a SMS mailbox to the multimedia configuration for receiving SMS messages in an email 
message.
Also, choose the skillset for the mailbox so that the SMS message is routed to the agent who has 
the optimal skillset to handle the specific contact.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Mailbox Configuration.

4. Click Add.

5. On the Mailbox tab, in the Inbound Server field, select the hostname of your POP3 or 
IMAP server along with the respective security protocol.

6. In the Outbound Server field, select the hostname of your SMTP server.

7. In the Mailbox field, type the mailbox name.

8. In the Domain field, type the mailbox domain.

9. In the Credentials field, from the list, select the required credentials.

10. In the Skillset field, choose a configured skillset for routing the contacts.

11. In the Contact Priority field, choose a priority for contacts received in this mailbox.

12. Click the Sender Address tab.

13. Select Use full sender address or Parse sender address for CLID.

14. If you select Parse sender address for CLID, in the Leading Characters to Remove 
field, type the characters that you must not dial when making the outgoing callback.

15. Click Save.

Variable definitions
Name Description
Inbound Server The hostname of the email server that handles 

email messages entering the contact center.
Outbound Server The hostname of the email server that delivers 

email messages that leave the contact center.

Table continues…
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Name Description
Mailbox Name of the mailbox on the email server that is 

polled for new incoming email messages.
Domain The domain name for the email server.
Credentials Credentials used to access the mailbox on the 

email server.
Skillset A label applied to a set of skills, capabilities, or 

knowledge that an agent requires to respond to a 
request. The skillsets are retrieved from the Contact 
Center Manager Server database. You must select 
a route point for a skillset used to route SMS 
contacts.

Priority The priority given to a request for a skillset agent. 
The lower the priority number, the greater the 
priority. The values of the priorities range from 1 to 
6.

For example, a call with priority 1 is handled before 
a call with priority 6.

Sender address Select Use full sender address or Parse the 
address for the Calling Line identification (CLID) to 
save for future contacts. The address in the format 
you select is stored with the contact for future 
communication with the customer.

Leading characters to remove If you select Calling Line Identification (CLID) to 
add the customer’s phone number into the contact 
information, type any leading characters or trunk 
numbers to remove from the current number.

Updating an SMS mailbox
Before you begin

• Add an SMS mailbox.

About this task
Update the properties of the SMS mailbox, as per your requirements.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Mailbox Configuration.

4. Select the mailbox to be edited.

Updating an SMS mailbox
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5. Click Edit.
6. Update the mailbox settings as required.

7. Click Save.

Deleting an SMS mailbox
Before you begin

• Add an SMS mailbox.

Important:
An SMS mailbox cannot be deleted if it is currently assigned to a skillset.

About this task
Delete an SMS mailbox, if it is no longer required.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Mailbox Configuration.

4. Select the mailbox to be deleted.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Configuring an SMS reply mailbox
About this task
Configure the reply information for the SMS message received by your contact center.
Configure the outgoing mailbox properties with a signature related to the skillset for replying to an 
SMS.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
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3. Click Reply Configuration.

4. Under Skillsets, select a fax skillset for the mailbox configuration.

5. Under Mailbox, select a configured mailbox.

OR

Click New to create a new mailbox.

OR

Click Edit to edit an existing mailbox.

6. In the SMTP Server box, select the SMTP server to use for outgoing email messages.

7. In the Mailbox box, specify the new mailbox or change the name of the existing mailbox.

8. In the Domain box, type the email server domain.

9. In the Credentials field, from the list, select the required credentials.

10. To use a different user name for the SMTP authentication, select the Use Alternative 
username for SMTP Authentication check box.

11. In the Username box, type the alternative user name.

12. Click Save.

Variable definitions
Name Description
SMTP Server The name of the email server that handles email 

messages leaving the contact center.
Mailbox Name of the mailbox on the email server polled for 

email messages.
Domain The domain name for the email server.
Credentials Credentials used to access the mailbox on the 

email server.
Use Alternative username for SMTP Authentication If SMTP authentication is required for your 

outbound email server, select the user name for the 
authentication.

Deleting an SMS reply mailbox
About this task
Delete an SMS reply mailbox, if it is no longer required.

Deleting an SMS reply mailbox
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, select Text Messaging (SMS).
3. Click Reply Configuration.

4. Select the mailbox to be deleted.

5. Click Delete.

The system displays a Warning dialog box.

6. Click Yes to confirm the deletion.

Updating the SMS system default rule
Before you begin

• Ensure that you know the default settings for the system delivery failure rule:
- use the SMS default skillset, SM_Default_Skillset
- use no automatic response
- assign priority 3

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, SM_Default_Skillset is used.

• Configure the route points for the skillset you assign to the system default rule. For more 
information, see Configuring a route point for an SMS skillset on page 209.

About this task
Update the SMS system default rule to ensure that email messages received with SMS text are 
routed to an agent if no other rule associated to the recipient mailbox routes the email message.
The system default rule is used in every rule group configured in Contact Center Multimedia.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Text Messaging (SMS).
3. Click Default Rules.

4. Under System Default Rule, from the Skillset list, select a skillset name to assign to the 
contact.

Short Message Service configuration

April 2024 Avaya Contact Center Select Advanced Administration 216
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


5. Under System Default Rule, from the Priority list, select the priority to assign to the 
contact.

6. Click Save.

Updating the SMS system delivery failure rule
Before you begin

• Ensure that you are licensed to handle email messages.
• Ensure that you know the default settings for the system delivery failure rule:

- use the SMS default skillset, SM_Default _Skillset
- use keyword group delivery failure keywords
- assign priority 10 (lowest)

• Use caution when you change the properties of the system default rule:
- If you change the properties of the rule, you affect the behavior of the system default rule, 

which affects all recipient mailboxes.
- If you delete the skillset associated with the default rule, SM_Default_Skillset is used.

• Configure the route point for the skillset you plan to assign to the system delivery failure rule. 
See Configuring a route point for an SMS skillset on page 209.

About this task
Update the SMS system delivery failure rule to ensure that any email message that contains 
particular phrases such as undeliverable, returned mail, unknown recipient, delivery failure, or 
delivery report is deleted, and not assigned to an agent.
When you create a recipient mailbox, the system delivery failure rule is copied as the first regular 
rule into list of rules for the recipient mailbox.

Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Text Messaging (SMS).
3. Under System Delivery Failure Rule, from the Skillset list, select a skillset name to 

assign to the contact.

4. To change the keyword group, select the keyword group which contains the delivery failure 
keywords from the Keyword Group list under the System Delivery Failure Rule.

5. To change the priority, under Priority, select the priority to assign to the contact from the 
Priority list under the System Delivery Failure Rule.

6. To close contacts matching the delivery failure keywords, select the Will close contact 
check box.
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7. Click Save.
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Chapter 15: Data Management - cleanup 
and purging

Use the procedures in this chapter to set up the cleanup rules and tasks to remove closed contacts 
from the active Multimedia database.

Avaya Contact Center Select includes a Multimedia Offline database, a background synchronization 
task, and cleanup and purge tools. The background synchronization task automatically updates 
contacts from the active Multimedia database to the Offline database. You create rules and 
schedules to clean up the active Multimedia database by removing closed contacts from it, while 
leaving them in the Offline database. This keeps the active database small and efficient, while also 
allowing for historical reporting across all the contacts in both the active and the Multimedia Offline 
databases. The Multimedia Offline database contains the archived contacts, which are accessible 
for custom reporting. You can report on the Offline database using custom reporting with an ODBC 
DSN referencing the Offline tables in the Multimedia namespace.

You can configure the Offline database to purge contacts over a specific age. You specify the age 
at which ACCS purges closed contacts. ACCS runs a purge task every day, and purges contacts 
that meet the age criteria. You cannot recover a purged contact other than by restoring a backed-up 
Offline database.

Database sizing and limits
The active Multimedia database supports a maximum of 1,000,000 contacts. You must regularly 
clean up contacts from the active Multimedia database to stay below this limit. The maximum size 
of the Offline database is 70% of the database drive size. For example, if the Multimedia database 
drive size is 200 Gb, then the maximum size of the Offline database is 140 Gb. If the Offline 
database fills up, you can either increase the Multimedia database disk space or change the Offline 
database purge interval.
To prevent service interruption, updates to the Offline database stop when the database drive size 
is 70% full and the Offline database has less than 5% free space. Updates continue after you purge 
contacts, or if space is freed or added to the drive.
You can check the current sizes of the databases in the Contact Center Multimedia (CCMM) Data 
Management tool.
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Figure 4: Data Management Configuration page

When the current size of the Offline database grows to 75% of the maximum size, CCMM logs 
this event to the log file. When the current size of the Offline database grows above 90% of the 
maximum size, CCMM logs events to the event viewer. If the current size of the Offline database 
exceeds 95%, CCMM stops automatically synchronizing contacts from the Multimedia database, 
and prevents you from running manual or scheduled archives.
You can purge contacts from the Offline database to reduce the database size. You specify the age 
at which ACCS purges closed contacts. ACCS runs a purge task every day, and purges contacts 
that meet the age criteria. You cannot recover a purged contact other than by restoring a backed-up 
Offline database.

Cleanup rules
You create a cleanup rule to select contacts for a scheduled cleanup task. Cleanup rules apply to 
the Multimedia database only. Cleanup rules select contacts based on the number of days they 
have been in a Closed state, and any one of the following criteria:

• Outbound campaign
• Email rule
• Contact skillset

Data Management - cleanup and purging

April 2024 Avaya Contact Center Select Advanced Administration 220
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


• Closed reason
• Contact customer

In addition, there are four system cleanup rules:
• Anonymous web customers with no contacts:  This rule clears anonymous customers that 

a Web Chat application can create, if it allows customers to start a web chat anonymously.
• Customers with no contacts:  This rule clears customer records with no contacts, which can 

occur on systems upgraded from an earlier release.
• All contacts more than 1 year old:  This rule clears all contacts that are more than 1 year old.
• All contacts more than 5 years old:  This rule clears all contacts that are more than 5 years 

old.
You cannot modify these rules. They enable you to clear customer records with no contacts that 
occur in exceptional circumstances. Run scheduled tasks with these rules periodically to clear 
unwanted customer records from the active database.
Each scheduled cleanup task uses a rule, so you must create a rule before you can create a 
scheduled task.

Figure 5: Multimedia Data Management utility rules interface
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Scheduled tasks
Create scheduled cleanup tasks to clear contacts from the active Multimedia database. A scheduled 
task uses a single cleanup rule to select the contacts to clear. Scheduled tasks clear only closed 
contacts that were already copied to the Multimedia Offline database. If a contact was not previously 
copied to the Multimedia Offline database, the scheduled task copies it and then clears it.
The following figure shows the interface that you use to create scheduled cleanups of the active 
Multimedia database.

Figure 6: Multimedia Archive Administration tool scheduling interface

The illustrated interface shows three work areas:

1 Top Bar.
2 Navigation Pane.
3 Scheduled Task Calendar.

Restoring contacts
You can restore the contacts cleared by a scheduled cleanup task.

Using the Multimedia Dashboard metrics to identify data to purge
You can use the Multimedia Dashboard metrics to identify data to clean up. The CCMM Database 
Metrics section shows alerts when the metrics exceed normal thresholds. If you place your mouse 
over the alerting metric, the Dashboard displays a tooltip with details of the database values causing 
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the alert. For example, if the database has one or more customers with over 1000 contacts, the 
tooltip displays:

• Customer IDs
• Number of contacts for the customer

Figure 7: Example of a dashboard tooltip identifying the number of contacts customers have

Starting the Multimedia Data Management Administration 
utility

About this task
Use this procedure to log on to the Multimedia Data Management utility, so that you can manage 
database contacts and customer privacy requests. For information on using the Data Management 
Administration utility, see Avaya Contact Center Select Advanced Administration.

Procedure
1. Log on to Contact Center Manager Administration.

If configured in Contact Center Manager Administration (CCMA) Security Settings, CCMA 
displays the date and time of your last login and also the number of failed login attempts 
since your last successful login.

2. On the Launchpad, click Data Management.
3. In the left pane, select the CCMM server to administer.

The system displays the Multimedia Administration screen in the right pane.

4. Select Install prerequisite software.

5. Click Launch Data Management Client.
6. On the File Download box, click Run.

Starting the Multimedia Data Management Administration utility

April 2024 Avaya Contact Center Select Advanced Administration 223
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


The prerequisite software takes some time to install. After the install, the system displays 
the CCMM Data Management Administration utility.

Creating an Outbound Campaigns cleanup rule
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
Create a cleanup rule to select closed contacts in the MULTIMEDIA database, based on the 
outbound campaign that closed the contact. You can use this rule in a scheduled cleanup task to 
clear these contacts from the MULTIMEDIA database. There are two criteria you can use to select 
contacts by outbound campaign:

• The number of days the contact has been in a Closed state.
• The outbound campaign that created and closed the contact.

Procedure
1. In the Data Management utility, select Rules.

2. Select Outbound Campaigns.

3. In the Outbound Campaigns screen, click New.

4. In the Rule Name field, enter a descriptive name for this rule.

5. In the Age of Closed Contacts field, type the number of days that a contact must be 
Closed to match this rule.

6. If you want to remove the campaign from the Outbound Campaign Management Tools 
(OCMT) Campaign List, select Delete Campaign.

OCMT removes the campaign from the Campaign List when a cleanup task has removed 
all the campaign contacts and the campaign is Expired, Cancelled, or Completed.

7. For each campaign you want to add to the rule:

a. In the Not Selected field, select an outbound campaign.

b. Click the right-arrow button to move the outbound campaign to the Selected field.

8. For each campaign you want to remove from the rule:

a. In the Selected field, select an outbound campaign.

b. Click the left-arrow button to move the outbound campaign to the Not Selected field.

9. Click Save.
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Next steps
Create a new scheduled task to use this rule to clear closed contacts from the MULTIMEDIA 
database.

Creating an Email Rules cleanup rule
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
Create a cleanup rule to select closed email contacts in the MULTIMEDIA database. You can use 
this rule in a scheduled cleanup task to clear these contacts from the database. You can use the 
following criteria to select email contacts:

• The number of days the contact has been in a Closed state.
• The email rule that the incoming email matched when Contact Center created the contact.

Procedure
1. In the Data Management utility, select Rules.

2. Select Email Rules.

3. In the Email Rules screen, click New.

4. In the Rule Name field, enter a descriptive name for this rule.

5. In the Age of Closed Contacts field, type the number of days that a contact must be 
Closed to match this rule.

6. For each email rule you want to add to the cleanup rule:

a. In the Not Selected field, select an email rule.

b. Click the right-arrow button to move the email rule to the Selected field.

7. For each email rule you want to remove from the rule:

a. In the Selected field, select an email rule.

b. Click the left-arrow button to move the email rule to the Not Selected field.

8. Click Save.

Next steps
Create a new scheduled task to use this rule to clear closed contacts from the MULTIMEDIA 
database.

Creating an Email Rules cleanup rule
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Creating a Skillsets cleanup rule
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
Create a cleanup rule to select closed contacts in the MULTIMEDIA database, based on the 
contact skillset. You can use this rule in a scheduled cleanup task to clear these contacts from the 
database. There are two criteria you can use to select contacts by skillset:

• The number of days the contact has been in a Closed state.
• The contact skillset.

Procedure
1. In the Data Management utility, select Rules.

2. Select Skillsets.

3. In the Skillset Rules screen, click New.

4. In the Rule Name field, enter a descriptive name for this rule.

5. In the Age of Closed Contacts field, type the number of days that a contact must be 
Closed to match this rule.

6. For each skillset you want to add to the cleanup rule:

a. In the Not Selected field, select a skillset.

b. Click the right-arrow button to move the skillset to the Selected field.

7. For each skillset you want to remove from the rule:

a. In the Selected field, select a skillset.

b. Click the left-arrow button to move the skillset to the Not Selected field.

8. Click Save.

Next steps
Create a new scheduled task to use this rule to clear closed contacts from the MULTIMEDIA 
database.

Creating a Closed Reason cleanup rule
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.
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About this task
Create a cleanup rule to select closed contacts in the MULTIMEDIA database, based on the 
closed reason. You can use this rule in a scheduled cleanup task to clear these contacts from the 
database. There are two criteria you can use to select contacts by closed reason:

• The number of days the contact has been in a Closed state.
• The closed reason code an agent applied to the contact.

Procedure
1. In the Data Management utility, select Rules.

2. Select Closed Reason.

3. In the Closed Reason Rules screen, click New.

4. In the Rule Name field, enter a descriptive name for this rule.

5. In the Age of Closed Contacts field, type the number of days that a contact must be 
Closed to match this rule.

6. For each closed reason you want to add to the cleanup rule:

a. In the Not Selected field, select a closed reason.

b. Click the right-arrow button to move the closed reason to the Selected field.

7. For each closed reason you want to remove from the rule:

a. In the Selected field, select a closed reason.

b. Click the left-arrow button to move the closed reason to the Not Selected field.

8. Click Save.

Next steps
Create a new scheduled task to use this rule to clear closed contacts from the MULTIMEDIA 
database.

Creating a Customers cleanup rule
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
Create a cleanup rule to select closed contacts in the MULTIMEDIA database, based on the 
contact customer. You can use this rule in a scheduled cleanup task to clear these contacts from 
the database. There are two criteria you can use to select contacts by customer:

• The number of days the contact has been in a Closed state.
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• The contact customer.

Note:
The search function returns and displays the customer's first and last name. Different 
customers might share the same first and last names. Therefore the results of the search 
function can be identical for different customer IDs.

Procedure
1. In the Data Management utility, select Rules.

2. Select Customers.

3. In the Customer Rules screen, click New.

4. In the Rule Name field, enter a descriptive name for this rule.

5. In the Age of Closed Contacts field, type the number of days that a contact must be 
Closed to match this rule.

6. For each customer you want to add to the cleanup rule:

a. In the Customer Search field, select the search key for the customer, either ID or 
E-mail.

b. In the Equal To field, type the ID or email address of the customer that you want to 
add to the rule.

c. Click Search.

d. Select the customer that the search function returns.

e. Click the right-arrow button to move the customer to the Selected field.

7. For each customer you want to remove from the rule:

a. In the Selected field, select a customer.

b. Click the left-arrow button to move the customer to the Not Selected field.

8. Click Save.

Next steps
Create a new scheduled task to use this rule to clear closed contacts from the MULTIMEDIA 
database.

Creating a new scheduled cleanup task
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.
• Create a new rule to select the contacts you want to clear.
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About this task
Create a scheduled cleanup task to clear contacts from the MULTIMEDIA contact database. A 
scheduled task uses a single cleanup rule to select the contacts to clear. Scheduled tasks clear 
only closed contacts that were already copied to the OFFLINE database. If a contact was not 
previously copied to the OFFLINE database, the scheduled task copies it before clearing it.
You can select only a single rule for each scheduled task. You can choose to run a scheduled 
task once, weekly, or monthly. If you select to run a scheduled task weekly or monthly, you can 
optionally set an end date after which the scheduled task does not run.
The Cleanup Schedule interface shows a calendar, in a similar manner to many graphical 
scheduling tools. You can change the calendar to use Week, Month, or Timeline views.

Procedure
1. In the Data Management utility, select Cleanup.

2. Select Cleanup Schedule.

3. In the schedule calendar, select the date on which you want to schedule a cleanup task. 
You can use the Day, Week, Month, Timeline, Back, Calendar, and Forward controls in 
the Top Bar to browse to a date if it is not currently visible.

4. Double click the date on which you want to create the scheduled task.

Contact Center displays the Schedule Cleanup window.

5. In the Name field, enter a display name for this scheduled task.

6. In the Description field, enter a description of what this scheduled task does.

7. In the Select Type field, select the type of cleanup rule for this scheduled task.

8. In the Select Rule field, select an existing cleanup rule that the scheduled task uses to 
identify contacts to clear.

9. In the Schedule section, select the frequency with which you want this task to run; either 
Run Once, Weekly, or Monthly.

10. If you selected Run Once:

In the Start Date fields, select the date and time on which you want the task to run.

11. If you selected Weekly:

a. In the Start Date fields, select the first date and time on which you want the task to 
run.

b. Select the days of the week on which you want the task to run.

c. If you want this scheduled task to stop running after a date in the future, select End 
on and select a date after which this task does not run.

12. If you selected Monthly:

a. In the Start Date fields, select the first date and time on which you want the task to 
run.

b. In the Day field, enter the day of the month on which you want the task to run.
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c. In the of every field, enter the frequency of this monthly task.

For example, enter 1 to run the task every month, enter 2 to run the task every 
second month, or enter 12 to run the task once a year.

d. If you want this scheduled task to stop running after a date in the future, select End 
on and select a date after which this task does not run.

13. Click Save.

Enabling OFFLINE database purging
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
Enable OFFLINE database purging to permanently remove closed contacts from the OFFLINE 
database. Choose the length of time that closed contacts can remain in the OFFLINE database 
before Contact Center purges them. Contact Center runs the purge task every day, and deletes 
contacts that have been closed for the duration you configure. Avaya recommends that you do not 
configure purging unless the OFFLINE database approaches maximum usage.

Important:
When Contact Center purges a contact from the OFFLINE database, you cannot recover the 
contact except by retrieving it from a backed-up OFFLINE database. Ensure that the duration 
you configure to retain contacts is consistent with your local legislative and corporate data 
retention requirements.

Procedure
1. In the Data Management utility, select Configuration.

2. Click Purge.

3. On the Purge Settings dialog, select Enable Data Purge.

4. In the Keep Offline records (months) field, type the number of months a contact must be 
closed for Contact Center to purge it from the OFFLINE database.

Ensure that the value you enter is consistent with your local legislative and corporate data 
retention requirements.

5. Click Save.

6. On the CCMM Data Management dialog, click Yes.

7. On the Purge Settings dialog, click Close.
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Restoring an archive from a previous Release
Before you begin

• The archive from the previous Release must be in the original archive location.

About this task
You can restore Multimedia database archives from the previous Release if you need to recover 
old contacts to work with them. Use the legacy Multimedia Archive/Restore Utility to restore the 
contacts. Reopen the contacts you want to work with, and then cleanup the rest of the contacts so 
that Contact Center moves them to the OFFLINE database.

Procedure
1. Run the legacy Multimedia RestoreArchive executable D:\Avaya\Contact 

Center\Multimedia Server\Server Applications\ARCHIVE 
RESTORE\ArchiveRestore.exe.

2. Click Restore.

3. In the Restore pane, select the archive you want to restore.

4. Click Restore.

5. When the restore completes, exit the Archive/Restore Utility.

6. Use Agent Desktop to search for and reopen the contacts that you want to work with, so 
that they remain in the MULTIMEDIA database.

7. From the Start menu, in the Avaya area, click Data Management.
8. Create a new cleanup rule to clear the restored contacts from the active database. The 

configuration of this rule depends on the contacts that you restored.

9. Click Cleanup Schedule.

10. Create a scheduled task with the new cleanup rule to clear the restored contacts from the 
MULTIMEDIA database.

Restoring contacts cleared by a scheduled task
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
Follow this procedure to restore the contacts cleared by a scheduled cleanup task. When you 
restore a scheduled task, Contact Center restores all the cleared contacts to the MULTIMEDIA 
database.
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If you need to restore contacts previously cleared by a scheduled task, check to ensure that an 
existing scheduled task does not clear the contacts the next time it runs. For example, reopen the 
contacts, cancel the scheduled task that originally cleared them, or change the cleanup rule that 
the contacts matched.
The Cleanup History list shows all completed scheduled tasks that cleared contacts. It provides 
the following information for each task:

• Task name.
• Execution date of the task.
• Number of contacts that the task cleared from the MULTIMEDIA database.
• Number of customers whose contacts the task cleared from the database.
• Number of campaigns for which the task cleared contacts from the database (only for tasks 

with an Outbound rule).
• Restore status of the task.

Tip:
Run one cleanup task at a time. Where more than one cleanup task is run, a contact might be 
included in each cleanup. Restoring any of the cleanups successfully moves the contact into 
the active database.

Procedure
1. In the Data Management utility, select Restore.

2. In the navigation pane, select Restore.

3. In the Cleanup History screen, review the list of completed scheduled cleanup tasks.

4. Select the scheduled task that cleared the contacts that you want to restore.

5. Click Restore.

6. On the CCMM Cleanup Restore window, click Yes.

Contact Center schedules a task to restore the contacts and shows the start time in the 
Restore Status field. When the restore task starts, the Restore Status field shows the 
task progress.
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Chapter 16: Data Management - customer 
privacy

The Multimedia Data Management utility includes a Customer Privacy tab that allows you to act on 
privacy requests from contact center customers. The following customer privacy requests can be 
addressed using the Multimedia Data Management utility:

• If a customer exercises their right to access information, you can provide customers with 
information stored about them in the Voice, MULTIMEDIA, and OFFLINE databases. You can 
save this information in an XML file, which can be modified before you provide it to the 
customer. The file contains all relevant customer information.

• If a customer exercises the right to be forgotten, you can delete their history records from the 
Voice, MULTIMEDIA, and OFFLINE databases. In High Availability solutions, the records are 
also deleted from standby and RGN servers.

Note:

To prevent deletion of contacts not yet handled by agents, a customer’s history records 
can be fully deleted only when all of their contacts are in a closed status. For example, a 
customer with contacts in new or open status cannot not be deleted.  

Generating a customer information file
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
If you receive a customer information request, use the Multimedia Data Management utility to 
generate customer information in an XML file. You can then modify this file if required, before you 
provide it to the customer.
The Multimedia Data Management utility retrieves the customer information from the Voice, 
MULTIMEDIA, and OFFLINE databases. You can search for customers based on customer ID, 
email address or phone number.

April 2024 Avaya Contact Center Select Advanced Administration 233
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Procedure
1. In the Data Management utility, select Privacy.

2. Select Information Request.
3. Under Customer Search or Voice History Search, from the drop-down list, select ID, 

E-mail or Phone Number.
4. In the Equal To box, type the customer’s ID, email address or phone number and click 

Search.

The search results appear in the table. To reset the search results, click Reset.
5. Select the customer and click Save.

The Customer information request submitted message appears. You can 
download the XML file with the customer information when it is generated.

Note:

The time it takes to generate the file depends on the size of the customer record.

6. To download the XML file, in the browser address box, enter the following URL: https://
CCMM_SERVER_NAME/outboundattachment\8072\CustomerInfo_87883.xml, 
where CCMM_SERVER_NAME is the name of your CCMM server.

7. Click OK.

Next steps
Modify the file if required before providing it to the customer.

Deleting customer history
Before you begin

• Log on to the Contact Center server.
• Start the Multimedia Data Management utility.

About this task
If you receive a customer right to be forgotten request, use the Multimedia Data Management 
utility to delete customer history records from the Voice, MULTIMEDIA, and OFFLINE databases. 
You can search for customers based on customer ID, email address or phone number.

Procedure
1. In the Data Management utility, select Privacy.

2. Select Delete Request.
3. Under Customer Search, from the drop-down list, select ID , E-mail or Phone Number.
4. In the Equal To box, type the customer’s ID or email address and click Search.
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5. Select the customer and click Delete.

6. Click Yes to confirm that you want to delete the customer history record.

Deleting customer history
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Chapter 17: Orchestration Designer 
example flow applications

This chapter describes how to create three example flow applications using Orchestration Designer 
(OD) that provide either estimated wait time or position in queue information to customers, or 
provide customers with the option to leave a voice mail if all agents are busy. These flow 
applications use Avaya Contact Center Select default sample data; you can use these example 
flows in your contact center.

This chapter also provides a brief description of how to install and use OD. You can use OD to 
create and manage flow applications to route contacts to an appropriate queue in the contact center. 
For more detailed information about Orchestration Designer and using Orchestration Designer in 
your contact center, see Using Contact Center Orchestration Designer.

Installing Orchestration Designer
About this task
Install the Orchestration Designer client to manage Contact Center applications.

Procedure
1. Log on to the Contact Center Manager Administration as an administrator.

Contact Center Manager Administration (CCMA) displays the date and time of your last 
login and also the number of failed login attempts before a successful login.

2. From the Launchapd, click Scripting.

3. Click Orchestration Designer > Launch Orchestration Designer.
4. When prompted to download Orchestration Designer, click OK.

5. In the File Download - Security Warning message dialog box, click Run.

6. In the Installation Welcome window, click Next.
7. In the Customer Information window, type a User Name and Organization Name in the 

appropriate boxes.

8. Under Install this application for, select the option for your installation.

9. Click Next.
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10. In the Destination Folder window, select the installation folder for Orchestration Designer.

11. Click Next.
12. In the Ready to Install the Program window, click Install.
13. After the installation is complete, click Finish.

Opening Orchestration Designer
About this task
Open Orchestration Designer to configure the routing in your contact center.

Procedure
1. Log on to Contact Center Manager Administration as an administrator.

2. From the Launchpad, click Scripting.

3. Click Orchestration Designer > Launch Orchestration Designer.

Procedure job aid
The following figure shows Orchestration Designer for Contact Center. Each part of the window 
contains a label that describes what appears in the panel.
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Figure 8: Orchestration Designer for Contact Center

1 Contact Center view: The Contact Center view of Orchestration Designer shows all applications, 
application variables, and application management data currently configured in your Contact 
Center.

2 Application editor view: The Application editor is the main tool to create or modify the default 
applications. It provides the canvas on which to place the blocks.

3 Synchronization view: The Synchronization view shows the difference between the objects in the 
Local view and the Contact Center view for the Contact Center Manager Server.
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Figure 9: Orchestration Designer tabs

1 View tabs: The tabs located across the top of the Application editor represent main pages and 
block editors for the flow applications on which you work.

2 Palette bar: The icons represent blocks that you can use to build your Contact Center 
applications. The blocks you see depend on the switch you use in your Contact Center.

3 Local view: The Local view provides a user work space on a desktop to work with copies of the 
variables and applications.

4 Application Manager Data folder contains a list of all the agents, skillsets, CDNs, and DNISs.

Applications folder contains a list of all the applications in the system. Applications are used 
to control how contacts are routed through the Contact Center and the treatment each contact 
receives.

Applications Variables contains a list of all the variables in the system. Variables are used to 
change the nature of a flow at run time without changing the application.

You can also start Orchestration Designer from the Apps screen.
If you start Orchestration Designer from the Apps screen, you can create and work with 
applications and variable data in a local version of Orchestration Designer without affecting the 
working contact center.
The local version of Orchestration Designer allows you to perform the following tasks:

• Access all information without restrictions by access classes.
• Perform updates without affecting your Contact Center applications.
• Create applications using Orchestration Designer before the rest of the Contact Center 

software is installed.
By default, the Local and Problems views appear in your Orchestration Designer window. The top 
right corner is reserved for the script or flow application editor.
If you start Orchestration Designer from the Contact Center Manager Administration application, 
there are no partition restrictions. You log on to Contact Center Manager Administration as an 
administrator and work with blocks and variables in Orchestration Designer as an administrator.
Only one instance of Orchestration Designer can run at a time.
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View name Description
Contact Center view The Contact Center view shows all of the applications, variables, and application 

management data that are currently inactive or active in your Contact Center.

You can make minor changes to applications in the Contact Center view. However, 
Avaya recommends that you work on a copy of the application in the Local view to 
make significant changes.

Local view The Local view shows all of the applications, variables, application management 
data, and intrinsics saved on the local machine. You need not be connected 
to a Contact Center Manager Administration or to the network to work with this 
data. You can upload applications to the Contact Center view after you finish your 
modifications.

Synchronization 
view

The Synchronization view shows the differences between all objects stored on the 
Contact Center Manager Server (Contact Center view) and the objects stored on 
the Local client (Local view) after you use the Synchronization command.

Problems view The Problems view shows the errors in the current application. You can use the 
problems view to determine where the problem is, and determine the reason for the 
problem.

Configuring a flow application to provide estimated wait 
time information

About this task
Create a new graphical flow application in Orchestration Designer that provides an estimated 
wait time to customers if a particular skillset is busy or out of service. This example uses Avaya 
Contact Center Select default sample data such as:

• The SimpleQueueing application template as a starting point.
• The Skill1 skillset.
• The Sample_Music Route, number 511. This corresponds to the default Sample_Music 

content group in CCMA Prompt Management, which includes two sample music files.
This example flow application uses custom media files, uploaded to the en_us content group using 
CCMA Prompt Management:

Prompt name Prompt transcript Sample flow application using 
this prompt

holdtime “The estimated hold time is 
currently”

QueuingWithEstWaitTime

seconds “seconds” QueuingWithEstWaitTime

Table continues…
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Prompt name Prompt transcript Sample flow application using 
this prompt

Note:

These prompts are not available in Avaya Contact Center Select by default. You must supply these 
custom media files.

Upload custom media files using CCMA Prompt Management. You must upload the .WAV files 
encoded as Linear 16-bit PCM, 8KHz Mono with a sampling rate of 128kbits/sec. For more 
information about how to upload media files using Prompt Management, see Administering Avaya 
Contact Center Select.

Procedure
1. Launch Orchestration Designer.

2. In the Contact Center pane, expand the CCMA name. The CCMA name matches the host 
name of the Avaya Contact Center Select server.

3. Expand CC.

4. Right-click Applications [Full Control], and select New > Application.

5. In the New Contact Center Application dialog box, select Create in Contact Center.
6. In the Application Name box, type the name of your new flow application. For this 

example, the name is QueuingWithEstWaitTime.

7. For Application Type, select Graphical Flow.

8. From the Application Template list, select SimpleQueuing.

9. Click Finish.

The Flow Editor opens the new flow based on the SimpleQueuing template.

10. Select the else condition icon that appears to the right of the Wait For 30 Secs block icon.

11. Right-click on the Wait For 30 Secs block icon and select (Dis)Connect.
12. From the palette bar, select the IVR block icon.
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13. Click the main [QueuingWithEstWaitTime] panel.

The CCIVRBLOCK icon appears in the Main Flow Editor. Reposition the icon if needed.

14. Select the else condition icon that appears to the right of the Wait For 30 Secs block icon.

15. Right-click on the CCIVRBLOCK icon and select (Dis)Connect.

16. From the palette bar, select the Treatment block icon.

17. Click the main [QueuingWithEstWaitTime] panel.

The CCTREATMENTBLOCK icon appears in the Main Flow Editor. Reposition the icon if 
needed.

18. Right-click on the CCTREATMENTBLOCK icon and select Rename.

19. In the Name box, type MusicOnHold and click OK.

20. Select the CCIVRBLOCK icon.

21. Right-click on the MusicOnHold icon and select (Dis)Connect.
22. Select the MusicOnHold icon.

23. Right-click on the Wait for 30 Secs icon and select (Dis)Connect.
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24. Double-click the CCIVRBLOCK icon.

25. In the Prompt Name box, type <MediaFileName1>+%n0+<MediaFileName2>. For 
example, type holdtime+%n0+seconds.

26. Select the Collected Digits check box and click Browse.

27. In the Chooser dialog box, expand Application Variables  > INTEGER.

28. Select c_estimated_wait_time_cv and click OK.

29. Close the CCIVRBLOCK tab.

30. Double-click the MusicOnHold treatment icon.

31. Under Treatment Options, select Music.

32. In the Music Route box, type 511.

Note:

This number corresponds to the Avaya Contact Center Select default Sample_Music 
route configured in CCMA.

33. Close the MusicOnHold tab.

34. Optionally, double-click the Wait for 30 Secs wait block.

a. Under Block Name, type a new name for the wait block. For example, type Wait 
for 10 Secs.

b. In the Duration (secs) box, type 10.

c. Close the Wait for 30 Secs tab.

35. Double-click the Check Out Of Service icon.

36. Click the Transition tab.
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37. Click the Default_Skillset In Service tab.

38. Under Conditional Expression, click Edit.
39. Under Condition, select ! OUT OF SERVICE Default_Skillset.

! OUT OF SERVICE Default_Skillset appears in the When box.

40. Click Clear Entry.

41. From the Not drop-down list, select Not. Ensure “!” appears in the When box after you 
select Not.

42. Click Variables.

43. On the Chooser dialog, expand Intrinsics > Skillset.
44. Select OUT OF SERVICE and click OK.

45. Click Variables.

46. On the Chooser dialog, expand Application Manager Data > Skillsets > Local.
47. From the list of skillsets, select a voice skillset. For example, select Skill1.

48. Click OK.

49. Click Change.
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50. Click Apply.

51. Close the Check Out Of Service tab.

52. Double-click the Queue to Default_Skillset icon.

53. Under Skillsets, click Add.

54. Expand Application Manager Data > Local Skillsets.

55. From the list of skillsets, select a voice skillset. For example, select Skill1.

56. Click OK.

57. To remove a skillset from the list, such as Default_Skillset, select the skillset and click 
Remove.
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58. Close the Queue to Default_Skillset tab.

59. Right-click the Queue to Default_Skillset icon and click Rename.

60. In the Name box, type Queue to Skill1 and click OK.

61. Close the QueuingWithEstWaitTime flow application.

62. On the Save Resource box, click Yes to save the application.

63. On the Confirm box, click OK to activate the application.

64. In the Contact Center view, double-click Master_Script.
65. Under Configured Routes in the right pane, expand CDN.

66. Select SampleCDN and click Edit.
67. In the Application Chooser, under Valid Applications, select the QueuingWithEstWaitTime 

flow application.

68. Click OK.

Calls to the SampleCDN (Route Point) are routed to the QueuingWithEstWaitTime flow 
application for treatment and queueing to the appropriate agent skillset queue (for 
example, the Skill1 skillset). If the skillset is busy or out of service for any reason, 
customers that call the sample Route Point hear a recording that provides an estimated 
wait time for their call to be answered by an agent.

69. Close Contact_Router.
70. On the Save Resource box, click Yes.

71. On the Confirm box, click OK to activate the Master_Script.
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Configuring a flow application to provide position in queue 
information

About this task
Create a new graphical flow application in Orchestration Designer that provides position in queue 
information to customers if a particular skillset is busy or out of service. This example uses Avaya 
Contact Center Select default sample data such as:

• The SimpleQueueing application template as a starting point.
• The Skill1 skillset.
• The Sample_Music Route, number 511. This corresponds to the default Sample_Music 

content group in CCMA Prompt Management, which includes two sample music files.
This example flow application uses custom media files, uploaded to the en_us content group using 
CCMA Prompt Management:

Prompt name Prompt transcript Sample flow application using 
this prompt

PosInQueue “Thank you for holding. You are 
currently number”

QueuingWithPOSQ

InQueue “in the queue. Please wait for the 
next available agent”

QueuingWithPOSQ

Note:

These prompts are not available in Avaya Contact Center Select by default. You must supply these 
custom media files.

Upload custom media files using CCMA Prompt Management. You must upload the .WAV files 
encoded as Linear 16-bit PCM, 8KHz Mono with a sampling rate of 128kbits/sec. For more 
information about how to upload media files using Prompt Management, see Administering Avaya 
Contact Center Select.

Procedure
1. Launch Orchestration Designer.

2. In the Contact Center pane, expand the CCMA name. The CCMA name matches the host 
name of the Avaya Contact Center Select server.

3. Expand CC.

4. Right-click Applications [Full Control], and select New > Application.

5. In the New Contact Center Application dialog box, select Create in Contact Center.
6. In the Application Name box, type the name of your new flow application. For this 

example, the name is QueuingWithPOSQ.

7. For Application Type, select Graphical Flow.

8. From the Application Template list, select SimpleQueuing.
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9. Click Finish.

The Flow Editor opens the new flow based on the SimpleQueuing template.

10. Select the else condition icon that appears to the right of the Wait For 30 Secs block icon.

11. Right-click on the Wait For 30 Secs block icon and select (Dis)Connect.
12. From the palette bar, select the IVR block icon.

13. Click the main [QueuingWithPOSQ] panel.

The CCIVRBLOCK icon is displayed in the Main Flow Editor. Reposition the icon if needed.

14. Select the else condition icon that displays to the right of the Wait For 30 Secs block icon.

15. Right-click on the CCIVRBLOCK icon and select (Dis)Connect.

16. From the palette bar, select the Treatment block icon.

17. Click the main [QueuingWithPOSQ] panel.

The CCTREATMENTBLOCK icon is displayed in the Main Flow Editor. Reposition the icon 
if needed.

18. Right-click on the CCTREATMENTBLOCK icon and select Rename.
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19. In the Name box, type MusicOnHold and click OK.

20. Select the CCIVRBLOCK icon.

21. Right-click on the MusicOnHold icon and select (Dis)Connect.
22. Select the MusicOnHold icon.

23. Right-click on the Wait for 30 Secs icon and select (Dis)Connect.

24. Double-click the CCIVRBLOCK icon.

25. In the Prompt Name box, type <MediaFileName1>+%i0+<MediaFileName2>. For 
example, type PosInQueue+%i0+InQueue.

26. Select the Collected Digits check box and click Browse.

27. In the Chooser dialog box, expand Application Variables  > INTEGER.

28. Select c_position_in_queue_cv and click OK.

29. Close the CCIVRBLOCK tab.

30. Double-click the MusicOnHold treatment icon.

31. Under Treatment Options, select Music.
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32. In the Music Route box, type 511.

Note:

This number corresponds to the Avaya Contact Center Select default Sample_Music 
route configured in CCMA.

33. Close the MusicOnHold tab.

34. Optionally, double-click the Wait for 30 Secs wait block.

a. Under Block Name, type a new name for the wait block. For example, type Wait 
for 10 Secs.

b. In the Duration (secs) box, type 10.

c. Close the Wait for 30 Secs tab.

35. Double-click the Check Out Of Service icon.

36. Click the Transition tab.

37. Click the Default_Skillset In Service tab.

38. Under Conditional Expression, click Edit.
39. Under Condition, select ! OUT OF SERVICE Default_Skillset.

! OUT OF SERVICE Default_Skillset is displayed in the When box.

40. Click Clear Entry.
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41. From the Not drop-down list, select Not. Ensure “!” appears in the When box after you 
select Not.

42. Click Variables.

43. On the Chooser dialog, expand Intrinsics > Skillset.
44. Select OUT OF SERVICE and click OK.

45. Click Variables.

46. On the Chooser dialog, expand Application Manager Data > Skillsets > Local.
47. From the list of skillsets, select a voice skillset. For example, select Skill1.

48. Click OK.

49. Click Change.

50. Click Apply.

51. Close the Check Out Of Service tab.

52. Double-click the Queue to Default_Skillset icon.
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53. Under Skillsets, click Add.

54. Expand Application Manager Data > Local Skillsets.

55. From the list of skillsets, select a voice skillset. For example, select Skill1.

56. Click OK.

57. To remove a skillset from the list, for example Default_Skillset, select the skillset and click 
Remove.

58. Close the Queue to Default_Skillset tab.

59. Right-click the Queue to Default_Skillset icon and click Rename.

60. In the Name box, type Queue to Skill1 and click OK.

61. Close the QueuingWithPOSQ flow application.

62. On the Save Resource box, click Yes to save the application.

63. On the Confirm box, click OK to activate the application.

64. In the Contact Center view, double-click on Master_Script.
65. Under Configured Routes in the right pane, expand CDN.

66. Select SampleCDN and click Edit.
67. In the Application Chooser, under Valid Applications, select the QueuingWithPOSQ flow 

application.

68. Click OK.

Calls to the SampleCDN (Route Point) are routed to the QueuingWithPOSQ flow 
application for treatment and queueing to the appropriate agent skillset queue (for 
example, the Skill1 skillset). If the skillset is busy or out of service for any reason, 
customers that call the sample Route Point hear a recording that provides position in 
queue information.

69. Close Contact_Router.
70. On the Save Resource box, click Yes.
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71. On the Confirm box, click OK to activate the Master_Script.

Configuring a flow application to provide a queuing 
customer with the option to leave a voicemail

About this task
Create a new graphical flow application in Orchestration Designer that enables a customer to 
leave a voicemail if all agents are busy. This example uses Avaya Contact Center Select default 
sample data such as:

• The SimpleQueueing application template as a starting point.
• The Skill1 skillset.
• The InvalidEntry_CS script variable. This variable corresponds to the InvalidEntry_CS prompt 

that informs customers that they have inputted an invalid entry.
• The Voicemail_gv script variable. This variable corresponds to a Voicemail Pro DN number. 

The default value of Voicemail_gv is the value entered in the Ignition Wizard configuration 
utility at install time. You can change the DN number for the Voicemail_gv script variable 
using the Scripting component in CCMA.

This example flow application uses a custom media file, uploaded to the en_us content group 
using CCMA Prompt Management:

Prompt name Prompt transcript Sample flow application using 
this prompt

VoiceMailOption “We are sorry for this delay. If you 
wish, press 1 now to be routed to 
our voicemail system to leave a 
message for one of our experts, 
or press 2 to remain queuing.”

LeaveVoiceMail

Note:

This prompt is not available in Avaya Contact Center Select by default. You must supply this custom 
media file.

Upload custom media files using CCMA Prompt Management. You must upload the .WAV files 
encoded as Linear 16-bit PCM, 8KHz Mono with a sampling rate of 128kbits/sec. For more 
information about how to upload media files using Prompt Management, see Administering Avaya 
Contact Center Select.

Procedure
1. Launch Orchestration Designer.

2. In the Contact Center pane, expand the CCMA name. The CCMA name matches the host 
name of the Avaya Contact Center Select server.

3. Expand CC.
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4. Right-click Applications [Full Control], and select New > Application.

5. In the New Contact Center Application window, select Create in Contact Center.
6. In the Application Name box, type the name of your new flow application. For this 

example, the name is LeaveVoiceMail.

7. For Application Type, select Graphical Flow.

8. From the Application Template list, select SimpleQueuing.

9. Click Finish.

The Flow Editor opens the new flow based on the SimpleQueuing template.

10. Select the else condition icon that displays to the right of the Wait For 30 Secs block icon.

11. Right-click on the Wait For 30 Secs block icon and select (Dis)Connect.
12. Select the Wait For 30 Secs block icon.

13. Right-click on the Check If Queued Correctly block icon and select (Dis)Connect.
14. From the palette bar, select the IVR block icon.

15. Click the main [LeaveVoiceMail] panel.

The CCIVRBLOCK icon is displayed in the Main Flow Editor. Reposition the icon if needed.

16. Right-click on the CCIVRBLOCK icon and select Rename.

17. In the Name box, type Prompt Menu Options and click OK.

18. Select the Wait For 30 Secs block icon.

19. Right-click on the Prompt Menu Options icon and select (Dis)Connect.
20. From the palette bar, select the Logic block icon.

21. Click the main [LeaveVoiceMail] panel.

The CCLOGICBLOCK icon is displayed in the Main Flow Editor. Reposition the icon if 
needed.

22. Right-click on the CCLOGICBLOCK icon and select Rename.
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23. In the Name box, type Check Menu Option and click OK.

24. Select the Prompt Menu Options block icon.

25. Right-click on the Check Menu Option icon and select (Dis)Connect.

26. Double-click on the Check Menu Option icon.

a. Click the Transition tab.

b. Click Add Transition.

c. Select the tran tab.

d. In the Description box, type a description.

Configuring a flow application to provide a queuing customer with the option to leave a voicemail

April 2024 Avaya Contact Center Select Advanced Administration 255
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


For example, type the following: If the customer enters 1, route the 
contact to IP Office Voicemail. Otherwise the contact remains 
queuing.

e. Under Conditional Expression, click Edit.
f. In the Condition Builder, click Variables.

g. In the Chooser box, expand Application Variables  > STRING.

h. Select im_str and click OK.

i. From the drop-down list, select Equal To.

Ensure that “im_str ==” is displayed in the When box when you select Equal To.

j. In the String box, type 1 and click Add.

k. To the right of the When box, click Add.

l. Click Apply.

m. Click Add Transition.

n. Click the newly created tran tab.

o. In the Description box, type a description.

For example, type the following: If the customer enters 2, continue 
queuing.
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p. Under Conditional Expression, click Edit.
q. In the Condition Builder, click Variables.

r. In the Chooser box, expand Application Variables  > STRING.

s. Select im_str and click OK.

t. From the drop-down list, select Equal To.

Ensure that “im_str ==” is displayed in the When box when you select Equal To.

u. In the String box, type 2 and click Add.

v. To the right of the When box, click Add.

w. Click Apply.

x. Close the Check Menu Option tab.

27. Right-click on the tran icon with the conditional expression of “im_str == 1” and select 
Rename.

28. In the Name box, type 1_Go to Voicemail and click OK.

29. Right-click on the tran icon with the conditional expression of “im_str == 2” and select 
Rename.
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30. In the Name box, type 2_Keep Queuing and click OK.

31. Click the 2_Keep Queuing icon.

32. Right-click the Check If Queued Correctly icon and select (Dis)Connect.
33. From the palette bar, select the Finish block icon.

34. Click the main [LeaveVoiceMail] panel.

The CCFINISHBLOCK icon is displayed in the Main Flow Editor. Reposition the icon if 
needed.

35. Right-click the CCFINISHBLOCK icon and select Rename.

36. In the Name box, type Voicemail and click OK.

37. Click the 1_Go to Voicemail icon.

38. Right-click the Voicemail icon and select (Dis)Connect.
39. From the palette bar, select the Ivr block icon.

40. Click the main [LeaveVoiceMail] panel.

The CCIVRBLOCK icon is displayed in the Main Flow Editor. Reposition the icon if needed.

41. Right-click the CCIVRBLOCK icon and select Rename.

42. In the Name box, type Invalid Data Announcement and click OK.

43. Select the Check Menu Option else icon.

44. Right-click the Invalid Data Announcement icon and select (Dis)Connect.
45. Select the Invalid Data Announcement icon.

46. Right-click the Prompt Menu Options icon and select (Dis)Connect.

47. From the palette bar, select the Treatment block icon.

48. Click the main [LeaveVoiceMail] panel.
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The CCTREATMENTBLOCK icon is displayed in the Main Flow Editor. Reposition the icon 
if needed.

49. Right-click the CCTREATMENTBLOCK icon and select Rename.

50. In the Name box, type Give Ring Back and click OK.

51. Click the Check If Queued Correctly else condition icon.

52. Right-click the Give Ring Back icon and select (Dis)Connect.
53. Click the Give Ring Back icon.

54. Right-click the Wait For 30 Secs icon and select (Dis)Connect.

55. Double-click the Prompt Menu Options icon.

a. On the Ivr tab, select Play and Collect.
b. In the Prompt Name box, type the name of your custom media file. For example, type 

VoiceMailOption.

c. Under Return Value, click Browse.

d. In the Chooser dialog box, expand Application Variables  > STRING.

e. Select im_str and click OK.

f. Under Digit Collection, select all check boxes.

g. In the Number of Digits box, type 1.

h. In the Timeout (secs) box, type 5.
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i. Close the Prompt Menu Options tab.

56. Double-click the Voicemail icon.

a. Under Treatment Options, select Route Call.

b. Select the DN option and click the icon ( ).

c. Click Browse.

d. In the Chooser dialog box, expand Application Variables  > DN.

e. Select Voicemail_gv and click OK.
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f. Close the Voicemail tab.

57. Double-click the Invalid Data Announcement icon.

a. On the Ivr tab, select Play Prompt.

b. Select the Prompt Name icon ( ) and click Browse.

c. In the Chooser dialog box, expand Application Variables  > STRING.

d. Select InvalidEntry_CS and click OK.

e. Close the Invalid Data Announcement tab.

58. Double-click the Give Ring Back icon.

a. In the Minimum Duration (secs) box, type 2.

b. Close the Give Ring Back tab.

59. (Optional) Double-click the Wait for 30 Secs wait block.

a. Under Block Name, type a new name for the wait block. For example, type Wait 
for 20 Secs.

b. In the Duration (secs) box, type 20.

c. Close the Wait for 30 Secs tab.

60. Double-click the Check Out Of Service icon.

a. Click the Transition tab.
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b. Click the Default_Skillset In Service tab.
c. Under Conditional Expression, click Edit.
d. Under Condition, select ! OUT OF SERVICE Default_Skillset.

! OUT OF SERVICE Default_Skillset is displayed in the When box.
e. Click Clear Entry.
f. From the Not drop-down list, select Not.

Ensure “!” is displayed in the When box after you select Not.
g. Click Variables.
h. On the Chooser dialog, expand Intrinsics > Skillset.
i. Select OUT OF SERVICE and click OK.
j. Click Variables.
k. On the Chooser dialog, expand Application Manager Data > Skillsets > Local.
l. From the list of skillsets, select a voice skillset. For example, select Skill1.

m. Click OK.
n. Click Change.
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o. Click Apply.

p. Close the Check Out Of Service tab.

61. Double-click the Queue to Default_Skillset icon.

a. Under Skillsets, click Add.

b. Expand Application Manager Data > Local Skillsets.

c. From the list of skillsets, select a voice skillset. For example, select Skill1.

d. Click OK.

e. To remove a skillset from the list, for example Default_Skillset, select the skillset and 
click Remove.

f. Close the Queue to Default_Skillset tab.

62. Right-click the Queue to Default_Skillset icon and click Rename.

63. In the Name box, type Queue to Skill1 and click OK.

64. Close the LeaveVoiceMail flow application.

65. On the Save Resource box, click Yes to save the application.
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66. On the Confirm box, click OK to activate the application.

67. In the Contact Center view, double-click Master_Script.
68. Under Configured Routes in the right pane, expand CDN.

69. Select SampleCDN and click Edit.
70. In the Application Chooser, under Valid Applications, select the LeaveVoiceMail flow 

application.

71. Click OK.

Calls to the SampleCDN (Route Point) are routed to the LeaveVoiceMail flow application 
for treatment and queuing to the appropriate agent skillset queue (for example, the Skill1 
skillset). If the skillset is busy or out of service for any reason, customers that call the 
sample Route Point have an option to leave a voicemail or to continue waiting for an agent.

72. Close Contact_Router.
73. On the Save Resource box, click Yes.

74. On the Confirm box, click OK to activate the Master_Script.

Next steps
Before you use the flow application in your contact center, ensure that the flow works correctly by 
performing the following:

• Take the Skill1 skillset out of service.
• Place a test call to the SampleCDN.
• Verify that after hearing ringback for 20 seconds, you hear the “VoiceMailOption” prompt.
• Verify that if you press 1 after hearing the prompt, you can leave a voicemail message.
• Verify that if you press 2 after hearing the prompt, you continue hearing ringback and the 

prompt plays every 20 seconds thereafter.
• Verify that if you press a key other than 1 or 2, or if you do not press any key, you hear the 

Invalid Entry prompt.
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Chapter 18: Avaya Aura® Media Server 
media configuration

Avaya Aura® Media Server (Avaya Aura® MS) provides default media for standard ringback and 
busy tones in a SIP-enabled contact center. Contact Center uses these default tones with SIP-
enabled phone calls.

Continuous streaming media
Avaya Aura® MS supports the configuration of a continuously streamed source for music. To use 
continuous streamed source, you can configure either a Really Simple Syndication (RSS) provider 
or a HTTP/MP3 provider from which the Avaya Aura® MS can provide music to the Contact Center. 
Avaya Aura® MS supports up to 64 music streams across all of the supported providers.
Avaya Aura® MS Element Manager (EM) has a page for monitoring the status of music streaming 
providers. EM displays statistics for each stream, which include bandwidth and the codec being 
used. When song metadata is available, EM displays details about the current song being played, 
including the song title and artist name.
To use streamed music in Contact Center Orchestration Designer (OD) flow applications, you create 
routes in Contact Center Manager Administration (CCMA) that link to the RSS or HTTP/MP3 Stream 
Key configured on Avaya Aura® MS. The OD flow applications reference these routes to access the 
streamed music.
Real Simple Syndication (RSS) provider: 
An RSS provider can be used to centrally manage music streams that have music files hosted on a 
remote web server. The media server downloads an RSS document specified by a URL. The media 
server downloads each file specified in the RSS document to a local cache.
The media server uses the RSS title element in the document as the title for the files in the cache. 
The files play in alphabetical order. The RSS provider on the media server supports audio files in 
WAV and MP3 formats. Avaya recommends that audio to be played by Avaya Aura® MS is encoded 
in G.711 or 16 bit, 8 kHz, single channel, PCM files. You can use codecs other than PCM, or with 
higher sampling rates for higher quality recordings; however, this reduces system performance. The 
RSS provider on the media server does not support multiple channels or stereo.

• The audio must be encoded in MPEG-1 Audio Layer 3 (MP3), MPEG-2 Audio Layer 3 (MP3) or 
WAV.

• The maximum RSS document size is 256 KB.
The Time To Live (TTL) element in an RSS document specifies how many minutes an RSS channel 
can be cached on the media server before refreshing from the source. The minimum TTL value is 1 
minute.
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The GUID element in an RSS document uniquely identifies an RSS item. If an RSS item title, 
enclosure type, URL, or the associated file changes, then the GUID must be updated. If a GUID 
changes, then the media server refreshes the specified content.
Avaya Aura® MS uses cached files to provide continuous streaming service when the RSS URL 
becomes unreachable. If you update or delete the RSS URL, then the files in the cache are deleted.
The RSS document must be formatted correctly. The maximum RSS document size is 256 KB. The 
following example shows an RSS document with correct formatting:

HTTP/MP3 provider: 
The HTTP/MP3 provider supports SHOUTCast ICY streams and HTTP/MP3.
Most streaming radio stations on the internet stream over HTTP/MP3. Many of the stations use 
the SHOUTCast ICY protocol. Typically, a SHOUTCast stream provides a playlist in a .pls or .m3u 
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file. The .pls file is known as a Winamp playlist. Winamp playlist files have HTTP URL entries that 
reference audio streams.
In some cases the URLs inside the playlist can use nonstandard HTTP ports. You must configure 
the HTTP proxy on the media server when the HTTP/MP3 server returns documents containing 
URLs on HTTP ports that are not permitted through the firewall.
The HTTP/MP3 provider on Avaya Aura® MS supports stereo and mono MP3 streams. When 
the specified radio station supports metadata, the media server accepts the song title and artist 
information as it is received in real-time. Element Manager displays the current song title and artist 
on the monitoring page.
Avaya Aura® MS supports only MP3 SHOUTCast streams. Avaya Aura® MS does not support 
Advanced Audio Coding (AAC). To ensure that the HTTP/MP3 stream is compatible with Avaya 
Aura® MS:

• The audio must be encoded in MPEG-1 Audio Layer 3 (MP3) or MPEG-2 Audio Layer 3 (MP3).
• Avaya Aura MS supports the following MPEG-1 sample rates: 32000, 44100, and 48000 Hz.
• Avaya Aura MS supports the following MPEG-2 sample rates: 22050, 24000, and 16000 Hz.
• Avaya Aura MS supports the following bit rates: 32, 64, 96, 128, 160, 192, 256 and 320 kbps.
• The content type for playlists must be audio/x-scpls or audio/x-mpegurl.
• The content type for audio must specify audio/mpeg, audio/x-mpeg, or application/octet-

stream.
• The server can respond with ICY 200 OK or standard HTTP 200 OK responses.
• Avaya Aura MS supports the ICY MetaData update mechanism. Use of this update mechanism 

is optional.
• Avaya Aura MS supports VLC and Icecast streaming sources, if the codec and content type 

used are also supported.
The Avaya Aura® MS HTTP/MP3 provider automatically records 15 minutes of content. The 
recorded content provides a backup when the streaming server is unreachable.

Avaya Aura® Media Server scripted music
Avaya Aura® MS supports the configuration of a continuously streamed source for scripted music. 
Configure Avaya Aura® MS to supply only scripted music treatments inserted in to a voice call by a 
Contact Center Orchestration Designer (OD) flow application.
Scripted music plays from an Avaya Aura® Media Server content store as a continuous stream.

Logging in to Avaya Aura® Media Server Element Manager
Before you begin
Obtain a valid user name and password to access Avaya Aura® Media Server Element Manager.

About this task
Log in to the Avaya Aura® Media Server Element Manager as an administrator to configure Avaya 
Aura® Media Server.

Logging in to Avaya Aura® Media Server Element Manager
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Element Manager (EM) is a web-based administration tool that facilitates the Operation, 
Administration, and Maintenance (OAM) of Avaya Aura® Media Server.

Procedure
1. On the Avaya Contact Center Select server, start a web browser and type https://

SERVER_IP_ADDRESS:8443/em in the address box.

SERVER_IP_ADDRESS is the IP address of the Avaya Aura® Media Server.

2. In the User ID box, type the Avaya Aura® Media Server User ID account name.

The default Element Manager User ID account name is Admin.

3. In the Password box, type the Avaya Aura® Media Server Element Manager password.

Admin123$ is the default Element Manager password.

4. Click Log in.

Configuring a HTTP proxy for external music source 
access

About this task
If external streaming servers use non-standard ports, enterprise firewalls can block outgoing 
HTTP connections. Perform the following procedure to configure the address and port of 
an internal HTTP proxy server, to allow access to external streaming servers. This proxy 
configuration applies to streaming that uses RSS, HLS, and ICY protocols over HTTP.
If your enterprise firewall does not block access to the external streaming servers, you can skip 
this procedure.

Before you begin
• Know the FQDN or IP address, and port, of the internal HTTP proxy server.

Procedure
1. Log on to Element Manager.

2. In the navigation pane, click System Configuration > Media Processing > Music > 
General Settings.

3. In the HTTP Proxy Host field, type the FQDN or IP address of the internal proxy server 
that provides access to the external streaming servers.

4. In the HTTP Proxy Port field, type the port of the internal proxy server.

5. Click Save.
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Configuring a streaming music source
Before you begin

• Ensure that the streaming music source server that you want to use is configured and 
operational.

• Ensure that the music source you configure meets the requirements for the provider type.

About this task
Configure Avaya Aura® Media Server to use a streaming music source URL to provide continuous 
streamed source music to the contact center.
To use the streamed music in an OD flow application or script, you must configure and acquire 
a route for the channel using the CCMA Configuration page. This route name must match the 
stream key that you configure. For more information, see Administering Avaya Contact Center 
Select.
To provide music to callers, add or edit a flow application or script to provide scripted music using 
OD, using the Route Number entered in the CCMA Configuration page. For more information, see 
Using Contact Center Orchestration Designer.

Note:
Perform this procedure on every primary Avaya Aura® Media Server.

Procedure
1. Log in to Element Manager.

2. In the navigation pane, click System Configuration > Media Processing > Music > 
Stream Provisioning.

3. Click Add.

4. From the Stream Type list, select the streaming music source type.

5. In the Name field, type a name for the new music source.

This is the stream key that you use to create a route in CCMA.

6. Do not enter a value in the Domain field; if you do, you create a stream key that you 
cannot use as a Route name in CCMA.

7. In the Primary URL field, type the address of the music source.

8. To provide an alternate music source, in the Backup URL field, type the address of 
another music source.

Avaya Aura® Media Server switches to the backup music source when the primary source 
is unavailable.

9. If you want to add the music source in the locked state so that Avaya Aura® Media Server 
cannot use the new music source, select the Locked check box.

To use this music source later, you must edit the music source to unlock it.

10. Click Save.

Configuring a streaming music source
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Chapter 19: Avaya Contact Center Select 
Server Configuration

This chapter describes how to change the configuration properties for the Avaya Contact Center 
Select software on your server. Configure the Avaya Contact Center Select server using Server 
Configuration. Use the Server Configuration utility to modify the data entered during the initial 
configuration of the Avaya Contact Center Select server. You can change the local settings, 
licensing, and network settings information.

Changing the local settings configuration
About this task
Change the local configuration settings of the Avaya Contact Center Select server, if you need to 
change the names and IP addresses required for Contact Center to run.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click Server Configuration.

3. In the Server Configuration dialog box, click the Local Settings tab.

4. Update the local settings.

5. Click Apply All.
6. Click Exit.
7. If prompted, restart the server.

Variable definitions
Name Description
Customer Name The designated contact person at the company that 

uses Contact Center software.
Company Name The name of the company that uses the Contact 

Center software.

Table continues…
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Name Description
CLAN subnet IP Address The IP address of the Contact Center server.
Site Name The site name for the Contact Center.

The site name must not contain spaces or non 
alphabetical characters except for hyphen (-) and 
underscore (_). The first character must be a letter. 
The site name must be unique and can consist of 
any combination of 6 to 15 characters.

Real-Time Statistics Multicast IP Address The RSM IP address of the server to associate with 
sending real-time data.

The IP address must be 224.0.1.0 to 
239.255.255.255. The default is 234.5.6.10.

Changing the licensed features configuration
About this task
Change the licensing configuration of the Avaya Contact Center Select to update the licensing 
details.
You can use this application to enable or disable Avaya Contact Center Select licensed features, 
including Open Queue.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click Server Configuration.

3. In the Server Configuration dialog box, click the Licensing tab.

4. Update the licensing details.

5. Click Apply All.
6. Click OK.

7. Click Exit.
8. If prompted, restart the server.
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Variable definitions
Name Description
CCMS Package The installation package indicates the licenses that 

you purchased with Contact Center:

• Nodal Enterprise: The base package for Contact 
Center.

Optional Packages You must choose the package you purchased. 
Packaged features includes:

• Web Based Statistics: Use Agent Web Statistics 
on Agent Desktop, so that agents and supervisors 
can use Agent Desktop to view real-time 
statistics for call handling, skillset data, and state 
information on Agent Desktop.

• Multiplicity: Use Multiplicity to ensure an agent 
can handle multiple concurrent contacts. At any 
one time an agent can be active on a voice and 
multimedia contact; only one of these can be 
active, the others automatically are on hold.

• Open Queue: Use Contact Center Multimedia 
to route multimedia contacts to agents by using 
the existing scripting and skillset routing features 
available for calls.

• Open Interfaces Open Queue—The Web services 
are a series of Open Interfaces provided to 
third parties to enable application communication 
based on the SOA architecture. The Web services 
ensure customers can discover the functions 
offered by each Web service using the WSDL 
provided.

• Off Site Agent: This feature allows agents to log 
on to Agent Desktop in Other Phone mode. This 
allows agents to handle skillset calls regardless of 
location.

Changing the IP Office network data
About this task
Change the IP Office network data after you install Avaya Contact Center Select to enable 
communication with the IP Office platform.
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Important:
Changes to the IP Office network data sometimes requires restarting Avaya Contact Center 
Select.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click Server Configuration.

3. In the Server Configuration dialog box, under SIP, click the Network Settings tab.

4. Update the IP Office Settings details.

5. Click Apply All.
6. Click OK.

7. Click Exit.
8. If prompted, restart the server.

Variable definitions
Name Description
IP Office Address The IP address of the IP Office server.
Voice Proxy Server — Port The server listening port. The default port is 5060.
IP Office System Password The system password for your IP Office server. 

Ask your IP Office Administrator for the System 
Password. If this password changes on the IP 
Office server, you must update the password in 
Server Configuration.

Changing the Local Subscriber data
About this task
Change the local subscriber data after you install Avaya Contact Center Select to enable 
communication with other network elements.

Important:
Changes to the Local Subscriber data sometimes requires restarting Avaya Contact Center 
Select.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click Server Configuration.

3. In the Server Configuration dialog box, under SIP, click the Local Subscriber tab.

Changing the Local Subscriber data
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4. Update the SIP Local Subscriber details.

5. Click Apply All.
6. Click OK.

7. Click Exit.
8. If prompted, restart the server.

Variable definitions
Name Description
Domain Name The SIP domain name of Avaya Contact Center 

Select. This domain name must match the IP Office 
SIP domain name.

MS Locale Locale (including language and dialects) of the 
system environment.

Local Listening Ports The SIP Communication protocol accepted by the 
system for incoming calls.

• TCP/UDP Port default is 5060.

• TLS Port default is 5061.
SIP Line Extension Number The IP Office SIP User Extension Number used to 

register Avaya Contact Center Select.
Password The password of the IP Office SIP User Extension 

Number used to register Avaya Contact Center 
Select.
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Chapter 20: REST API configuration

Contact Center enables you to invoke REST API in a Contact Center workflow. Representational 
state transfer (REST) provides efficient scalable services for web communications.
A Contact Center workflow can request data using scripting commands. The workflow uses the 
TfeRestService to request and retrieve data from the REST API.
The Contact Center workflows pass JSON data to the TfeRestService, which identifies the REST 
API to invoke and populates the REST API parameters. The data returned from the API is 
reconfigured into a JSON object and then passed back to the workflow. Contact Center supports 
generic REST API exposed as a URL endpoint and query string parameters.
For more information about creating and configuring Contact Center workflows for REST API 
integration, see Using Contact Center Orchestration Designer.

TFE REST Configurator
Contact Center provides an application to configure and test REST API calls. The TFE REST 
Configurator enables you to configure your REST API endpoint and parameters, and to test your 
configuration. If you receive a successful response after sending the test request, you can then 
save your configuration to the database. You can use the application to create GET, POST, PUT, or 
DELETE requests.
You can also add environments using the TFE REST Configurator. Environments enable the use 
of environment variables. An environment variable is shared across all requests associated with 
the environment. For example, a service defines a security access token that must be included 
in the header of all requests for that service. Contact Center provides a default environment 
named ‘No environment’. You cannot delete this environment. When you create a new request, it is 
automatically associated with the default environment, unless you select an alternative environment 
that you previously created. The TfeRestService replaces any environment variables in the request 
with the variable value that you set when creating the environment.

REST API security
Using the TFE REST Configurator, you can configure the following authorization protocols:

• No Auth
• Basic Auth
• OAuth 2.0
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Adding a new environment
About this task
Add environments using the TFE REST Configurator. Environments enable the use of 
environment variables.

Procedure
1. From the Start menu, in the Avaya area, click REST Configurator.
2. In the TFE REST Configurator application, click the Environment settings icon.

3. On the Environment window, click the New environment icon.

4. In the Key and Value fields, type the key and value for the environment variable.

5. Click Add.

Creating and testing REST requests
About this task
Use the TFE REST Configurator to configure your REST API endpoint and parameters, and to 
test and save your configuration. The TFE REST Configurator supports the GET, POST, PUT, and 
DELETE request methods.
You can configure multiple key-value pairs for testing. The key-value pairs are JSON encoded.

Important:
When you finish this procedure, note the ID of your saved REST requests. The ID is required 
when you configure scripts for REST API integration.

Before you begin
• Ensure that you have all required REST API endpoint and security details.
• Add an environment if required.
• Ensure that you have a valid endpoint certificate.

If you do not have a valid certificate, you see an error when using a secure SSL or HTTPS 
connection. The error message indicates that the request cannot be sent and that the 
underlying connection was closed.

Procedure
1. From the Start menu, in the Avaya area, click REST Configurator.
2. In the TFE REST Configurator application, click the New request option.

3. From the drop-down list, select an environment if required.

The default environment is automatically selected.

REST API configuration
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4. If security details are required to test the REST API endpoint, click the Authorisation tab.

If security is not required, skip to step 7 on page 277.

5. Select Basic Auth or OAuth 2.0.

6. If you select Basic Auth:

a. In the Username box, type the username for the REST API endpoint.

b. In the Password box, type the password.

7. If you select OAuth 2.0:

a. To create a new access token, click New token.

If an access token already exists, skip to step 7.h on page 277.

b. On the Access Token window, in the Token Name field, type a name for the token.

c. In the Access Token URL field, type the URL to access the security token for your 
endpoint.

d. In the Client ID field, type the client ID that identifies the endpoint.

e. In the Client Secret field, type the OAuth 2.0 client secret generated for the endpoint.

f. From the Client Authentication list, select the authentication method for your 
endpoint.

g. Click Request.
h. From the Available tokens list, select the access token you created.

8. From the request method drop-down list, select one of the following request methods for 
the new request:

• GET

• POST

• PUT

• DELETE

9. In the Please enter request field, type the request URL.

10. Click the Parameters tab to add parameters to the request.

11. In the Key and Value fields, type one or more key-value pairs to test.

12. Click the Headers tab to add header data to the request.

13. In the Key and Value fields, type one or more key-value pairs of header data to test.

If you selected the POST request method above, set the following key-value pair for the 
header:

• Key: content-type
• Value: application/json

Creating and testing REST requests
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14. Click the Body tab to configure the body data in the request.

15. Select one of the following options:

• form-data

• x-www-form-urlencoded

• raw

16. If you selected form-data or x-www-form-urlencoded, type one or more key-value pairs 
of body data in the Key and Value fields.

17. If you selected raw, select one of the following content types from the drop down list:

• Text

• JavaScript

• JSON

• HTML

• XML

18. In the text box, type the request body.

19. Click Execute to run the request.

The result of the request is displayed in the Response panel.

If you do not have a valid trusted endpoint certificate, an error is displayed when you 
try to run an HTTPS URL. You can ignore the certificate error for invalid or outdated 
certificates. For information about uploading a valid certificate, see Uploading a trusted 
endpoint certificate on page 278.

20. If the request was successful, click Save to add the REST request to the database.

21. In the Warning dialog box, click Continue.

22. In the Success dialog box, click OK.

The REST request is displayed in the REST Services list.

Uploading a trusted endpoint certificate
About this task
You must have a valid trusted endpoint certificate when creating a REST request. This trusted 
certificate is required for secure HTTPS connections. If you do not have a valid certificate, an 
Unable to send the request error message is displayed. To resolve this error, upload a 
valid endpoint certificate to the Trusted Root Authorities store.

Procedure
1. On the Contact Center server, run the MMC command.

REST API configuration
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2. From the console window, click File > Add/Remove Snap-in.

The Add or Remove Snap-ins window is displayed.

3. From the Available snap-ins list, click Certificates and then click Add.

4. From the list of account options on the Certificates snap-in window, click Computer 
account.

5. Click Next.
6. When prompted to specify the computer the snap-in will manage, click Local computer.
7. Click Finish.

8. In the Add or Remove Snap-ins window, click OK.

9. From Start > Control Panel, navigate to Manage computer certificates.

10. From [Certificates - Local Computer], expand Trusted Root Certification Authorities.

11. Right-click the Certificates folder and then click All Tasks > Import.
12. On the Certificate Import Wizard window, click Next.
13. Click Browse and navigate to the certificate file you want to import.

14. Click Next.
15. When the import process is complete, click Finish.

Related links
Administering security on page 334

Updating a REST request
About this task
Use the TFE REST Configurator to update your saved REST requests.

Procedure
1. From the Start menu, in the Avaya area, click REST Configurator.
2. From the REST Services list, select the request to update.

3. Modify the request.

4. Click Execute to test the updated request.

The result of the request is displayed in the Response panel.

5. If the request was successful, click Update to add the REST request to the database.

6. In the Warning dialog box, click Continue.

7. In the Success dialog box, click OK.

Updating a REST request
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The REST request is displayed in the REST Services list.

Deleting a REST request
About this task
Use the TFE REST Configurator to delete your saved REST requests from the database.

Procedure
1. From the Start menu, in the Avaya area, click REST Configurator.
2. From the REST Services list, select the request to delete.

3. Click Delete.

4. In the Warning dialog box, click Continue.

5. On the Success box, click OK.

The REST request is removed from the REST Services list.

Updating an environment
About this task
Update an environment using the TFE REST Configurator.

Procedure
1. From the Start menu, in the Avaya area, click REST Configurator.
2. In the TFE REST Configurator application, click the Environment settings icon.

3. On the Environment window, select the environment to edit and click the Edit 
environment icon.

4. Edit the Key and Value fields as required.

5. Click Update.

Deleting an environment
About this task
Delete an environment using the TFE REST Configurator.
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Procedure
1. From the Start menu, in the Avaya area, click REST Configurator.
2. In the TFE REST Configurator application, click the Environment settings icon.

3. On the Environment window, select the environment to delete and click the Delete 
environment icon.

4. In the Warning dialog box, click Continue.

The environment is deleted.

Deleting an environment
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Chapter 21: Avaya Contact Center Select 
routine maintenance

This chapter describes how to maintain the Avaya Contact Center Select software and server. You 
must maintain Avaya Contact Center Select to protect against data loss and to ensure that you are 
using the most recent software.

The Avaya Aura® Media Server software appliance does not support root account access; therefore, 
it has distinct routine maintenance instructions. When maintaining the Avaya Aura® Media Server 
software appliance, use the procedures specific to the software appliance. Use the Avaya Aura®

Media Server Open Virtual Appliance (OVA) file to create a VMware-based Avaya Aura® Media 
Server software appliance.

Database maintenance
Perform an immediate backup of the Avaya Contact Center Select databases to save the current 
data. Complete this procedure after you complete your installation or when any significant change 
occurs in the database, so that you can restore the database easily. Perform backups during low 
traffic periods. Avaya Contact Center Select services are not shut down during backups. Back up 
the databases to a secure network location. Schedule regular backups of the Avaya Contact Center 
Select databases to ensure resiliency against media failure or data loss. You can also restore the 
database content to your server using the Database Maintenance utility.
Avaya Contact Center Select logs a warning message when there has not been a scheduled or 
manual backup for a specified number of days. You can configure the number of days before Avaya 
Contact Center Select logs the warning. The default is seven days. The Database Maintenance 
Utility also displays the time that has elapsed since the last backup.

Backing up the Contact Center databases
About this task
Perform an immediate backup of the Contact Center server databases to save the current data. 
Perform a scheduled backup to maintain snapshots of data for emergency purposes. For more 
information about scheduled backups, see Scheduling a backup of the Contact Center server 
databases on page 286.
It is important to complete this procedure after you complete your installation or when any 
significant change occurs in the database, so that you can restore the database easily if required.
Perform backups during low traffic volume periods.
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Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.

2. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

3. In the right pane, click Create.

4. From the Drive Letter list, select the network drive on which to store the Contact Center 
database.

5. In the UNC Path box, type the location to store the backup, in the format \\Computer 
Name\Folder\Backup Location.

6. In the Username box, type the user name used to log on to the computer specified in the 
UNC Path box. The user name is in the format Computer Name\Account Name.

7. In the Password box, type the user password.

8. Click Save.

Backing up the Contact Center databases
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9. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Immediate Backup.

10. In the Media Type section, select Network Location.

11. From the Backup Location list, select the network drive on which to store the backup.

12. Click Backup.

13. Click Yes, to continue with the backup.

The database is backed-up.

14. Click Exit.
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Configuring the overdue backup notification
About this task
Avaya Contact Center Select logs a warning message when there has not been a scheduled or 
manual backup for a specified number of days. Configure the number of days after which Avaya 
Contact Center Select logs a warning that a backup is overdue.

Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.

2. In the Database Maintenance dialog box, click Backup Locations.

3. In the right pane, in the Number of days without a backup before notification box, type 
the number of days after which Avaya Contact Center Select logs a warning that a backup 
is overdue.

You can set the notification period from 1 day to 999 days. The default value is seven days.

4. Click Save.

Creating a backup location for scheduled backups
Before you begin
Ensure that you log in with a user account with full permissions to access the location where you 
store database backups.

About this task
Create a backup location on your network with the correct access permissions to ensure that you 
have a designated location for the scheduled backups.

Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.

2. In the Database Maintenance window, click Backup Locations.

3. In the right pane, click Create.

4. From the Drive Letter list, select a drive letter.

5. In the UNC Path text box, type the location to which to back up the database.

6. In the Username box, type the username used to log in to the server specified in the UNC 
Path box in the format Computer Name\Account Name.

7. In the Password box, type the Windows password.
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8. Click Save.

Scheduling a backup of the Contact Center server 
databases

Before you begin
• Create a backup location. For more information, see Creating a backup location for 

scheduled backups on page 285.

About this task
Schedule a backup of the Contact Center server databases to save the data regularly. Perform a 
scheduled backup to maintain snapshots of data for emergency purposes.
Perform backups during low traffic volume periods.
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Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.

2. In the Database Maintenance dialog box, in the left pane, click Scheduled Backup.

3. In the right pane, click Create.

4. Under General Properties, in the Name box, type a name for the scheduled backup.

5. From the Media Type list, select Network Location.

6. In the Start Date box, type the date on which to begin scheduled backups.

OR

Click the calendar icon and select a date on which to begin scheduled backups.

7. In the Start Time box, select the time to start the backup.

8. From the Backup Location list, select a drive to store the backup.

9. From the Frequency list, select the frequency of the backup.
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10. Click Save.

11. In the confirm dialog, click OK.

12. Click Exit to close the Database Maintenance utility.

Restoring the Avaya Contact Center Select Release 7.x 
databases

Before you begin
• Back up the old databases.
• Map a drive to the database backups.

About this task
Restore the Avaya Contact Center Select Release 7.x databases. You must complete this 
procedure to ensure all databases are restored at the same time.

Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.

2. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

3. In the Backup Locations pane, click Create.

4. Select the Drive Letter, UNC path, username, and password to specify the network location 
where you stored the server database backup.

5. Click OK.

6. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Restore.

7. In the Media Type area, select Network Location.

8. In the Application area, select CCT, CCMS, CCMM, ADMIN, and CCMA.

9. From Restore contents, select Data and Offline.

10. From the Backup Location list, select the network drive containing the backed up Avaya 
Contact Center Select server databases.

11. Click Restore.

12. Use the Progress information field to monitor the progress of the restoration.

13. On the Database Maintenance message box, click OK.

Wait for the restore to complete.

14. From the Start menu, in the Avaya area, click Server Configuration.
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15. In the Server Configuration window, in the Main Menu pane, click Local Settings.

16. In the Avaya Server Subnet pane, in the IP Address field, enter the IP address of the 
Avaya Contact Center Select server.

17. In the Site Name pane, enter the name of the Avaya Contact Center Select server.

18. Click Apply All.
19. In the Updated IP Warning dialog box, click OK.

20. In the Make changes to AAMS Content Store dialog box, click OK.

21. Restart the Avaya Contact Center Select server.

Logging in to Avaya Aura® Media Server Element Manager
Before you begin
Obtain a valid user name and password to access Avaya Aura® Media Server Element Manager.

About this task
Log in to the Avaya Aura® Media Server Element Manager as an administrator to configure Avaya 
Aura® Media Server.
Element Manager (EM) is a web-based administration tool that facilitates the Operation, 
Administration, and Maintenance (OAM) of Avaya Aura® Media Server.

Procedure
1. On the Avaya Contact Center Select server, start a web browser and type https://

SERVER_IP_ADDRESS:8443/em in the address box.

SERVER_IP_ADDRESS is the IP address of the Avaya Aura® Media Server.

2. In the User ID box, type the Avaya Aura® Media Server User ID account name.

The default Element Manager User ID account name is Admin.

3. In the Password box, type the Avaya Aura® Media Server Element Manager password.

Admin123$ is the default Element Manager password.

4. Click Log in.
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Creating a backup destination for Avaya Aura® Media 
Server

Before you begin
• Configure the destination ftp server and check that it is operational. If you plan to use the 

default backup location for Avaya Aura® Media Server backups, do not configure an ftp 
server.

• Ensure that you have the address or host name, ftp account details, and path for the backup 
server.

About this task
Create a location to store backups. You can specify an ftp server to which you can send backups 
from Avaya Aura® Media Server Element Manager.
You can configure any number of remote backup destinations. When performing remote backup 
destinations, Element Manager (EM) uploads the backup files to the specified File Transfer 
Protocol (FTP) server and then deletes the duplicate backup files from the Avaya Aura® Media 
Server server. To perform a backup and restore, you must have permission to upload files to the 
remote backup destination.
You can accept the default backup location to save the Avaya Aura® Media Server backup on the 
local server. Avaya Aura® Media Server stores the backups in:

• For Linux: $MASHOME/platdata/EAM/
• For Windows: %MASHOME%\platdata\EAM

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Expand Tools > Backup and Restore > Backup Destinations.

3. On the Backup Destinations page, click Add.

4. In the Destination Name field, type a unique name for the backup destination.

5. In the Host Name field, type the host name of the destination server.

6. In the User Name field, type the ftp user name.

7. In the Password field, type the ftp password.

8. In the Destination Path field, type the path on the backup location to specify where the 
backup function writes the backup files.

9. Optionally, click Test to test your connection.

10. Click Save.
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Backing up the Avaya Aura® Media Server database
Before you begin

• Configure the destination ftp server and check that it is operational.
• Ensure that you have the address or host name, ftp account details, and path for the backup 

server.

About this task
Create a location to store backups. You can specify an ftp server to which you can send Avaya 
Aura® Media Server Element Manager backups. Backup the Avaya Aura® Media Server data so 
you can restore it on the new server.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Expand Tools > Backup and Restore > Backup Tasks.

3. On the Backup Tasks window, click Add.

4. On the Add New Backup Task window, in the Backup Task Name box, type a name for 
this backup.

5. Select System Configuration.

6. Select Application Content.
7. Choose the backup destination that you created for the migration.

8. Select Manually, as needed.

9. Click Save.

10. In the Backup Tasks window, select the backup task you created.

11. Click Run Now.

The Confirm Backup window appears, showing the backup task name details about the 
backup.

12. Click Confirm.

The History Log Window appears. When the backup is complete, the backup details 
appear in the list.

Recovering a scheduled backup
Before you begin

• Ensure that you view the event in Windows Event Viewer and address the reason why the 
scheduled backup failed.
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About this task
Recover a scheduled backup if an error occurs while the backup is running. A scheduled backup 
failure can occur for several reasons, for example, if the backup location is not available or if 
there is not enough space to save the backup file. If an error occurs, the scheduled backup stops 
running and an event is created. To view the event, use Windows Event Viewer.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click Database Maintenance.

3. In the Database Maintenance dialog box, in the left pane, click Scheduled Backup.

4. Click the name of the scheduled backup you want to recover.

5. Click Reset.
6. Click OK.

To run the schedule next time the error is cleared and the scheduled backup is recovered.

Restoring the Avaya Aura® Media Server database
Before you begin
Copy the backup zip files to the new Avaya Aura® Media Server server. The backup file names 
derive from the name that you entered in Element Manager for the backup task.

About this task
Restore the Avaya Aura® Media Server database backup data.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Expand Tools > Backup and Restore > Restore.

3. On the Restore window, from the Restore Source list, select Upload Backup Files.

4. Click Browse.

5. Select the Avaya Aura® Media Server backup that you want to restore.

6. Click Upload Files.

7. On the Confirm Restore page, review the information and click Confirm to proceed with 
the restore.

8. Restart the server.
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Backing up the Avaya Aura® Media Server software 
appliance database

About this task
Backup the Avaya Aura® Media Server software appliance database. The Avaya Aura® Media 
Server software appliance (OVA) does not support root access. Use this procedure to backup data 
on an Avaya Aura® Media Server software appliance.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Navigate to Tools > Backup and Restore > Backup Tasks.

3. Create or select an existing backup task that includes System Configuration and 
Application Content backup types.

4. Click Run Now.

5. To monitor the Backup and Restore History Log, navigate to Tools > Backup and 
Restore > History Log.

After the backup is complete, the log shows a completed backup task entry.

6. If you are using an FTP or SFTP backup destination, ensure that the backup files are 
saved to their required location.

There is one file for each backup type for a total of two backup files.

7. If you are using a local backup destination and are about to perform an upgrade or 
redeploy of the Avaya Aura® Media Server appliance, move the backup files to a safe 
location by performing the following steps:

a. Log in to a Linux shell using the customer cust account.

b. Change to the public directory by using the cdpub alias or the following command:

cd /opt/avaya/app/pub
c. List the backups available on the local system by using the following command:

bkupFile –list
d. Move the recent configuration and application data backups from the local backup 

storage to the current directory by using the following commands:

bkupFile –retrieve SystemConfiguration_backup.zip
bkupFile –retrieve ApplicationContent_backup.zip

e. Save both backup files in a safe location by using the SFTP file transfer tool, or 
another similar tool, to transfer the files off the server.

f. After you confirm the files are safely saved, you can delete the backup files from the 
current directory to free disk space.
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Uploading a backup file to an Avaya Aura® Media Server 
software appliance

About this task
Upload a backup file to an Avaya Aura® Media Server software appliance (OVA). The Avaya 
Aura® Media Server software appliance (OVA) does not support root access. Use this procedure 
to upload data to a default backup folder on an Avaya Aura® Media Server software appliance.
The default backup folder: $MASHOME/platdata/EAM/Backups
Procedure

1. Log in to Avaya Aura® Media Server Element Manager.

2. Navigate to Tools > Backup and Restore > Restore.

3. On the Restore page, in the Restore Source drop-down list, select Upload Backup Files.

4. Click Browse to select the backup files.

You can upload a System Configuration and Application Content backup at the same time.

5. On the Confirm Restore page, click Confirm to proceed with the upload.

Important:

Restoring a backup archive might impact running applications. After you click Confirm, 
the system invokes the restore task. Then Element Manager and Avaya Aura® Media 
Server close the connections to all users until the system completes the restoration.

Restoring data from the local folder on an Avaya Aura®

Media Server software appliance
Before you begin
Upload a backup file to the Avaya Aura® Media Server software appliance.

About this task
Restore an Avaya Aura® Media Server OVA database from a default backup folder. The Avaya 
Aura® Media Server software appliance (OVA) does not support root access. Use this procedure 
to restore data to an Avaya Aura® Media Server software appliance.
The default backup folder: $MASHOME/platdata/EAM/Backups
Procedure

1. Log in to Avaya Aura® Media Server Element Manager.

2. Navigate to Tools > Backup and Restore > Restore.
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3. On the Restore page, in the Restore Source drop-down list, select Default Backup 
Destination.

4. From Restore Task List, select the backups from the list which you want to use for the 
restore.

Important:

To ensure that the application data is restored to the configured location, restore the 
system configuration data before restoring the application data.

5. Click Restore Now.

6. On the Confirm Restore page, click Confirm to proceed with the restore.

Important:

Restoring a backup archive might impact running applications. After you click Confirm, 
the system invokes the restore task. Then Element Manager and Avaya Aura® Media 
Server close the connections to all users until the system completes the restoration.
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Chapter 22: Simple Network Management 
Protocol administration

Windows provides a Simple Network Management Protocol (SNMP) agent, which runs as a service 
on each Contact Center server. Contact Center servers use this service to forward events to a 
Network Management System (NMS) on your network. Contact Center automatically installs the 
Windows SNMP Service.

For more information about event codes and a list of recommended events to forward, see Contact 
Center Event Codes.

This chapter describes how to configure the Simple Network Management Protocol for your contact 
center.

Configuring Windows SNMP Service
About this task
Configure Windows Simple Network Management Protocol (SNMP) service on each Contact 
Center server to forward events to a Network Management System (NMS) on your network.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Start screen, click Administrative Tools  > Services.

3. In the Services window, select the SNMP Service.

4. Click Action  > Properties.

5. In the SNMP Service Properties window, click the Traps tab.

6. If no community name is defined, in the Community name box, type public.

7. Click Add to list.
8. Click Add to add the IP address of the NMS to which the server sends traps.

9. In the SNMP Service Configuration window, type the IP address of the NMS.

10. Click Add.

11. In the SNMP Service Properties window, click Add.
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12. In the Services window, right-click the SNMP Trap Service, and select Start.
13. Close the Services window.

Selecting CCMS events to be forwarded
About this task
Contact Center Manager Server uses SNMPFilterCnfg.exe to forward all Contact Center 
Manager Server related events. These events fall between the range of 44900 to 51400.

Procedure
1. Using Windows Explorer, browse to the folder D:\Avaya\Contact Center\Manager 

Server\bin, and double-click SNMPFilterCnfg.exe.

2. In the Level of Filtering box, select the types of events that you want to forward to the 
Network Management System (NMS).

Important:

All displayed event types and the type that you select are also forwarded. For example, 
if you select Major, then all Unknown, Critical, and Major events are forwarded.

3. Click OK.

Selecting CCMA, LM, CCT, and CCMM events to be 
forwarded

About this task
Contact Center Manager Administration, License Manager, Communication Control Toolkit, and 
Contact Center Multimedia use the Windows Server Event to Trap Translator (evntwin.exe) to 
select the events to be forwarded to the Network Management System (NMS).
When you are selecting events to forward, not all event sources populate the event descriptions. 
For some event sources, the Event to Trap Translator shows event codes and descriptions, and 
for others it shows event codes.
Avaya provides a SNMP Trap Configuration File (.cnf) that is aligned with the Contact Center 
Event Codes document. Download the Contact Center Release 7.1 SNMP Trap Configuration File 
from the Avaya Support website at http://support.avaya.com. The file is available in the Contact 
Center software download Service Pack section. You can load this SNMP Trap Configuration file 
into the Event to Trap Translator on the Contact Center server.
In addition to the recommended SNMP Traps, you can add additional event codes to be forwarded 
to the NMS.
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For more information about event codes, event source names, and a list of recommended events 
to forward, see Contact Center Event Codes.

Procedure
1. Download the Contact Center SNMP Trap Configuration file (.cnf) from the Avaya Support 

website at https://support.avaya.com.

The file is available in the Contact Center software download Service Pack section. You 
can copy the .cnf file to the Contact Center server.

2. On the Contact Center server, open a command window and navigate to the location of the 
downloaded .cnf file.

3. Use the Windows evntcmd utility to load the SNMP Trap Configuration file.
evntcmd -v 10 <SNMP Trap Configuration file name.cnf>

For example: evntcmd -v 10 ACC_7_1_0_0_SNMP_Trap_File_ver1_0.cnf
4. On the Desktop page, right-click the Windows icon and select Run.

5. In the Run text box, type C:\Windows\System32\evntwin.exe.

6. On the Event to Trap Translator window, under Configuration type, select Custom.

Ensure the recommended event traps from the Contact Center Event Codes document are 
listed.

Important:

Contact Center and related event sources are listed under several categories, 
including Application and System. License Manager events are listed under the NGEN 
event source.

7. Click OK to save the settings.

8. (Optional) Add additional event codes to be forwarded to the NMS.

a. Click Edit.
b. Under Event sources, click the folder for the event source you require.

Contact Center and related event sources are listed under several categories, 
including Application and System. License Manager events are listed under the 
NGEN event source.

c. From the list of events, double-click the event you want to convert to an SNMP trap.

d. On the Properties window, click OK if no change is required to generate the trap.

e. Repeat these sub-steps for each event that you want added to the list of events to be 
translated into SNMP traps.

9. Close the Event to Trap Translator window.
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Configuring the NMS
About this task
After you configure the server, you must configure the Network Management System (NMS) to 
receive and interpret traps (including identification to the NMS, and the origin and format of the 
Contact Center traps).
Load or compile the Contact Center Manager Server Management Information Block (MIB) files in 
the NMS. The following Contact Center Manager Server MIB files describe the format of the traps 
generated by Contact Center Manager Server:

• NB-FLT.mib - This is an SMNP v1 MIB that supports RFCs 1115,1212,1213 & 1215. This MIB 
describes the format of the traps that are sent from Contact Center Manager Server.

• RR-AACCDB.mib - This is an SNMP v2 MIB that supports RFCs 2578, 2579, & 2580. This 
MIB describes the format of the traps that are sent from the Contact Center Cache Database 
component.

You can use these files on the NMS system.
• The NB-FLT.mib file is available on the Contact Center Manager Server server, in the 
D:\Avaya\Contact Center\Manager Server\data folder.

• The RR-AACCDB.mib file is available on the Contact Center Manager Server server, in the 
D:\Avaya\Contact Center\Common Components\Cache folder.

Procedure
For more information about configuring your NMS, see your NMS documentation.
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Chapter 23: Licensing administration

The Contact Center License Manager (LM) controls the licensing for Avaya Contact Center Select. 
Contact Center License Manager provides central control and administration of application licensing 
for all elements of Avaya Contact Center Select.

If the Contact Center cannot communicate with Contact Center License Manager, it continues to 
function for a period of time. This is called a grace period. If the grace period expires, Contact 
Center shuts down and locks. You cannot restart Contact Center without resetting the grace period.

Important:

Avaya Aura® Media Server does not support the grace period. In a Hardware Appliance 
deployment of Avaya Contact Center Select, if the licensing services stop, Avaya Aura® Media 
Server stops and Contact Center ceases to process voice contacts.

This chapter describes how to configure Contact Center License Manager for your contact center.

Resetting the grace period
Before you begin

• You must apply separate unlock codes for the CCMS Control Service and the ASM Service. 
Repeat this procedure for each service.

• Obtain a Grace Period Unlock Code from Product Support.

About this task
If Contact Center is not able to communicate with Contact Center License Manager, normal 
operation of the Contact Center Manager Server continues for a period of time called a grace 
period.
If the grace period expires, Contact Center shuts down and locks. You cannot restart Contact 
Center without resetting the grace period.
When a communication error occurs, an event is fired to the Server Utility. The Server Utility 
records the details, the time elapsed in the Grace Period and a Grace Period Lock Code. These 
details must be sent to Product Support to obtain a Grace Period Unlock Code. Use this Grace 
Period Unlock Code to unlock the server and continue working.

Procedure
1. Log on to the Contact Center server.
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2. From the Event Viewer, make a copy of the lock code and send this code to Product 
Support.

3. From the Start menu, in the Avaya area, click License Grace Period Reset.
4. Enter the unlock code you received from Product Support.

5. Click Apply.

6. Click Exit.
7. Restart Contact Center.

Updating the license file
About this task
Update the license file to upgrade or expand your Avaya Contact Center Select solution.
If you are using a remote Avaya WebLM server, see the Avaya WebLM documentation for 
instructions on applying your updated license file on the Avaya WebLM server.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click License Manager Configuration.

3. Select the Configuration tab.

4. From the License Type list, select the type of license you are using.

5. Click Browse to navigate the file system and locate the new license file.

6. Click Open.

7. Click Apply.

8. On the dialog, click Yes to restart Contact Center License Manager.

9. Click Close to close the window.

Changing the licensing information for Contact Center
Before you begin

• Shut down the Contact Center services on the server.
• Plan to restart the server at the end of this procedure.

About this task
Change the license manager package information on the Avaya Contact Center Select server if 
you purchased additional features.
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Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click System Control and Monitor Utility.

3. Click the Contact Center tab.

4. Click Shut down Contact Center.

Contact Center shuts down.

5. From the Start menu, in the Avaya area, click Server Configuration.

6. Click Licensing.

7. Under License Manager Package, change the Package and Features information to 
reflect your new licensed options.

8. Click Apply All.
9. Click Yes to restart the server.

Configuring a remote Avaya WebLM server
About this task
Configure Contact Center License Manager to use a remote Avaya WebLM server without 
centralized licensing. Contact Center License Manager can obtain licenses from a remote Avaya 
WebLM server, and then use these licenses to control Avaya Contact Center Select licensed 
features.
Refer to the Avaya WebLM documentation for instructions on applying your updated license file on 
the remote Avaya WebLM server.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click License Manager Configuration.

3. Click the Configuration tab.

4. From the License Type list, select the Remote WebLM license.

5. In the WebLM IP or Fully Qualified Domain Name box, type the IP address or FQDN 
host name of the remote Avaya WebLM server.

6. Click Apply.

7. On the dialog, click Yes to restart Contact Center License Manager.

8. Click Close to close the window.
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Configuring Avaya WebLM centralized licensing
About this task
Configure Contact Center License Manager to use Avaya WebLM centralized licensing in an 
Avaya Contact Center Select Powered solution. Contact Center License Manager can share 
licenses from an Avaya WebLM server with centralized licensing, and use these licenses to control 
ACCS licensed features.
Refer to the Avaya WebLM documentation for instructions on applying your updated license file on 
the remote Avaya WebLM server.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click License Manager Configuration.

3. Click Configuration.

4. From the License Type list, select Remote WebLM.

5. Select Centralized Licensing.

6. In the WebLM IP or Fully Qualified Domain Name box, type the IP address or FQDN 
host name of the Avaya WebLM server.

7. In the CLID box, type the Centralized License ID (CLID) for this ACCS server.

8. Click Apply.

9. On the dialog, click Yes to restart Contact Center License Manager.

10. Click Close to close the window.

Checking the Host ID of the Local WebLM
About this task
Use this procedure to check the Host ID of the Local WebLM.

Procedure
1. Start the License Manager Configuration Tool and then click the Configuration tab.

2. If not already selected, select Local WebLM from the drop-down list.

3. Select the Host ID check box.

The License Manager Configuration Tool displays the Host ID of the Local WebLM. You 
can copy the Host ID if needed.
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License expiration
When a temporary license expires, Contact Center enters the Avaya-standard Grace Period. The 
Avaya-standard Grace Period is a 30-day period that enables Contact Center to function when a 
temporary license expires. During this period, Contact Center continues to operate normally.

When the Avaya-standard Grace Period starts, the Event Viewer displays a Critical event number 
61120. This event number indicates that the license is in the 30-day expiry period and must 
be replaced. As the Avaya-standard Grace Period expires, the Event Viewer generates a daily 
event number 61117 specifying the number of days left until the license expiration. When the 
Avaya-standard Grace Period expires, the Event Viewer displays a Critical event number 61118 
and Contact Center shuts down.
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Chapter 24: Dialed number identification 
services configuration

This section describes the configuration you must perform on IP Office to support dialed number 
identification service (DNIS) on Avaya Contact Center Select.

DNIS is an optional service that Avaya Contact Center Select uses to identify the phone number 
dialed by the incoming caller. Avaya Contact Center Select uses direct dial-in (DDI) information it 
receives from IP Office to route calls to appropriate skillsets or agents based on DNIS numbers.

You must also configure DNIS numbers in Contact Center Manager Administration. For more 
information about configuring DNIS numbers in Contact Center Manager Administration, see 
Administering Avaya Contact Center Select.

Configuring DNIS on IP Office
About this task
A dialed number identification service (DNIS) is an optional service that Avaya Contact Center 
Select uses to identify the phone number dialed by the incoming caller. Avaya Contact Center 
Select uses direct dial-in (DDI) information it receives from IP Office to route calls to appropriate 
skillsets or agents based on DNIS numbers.
To configure DNIS for Avaya Contact Center Select, you must configure an Incoming Call Route 
number on IP Office that corresponds to an Avaya Contact Center Select DNIS number. You must 
then add an IP Office short code as a destination for the Incoming Call Route. Each IP Office short 
code is mapped to an Avaya Contact Center Select CDN (Route Point) number. You can assign 
multiple DNIS numbers (Incoming Call Routes) to a single Contact Center Route Point number or 
multiple Contact Center Route Point numbers.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the Solution node, right-click on Incoming Call Route 
and select New.

3. In the right pane, from the Bearer Capability List select Any Voice.

4. In the Line Group ID box, type the Line Group ID number.

5. In the Incoming Number box, type the DNIS number.
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6. Click the Destinations tab.

7. From the Destination list, select the IP Office short code you want to assign the DNIS 
number to.

8. Click OK.
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Chapter 25: Secure SIP and CTI 
communication configuration

This section describes how to configure secure SIP and CTI communication between Avaya Contact 
Center Select (ACCS) and IP Office (IPO).

ACCS uses SIP and custom CTI interfaces to communicate with IPO.

IPO supports Transport Layer Security (TLS) communication for the SIP and CTI connections with 
ACCS .

TLS is a public key encryption cryptographic protocol that helps secure a communications channel 
from danger or loss, and thus helps provide privacy and safety. With public key cryptography, two 
keys are created, one public and one private.

Certificate Authorities (CA) issue and manage server certificates in software security systems that 
use public key technologies, such as telecoms systems that use Transport Layer Security (TLS) 
communication.

When you get a signed server certificate and a corresponding root certificate from a CA, you install 
the certificates on the server system that requested the certificate, for example IP Office. You then 
install the root certificate into the Trusted Store of the client system(s), for example ACCS. This 
allows the client systems to request secure communications with the server systems.

Both ACCS and IPO can request secure communications of the other. Therefore, you must generate 
a Certificate Signing Request (CSR) and get a signed server certificate from a CA on both ACCS 
and IPO. Both ACCS and IPO must have a root certificate to match the server certificates. When 
these are in place, IP Office and ACCS can communicate securely using TLS SIP and TLS CTI 
connections.
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Figure 10: ACCS and IPO secure SIP communication configuration using Certificate Authority

For example, if your IP Office uses Certificate Authority “CA1”, and if ACCS uses a Certificate 
Authority “CA2”, then:

• The ACCS Security Store contains a server certificate supplied and signed by the ACCS 
Certificate Authority (CA2) and the IP Office Certificate Authority (CA1) root certificate.

• The IP Office Trusted Security Store contains the ACCS Certificate Authority (CA2) root 
certificate.

• IP Office and ACCS can use the same Certificate Authority. Therefore, “CA1” and “CA2” can be 
the same Certificate Authority.

A server certificate must be signed by a CA; ACCS Security Manager does not sign certificates. 
Avaya recommends that you use third-party CA or your organization’s Certificate Authority to sign 
your server certificates.

Certificate Authority deployments vary depending on IT infrastructure and security requirements. 
You can use either a third party CA, or configure your own CA within your IT infrastructure.

The SIP and CTI links between Avaya Contact Center Select and IP Office use the Transport Layer 
Security (TLS) protocol to provide secure communication. TLS uses signed security certificates to 
secure the link between the Avaya Contact Center Select and the IP Office.

The Avaya Contact Center Select Security Manager can request and store these signed security 
certificates. The ACCS Security Manager generates a Certificate Signing Request (CSR) file. A 
Certificate Authority uses this Certificate Signing Request file to create a signed certificate. ACCS 
Security Manager then imports and stores Certificate Authority supplied root certificates and signed 
certificates.

In ACCS solutions using IP Office and ACCS Business Continuity resiliency, the active and standby 
Avaya Contact Center Select servers can both have TLS certificates in place to communicate 
securely with the IP Office server and to support Business Continuity switchover.
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Secure SIP and CTI Communication configuration 
procedures

This task flow shows you the sequence of procedures you perform to configure secure SIP 
communication between Avaya Contact Center Select and IP Office.
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Figure 11: Configuring secure SIP and CTI communication between ACCS and IPO
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Figure 12: Configuring secure SIP and CTI communication between ACCS and IPO continued
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Creating a new security store
About this task
The Security Manager uses a store to hold Certificate Authority root certificates and signed 
certificates. Create the security store if you plan to use a Certificate Authority and generate signed 
certificates.
The default encryption setting is SHA2 with a key size of 2048. For backward compatibility, you 
can choose SHA1 or a key size 1024. However, SHA1 and 1024 do not provide the industry-
recommended level of encryption. If you select one of these values, Contact Center displays a 
warning message.
If you created a security store at install time using the Ignition Wizard, skip this procedure.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In the Security Manager window, click the Security Store tab.

4. On the Security Store tab, in the Full Computer Name (FQDN) box, type the full FQDN of 
the server on which you are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides 
on. The FQDN name is case-sensitive.

5. In the Name of Organizational unit box, type the name of the department or division 
within the company.

6. In the Name of Organization box, type the company name.

7. In the City or Locality box, type the name of the city or district in which the contact center 
is located.

8. In the State or Province box, type the state or province in which the contact center is 
located.

9. In the Two Letter Country Code box, type the country code in which the contact center is 
located.

10. In the Security Store password box, type a password for accessing the new security 
store.

11. In the Confirm Store password box, confirm the password for accessing the new security 
store.

Important:

Ensure you remember this password, because you will need it the next time you log on 
to Security Manager. If you forget the password, you cannot access Security Manager.
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12. If you want to change the encryption setting, select the required encryption settings from 
the Encryption Algorithm and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA2 and the default value for Key Size is 
2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center 
includes these values for backward-compatibility only because these settings do not meet 
the industry-recommended level of encryption.

13. Click Create Store.

Contact Center creates the private key required for private-public key encryption.

Security Manager automatically displays the Certificate Request tab, showing the newly 
created Certificate Signing Request file contents.

Contact Center automatically backs up the new security store to the folder 
D:\Avaya\Contact Center\autoBackUpCertStore. Do not overwrite or delete this 
backup location.

14. If you have a Multimedia Contact Server, repeat this procedure on the Multimedia Contact 
Server.

Next steps
Send the Certificate Signing Request file to the Certificate Authority, and receive a signed server 
certificate, so that you can import the server certificate to the security store.

Copying the Certificate Signing Request file
Before you begin

• Speak with your System Administrator to identify a Certificate Authority.

About this task
Security Manager automatically generates a Certificate Signing Request (CSR) when it creates a 
new security store. The Security Manager—Certificate Request tab displays the name, location, 
and contents of the Certificate Signing Request (CSR) file on the server. A Certificate Authority 
uses this Certificate Signing Request (CSR) file to generate a signed server certificate. Contact 
Center uses the signed server certificate to establish secure communication links with IP Office, 
the Agent Browser application, and Web Services clients.
Until you add a signed server certificate, the Signing Request Status field shows the CSR status 
as Pending. When the CSR is signed, and you add it to the security store using the “Add 
Certificate Tab”, the status changes to “Signed” to indicate that this CSR has been signed.

Procedure
1. Log on to the Contact Center server containing the security store.

2. From the Start menu, in the Avaya area, click Security Manager.
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3. Select the Certificate Request tab.

4. Check the Signing Request Status value. If this value is Pending, you must have the 
CSR signed by a Certificate Authority.

5. Note the location of the Certificate Signing Request file from File location.

6. Select Logout.
7. Copy the Certificate Signing Request file from the directory referenced in File location, to 

send to a Certificate Authority.

8. If you have a Multimedia Contact Server, repeat this procedure on the Multimedia Contact 
Server.

Next steps
After you perform this procedure, the certificate must be signed by a Certificate Authority. Contact 
your System Administrator for the preferred method of processing the signed certificate request 
file to obtain a signed certificate. Send the Certificate Signing Request file to a Certificate Authority 
and receive a signed server certificate and root certificate to import into the security store.

Adding certificate files to the security store
Before you begin

• Use the CSR file from the Contact Center Security Manager to obtain a Certificate Authority 
(CA) signed server certificate and root certificate.

• Save the certificate files on the Contact Center server.

About this task
Contact Center Security Manager can add both CA root certificates and signed server certificates 
to the security store. Contact Center requires a signed server certificate and a corresponding CA 
root certificate to communicate using secure services.
There are two options when adding CA root and signed server certificates.
Automatically adding certificates : 
You can select a folder that contains signed server and root certificates. Security Manager 
accesses this folder and automatically determines which are server certificates and which are 
root certificates and then adds them to the security store accordingly.

Important:
Security Manager attempts to import all files and certificates it finds in the certificate folder. 
Ensure that the certificate folder contains only CA root certificates and server certificates.

Manually adding certificates : 
For manually added certificates, you can browse for individual signed server and CA root 
certificates and add them to the security store, one at a time. Security Manager checks the 
certificates and does not add server certificates as root CA certificates.
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Procedure
1. Log on to the Contact Center server containing the security store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the security store password.

4. Click OK.

5. In the Security Manager window, select the Add Certificate tab.

6. To add certificates automatically:

a. Click Browse.

b. On the Select Directory dialog, browse to the directory where you saved the certificate 
files, and click Select Directory.

Security Manager displays the certificates in the Certificates field.

c. Click Add all Certificates.

7. To add certificates manually:

a. Select Add Certificates Manually.

b. To manually add a CA root certificate, click Browse.

c. Browse to the CA root certificate, and click Select File.

d. Click Add CA Certificate.

e. To manually add a server certificate, click Browse.

f. Browse to the CA signed server certificate, and click Select File.

g. Click Add Signed Certificate.

Exporting a root certificate from the security store
About this task
Export the CA root certificate from the Contact Center security store so that clients using secured 
services can trust the server public key for encryption. Avaya recommends that you always export 
the root certificate from the security store, so that it is consistent with the current server certificate.

Before you begin
• Add a server certificate and root certificate to the security store.

Procedure
1. Log on to the Contact Center server containing the store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the security store password, and click OK.

Exporting a root certificate from the security store
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4. In the Security Manager window, select the Store Maintenance tab.

5. In the Root Certificates field, select the root certificate that you want to export.

6. Click Export.
7. On the Select Directory To Export To dialog, select or create a directory to which you want 

to export the root certificate.

8. Click Export To.

Security Manager exports two files to the directory. For most clients, use the Security 
Certificate file. Use the PEM file for Avaya Aura® MS and any client that supports only PEM 
format.

Next steps
Apply the root certificate to all ACCS clients.
Import the PEM format root certificate to Avaya Aura® MS.

Adding the ACCS CA root certificate to the IP Office 
trusted store

About this task
Add the Avaya Contact Center Select Certificate Authority root certificate to the IP Office trusted 
store.
The security store contains a set of trusted certificates used to evaluate received client certificates. 
You can install up to 25 X.509v3 certificates.
For more information about the types of certificates supported by IP Office, refer to the IP Office 
and IP Office Manager documentation. You can also find information about configuring IP Office in 
the IP Office Manager online help and documentation.

Procedure
1. Using IP Office Manager, click File  > Advanced  > Security Settings  > System > 

Certificates.

2. From Trusted Security Store, click Add.
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3. Locate and add the Avaya Contact Center Select Certificate Authority root certificate.

4. Click OK.

5. Click File  > Save Security Settings.

Enabling IP Office SIP link certificate validation
Before you begin
For more information about configuring IP Office, refer to IP Office Manager online help and 
documentation.

About this task
Enable IP Office SIP link certificate validation. When using TLS as the transport protocol for the 
SIP link, certificate validation must be enabled in IP Office. This configures IP Office to verify that 
the ACCS certificate is trusted and permits an ACCS TLS SIP connection with IP Office.

Note:
This configuration item is not unique to Avaya Contact Center Select and might have possible 
impacts on other endpoints configured to use TLS with IP Office.

Procedure
1. Using IP Office Manager, click File  > Advanced  > Security Settings  > System > 

Certificates.
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2. From the Received Certificate Checks (Telephony Endpoints) list, select Medium.

3. Click OK.

4. Click File  > Save Security Settings.

Configuring the IP Office TLS port for SIP communication
About this task
Configure the IP Office TLS port used for SIP communication.
For more information about configuring IP Office, refer to IP Office Manager online help and 
documentation.

Note:
This configuration item is not unique to Avaya Contact Center Select and might have possible 
impacts on other endpoints configured to use TLS with IP Office.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

3. Navigate to LAN1  > VoIP.

4. In the SIP Registrar area, in the Layer 4 Protocol section, select TLS.

5. Record the TLS port number.
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This port number must match the Avaya Contact Center Select TLS port number.

6. Click OK.

7. Click File  > Save Security Settings.

Enabling IP Office CTI link certificate validation
About this task
Enable the IP Office CTI link certificate validation. When using TLS as the transport protocol for 
the CTI link, certificate validation must be enabled in IP Office. This configures IP Office to verify 
that the Avaya Contact Center Select certificate is trusted and permits an Avaya Contact Center 
Select TLS CTI connection with IP Office.
For more information about configuring IP Office, refer to IP Office Manager online help and 
documentation.
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Note:
This configuration item is not unique to the Avaya Contact Center Select CTI connection to 
IP Office. Turning on CTI certificate validation on the Avaya Contact Center Select TAPID 
link also turns on certificate validation for the TAPI SCN links in an IP Office SCN. For more 
information, see Installing certificates across IP Office SCN on page 327.

Procedure
1. Using IP Office Manager, click File  > Advanced  > Security Settings  > System > 

Unsecured Interfaces.

2. In the Application Controls area, clear the TAPI check box.

3. Click OK.

4. Click File  > Save Security Settings.
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Configuring the optional IP Office Secondary Server
Before you begin

• Configure secure TLS communication for the IP Office Primary Server.
• For more information about configuring IP Office, refer to IP Office Manager online help and 

documentation.

About this task
If your Avaya Contact Center Select solution uses an IP Office Secondary Server, configure TLS 
communication between Avaya Contact Center Select and the Secondary Server.

Procedure
1. Add the ACCS Certificate Authority root certificate to the IP Office Secondary Server. For 

more information, see Adding the ACCS CA root certificate to the IP Office trusted store on 
page 316.

2. Ensure the IP Office Secondary Server uses the a TLS port number that matches ACCS. 
For more information, see Configuring IP Office TLS port for SIP Communication on 
page 318.

3. Configure the IP Office Secondary Server to support TLS certificates. For more 
information, see Enabling IP Office CTI link Received Certificate Checks on page 319.

Exporting the default CA root certificate from IP Office
Before you begin
For information about configuring IP Office, refer to IP Office Manager online help and 
documentation.

About this task
Export the default Certificate Authority (CA) root certificate from IP Office.

Procedure
1. Log in to IP Office Web Manager.

Configuring the optional IP Office Secondary Server

April 2024 Avaya Contact Center Select Advanced Administration 321
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


2. From the Solution view, locate the IP Office node that you are configuring, click the 
Settings icon on the right hand side, and select Platform View.

3. Click Settings > General.
4. Scroll down to the Certificates area.

5. In the CA Certificate section, click Download (DER-encoded) and save the file to a secure 
location.

If you see an error message after clicking Download (DER0-encoded), it is possible that 
there is no Certificate Authority (CA) configured. To resolve this issue, click Generate to 
create a new default CA and then click Download (DER-encoded).
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Next steps
Install this exported IP Office CA root certificate in the Avaya Contact Center Select security store.

Generating the default signed certificate
Before you begin
For information about configuring IP Office, refer to IP Office Manager online help and 
documentation.

About this task
Generate the default signed certificate for IP Office.
When IP Office starts up for the first time, or whenever the identity certificate is deleted, a 
new identity certificate is created at startup time. This certificate, created at startup time, is not 
compatible with the TLS communication links on Avaya Contact Center Select. You must create a 
new identity certificate for IP Office, which is compatible with Avaya Contact Center Select.

Procedure
1. Log in to IP Office Web Manager.

2. From the Solution view, locate the IP Office node that you are configuring, click the 
Settings icon on the right hand side, and select Platform View.

3. Click Settings  > General.
4. Scroll to the Certificates area.

5. In the Identity Certificate section, click Generate and Apply to set a new identity certificate 
for IP Office.

You only need to do this if a new identity certificate has not yet been applied to IP Office.
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Obtaining security certificates for IP Office
About this task
Obtain security certificates for IP Office.

Procedure
Obtain a Certificate Authority root certificate and signed server certificate from your IP Office or 
corporate Security Prime.

Installing the signed certificate in IP Office
Before you begin

• Obtain security certificates for IP Office.
• For information about configuring IP Office, refer to IP Office Manager online help and 

documentation.

About this task
Install the signed certificate in IP Office. When a signed certificate has been generated and the 
corresponding CA root certificate received from the CA that signed the certificate, then install the 
signed certificate in IP Office. The CA root certificate is not installed in IP Office. It is installed in 
the ACCS security store so that ACCS can validate the IP Office signed certificate.
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Note:
This configuration is not unique to Avaya Contact Center Select and might have possible 
impacts on other Management Interfaces and Telephony Endpoints configured to use TLS 
with IP Office.

The identity certificate is an X.509v3 certificate that identifies the system to a connecting client 
device such as Avaya Contact Center Select. This certificate is offered in the TLS exchange when 
the system is acting as a TLS server, which occurs when accessing a secured service.
You can use different certificates for the SIP and CTI link in IP Office. The SIP link falls under 
the category of Telephony Endpoints while the CTI link falls under the category of Management 
Interfaces.

Procedure
1. Using IP Office Manager, click File > Advanced  > Security Settings  > System > 

Certificates.

2. In the Identity Certificate section, click Set.
3. Locate and add the IP Office signed certificate.

4. To use a different signed certificate for the SIP link, click Use different Identity Certificate 
for Telephony.

5. In the Telephony Certificate section, click Set.
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6. Locate and add the IP Office signed certificate to be used for the SIP link.

7. Click OK.

8. Click File > Save Security Settings.

Adding the IP Office CA root certificate to the ACCS 
security store

Before you begin
• Obtain an IP Office CA root certificate. If you are using a custom certificate, see Obtaining 

security certificates for IP Office  on page 324. If you are using the default IP Office 
certificate, see Exporting the default CA root certificate from IP Office on page 321.

• Save the certificate file on the Avaya Contact Center Select (ACCS) server.
• For information about configuring IP Office, refer to IP Office Manager online help and 

documentation.

Secure SIP and CTI communication configuration

April 2024 Avaya Contact Center Select Advanced Administration 326
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


About this task
Add the IP Office CA root certificate to the ACCS security store so that ACCS can request secure 
communication with IP Office. If you used a different CA to generate the signed certificate for the 
SIP link, you must also add that CA root certificate to the security store.

Procedure
1. Log in to the server containing the security store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access window, type the security store password.

4. Click OK.

5. In the Security Manager window, click the Add Certificate tab.

6. Click Add Certificates Manually.

7. To manually add a CA root certificate, click Browse.

8. Browse to the IP Office CA root certificate and click Select File.

9. Click Add CA Certificate.

10. Click Close.

Installing certificates across IP Office SCN
Before you begin

• For more information about configuring IP Office, refer to IP Office Manager online help and 
documentation.

• For more information about configuring an IP Office Small Community Network, refer to IP 
Office Web Manager online help and documentation.

About this task
A Small Community Network (SCN) is a system of networked IP Office telephone systems that 
can, among other features, share extension numbers and user names. Each IP Office SCN 
supports a single connected Avaya Contact Center Select.
If you configure TLS certificate checking for the TAPID CTI link between Avaya Contact Center 
Select and an IP Office server in an SCN, you must also configure certificate checking for all TAPI 
links in that SCN. This includes the TAPI SCN links between IP Office nodes in an IP Office SCN 
environment.
The default certificate generated by each node is not generated from a single root. They are 
generated from a local Certificate Authority (CA) root on each node and the local CA root certs are 
not installed in the Trusted Store of any other node on the SCN. So by default the TAPI SCN links 
might not pass TLS authentication once certificate checking is enabled. To overcome this potential 
issue you must configure and install signed certificates and CA root certificates across all nodes in 
the SCN. The procedure describes two methods of doing this.
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Procedure
1. Method 1: This method is applicable if you are using custom certificates for IP Office. 

Generate a signed certificate for each node in the SCN from a single CA, deploy the 
signed certificates to each IP Office node and install the common CA root certificate to the 
Trusted Store of all nodes in the network. For each IP Office node in the SCN:

a. Obtain a security certificate and install the signed certificate in IP Office. For more 
information, see Obtaining security certificates for IP Office  on page 324.

b. Install the certificate on the IP Office node. For more information, see Installing the 
signed certificate in IP Office on page 324.

c. Install the CA root certificate that was used to sign the certificate in step (a) in the 
Trusted Store of the IP Office node. For more information, see Adding the ACCS CA 
root certificate to the IP Office trusted store on page 316.

2. Method 2: You can use one of the IP Office nodes as the CA server to generate the signed 
certificates and provide the common CA root certificate. For each IP Office node in the 
SCN:

a. Generate a security certificate using IP Office Web Manager. Use the same Web 
Manager instance to generate all certificates, this ensures a common CA root 
certificate is used for all certificates.

• i. Log on to IP Office Web Manager.

• ii. From Solution view, find the IP Office node you are configuring, click the 
Settings icon on the right hand side and select Platform View.

• iii. Select Settings > General and scroll to the Certificates section.

• iv. Select Create certificate for a different machine.

• v. In the Machine IP box, enter the IP address of the IP Office node that the 
certificate is being generated for.

• vi. In the Password box, enter a password. This password is required later when 
importing the certificate on the IP Office node. The password must adhere to the 
password complexity requirements as specified on the Certificates user interface.

• vii. In the Subject Name box, enter the FQDN or hostname of the IP Office node 
that the certificate is being generated for.

• viii. In the Subject Alternate Name(s) box, enter the a string in the following 
format: “DNS: “ + FQDN (or hostname) + “, IP: ” + ip address.

For example: “DNS: myserver.mycompany.com, IP: 10.134.120.130”

• ix. In the Duration box, enter the number of days after which the certificate expires.

• x. From the Public Key Algorithm list, select RSA-2048.

• xi. From the Secure Hash Algorithm list, select SHA-256.
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• xii. Click Generate.

• xiii. On the message box, click on the link and save the certificate with a .p12 
extension.

b. Install this signed certificate on the IP Office node that the certificate was generated 
for. For more information, see Installing the signed certificate in IP Office on page 324.

c. Export the common CA root certificate. For more information, see Exporting the 
default CA root certificate from IP Office on page 321.

d. Install the common CA root certificate in the trusted store of the same IP Office node 
as step (b). For more information, see Adding the ACCS CA root certificate to the IP 
Office trusted store on page 316.

Configuring Avaya Contact Center Select SIP TLS details
Before you begin
Know the TLS port number used by IP Office. For more information, see Configuring IP Office TLS 
port for SIP Communication on page 318.

About this task
Configure Avaya Contact Center Select SIP TLS details.

Procedure
1. Log in to the Avaya Contact Center Select active server.

Configuring Avaya Contact Center Select SIP TLS details
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2. From the Start menu, in the Avaya area, click Server Configuration.

3. On the Server Configuration window, under SIP, click the Network Settings tab.

4. From the Transport list, select TLS.

5. In the Port number box, ensure the configured port number is the same as the TLS port 
number configured in IP Office.

6. If your solution has an IP Office Secondary Server, enable Use IP Office Resilience, 
select TLS transport for it, and configure the TLS port number to match the IP Office 
Secondary Server.

7. Click Apply All.
8. Click OK.
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Configuring Avaya Contact Center Select CTI TLS details
About this task
Configure Avaya Contact Center Select to use TLS CTI communication with IP Office, and to 
support certificates for TLS communication. Avaya Contact Center Select supports both TCP and 
TLS CTI communication with IP Office.

Procedure
1. Log in to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click Server Configuration.

3. On the Server Configuration window, under SIP, click the Network Settings tab.

4. Select Received Certificate Check (CTI).
5. From the IP Office (Primary) CTI Transport drop-down list, ensure that TLS is selected.
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6. If your solution has an IP Office Secondary Server, enable Use IP Office Resilience, and 
in the IP Office Secondary Server section, select Received Certificate Check (CTI) and 
ensure that TLS is selected from the IP Office (Primary) CTI Transport drop-down list.

7. Click Apply All.
8. Click OK.

9. Click Exit.

Verifying TLS communication
About this task
Verify the TLS communication between Avaya Contact Center Select and IP Office.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click SIP Gateway Management Client.
3. Select the Transport Status tab.

4. Verify that the Voice Outbound Proxy link Transport setting is TLS and that the link 
status is CONNECTED.
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5. Verify that the CTI Proxy link Transport setting is TLS and that the link status is 
CONNECTED.

6. If your solution uses an IP Office Secondary Server, verify that the links to the Secondary 
Server use TLS. Avaya Contact Center Select connects to one IP Office at a time, so only 
one set of links can be CONNECTED at a time.
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Chapter 26: Administering security

Avaya Contact Center Select (ACCS) includes a number of services and connections that you can 
secure using TLS. You can use the Ignition Wizard to create a security store, generate a Certificate 
Signing Request (CSR) and import a Certificate Authority (CA) root certificate. Use the procedures 
in this chapter to administer web services security, including turning on security, backing up the 
security store, and modifying a security store inspection task.
The following web services use the security store to implement HTTPS:

• Contact Center Manager Administration (CCMA)
• Contact Center Multimedia (CCMM) Administration
• Agent Desktop
• Multimedia Services
• Orchestration Designer
• Outbound Campaign Management Tool
• Agent Browser application

ACCS security store
ACCS includes a security store for securing both SIP communications and web services. When you 
configure the ACCS security store for SIP communications, it is ready to secure web services.
The ACCS security store includes a server certificate and root certificate. ACCS also uses the 
Internet Information Services (IIS) security store for some services.

Security Manager
Security Manager provides an interface for managing security certificates in the ACCS security 
store and the IIS security store. ACCS supports the management of the IIS security store only 
through Security Manager. Do not use IIS functions to manage the IIS security store on an ACCS 
server. Security Manager supports importing chained certificates and places these certificates in the 
Contact Center security store for distribution across the solution.

Supported TLS versions
Contact Center defaults to using only TLS 1.2 for secured services and connections. For backward 
compatibility, Contact Center supports administrators changing the minimum TLS version that 
Contact Center can negotiate with other systems. This is to interoperate with legacy systems that do 
not support TLS 1.2. You can set minimum TLS versions separately for the following connections:

• SIP signaling
• CCMA and CCMM administration
• Event Broker web service - this setting also sets the minimum TLS version used for Web 
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If you change the CCMA and CCMM administration setting, the configuration applies the Windows 
Server TLS settings and affects all applications on the server that use Windows Server secure 
communications technology.
When the Contact Center configuration is for a TLS version lower than 1.2, Contact Center still 
attempts to negotiate the highest (and most secure) version first, before stepping down to a lower 
(and less secure) version.
Avaya recommends that you maintain the TLS version settings at the highest possible TLS version. 
Only change these settings if you know that parts of your overall Contact Center solution do not 
work with the higher TLS version.

ACCS Business Continuity
In a Business Continuity (BC) system, the security stores must use Subject Alternative Names 
(SANs). Include a SAN for the Managed name and the server name. This ensures clients 
connecting to ACCS using the Managed name do not get warnings that the signed certificate name 
does not match the server name.

Certificate Authority root certificates
When a client initiates a secure connection with a server, it must have a root certificate from the 
CA that provided the server signed certificate. If the client does not have a matching root certificate, 
it does not complete the connection. If the client has a root certificate from a CA, it can trust any 
server certificate signed by that CA.
To secure ACCS web services, you must export the root certificate from Security Manager and 
import it to all ACCS clients, including CCMA clients and Agent Desktop computers.
Avaya recommends that you use a single CA to sign all the certificates in your Contact Center. This 
simplifies the deployment process because you only need to distribute a single root certificate to all 
the clients. If you want to use different CAs to sign certificates for your different servers, you must 
copy the root certificate from each CA to all the clients in your Contact Center.
For some web services, servers can act as clients of other servers. Therefore you must ensure that 
all servers also have the required CA root certificate(s).

Offline Store
You can create an offline store using Security Manager, which minimizes downtime if you want to 
replace your current security store. When your offline store is created, you can swap between the 
active store and the offline store. You can make the offline store the active store at any point using 
Security Manager. Stop Contact Center services before making the offline store active.

Security Store notifications
Security certificates contain an expiration date and they are not valid after this date. If the security 
certificates used by ACCS expire, the contact center loses call control and stops functioning.
Security Manager provides a security store inspection utility to help you monitor and maintain 
valid security certificates. You can use Security Manager to schedule a security store inspection 
task. Security Manager adds the scheduled task to the underlying Windows Task Scheduler. The 
scheduled task runs the security store inspection utility once a week. The inspection utility checks 
the status of the security certificates in the ACCS security store. If any of the security certificates are 
due to expire within a month, the inspection utility sends a notification email to the Contact Center 
administrator. The contact center administrator must then refresh the security certificates.
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Security Manager provides the notification email, but it cannot renew expired security certificates. 
For uninterruptedContact Center functionality, if you receive an email about upcoming certificate 
expiration dates, you must renew the security certificates before they expire.
Security Manager uses the Microsoft Windows Task Scheduler to schedule the weekly security store 
inspection. You must ensure that there is a Microsoft Windows user account that has the necessary 
privileges from which Security Manager can schedule a task on Windows Task Scheduler. You can 
use the Windows administrator account that you used to install ACCS to add a task to Windows 
Task Scheduler.
Security Manager uses a specified SMTP server to send the notification emails to the 
administrator’s email address. ACCS does not provide this SMTP server. You must provision this 
SMTP server and ensure that the ACCS server can always communicate with it. ACCS does not 
support SSL connectivity to this SMTP server.

Server Message Block signing on Windows Server
Both the Contact Center DVD and the Release Pack installer modify the Windows Server local 
group policy to enable Server Message Block (SMB) signing. SMB signing places a digital “tag” into 
each server message block, which helps prevent man-in-the-middle attacks on network file sharing.
If you do not want to use SMB signing, you can disable it by modifying the Windows Server local 
group policy.

Exporting a root certificate from the security store
About this task
Export the CA root certificate from the Contact Center security store so that clients using secured 
services can trust the server public key for encryption. Avaya recommends that you always export 
the root certificate from the security store, so that it is consistent with the current server certificate.

Before you begin
• Add a server certificate and root certificate to the security store.

Procedure
1. Log on to the Contact Center server containing the store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the security store password, and click OK.

4. In the Security Manager window, select the Store Maintenance tab.

5. In the Root Certificates field, select the root certificate that you want to export.

6. Click Export.
7. On the Select Directory To Export To dialog, select or create a directory to which you want 

to export the root certificate.

8. Click Export To.
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Security Manager exports two files to the directory. For most clients, use the Security 
Certificate file. Use the PEM file for Avaya Aura® MS and any client that supports only PEM 
format.

Next steps
Apply the root certificate to all ACCS clients.
Import the PEM format root certificate to Avaya Aura® MS.

Applying the root certificate to a Contact Center client
About this task
Copy the root certificate exported from the Contact Center security store to the Contact Center 
clients and servers that use secure services. If you have a large number of clients, you can 
use automated methods to distribute and apply the root certificates. For example, you can use a 
Group Policy to distribute root certificates to clients using supported Microsoft Windows operating 
systems.
This procedure shows how to manually apply a root certificate on a Microsoft Windows operating 
system.

Before you begin
• Add a signed certificate and root certificate to the security store.
• Export the root certificate from the security store.

Procedure
1. On the client operating system Desktop, click Start > Run.

2. Type MMC, and click OK.

3. Select Click File > Add/Remove Snap In.

4. From the Available snap ins list, select Certificates, and click Add.

5. On the Certificates Snap in dialog, select Computer account, and click Next.
6. Click Finish.

7. On the Add or Remove Snap-ins dialog, click OK.

8. In the console root, expand Certificates (Local Computer) and then expand Trusted 
Root Certification Authorities.

9. Right-click the Certificates folder.

10. Select All Tasks > Import.
11. On the Certificate Import Wizard dialog, click Next.
12. Click Browse, and browse to the location where you copied the root certificate file.

13. Select the root certificate file and click Open.
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14. On the Certificate Import Wizard dialog, click Next.
15. Click Next.
16. When the Certificate Import Wizard finishes importing the certificate, click Finish.

Importing the Contact Center root certificate into Avaya 
Aura® MS

Before you begin
• Export the root certificate from the Contact Center security store.

About this task
Import the Contact Center root certificate into the Avaya Aura® MS trust store to support Transport 
Layer Security (TLS) communications.

Procedure
1. Log on to Avaya Aura® MS Element Manager.

2. Navigate to EM > Security > Certificate Management > Trust Store.

3. Click Import.
4. In the Trust friendly name field, type a friendly name for the CA root certificate.

5. Click Browse.

6. Select the root certificate file that you exported from the Contact Center security store.

7. Click Save.

Creating an offline store
Before you begin

• Ensure that a security store already exists.

About this task
Create an offline security store if you want to replace the existing active security store, and 
minimize downtime. The procedure to create an offline store is the same as creating an active 
security store.
Security Manager uses a store to hold Certificate Authority root certificates and signed certificates. 
Create the security store if you plan to use a Certificate Authority and generate signed certificates.
The default encryption setting is SHA2 with a key size of 2048. For backward compatibility, 
you can choose SHA1 or a key size 1024. However, neither SHA1 nor 1024 provide the industry-
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recommended level of encryption. If you select one of these values, Contact Center displays a 
warning message.
You cannot make any security configuration changes in Security Manager while you are viewing 
the offline store.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In the Security Manager window, click Store Commands > Create Offline Store.

4. In the Security Store tab, in the Full Computer Name (FQDN) box, type the full FQDN of 
the server on which you are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides 
on. The FQDN name is case-sensitive.

5. In the Name of Organizational unit box, type the name of the department or division 
within the company.

6. In the Name of Organization box, type the company name.

7. In the City or Locality box, type the name of the city or district in which the contact center 
is located.

8. In the State or Province box, type the state or province in which the contact center is 
located.

9. In the Two Letter Country Code box, type the country code in which the contact center is 
located.

10. In the Security Store password box, type a password for accessing the new security 
store.

11. In the Confirm Store password box, confirm the password for accessing the new security 
store.

Important:

Ensure you remember this password, because you need it the next time you log on 
to Security Manager. If you forget the password, you are not able to access Security 
Manager.

12. If you want to change the encryption setting, select the required encryption settings from 
the Encryption Algorithm and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size 
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center 
includes these values for backward-compatibility only, because these settings do not meet 
the industry-recommended level of encryption.
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13. Click Create Store.

Contact Center creates the private key required for private-public key encryption.

Security Manager automatically displays the Certificate Request tab, showing the newly 
created Certificate Signing Request file contents.

Contact Center automatically backs up the new security store to the folder 
D:\Avaya\Contact Center\OfflineAutoBackUpCertStore. Do not overwrite or 
delete this backup location.

14. If you have a Multimedia Contact Server, repeat this procedure on the Multimedia Contact 
Server.

Switching between the active and offline security stores
About this task
When an active and offline security store exist, you can view either store without any impact to 
Contact Center operation. Security Manager displays a message indicating which store you are 
currently viewing. You cannot make configuration changes to the offline security store.

Before you begin
• Ensure that an active and offline security store already exist.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In the Security Manager window, click Store Commands > View.

Depending on which store you are currently viewing, you can choose to view the other 
security store. Security Manager displays a message indicating which store you are 
currently viewing.

Making an offline store active
About this task
When the offline security store is ready to be placed into production, you can activate the offline 
store using Security Manager.

Note:
You must restart the Contact Center server after activating the offline store.
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Before you begin
• Ensure that an active and offline security store already exist.
• Stop Contact Center services.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In the Security Manager window, click Store Commands > View > Offline Store.

4. In the Security Manager window, click the Make Active button.

5. Click Confirm to apply the new security settings and activate the offline store.

A message appears under Store Status to indicate that the Make Active operation was 
successful. The offline security store is now the new active security store. The old active 
security store is now the offline store.

6. Restart the Contact Center server.

Next steps
After restarting the Contact Center server, verify the configuration settings for the new active 
security store using the Security Configuration tab in Security Manager.

Turning on Web Services security
About this task
Turn on Web Services security if you want to use HTTPS security for management and agent 
operations.

Before you begin
• Read the security section of Avaya Contact Center Select Solution Description.
• Create a new security store and import the signed server certificate and root certificate from 

the CA.
• Export the CA root certificate from the security store, and apply it to all the CCMA and Agent 

Desktop clients in the contact center.

Procedure
1. Log on to the server as a local administrator.

Important:

If you log on to the server as a domain administrator, this procedure does not complete 
successfully.

2. From the Start menu, in the Avaya area, click Security Manager.
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3. On the Store Access dialog, type the password for the security store, and click OK.

4. On the Security Manager screen, select the Security Configuration tab.

5. Click Security On.

6. Click Apply.

7. On the Security Change Confirmation dialog, click Confirm.

8. Click Log Out.
Next steps
Configure the IPO data synchronization user account to match the Web Services security settings. 
For more information, see Changing the data synchronization user account to match Web 
Services security settings on page 343.
Instruct all users in the contact center to use https instead of http when connecting to the 
server from CCMA clients or Agent Desktop.

Configuring the minimum TLS version
About this task
Configure minimum TLS versions that Contact Center can negotiate for secure connections. This 
enables third-party and legacy systems that do not support TLS 1.2 to communicate securely with 
Contact Center. If you do not change these settings, Contact Center uses only TLS 1.2, and does 
not connect to systems that support only lower versions of TLS.
You can set minimum TLS versions separately for the following communications:

• SIP and CTI signaling
• CCMA and CCMM administration
• Event Broker Web service
• Web statistics (this setting also sets the minimum TLS version used for Web Statistics)

Before you begin
• Read the security section of Avaya Contact Center Select Solution Description.
• Create a new security store and import the signed server certificate and root certificate from 

the CA.

Procedure
1. Log on to the server as a local administrator.

Important:

If you log on to the server as a domain administrator, this procedure does not complete 
successfully.

2. From the Start menu, in the Avaya area, click Security Manager.
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3. On the Store Access dialog, type the password for the security store, and click OK.

4. On the Security Manager screen, select the Security Configuration tab.

5. In the SIP and CTI Signalling Level box, select the lowest version of TLS for SIP and CTI 
signaling communication.

In addition to the SIP signaling level, this also controls the TLS protocol version used for 
the TAPID CTI link between Avaya Contact Center Select and IP Office.

6. In the CCMA — Multimedia Web Service Level box, select the lowest version of TLS for 
CCMA and Multimedia Web service communication.

This changes the setting for IIS, and for Windows Server generally.

7. In the Event Broker Web Service Level box, select the lowest version of TLS for Event 
Broker Web Service communication.

8. Click Apply.

9. Click Log Out.

Changing the data synchronization user account to match 
Web Services security settings

About this task
Change the configuration of the data synchronization user account to match the Web Services 
security configuration. If you turn on Web Services security, the URL prefix must be https, and if 
you turn off Web Services security it must be http.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

3. Select the Contact Center tab.

4. In the CCMA Address box, type the address of the Avaya Contact Center Select server.

If you turned on Web Services security, type https://<ACCS server IP Address>.

If you turned off Web Services security, type http://<ACCS server IP Address>.

5. Click OK.
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Turning off Web Services security
About this task
Turn off Web Services security if you want to stop using the feature.

Before you begin
• Read the security section of Avaya Contact Center Select Solution Description.

Procedure
1. Log on to the server as a local administrator.

Important:

If you log on to the server as a domain administrator, this procedure does not complete 
successfully.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the password for the default security store, and click OK.

4. On the Security Manager screen, select the Security Configuration tab.

5. Click Security Off.
6. Click Apply.

7. On the Security Change Confirmation dialog, click Confirm.

8. Click Log Out.
Next steps
Configure the IPO data synchronization user account to match the Web Services security settings. 
For more information, see Changing the data synchronization user account to match Web 
Services security settings on page 343.
Instruct all users in the contact center to use http instead of https when connecting to the 
server from CCMA clients or Agent Desktop.

Scheduling a security store inspection task
Before you begin

• Configure the SMTP server and email account details.

About this task
Schedule a security store inspection task. Security Manager adds the scheduled task to the 
underlying Windows Task Scheduler. The scheduled task runs the security store inspection utility 
once a week. You can select the time and day of the week that the security store inspection task 
runs during the week.
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Procedure
1. Log on to the Avaya Contact Center Select Security Manager.

2. From the Start menu, in the Avaya area, click Security Manager.
3. Select Expiration Alerts  > Schedule Alerts.

4. To enable the weekly inspection task, select Schedule alerts.

5. From the Day of week list, select the day on which to schedule the weekly inspection task.

6. In the Time (24 hr) section, enter the time of day on which to schedule the weekly 
inspection task. Use twenty four hour format time.

7. In the User box, enter the name of a Windows user account that has the privileges 
necessary to access the Windows Task scheduler and schedule the task.

8. In the Password box, enter the password of the Windows user account that has the 
privileges necessary to access the Windows Task scheduler and schedule the task.

9. Click Apply Schedule.

Security Manager schedules this task on the underlying Microsoft Windows Task 
Scheduler. After successfully scheduling the task, the name on the Apply Schedule button 
changes to Modify Schedule and the button is disabled. To enable the Modify Schedule 
button, select a new time. You can then update the scheduled task time by clicking Modify 
Schedule.

Example of a scheduled task:
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Configuring SMTP server details
Before you begin

• Provision, configure, and maintain a Simple Mail Transport Protocol (SMTP) server. Contact 
Center Security Manager supports Microsoft Exchange Server.

• Know the authentication logon account and password details for the SMTP server.
• Ensure that the Contact Center server can access the SMTP server at all times.
• On the SMTP server, configure an email address for the contact center administrator. 

Security Manager sends the notification emails to this address. Ensure the contact center 
administrator monitors this email address.

• On the SMTP server, configure an email address for Avaya Contact Center Select Security 
Manager. Security Manager can then use this email address to send notification emails.

Administering security
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About this task
Configure the details of the SMTP server and accounts used to send the Security Manager status 
report email.

Procedure
1. On the Security Manager screen, select the Expiration Alerts tab.

2. Select SMTP Configuration.

3. From the Outgoing e-mail server (SMTP) list, select IP or Address. The Contact Center 
server must be able to communicate with the SMTP server by IP address or SMTP 
address.

4. In the Outgoing e-mail server (SMTP) box, enter the IP address or SMTP address of the 
SMTP server.

5. In the Port number box, enter the TCP port number for the SMTP server. The default port 
number is 25.

6. In the Sender e-mail address box, enter the email address to be used by Security 
Manager to send notification emails. Ensure this email address is registered with the 
SMTP server.

7. In the Recipient e-mail address box, enter the email address to which Security Manager 
is to send the notification emails. Ensure this email address is registered with the SMTP 
server. This is typically the contact center administrator’s email address. You must monitor 
this email address for notifications about the status of Contact Center security certificates.

8. If your SMTP server requires authentication, select SMTP server requires 
authentication. If your SMTP server does not require authentication, clear this check box.

9. In the User name box, enter the user account name used to authenticate with the SMTP 
server.

10. In the Password box, enter the password of the user account used to authenticate with the 
SMTP server.

11. Click Save Configuration.

Modifying a scheduled security store inspection task
Before you begin

• Configure the scheduled task.

About this task
Modify the time of day for an existing scheduled task. For an existing scheduled task, you can 
change only the time of day; you cannot change the day of week for an existing scheduled task.
This is an optional procedure.

Modifying a scheduled security store inspection task
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Procedure
1. Log on to the Avaya Contact Center Select Security Manager.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In Store Access, type the certificate store password.

4. Click OK.

5. Select Expiration Alerts  > Schedule Alerts.

6. In the Time (24 hr) section, enter the new time of the day on which to schedule the 
security store inspection task. Use twenty four hour format time.

7. In the User box, enter the name of a Windows user account that has the privileges 
necessary to access the Windows Task scheduler and schedule a task.

8. In the Password box, enter the password of the Windows user account that has the 
privileges necessary to access the Windows Task scheduler and schedule the task.

9. Click Modify Schedule.

Security Manager then schedules this task to run at the new time of day on the underlying 
Microsoft Windows Task Scheduler.

Verifying the scheduled security store inspection task
Before you begin

• Configure the scheduled task.

About this task
Verify that the Windows Task Scheduler lists the Security Manager scheduled inspection task. 
Do not modify the scheduled task in Task Scheduler. Use only Security Manager to modify the 
scheduled inspection task.

Procedure
1. Log on to the Contact Center server.

2. On the Start screen, under Administrative Tools, click Task Scheduler.
3. In the left pane, click Task Scheduler Library.

4. In the middle pane, confirm that there is a task named aaccSentinel.
5. Confirm that the task Status is Ready.

6. If you have a Multimedia Contact Server, repeat this procedure on the Multimedia Contact 
Server.
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Removing a scheduled security store inspection task
Before you begin

• Configure the scheduled task.

About this task
Remove the Security Manager activated scheduled task from the Windows Task Scheduler. If you 
delete the scheduled security store inspection task, Security Manager no longer sends notification 
emails when Security Manager security certificates are due to expire. You must then manually 
monitor the status and expiration dates of the security certificates.

Procedure
1. Log on to the Avaya Contact Center Select Security Manager.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In Store Access, type the certificate store password.

4. Click OK.

5. Select Expiration Alerts  > Schedule Alerts.

6. Click Remove Schedule.

Examining a certificate file in the security store
Before you begin

• The security store must contain one or more certificate.

About this task
View the certificates in the store using the Security Manager Display Certificates tab.

Procedure
1. Log on to the server containing the store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In Store Access, enter the security store password.

4. Click OK.

5. Select the Display Certificates tab.

6. Select List, to list all stored certificates in the store.

7. Select a certificate.

The details of the certificate are displayed.

8. Select Close.
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Removing a certificate file from the security store
About this task
You can remove the certificates added to the store manager by using the Store Maintenance tab 
of the Security Manager.

Procedure
1. Log on to the server containing the store.

2. From the Start menu, in the Avaya area, click Security Manager.
3. In Store Access, type the security store password.

4. Click OK.

5. In the Security Manager window, Select the Store Maintenance tab.

6. Under Signed and Root Certificates that reside in the store, Security Manager lists all 
certificates in the store.

7. To delete a signed certificate, click Delete Signed Cert and click OK.

8. To delete a root certificate, select the certificate to remove from the Root Certificates list 
and click Delete.

Disabling Server Message Block signing in the server 
local group policy

About this task
Both the Contact Center DVD and the Release Pack installer modify the Windows Server local 
group policy to enable Server Message Block (SMB) signing. SMB signing places a digital “tag” 
into each server message block, which helps prevent man-in-the-middle attacks on network file 
sharing.
If you do not want to use SMB signing, follow this procedure to disable it by modifying the 
Windows Server local group policy.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type gpedit.msc.

4. Click OK.

5. On the Local Group Policy Editor window, in the left pane, select Computer 
Configuration > Windows Settings > Security Settings  > Local Policies > Security 
Options.
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6. In the Name column, right-click Microsoft network client: Digitally sign 
communications (always), and select Properties.

7. On the Microsoft network client: Digitally sign communications (always) dialog, select 
Disable.

8. In the Name column, right-click Microsoft network server: Digitally sign 
communications (always), and select Properties.

9. On the Microsoft network server: Digitally sign communications (always) dialog, select 
Disable.

Backing up the security store
About this task
Back up the security store for restoring the server or before creating a new security store. Keeping 
a backup of the security store allows you to restore Security Manager if there is a failure with the 
current store.

Important:
Record the password for this security store. If you restore this backup, you need the security 
store password to log on to Security Manager.

Before you begin
• Read the security section of Avaya Contact Center Select Solution Description.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the security store password, and click OK.

4. On the Security Manager screen, select the Store Maintenance tab.

5. Under Backup and Restore Security Store, click Browse.

6. On the Select Directory dialog, browse to the folder where you want to back up the security 
store.

7. Click Select Directory.

8. On the Store Maintenance screen, click Backup.

Security Manager displays the result of the backup and updates the Last Backup section.
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Deleting the security store
About this task
Delete an existing security store when it is no longer required. You can delete an active or an 
offline security store.

Procedure
1. Use the System Control and Monitor Utility to stop all Avaya Contact Center Select 

services.

a. On the Apps screen, in the Avaya section, select System Control and Monitor 
Utility.

b. Click the Contact Center tab.

c. Click Shut down Contact Center.
2. On the Security Manager screen, select the Security Store tab.

3. Click Delete Store.

4. On the Security Manager — Delete Store Confirmation dialog, click Delete Store.

Security Manager deletes the store and updates the Store Status to “NOT CREATED”.

5. If you have a Multimedia Contact Server, repeat this procedure on the Multimedia Contact 
Server.
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Chapter 27: CCMA Password Policy

CCMA Password Policy is a set of rules that Contact Center Manager Administration uses to 
validate passwords of CCMA accounts. Contact Center Manager Administration provides two 
Password Policy modes: Basic Security mode and Advanced Security mode. You can either use 
default Basic Security mode with fixed rules or enable Advanced Security mode to configure custom 
password rules.

Basic Security mode
This is a mode with fixed password rules, which you cannot change. By default, CCMA applies 
these rules to all accounts.
Basic Security mode provides the following password rules:

• Must be between 8 and 20 characters long
• Must contain at least 1 number
• Must contain at least 1 uppercase and 1 lowercase character
• Must not contain any spaces
• Must not contain special characters, such as: double-quote, ampersand, colon, less than, 

greater than, pipe ("" & : < > |)

Advanced Security mode
Advanced Security mode provides the ability to use the advanced password rules for CCMA 
accounts validation, as well as configure custom CCMA Password Policy. When you enable 
Advanced Security mode, CCMA starts validating new and previously created accounts against 
the new CCMA Password Policy. When you create a password for a new user or update a password 
for an existing user in Access and Partition Management or Contact Center Management, you can 
view the current password rules by hovering the cursor over the Info icon.
Advanced Security mode provides separate password rules for human and programmatic accounts. 
Human accounts are the accounts that you create for users and administrators. Programmatic 
accounts are used for the non-interactive establishment of secure communication between internal 
processes, for example, when using Web Services for integration with third-party applications. 
If Advanced Security mode is enabled, you can configure an account as programmatic by 
selecting the Programmatic account checkbox in the User Details section of Access and Partition 
Management.

April 2024 Avaya Contact Center Select Advanced Administration 353
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Enabling Advanced Security mode for CCMA Password 
Policy

About this task
By default, CCMA Password Policy uses Basic Security mode with fixed password rules for 
account validation.
Enable Advanced Security mode to apply advanced password rules and configure custom 
password rules for CCMA accounts.
When you disable Advanced Security mode, CCMA Password Policy returns to Basic Security 
mode.

Procedure
1. Log on to the Contact Center Manager Administration server.

2. On the Apps screen, in the Avaya section, click Manager Administration Configuration.

3. In the Avaya Applications Configuration window, in the right pane, click the CCMA 
Password Policy icon.

4. In the CCMA Password Policy dialog, select the Apply Advanced Security mode check 
box.

5. Click Save.

Result
After you enable Advanced Security mode, Contact Center Manager Administration applies new 
password rules for account validation.

Next steps
Configure Advanced Security mode for human and programmatic accounts.

Advanced Security mode configuration
Advanced Security mode provides default password rules for CCMA accounts. You can 
change the default password characteristics to create custom password rules for human and 
programmatic accounts. You can also return the password rules to their default settings if required.
See the following table for the variable password characteristics and their default values for 
human and programmatic accounts:

Password characteristics Human accounts Programmatic accounts
Minimum password length, 
characters

Default: 14 Default: 32

Table continues…
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Password characteristics Human accounts Programmatic accounts
Maximum password length, 
characters

Fixed value: 20 Default: 50

Minimum number of lowercase 
characters

Default: 1 Default: 1

Minimum number of uppercase 
characters

Default: 1 Default: 1

Minimum number of digits Default: 1 Default: 1
Minimum number of special 
characters

Default: 0 Default: 0

Number of previous passwords 
that must not match

Range: 0-24

Default: 10

Range: 0-24

Default: 24
Maximum number of consecutive 
repeated characters

Default: 2 Default: not defined

Maximum number of consecutive 
characters in the same class

Default: 4 Default: not defined

Configuring password rules for human accounts
About this task
Configure the password rules for human accounts. Human accounts are the accounts that you 
create for users and administrators.
When you update CCMA Password Policy for human accounts, CCMA starts applying the updated 
password rules to validate new and existing human accounts.
Password validation occurs every time a user logs on to CCMA. If a password of an existing 
account does not comply with the updated password rules, CCMA forces the user to change the 
password.

Before you begin
Enable Advanced Security mode for CCMA Password Policy.

Procedure
1. Log on to the Contact Center Manager Administration server.

2. On the Apps screen, in the Avaya section, click Manager Administration Configuration.

3. In the Avaya Applications Configuration window, in the right pane, click the CCMA 
Password Policy icon.

4. Select Human account.
5. Configure the following password characteristics:

• Minimum password length

• Maximum password length

Advanced Security mode configuration
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This is a fixed value and it equals 20 characters. You cannot change this value for 
human accounts.

• Minimum number of lowercase characters

• Minimum number of uppercase characters

• Minimum number of digits

• Minimum number of special characters

• Number of previous passwords that must not match

You can select a value between 0 and 24.

• Maximum number of consecutive repeated characters

• Maximum number of consecutive characters in the same class

6. Click Save.

Contact Center Manager Administration applies the new password rules to human 
accounts validation.

7. To return the password rules to their default settings, click Reset and then Save.

Configuring password rules for programmatic accounts
About this task
Configure the password rules for programmatic accounts. Programmatic accounts are the 
accounts that you create for the non-interactive establishment of secure communication between 
internal processes, for example, when using Web Services for integration with third-party 
applications.
When you update CCMA Password Policy for programmatic accounts, CCMA starts using the 
updated password rules to validate new and existing programmatic accounts.
Password validation occurs every time a user logs on to the system without using the CCMA user 
interface, for example, when logging on to an integrated third-party application. If a password does 
not comply with the updated password rules, a notification appears informing a user about the 
invalid password and asking them to log on to CCMA for password change.

Before you begin
Enable Advanced Security mode for CCMA Password Policy.

Procedure
1. Log on to the Contact Center Manager Administration server.

2. On the Apps screen, in the Avaya section, click Manager Administration Configuration.

3. In the Avaya Applications Configuration window, in the right pane, click the CCMA 
Password Policy icon.

4. Select Programmatic account.

CCMA Password Policy
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5. Configure the following password characteristics:

• Minimum password length

• Maximum password length

• Minimum number of lowercase characters

• Minimum number of uppercase characters

• Minimum number of digits

• Minimum number of special characters

• Number of previous passwords that must not match

You can select a value between 0 and 24.

• Maximum number of consecutive repeated characters

• Maximum number of consecutive characters in the same class

6. Click Save.

Contact Center Manager Administration applies the new password rules to programmatic 
accounts validation.

7. To return the password rules to their default settings, click Reset and then Save.
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Chapter 28: Database encryption 
administration

This chapter describes the steps you need to perform to encrypt the Contact Center database. 
Using Security Manager, you can create and activate an encryption key and use it to encode the 
files in the Contact Center Caché database.

Caution:

You must back up the encryption key, and the encryption key credentials. If you lose the 
encryption key or its credentials, they are not retrievable. This can result in loss of service.

You can also use Security Manager to decrypt the Contact Center database.

Important:

You must perform Contact Center database encryption or decryption during a scheduled 
maintenance window.

Business Continuity
In a Business Continuity (BC) solution, you must use the same encryption key on all Contact Center 
servers in the solution. Contact Center supports BC solutions where the Active server database is 
encrypted and the Standby server database is not encrypted, and vice versa. Database shadowing 
remains operational regardless of the encryption status of the Contact Center database. This allows 
you to minimize downtime while you implement database encryption in your solution. If you want to 
encrypt the databases in a BC solution, you can use the following procedure to minimize downtime:

1. Stop all Contact Center services on the standby server system (Server B).
2. Encrypt the standby server database (Server B).
3. Start the standby server B. Ensure that you synchronize the data between the servers.
4. Run a manual switchover, the current standby Server B becomes an active server. Server B 

is now running and processing contacts.
5. Stop all Contact Center services on Server A.
6. Encrypt the new standby server database (Server A). You must use the same encryption key 

as you used to encrypt Server B.
7. Backup all the contact center databases on the active server, Server B.
8. Restore all the active Server B contact center database backups onto Server A.
9. Configure Business Continuity on the standby Server A.

10. Configure standby Server A for your contact center.
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11. Start the standby Server A. Ensure that data is synchronized between the servers.
12. Run a manual switchover if required, the current standby Server A becomes an active 

server. Server A is now running and processing contacts.

Upgrades
Before you upgrade your Contact Center solution, you must ensure that all databases are not 
encrypted.

Creating and activating an encryption key
About this task
Create and activate an encryption key and use it to encode the files in the Contact Center Caché 
database.
You can store encryption keys either locally, or in a shared location, however, when saving an 
encryption key in a shared folder, you must enter credentials of a shared location.

Procedure
1. Log on to the Contact Center server.

2. On the Apps screen, in the Avaya section, select Security Manager.
3. On the Store Access dialog, type the security store password, and click OK.

4. On the Security Manager screen, select the Database Encryption tab.

5. Under Credentials, in the User Name box, type the user name for the new encryption key.

6. In the Password box, type the password for the new encryption key.

Note:

Passwords must be between 8 and 20 characters in length, and include at least one 
number, at least one uppercase letter, at least one lowercase letter, and no spaces. 
Passwords must not contain any of the following characters: & " : > |.

7. Under Create/Select and Activate Key, click Browse.

8. Browse to the folder where you want to save the encryption key.

9. In the File Name box, type a name for the key and click Save File.

10. Click Create and/or Activate Key.

11. On the Confirm Password dialog box, type the encryption key password and click OK.

The Output pane shows the progress of the task.

12. (Optional) On the Shared location credentials dialog box, enter credentials of the shared 
location where you want to save the encryption key.

Security Manager displays the Shared location credentials dialog box only if you select a 
shared folder for saving the encryption key.
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Next steps
Caution:
You must back up the encryption key, and the encryption key credentials. If you lose the 
encryption key or its credentials, they are not retrievable. This can result in loss of service.

Encrypting the Contact Center database
About this task
Encrypt the Contact Center database during a scheduled maintenance window to ensure that 
sensitive data is secure.

Before you begin
• Create an encryption key, and ensure that the location of the key is accessible from the 

Contact Center server.
• Stop Contact Center services.

Procedure
1. Log on to the Contact Center server.

2. On the Apps screen, in the Avaya section, select Security Manager.
3. On the Store Access dialog, type the security store password, and click OK.

4. On the Security Manager screen, select the Database Encryption tab.

5. Under Credentials, in the User Name box, type the user name for the encryption key.

6. In the Password box, type the password for the encryption key.

Note:

Passwords must be between 8 and 20 characters in length, and include at least one 
number, at least one uppercase letter, at least one lowercase letter, and no spaces. 
Passwords must not contain any of the following characters: & " : > |.

7. Under Encrypt/Decrypt Database, if the Key Location box is not already populated with 
the encryption key location, click Browse.

8. In the Select Key File window, navigate to the location of the encryption key.

9. Select the encryption key file and click Select File.

10. Click Encrypt.

The Output pane shows the progress of the task. The amount of time this task takes 
depends on the size of the Contact Center database.

Next steps
When the encryption is complete, start Contact Center services.
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Decrypting the Contact Center database
About this task
Decrypt the Contact Center database during a scheduled maintenance window. Before you 
upgrade Contact Center software, you must decrypt the database.

Before you begin
• Ensure that the location of the encryption key is accessible from the Contact Center server.
• Stop Contact Center services.

Procedure
1. Log on to the Contact Center server.

2. On the Apps screen, in the Avaya section, select Security Manager.
3. On the Store Access dialog, type the security store password, and click OK.

4. On the Security Manager screen, select the Database Encryption tab.

5. Under Credentials, in the User Name box, type the user name for the encryption key.

6. In the Password box, type the password for the encryption key.

7. Under Encrypt/Decrypt Database, click Browse.

8. In the Select Key File window, navigate to the location of the encryption key.

9. Select the encryption key file and click Select File.

10. Click Decrypt.

The Output pane shows the progress of the task. The amount of time this task takes 
depends on the size of the Contact Center database.

Next steps
When the decryption is complete, start Contact Center services.
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Chapter 29: Agent Desktop client software 
installation using Remote 
Desktop Services

This chapter describes how to use Remote Desktop Services on a Windows Server to host and 
publish Agent Desktop.

Agent Desktop client software installation using Remote 
Desktop Services prerequisites

• Install the required Contact Center server software.

• Install and commission one or more Agent Desktop clients to confirm Agent Desktop 
functionality.

• Deploy and integrate Windows Server Remote Desktop Services servers in your solution. 
Deploy a RD Connection Broker, a RD Web Access, and a RD Session Host co-resident or 
standalone.

• Install Agent Desktop software on the RD Session Host server, using the Agent Desktop 
MSI installation package. Ensure that you disable the softphone option. For more information 
about installing Agent Desktop using MSI installation package, see the ACCS Deployment 
guide that applies to your solution:

- Deploying Avaya Contact Center Select DVD

- Deploying Avaya Contact Center Select Software Appliance

- Deploying Avaya Contact Center Select Hardware Appliance

• Review the Agent Desktop client requirements for deployment using Remote Desktop 
Services. See Avaya Contact Center Select Solution Description.
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Publishing Agent Desktop client software using Remote 
Desktop Services

About this task
Remote Desktop Services, formerly known as Terminal Services, allows a server to host multiple 
simultaneous client sessions. In the Remote Desktop Services (RDS) environment, an application 
runs entirely on the Remote Desktop Session Host (RD Session Host) server. The RDS client 
performs no local processing of application software.
Follow the procedure below to publish Agent Desktop client software using Remote Desktop 
Services.

Procedure
1. Configure CCMM to support Agent Desktop on the Windows operating system:

a. Log on to CCMA.

b. On the Launchpad, click Multimedia.

c. In the left pane, select the server to which you want to log on.

d. Click Launch Multimedia Client.
e. In the left column, select Agent Desktop Configuration.

f. Click Common Settings.

g. Select Suppress OS not supported popup check box.

h. Click Save.

2. Log on to the RDS Session Host server with administrative privileges.

3. Using the Server Manager – Remote Desktop Services utility, select Collections > 
QuickSessioncollection.

4. In the REMOTEAPP PROGRAMS section, from the TASKS drop-down list, select Publish 
RemoteApp Programs.

5. From the RemoteApp Programs list, select Avaya Agent Desktop 7.1.

6. Click Next.
7. Click Publish.

8. From the REMOTEAPP PROGRAMS list, right-click Agent Desktop and select 
Properties.

9. Configure the agent, user, and user group accounts to access the Agent Desktop 
RemoteApp.

10. Log on to an agent client computer.

11. Use a web browser to access the RD Web Access Interface. For example, you can use 
Microsoft Edge with the Internet Explorer mode to access the RD Web Access Interface by 
using the following URL:
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https://<RDS Server FQDN>/RDWeb
12. On the Work Resources page, enter the Windows domain account details for the agent 

and click Sign in.

The web interface lists the RemoteApps available to the agent.

13. In the Current folder section, double-click Agent Desktop.

14. Log on to Agent Desktop and Go Ready.

15. Verify that the Agent Desktop RemoteApp can handle routed customer calls, and continue 
to verify the features your solution requires.

Next steps
Using the Server Manager Performance and Best Practice Analyzer, continue to monitor all the 
resources of the RDS host servers, focusing on CPU, memory, and disk drive resources. Capture 
the initial CPU and memory usage as baseline performance metrics.
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Chapter 30: Publishing ACCS client 
software in a Citrix deployment

This chapter describes how to configure and publish Avaya Contact Center Select software 
applications in a Citrix deployment.

Prerequisites
• Install Avaya Contact Center Select.

• Ensure that you have administrative privileges on the client computer.

• Install one of the following supported operating systems on the client computer:

- Windows 10

- Windows 11

• Ensure that you are using the Microsoft Edge browser in Internet Explorer mode.

• Optionally, depending on your solution, create the Citrix users allowed to run the published 
Avaya Contact Center Select applications.

Configuring the client OS setting for Citrix deployments
About this task
Configure Contact Center Multimedia to support Agent Desktop in Citrix deployments.

Procedure
1. Log on to Contact Center Manager Administration with administrator privileges.

2. On the Launchpad, click Multimedia.

3. In the left pane, select the server to which you want to log on.

4. Click Launch Multimedia Client.
5. In the left column, select Agent Desktop Configuration.
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6. Click Common Settings.

7. Select the Suppress OS not supported popup check box.

8. Click Save.

Publishing Agent Desktop client software on a Citrix 
server

Before you begin
• Install Agent Desktop on the Avaya Contact Center Select server.
• Copy the Agent Desktop client folder from the Avaya Contact Center Select server to a 

location on the Citrix server. The folder is located on the server at: D:\Avaya\Contact 
Center\Multimedia Server\Agent Desktop\client

About this task
Agent Desktop must be configured as a published application before you can launch Agent 
Desktop software on a client computer. Use this procedure to publish Agent Desktop client 
software on a Citrix Server.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.

3. On the Name page, in the Display name field, type a name such as Agent Desktop.

4. In the Application description field, type a description for the published application.

5. Click Next.
6. On the Type page, from Application type, click Accessed from a server.
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7. Click Next.
8. On the Location page, click Browse.

9. Navigate to the Citrix server location where the Agent Desktop client folder is stored.

10. Select the CCAD.exe file and click OK.
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11. Click Next.
12. On the Servers page, click Add.

13. On the Select Servers window, select the Citrix server used to run the Agent Desktop 
application and then click Add.

14. Click OK.

15. Click Next.
16. On the Users page, click Add.

17. On the Select Users or Groups window, select the users allowed to run the published 
application.

For example, select your Contact Center agents.
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18. Click Add.

19. Click OK.

20. Click Next.
21. On the Shortcut presentation page, select an application shortcut option.

Agent Desktop displays as an icon by default. You can also choose to create a client 
application folder on each client computer that contains all published applications, or add 
shortcuts to the client computer’s Start menu or desktop.
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22. Click Next.
23. On the Publish immediately page, select Configure advanced application settings now 

and click Next.
24. Continue clicking Next until the Limits page is displayed.

25. Select Allow only one instance of application for each user.
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26. Click Next.
27. Click Finish.

On the client computer, agents can now launch Agent Desktop using one of the configured 
shortcuts.

Publishing Contact Center Manager Administration on a 
Citrix server as content

Before you begin
Install Avaya Contact Center Select.

About this task
You can access the Contact Center Manager Administration (CCMA) application on a client 
computer using a Citrix server. You must configure your Citrix server to publish CCMA as 
published content.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.
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3. On the Name page, in the Display name field, type a name for the new published 
application.

For example, type ccma.

4. In the Application description field, type a description for the published application.

5. Click Next.
6. On the Type page, under Choose the type of application to publish, click Content.
7. Click Next.
8. On the Location page, type the Contact Center Manager Administration URL.

For example, type http://<server name>, where <server name> is the name of the 
Avaya Contact Center Select server.

9. Click Next.
10. On the Users page, select Allow only configured users.

11. From the Select directory type drop-down list, select Citrix User Selector.
12. Click Add.

13. On the Select Users or Groups window, select the users allowed to run the published 
application.

For example, select your Contact Center administrators.
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14. Click Add.

15. Click OK.

16. Click Next when prompted.

17. Click Finish.

On the client computer, authorized users can now access CCMA using the Citrix client.

Publishing Contact Center Manager Administration on a 
Citrix server as an installed application

Before you begin
Install Avaya Contact Center Select.

About this task
You can access the Contact Center Manager Administration application on a client computer using 
a Citrix server. You must configure your Citrix server to publish CCMA as an installed application.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.

3. On the Name page, in the Display name field, type a name for the new published 
application.

For example, type ccma.

4. In the Application description field, type a description for the published application.

5. Click Next.
6. On the Type page, under Choose the type of application to publish, click Application.

7. Under Application Type, click Accessed from a server.
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8. Click Next.
9. On the Location page, click Browse.

10. On the Citrix server, navigate to the location of the Internet Explorer executable.

For example, navigate to C:\Program Files (x86)\Internet 
Explorer\iexplore.exe.

11. Ensure that the location is within quotation marks and type the CCMA URL after the 
location.

For example, type “C:\Program Files (x86)\Internet 
Explorer\iexplore.exe” http://<server name>, where <server name> is the 
name of the Avaya Contact Center Select server.

12. Click Next.
13. On the Servers page, click Add.

14. On the Select Servers window, select the Citrix server used to run the CCMA application 
and then click Add.

15. Click OK.

16. Click Next.
17. On the Users page, select Allow only configured users.

18. From the Select directory type drop-down list, select Citrix User Selector.
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19. Click Add.

20. On the Select Users or Groups window select the users allowed to run the published 
application.

For example, select your Contact Center administrators.

21. Click Add.

22. Click OK.

23. Click Next when prompted.

24. Click Finish.

On the client computer, authorized users can now access CCMA using the Citrix client.

Installing the ActiveX Controls on the Citrix server
Before you begin
Configure your browser to enable, initialize, and script ActiveX Controls not marked as safe.

•
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About this task
Install the ActiveX Controls.msi file on the Citrix server.

The ActiveX controls are rules that specify how applications share information using the web 
browser. In Contact Center, ActiveX controls enable communication between the clients and 
servers to report data and display information from the database.
Controls downloaded using the ActiveX Controls.msi file are not displayed with your 
browser's downloaded program files.

Procedure
1. Read the Avaya Contact Center Select Release Notes to obtain the location of the latest 

ActiveX Controls.msi file for your Avaya Contact Center Select release.

2. Log in to the Citrix server with administrator privileges.

3. Copy the ActiveX Controls.msi to a location on the Citrix server.

4. From this location, double-click ActiveX Controls.msi to begin the installation.

5. Click Next.
6. Select a destination folder or accept the default installation folder.

7. Click Next.
8. In the window displayed for the installation, click Install.
9. Click Finish.
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Chapter 31: Language support 
fundamentals

This chapter provides background information for Language support. If you want to use English 
across all platforms, you can ignore this chapter.

Contact Center Multimedia (CCMM) and Contact Center Manager Administration (CCMA) support 
the following languages:

• English

• French (FR)

• German (DE)

• Japanese (JA)

• Russian (RU)

• Simplified Chinese (Zh-CN)

• Latin American Spanish (ES)

• Brazilian Portuguese (PT-BR)

• Italian (IT)

• Korean (KO)

The following table lists the compatibility between the CCMA language and the Operating System 
(OS) language family. You can only enable compatible languages on the Contact Center server.

OS 
language

FR DE ES PT-BR IT Zh-CN JA RU KO

English Yes Yes Yes Yes Yes No No No No
Any 1 Latin 
language

Yes Yes Yes Yes Yes No No No No

Simplified 
Chinese

No No No No No Yes No No No

Japanese No No No No No No Yes No No
Russian No No No No No No No Yes No
Korean No No No No No No No No Yes

You use the CCMA Language Settings utility to enable additional languages. Access the Language 
Settings utility from the CCMA Configuration page. The English language is always enabled and 
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you cannot disable it. The Language Settings utility displays the current server code page for the 
Contact Center server.

A code page is an internal table that the operating system uses to map symbols (letters, numerals, 
and punctuation characters) to a number. Different code pages provide support for the character 
sets used in different languages. Code pages have a number for reference; for example, code page 
932 represents the Japanese character set, and code page 950 represents the Chinese character 
set. In a Contact Center solution, on an English Contact Center server, the server code page is 
1252. On a Contact Center server with Japanese, the server code page is 932.

Install the most recent Service Pack and patches to enable the localized languages in the CCMA 
Language Settings utility. A Service Pack contains all supported languages. For CCMA, you can 
enable languages that are appropriate to the local operating system of the server. For example, you 
can enable the simplified Chinese language on a simplified Chinese OS, but you cannot enable 
German on a simplified Chinese OS. The client computers operating systems must be of the 
same language family as the associated server. You can enable multiple languages from the same 
language family on a single server.

Note:

If the server code page changes, you can still change previously enabled languages. You must 
disable the languages that are not supported.

If you enable a language in the Language Settings utility, users see the localized CCMA pages in 
the preferred language that is set in their client browser. For example, if you enable Spanish in the 
Language Settings utility, and if Spanish is the preferred language in your browser on the CCMA 
client computer, then CCMA displays in Spanish in the CCMA client browser.

For some languages, translations can be different from the terms usually used in your region:

• French: The translation attempts to find terms that are acceptable to both Canadian and 
European French speakers.

• Latin American (LA) Spanish: The translation attempts to find terms that are acceptable to both 
Latin American and European Spanish speakers.

Read the Contact Center Service Pack Release Notes for further information. The Service Pack 
Release Notes contain the most recent information about language support.

Language levels
Contact Center Multimedia and Contact Center Manager Administration support two levels of 
language environment:

• international environment
• international and local environment

International environment
In the international environment, the graphical user interface, the online Help, and all reports are 
in English. However, you can enter user information that contains non-ASCII characters (such 
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as agent and supervisor names). Also, you can manage date and time formats from a different 
regional time zone.

International and local environment
In the combined international and local environment, the graphical user interface, the online Help, 
and many reports are translated into one of the following supported languages: French, German, 
Japanese, Italian, Korean, Russian, Simplified Chinese, LA Spanish, and Brazilian Portuguese. 
Also, you can enter user information that contains non-ASCII characters and you can use date 
and time formats from a different regional time zone. For details of the reports that are translated 
for a particular language, see the Contact Center Service Pack Release Notes.
In this environment, you must install the most recent Service Pack on the Contact Center servers. 
See the Service Pack Release Notes for further information.

Language family compatibility
For Contact Center Manager Administration to function properly, the language family of the 
operating systems must be compatible across all platforms in the network. If the language 
versions of the operating systems on the Contact Center Manager Server, Contact Center 
Multimedia, Contact Center Manager Administration server, and the client PC belong to the same 
language family, the platforms can coexist on the same network. This compatibility is useful if your 
contact center supports multiple languages.

The character sets for English are included in all language families. Contact Center Multimedia 
and Contact Center Manager Administration recognize the following language families:

• Latin-1

• Japanese

• Russian

• Simplified Chinese

• Korean

Latin-1 includes all Western European languages that use the Latin-1 character set. French, 
German, Italian, LA Spanish, and Brazilian Portuguese belong to the Latin-1 language family. 
Agents in the contact center can view Contact Center Manager Administration and Contact Center 
Multimedia in English, French, German, LA Spanish, Italian, or Brazilian Portuguese. For Latin-1 
language family and server compatibility, see the Contact Center Localization Release Notes for 
further information.

If you use the Japanese language family, users in the same contact center can view Contact 
Center Manager Administration and Contact Center Multimedia in English or Japanese. If you 
use the Simplified Chinese language family, users in the same contact center can view Contact 
Center Manager Administration and Contact Center Multimedia in English or Simplified Chinese. If 
you use the Russian language family, users in the same contact center can view Contact Center 
Manager Administration and Contact Center Multimedia in English or Russian.
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Configuring the operating system language
About this task
Perform the following procedure to configure a new language for the Contact Center server 
operating system. You must perform this procedure to ensure that Contact Center operates 
correctly when using a new operating system language.

Before you begin
• Download and install the language pack for the language you want to configure on the 

operating system. Refer to Microsoft documentation for information about language packs.

Procedure
1. Log on to the Contact Center server.

2. On the Start screen, click Control Panel.
3. In the Control Panel, click Clock, Language, and Region.

4. Click Language.

5. Click Add a language.

6. From the list of languages, select a language and click Open.

7. If required, from the list of regional variants, select the regional variant of the language and 
click Add.

8. On the Language window, select the newly added language and click Move up.

9. Click Advanced settings.

10. Under Override for Windows display language, from the drop-down list, select the newly 
added language.

11. Under Override for default input method, from the drop-down list, select the newly 
added language.

12. Click Save.

13. On the Change display language dialog box, click Log off later.
14. On the Language window, in the left pane, click Change date, time, or number formats.

15. On the Region window, select the Administrative tab.

16. Click Copy settings.

17. On the Welcome screen and new user accounts settings window, select the Welcome 
screen and system accounts check box and the New user accounts check box.

18. Click OK.

19. Restart the Contact Center server.
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Setting the system locale
About this task
Ensure that the Contact Center server system locale matches the operating system language. If 
the system locale does not match the operating system language, you cannot enable a localized 
language in Contact Center Manager Administration (CCMA).

Procedure
1. Log on to the Contact Center server.

2. On the Start screen, click Control Panel.
3. In the Control Panel, click Clock, Language, and Region.

4. On the Clock, Language, and Region window, click Region.

5. On the Region window, select the Administrative tab.

6. Click Change system locale.

7. On the Region Settings window, in the Current system locale field, select a locale that 
matches the operating system language.

8. Click OK.

9. On the Region window, click OK.

Enabling a localized language
Before you begin

• Check that the system locale matches the operating system language setting. For information 
about setting the system locale, see Setting the system locale on page 381.

• Read the Contact Center Service Pack Release Notes for more information. The Release 
Notes contain the most recent information about language support.

• Ensure that Contact Center is working before installing the Service Pack.
• Using the Release Pack Installer (RPI) and Avaya Contact Center Update Manager, apply 

the most recent Service Pack and patches.

About this task
Enable a language using the Contact Center Manager Administration (CCMA) Language Settings 
utility so that CCMA administrators and users see the localized CCMA screens in their client 
browsers.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Manager Administration Configuration.
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3. In the Avaya Applications Configuration window, in the right pane, click Language 
Settings.

4. In the Language Settings window, select the required CCMA localized language from the 
list, and select Enabled for that language.

5. Click Save.

Accessing CCMA web client with local language
About this task
If the CCMA web client runs on an English OS client computer and displays text in the English 
language, use this procedure to enable CCMA to display the same text in the local language.
Therefore, a local administrator or a user who has an English OS client computer can read the text 
in CCMA in the local language.
Ensure that you do the following:

• Use the name of the Contact Center server to log on to CCMA.
• Do not use the IP address of the Contact Center server to log on to CCMA.

Before you begin
Install the most recent service pack on the Contact Center server.

Procedure
1. Start the Microsoft Edge web browser and enable the Internet Explorer mode.

2. In the address bar, type the URL of the Contact Center server.

For example, type https://<Contact Center server name>.

If you turn off the security of the Contact Center server, type http://<server name>, 
where <server name> is the computer name of the Contact Center server.

3. Press Enter.

4. Press Alt+F and click Settings.

5. In the Settings pane, click Languages.

6. In the Languages area, click Add languages.

The browser displays the Add languages dialog box.

7. From the list of languages, select the check box that indicates the local language.

For example, to select the German language, select the check box for German (Germany) 
- Deutsch (Deutschland).

8. Click Add.

Language support fundamentals

April 2024 Avaya Contact Center Select Advanced Administration 382
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


The browser closes the Add languages dialog box and displays the local language in the 
Preferred languages area.

9. In the Language Preferences area, click the Move up button to move the local language to 
the top of the list to indicate your preference.

10. Click Save.

CCMA displays the text in the local language.

For example, if you set a preference for the German language, CCMA displays the text in 
German.
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Chapter 32: Common procedures

This chapter describes the common procedures that you perform to administer your Avaya Contact 
Center Select software.

Starting or stopping Contact Center applications
About this task
Use the System Control and Monitor Utility to start and stop all applications in Contact Center.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click System Control and Monitor Utility.

3. Click the Contact Center tab.

4. Select the check box for each application to start or stop on the server.

5. Do one of the following:

• To start the selected applications, click Start Contact Center.
• To stop the selected applications, click Shut down Contact Center.
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Appendix A: Server name or IP address 
change - hardware appliance 
or DVD install

This Appendix describes the procedures you must perform to change the name or IP address of the 
Avaya Contact Center Select hardware appliance or an Avaya Contact Center Select server. You 
must perform a server name or IP address change during a Contact Center maintenance window.

Important:

Avaya Contact Center Select does not support changing the server name or IP address of 
servers configured for Business Continuity. Avaya recommends that you configure the final 
production name of the Avaya Contact Center Select servers before configuring Business 
Continuity.

Avaya Contact Center Select server name change
Change the name of the Avaya Contact Center Select server. You must also change the 
server name of Avaya Aura® Media Server. The new host name of the server must meet the 
specifications of the server names in the Contact Center suite.

Security considerations
If you change the name of a secured Contact Center server, Avaya recommends that you create a 
new security store with a server certificate that matches the new server name.
Each server certificate has a name, which normally derives from the server Fully Qualified Domain 
Name (FQDN). If a server certificate name does not match the name of the website or web service 
to which a client connects, the client generates a warning. Normally on a GUI, a user can bypass 
the warning and continue. If the client is a service on another system, it does not handle and 
bypass the warning unless coded to do so.
If you change the server name and do not change the server certificate, users always see 
warnings when they connect to Contact Center web services.

Solutions that require server certificates
• Solutions that use TLS security for the CTI link to IP Office.
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• Solutions using the Agent Browser application. These always use TLS security for the Agent 
Browser application client.

• Solutions on which you enabled Web Services security.
• Solutions using Secure Real Time Protocol for voice traffic.

Preparing a server certificate before changing the server name
If you use an external Certificate Authority (CA), it can sometimes take an extended period to 
receive a signed server certificate after submitting your Certificate Signing Request (CSR) to the 
CA. To minimize the time elapsed for a server name change, you can create a CSR and request 
and receive a new server certificate before changing the server name. The following high-level 
procedures outline how to create a new CSR to send to the CA.

Important:
If the CA you use to sign the new server certificate is different to the CA you used to sign the 
old server certificate, you must also distribute a new root certificate to all the relevant clients 
and servers after changing the server name and applying the new server certificate.

To create a new CSR in the Contact Center security store using Security Manager:
• Schedule a maintenance window for this task, because you must stop the Contact Center 

services.
• In Security Manager, back up the Contact Center security store.
• Delete the existing security store.
• Create a new security store, specifying the planned new server name as the common name 

for the certificate.
• Copy the CSR content from the new security store, to send to the CA to request a server 

certificate.
• Restore the Contact Center security store that you backed up.

You can now use the CSR you generated to request a server certificate from a CA. When the CA 
provides the new server certificate, you can schedule the Contact Center server name change.
In Avaya Aura® Media Server, you can create a new CSR at any time without stopping the server 
or impacting the existing certificates. Create a new CSR to request a new server certificate from a 
CA. When the CA provides the new server certificate, you can schedule the server name change.

Avaya Contact Center Select server name change prerequisites
• Ensure that the new server name is unique.
• Ensure that the new server name is from 6 to 15 characters and that the first character is 

alphabetical.
• Ensure that the new server name contains no underscores (_), spaces ( ), or punctuation.

Turning off Web Services security
About this task
Turn off Web Services security before you rename the server. If Web Services security is not 
enabled on your contact center, you can skip this procedure.

Server name or IP address change - hardware appliance or DVD install

April 2024 Avaya Contact Center Select Advanced Administration 386
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Procedure
1. Log on to the Contact Center server as a local administrator.

Important:

If you log on to the server as a domain administrator, this procedure does not complete 
successfully.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the password for the security store, and click OK.

4. On the Security Manager screen, select the Security Configuration tab.

5. Click Security Off.
6. Click Apply.

7. On the Security Change Confirmation dialog, click Confirm.

8. Click Log Out.
9. Restart the Contact Center server.

Stopping Avaya Contact Center Select
About this task
You must stop the Avaya Contact Center Select system before changing the server name or IP 
address.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. On the Windows System Tray, right-click on the System Management and Monitoring 
Component (SMMC) system tray icon, and select Stop System.

Avaya Contact Center Select services begin shutting down. When all services are shut 
down, the SMMC icon in the Windows System Tray changes to the stopped state.

Changing the server name in the operating system
About this task
Change the server name of the Avaya Contact Center Select server operating system to reflect 
the new name of the server.

Procedure
1. Log on to the Avaya Contact Center Select server as an administrator.

2. On the Start screen, click Control Panel.
3. Click System and Security > System.

Avaya Contact Center Select server name change

April 2024 Avaya Contact Center Select Advanced Administration 387
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


4. In the Computer name, domain, and workgroup settings section, click Change 
settings.

5. Click the Computer Name tab.

6. Click Change.

7. Type the new server name.

8. Click OK.

9. When you receive a prompt, click Yes to restart the server.

10. If you are using a Domain Name Service (DNS), contact your local network administrator 
to update the DNS with the new server name.

Updating the HOSTS file on the Avaya Contact Center Select 
server

Before you begin
• Determine if you need to update the HOSTS table on your server.

Important:
Incorrectly modifying a host table can cause extensive network problems. Before you 
modify host tables, review the information about hosts in the supporting documentation 
for Microsoft Windows Server.

About this task
If you do not have a DNS server, you must manually update the HOSTS file on the Avaya Contact 
Center Select server with the new server name and IP address. This ensures that all servers can 
interpret the new server name.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. Browse to the HOSTS file in the installation directory, 
C:\Windows\system32\drivers\etc.

3. Right-click the HOSTS file and open the file with a text editor such as Notepad to modify 
the host tables.

4. Update the file to reflect the new server name, IP address, or both.

5. On the File menu, click Save.

6. Close all windows.

Verifying the server name change
About this task
Verify that the Domain Name Service server or network has the correct server name.
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Procedure
1. On the Desktop screen, right-click on the Windows icon and select Run.

2. In the Open box, enter cmd.

3. In a Command line window, type ping <server name>.

Where <server name> is the new name of the Avaya Contact Center Select server.

4. Verify that the IP address matches the IP address of the server with the new name.

Synchronizing the operating system name with the Avaya Contact 
Center Select server name

About this task
Synchronize the operating system name with the Avaya Contact Center Select server name to 
ensure that the Contact Center suite uses the new server name.

Important:
Ensure that Avaya Contact Center Select services are stopped before you run the Computer 
Name Synchronisation Utility.

Procedure
1. Log on to the Avaya Contact Center Select server as an administrator.

2. Close the System Control and Monitor Utility if it is running.

3. From the Start menu, in the Avaya area, click Computer Update Utility.

4. Verify that the new Avaya Contact Center Select server name appears in the New 
Computer Name box.

5. Under System Account Configuration, in the Password box, type the password for the 
Avaya Contact Center Select administration account. The password is not checked against 
the server security policy for minimum password requirements. Avaya recommends that 
you enter a password that conforms to your corporate password policy.

6. In the Confirm Password box, type the password.

7. Click Apply and click Yes to confirm.

8. After the synchronization process is complete, click Restart to restart the server.

Note:

The Computer Name Synchronisation Utility provides information about the success of 
the synchronization process for each of the components: Avaya Contact Center Select, 
Avaya Aura® Media Server, and Avaya IP Office. If you want to view the log file for the 
synchronization process, click Open log file before you click Restart.
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Changing the server name for Enterprise Web Chat
About this task
If your contact center implements Avaya Enterprise Web Chat, update the CCMM server name for 
EWC.

Before you begin
Shut down the CCMM services using SCMU.

Procedure
1. Log on to the Multimedia Contact Server

2. Right-click Start.
3. Select Run.

4. Type cmd.

5. Click OK.

6. In the command line window, enter CD D:\Avaya\Contact 
Center\EnterpriseWebChat\eJabberd

7. Enter update_hostname.bat <CCMM_servername>
where <CCMM_servername> is the new Multimedia Contact Server name.

8. Use SCMU to start the CCMM services.

Configuring Enterprise Web Chat settings
Before you begin
Enterprise Web Chat (EWC) works only if Contact Center is deployed on Communication Manager 
with a Voice and Multimedia Contact Server with or without AAMS, or a standalone Multimedia 
Contact Server. You must also ensure that your Contact Center is licensed for EWC.

About this task
Configure the EWC server domain and optionally the Transcript Filtering Web Service, if your 
Contact Center uses Enterprise Web Chat (EWC).
Use the Transcript Filtering Web Service to modify EWC chat transcripts before the transcripts 
are saved to the Multimedia database. Creating filters is the responsibility of the customers and 
a sample filter is provided as part of the EWC SDK. You can configure EWC to use a transcript 
filter created by the customer. The transcript filter can be used to modify the transcript to mask 
sensitive data such as account details, credit card numbers, or personal identification numbers. 
The transcripts are associated with the customer record whose email sent the chat request.

Note:
• EWC filters out the < and > characters making these characters invisible to the other 

party in the chat. Therefore, in EWC chat messages, agents or customers must not use 
the < or > characters.

• EWC does not support the NIC Teaming feature.
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Procedure
1. Open the Multimedia Administration utility. See Starting CCMM Administration utility on 

page 46.

2. In the left pane, click Web Comms.

3. Click Config.

4. To enable your Agent Desktop to handle EWC contacts, click the Enable Enterprise Web 
Chat option.

By default the Enable Enterprise Web Chat option is not enabled. You can select the 
Enable Enterprise Web Chat option only if the EWC license is present.

5. In the External Web Server Domain box, type the domain name for the server hosting the 
customer-facing website for EWC.

6. (Optional) In the Transcript Filtering Web Service box, type the URL of a REST service 
used to filter customer chat transcripts.

The format of the URL of the REST service is either http://<uri> or https://<uri>, 
where <uri> is the service URI of the transcript filtering service.

For more information on Transcript Filtering Web Service, see the SDK documentation.

7. Click Save.

Configuring the external Web Communications server
Before you begin

• Know the custom interface folder names and paths for the web.xml and .jsp files for the 
sample Web communications installation.

About this task
If your solution uses an external Web Communications server, configure the Web Communications 
server to update the files with the new server name.
You must update for .jsp files with Apache Tomcat. If you use a different servlet engine (for 
example, JRun or WebLogic) or a different technology (ASP.NET), you must use the standard 
procedures for your environment.

Procedure
1. Log on to your external Web Communications Web server.

2. Open the config file located at C:\xampp\htdocs\Code\include in Notepad or another 
text editor.

3. Locate the text string CCMM_MACHINE_NAME and update the new server name after 
the ’=’ sign.

4. Save and close the file.

Avaya Contact Center Select server name change

April 2024 Avaya Contact Center Select Advanced Administration 391
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AvayaContactCenterSelectAdvancedAdministration&p3=16


Updating the HOSTS file for clients
Before you begin

• Determine if you need to update the HOSTS table on your client.

Important:
Incorrectly modifying a host table can cause extensive network problems. Before you 
modify host tables, review the information about hosts in the supporting documentation 
for Microsoft Windows.

About this task
If you do not have a DNS server, you must manually update the HOSTS file on each client in your 
contact center with the new computer IP address. This ensures that all clients can interpret the 
new server name.

Procedure
1. Log on to the client computer.

2. Browse to the HOSTS file in the Windows installation directory, 
C:\Windows\system32\drivers\etc.

3. Right-click the HOSTS file and open the file with a text editor such as Notepad to modify 
the host tables.

4. Update the HOSTS file to reflect the new Avaya Contact Center Select server name or IP 
address.

5. On the File menu, click Save.

6. Close all windows.

7. Repeat this procedure on each client computer.

Updating client browsers and shared folders
Before you begin

• Ensure that you export scheduled reports in your Contact Center.
• Ensure that you updated the HOSTS file on the clients with the new Avaya Contact Center 

Select server name.

Important:
Administrators cannot update the browsers and shared folders for each user, therefore 
users needs to update their respective browsers and shared folders.

About this task
Update the client browsers and shared folders to reference the new Avaya Contact Center Select 
server name in the browser.

Procedure
1. Log on to Contact Center Manager Administration as an administrator.
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2. From the Launchpad, click Historical Reporting.

3. In the Historical Reporting main window, click the CC server.

4. For each report associated with the new server, click the report name.

5. In the Report Properties window, click the Output Options heading to expand the section.

6. Select the Output to file check box.

7. In the Output box, browse to the path of the report.

8. Click Save Report.
9. Click Activate.

10. Close the report.

11. Repeat step 4 to step 10 for each report.

Reinstalling Agent Desktop
Before you begin

• Change the name of the Avaya Contact Center Select server.
• Uninstall Agent Desktop. For more information on installing and uninstalling Agent Desktop, 

see Using Agent Desktop for Avaya Contact Center Select .

About this task
Reinstall Agent Desktop to allow agents to monitor calls and make calls.

Procedure
Install Agent Desktop.

Important:

Install Agent Desktop using the new server name.

Avaya Contact Center Select server IP address change
Change the IP address of the Avaya Contact Center Select server. You must also update the 
Avaya Aura® Media Server IP address.

Stopping Avaya Contact Center Select
About this task
You must stop the Avaya Contact Center Select system before changing the server name or IP 
address.
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Procedure
1. Log on to the Avaya Contact Center Select server.

2. On the Windows System Tray, right-click on the System Management and Monitoring 
Component (SMMC) system tray icon, and select Stop System.

Avaya Contact Center Select services begin shutting down. When all services are shut 
down, the SMMC icon in the Windows System Tray changes to the stopped state.

Changing the contact center subnet IP address of the Avaya 
Contact Center Select server

About this task
You must perform the following steps to update the Avaya Contact Center Select server IP 
address references.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click System Control and Monitor Utility.

3. On the System Control & Monitor Utility window, click Shut down Contact Center.
4. On the Start screen, click Control Panel.
5. Click Network and Internet  > Network and Sharing Center.
6. Click Change adapter settings.

7. Right-click the LAN connection of the contact center subnet network interface card and 
select Properties.

8. Select Internet Protocol Version 4 (TCP/IPv4) and then click Properties.

9. In the IP address field, type the new IP address and click OK.

10. Click Close.

11. Restart the server.

12. From the Start menu, in the Avaya area, click Server Configuration.

13. In the Server Configuration dialog box, click Apply All.
14. If you are using a Domain Name Service (DNS), contact your local network administrator 

to update the DNS with the new IP address.

Verifying the server IP address change
About this task
Verify that the Domain Name Service server or network has the correct server IP address.
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Procedure
1. On the Desktop screen, right-click on the Windows icon and select Run.

2. In the Open box, enter cmd.

3. In a Command line window, type ping <server name>.

Where <server name> is the name of the Avaya Contact Center Select server.

4. Verify that the IP address matches the new IP address of the server.

Synchronizing the operating system IP address with the Avaya 
Contact Center Select server IP address

About this task
Synchronize the operating system IP address with the Avaya Contact Center Select server IP 
address to ensure that the Contact Center suite uses the new server IP address.

Important:
Ensure that Avaya Contact Center Select services are stopped before you run the Computer 
Name Synchronisation Utility.

Procedure
1. Log on to the Avaya Contact Center Select server as an administrator.

2. Close the System Control and Monitor Utility if it is running.

3. From the Start menu, in the Avaya area, click Computer Update Utility.

4. Verify that the new Avaya Contact Center Select server IP address appears in the New IP 
Address box.

5. Click Apply and click Yes to confirm.

6. After the synchronization process is complete, click Restart to restart the server.

Note:

The Computer Name Synchronisation Utility provides information about the success of 
the synchronization process for each of the components: Avaya Contact Center Select, 
Avaya Aura® Media Server, and Avaya IP Office. If you want to view the log file for the 
synchronization process, click Open log file before you click Restart.

Updating the Avaya Aura® Media Server IP Interface Assignment
About this task
Perform the following procedure if you need to change the IP address of a Windows-based Avaya 
Aura® Media Server. After you change the IP Interface Assignment, you must start Avaya Aura®

Media Server.
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Procedure
1. Log on to Avaya Aura® Media Server Element Manager (EM).

If you are using a remote browser to gain access to EM, use the new IP address in the 
URL for the EM login.

2. Navigate to EM  > System Configuration  > Network Settings > IP Interface 
Assignment.

3. The IP Interface Assignment fields show errors as a result of the IP address change. 
Select valid IP addresses from the drop-down menus for the each field showing Invalid.

4. Click Save.

5. Click Confirm.

6. Navigate to EM  > System Status  > Element Status.

7. Click Start.
8. Click Confirm to proceed with the action.

The Avaya Aura® Media Server system starts.

Updating the HOSTS file for clients
Before you begin

• Determine if you need to update the HOSTS table on your client.

Important:
Incorrectly modifying a host table can cause extensive network problems. Before you 
modify host tables, review the information about hosts in the supporting documentation 
for Microsoft Windows.

About this task
If you do not have a DNS server, you must manually update the HOSTS file on each client in your 
contact center with the new computer IP address. This ensures that all clients can interpret the 
new server name.

Procedure
1. Log on to the client computer.

2. Browse to the HOSTS file in the Windows installation directory, 
C:\Windows\system32\drivers\etc.

3. Right-click the HOSTS file and open the file with a text editor such as Notepad to modify 
the host tables.

4. Update the HOSTS file to reflect the new Avaya Contact Center Select server name or IP 
address.

5. On the File menu, click Save.

6. Close all windows.
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7. Repeat this procedure on each client computer.
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Appendix B: Server name or IP address 
change - software appliance

This Appendix describes the procedures you must perform to change the server names or IP 
addresses of the Avaya Contact Center Select software appliance. You must perform a server name 
or IP address change during a Contact Center maintenance window.

Important:

Avaya Contact Center Select does not support changing the server name or IP address of 
servers configured for Business Continuity. Avaya recommends that you configure the final 
production name of the Avaya Contact Center Select servers before configuring Business 
Continuity.

Avaya Contact Center Select server name change
Change the name of the Avaya Contact Center Select server. The new name of the server must 
meet the specifications of the server names in the Contact Center suite.

Security considerations
If you change the name of a secured Contact Center server, Avaya recommends that you create a 
new security store with a server certificate that matches the new server name.
Each server certificate has a name, which normally derives from the server Fully Qualified Domain 
Name (FQDN). If a server certificate name does not match the name of the website or web service 
to which a client connects, the client generates a warning. Normally on a GUI, a user can bypass 
the warning and continue. If the client is a service on another system, it does not handle and 
bypass the warning unless coded to do so.
If you change the server name and do not change the server certificate, users always see 
warnings when they connect to Contact Center web services.

Solutions that require server certificates
• Solutions that use TLS security for the CTI link to IP Office.
• Solutions using the Agent Browser application. These always use TLS security for the Agent 

Browser application client.
• Solutions on which you enabled Web Services security.
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• Solutions using Secure Real Time Protocol for voice traffic.

Preparing a server certificate before changing the server name
If you use an external Certificate Authority (CA), it can sometimes take an extended period to 
receive a signed server certificate after submitting your Certificate Signing Request (CSR) to the 
CA. To minimize the time elapsed for a server name change, you can create a CSR and request 
and receive a new server certificate before changing the server name. The following high-level 
procedures outline how to create a new CSR to send to the CA.

Important:
If the CA you use to sign the new server certificate is different to the CA you used to sign the 
old server certificate, you must also distribute a new root certificate to all the relevant clients 
and servers after changing the server name and applying the new server certificate.

To create a new CSR in the Contact Center security store using Security Manager:
• Schedule a maintenance window for this task, because you must stop the Contact Center 

services.
• In Security Manager, back up the Contact Center security store.
• Delete the existing security store.
• Create a new security store, specifying the planned new server name as the common name 

for the certificate.
• Copy the CSR content from the new security store, to send to the CA to request a server 

certificate.
• Restore the Contact Center security store that you backed up.

You can now use the CSR you generated to request a server certificate from a CA. When the CA 
provides the new server certificate, you can schedule the Contact Center server name change.
In Avaya Aura® Media Server, you can create a new CSR at any time without stopping the server 
or impacting the existing certificates. Create a new CSR to request a new server certificate from a 
CA. When the CA provides the new server certificate, you can schedule the server name change.

Avaya Contact Center Select server name change prerequisites
• Ensure that the new server name is unique.

• Ensure that the new server name is from 6 to 15 characters and that the first character is 
alphabetical.

• Ensure that the new server name contains no underscores (_), spaces ( ), or punctuation.

Turning off Web Services security
About this task
Turn off Web Services security before you rename the server. If Web Services security is not 
enabled on your contact center, you can skip this procedure.
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Procedure
1. Log on to the Contact Center server as a local administrator.

Important:

If you log on to the server as a domain administrator, this procedure does not complete 
successfully.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the password for the security store, and click OK.

4. On the Security Manager screen, select the Security Configuration tab.

5. Click Security Off.
6. Click Apply.

7. On the Security Change Confirmation dialog, click Confirm.

8. Click Log Out.
9. Restart the Contact Center server.

Stopping Avaya Contact Center Select
About this task
You must stop the Avaya Contact Center Select system before changing the server name or IP 
address.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. On the Windows System Tray, right-click on the System Management and Monitoring 
Component (SMMC) system tray icon, and select Stop System.

Avaya Contact Center Select services begin shutting down. When all services are shut 
down, the SMMC icon in the Windows System Tray changes to the stopped state.

Changing the server name in the operating system
About this task
Change the server name of the Avaya Contact Center Select server operating system to reflect 
the new name of the server.

Procedure
1. Log on to the Avaya Contact Center Select server as an administrator.

2. On the Start screen, click Control Panel.
3. Click System and Security > System.
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4. In the Computer name, domain, and workgroup settings section, click Change 
settings.

5. Click the Computer Name tab.

6. Click Change.

7. Type the new server name.

8. Click OK.

9. When you receive a prompt, click Yes to restart the server.

10. If you are using a Domain Name Service (DNS), contact your local network administrator 
to update the DNS with the new server name.

Updating the HOSTS file on the Avaya Contact Center Select 
server

Before you begin
• Determine if you need to update the HOSTS table on your server.

Important:
Incorrectly modifying a host table can cause extensive network problems. Before you 
modify host tables, review the information about hosts in the supporting documentation 
for Microsoft Windows Server.

About this task
If you do not have a DNS server, you must manually update the HOSTS file on the Avaya Contact 
Center Select server with the new server name and IP address. This ensures that all servers can 
interpret the new server name.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. Browse to the HOSTS file in the installation directory, 
C:\Windows\system32\drivers\etc.

3. Right-click the HOSTS file and open the file with a text editor such as Notepad to modify 
the host tables.

4. Update the file to reflect the new server name, IP address, or both.

5. On the File menu, click Save.

6. Close all windows.

Verifying the server name change
About this task
Verify that the Domain Name Service server or network has the correct server name.
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Procedure
1. On the Desktop screen, right-click on the Windows icon and select Run.

2. In the Open box, enter cmd.

3. In a Command line window, type ping <server name>.

Where <server name> is the new name of the Avaya Contact Center Select server.

4. Verify that the IP address matches the IP address of the server with the new name.

Synchronizing the operating system name with the Avaya Contact 
Center Select server name

About this task
Synchronize the operating system name with the Avaya Contact Center Select server name to 
ensure that the Contact Center suite uses the new server name.

Important:
Ensure that Avaya Contact Center Select services are stopped before you run the Computer 
Name Synchronisation Utility.

Procedure
1. Log on to the Avaya Contact Center Select server as an administrator.

2. Close the System Control and Monitor Utility if it is running.

3. From the Start menu, in the Avaya area, click Computer Update Utility.

4. Verify that the new Avaya Contact Center Select server name appears in the New 
Computer Name box.

5. Under System Account Configuration, in the Password box, type the password for the 
Avaya Contact Center Select administration account. The password is not checked against 
the server security policy for minimum password requirements. Avaya recommends that 
you enter a password that conforms to your corporate password policy.

6. In the Confirm Password box, type the password.

7. Click Apply and click Yes to confirm.

8. After the synchronization process is complete, click Restart to restart the server.

Note:

The Computer Name Synchronisation Utility provides information about the success of 
the synchronization process for each of the components: Avaya Contact Center Select, 
Avaya Aura® Media Server, and Avaya IP Office. If you want to view the log file for the 
synchronization process, click Open log file before you click Restart.
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Configuring Avaya Aura® Media Server name resolution
About this task
Configure Avaya Aura® Media Server to resolve the hostname and Fully Qualified Domain Name 
(FQDN) of the Contact Center Manager Administration server. The Contact Center Manager 
Administration (CCMA) software is installed on the Contact Center server.

Procedure
1. Log in to Element Manager with administrative privileges.

2. Navigate to EM > System Configuration > Network Settings > Name Resolution.

3. Click Add.

4. In the IP Address box, enter the Contact Center Manager Administration IP address.

5. In the Hostname box, enter the Contact Center Manager Administration hostname.

6. Click Save.

Configuring the external Web Communications server
Before you begin

• Know the custom interface folder names and paths for the web.xml and .jsp files for the 
sample Web communications installation.

About this task
If your solution uses an external Web Communications server, configure the Web Communications 
server to update the files with the new server name.
You must update for .jsp files with Apache Tomcat. If you use a different servlet engine (for 
example, JRun or WebLogic) or a different technology (ASP.NET), you must use the standard 
procedures for your environment.

Procedure
1. Log on to your external Web Communications Web server.

2. Open the config file located at C:\xampp\htdocs\Code\include in Notepad or another 
text editor.

3. Locate the text string CCMM_MACHINE_NAME and update the new server name after 
the ’=’ sign.

4. Save and close the file.

Updating the HOSTS file for clients
Before you begin

• Determine if you need to update the HOSTS table on your client.
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Important:
Incorrectly modifying a host table can cause extensive network problems. Before you 
modify host tables, review the information about hosts in the supporting documentation 
for Microsoft Windows.

About this task
If you do not have a DNS server, you must manually update the HOSTS file on each client in your 
contact center with the new computer IP address. This ensures that all clients can interpret the 
new server name.

Procedure
1. Log on to the client computer.

2. Browse to the HOSTS file in the Windows installation directory, 
C:\Windows\system32\drivers\etc.

3. Right-click the HOSTS file and open the file with a text editor such as Notepad to modify 
the host tables.

4. Update the HOSTS file to reflect the new Avaya Contact Center Select server name or IP 
address.

5. On the File menu, click Save.

6. Close all windows.

7. Repeat this procedure on each client computer.

Updating client browsers and shared folders
Before you begin

• Ensure that you export scheduled reports in your Contact Center.
• Ensure that you updated the HOSTS file on the clients with the new Avaya Contact Center 

Select server name.

Important:
Administrators cannot update the browsers and shared folders for each user, therefore 
users needs to update their respective browsers and shared folders.

About this task
Update the client browsers and shared folders to reference the new Avaya Contact Center Select 
server name in the browser.

Procedure
1. Log on to Contact Center Manager Administration as an administrator.

2. From the Launchpad, click Historical Reporting.

3. In the Historical Reporting main window, click the CC server.

4. For each report associated with the new server, click the report name.
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5. In the Report Properties window, click the Output Options heading to expand the section.

6. Select the Output to file check box.

7. In the Output box, browse to the path of the report.

8. Click Save Report.
9. Click Activate.

10. Close the report.

11. Repeat step 4 to step 10 for each report.

Reinstalling Agent Desktop
Before you begin

• Change the name of the Avaya Contact Center Select server.
• Uninstall Agent Desktop. For more information on installing and uninstalling Agent Desktop, 

see Using Agent Desktop for Avaya Contact Center Select .

About this task
Reinstall Agent Desktop to allow agents to monitor calls and make calls.

Procedure
Install Agent Desktop.

Important:

Install Agent Desktop using the new server name.

Avaya Contact Center Select server IP address change
Change the IP address of the Avaya Contact Center Select server.

Important:

After you change the IP address of the virtualized Avaya Contact Center Select server, you 
must request a new license. Your existing license is no longer valid after you change the IP 
address.

Stopping Avaya Contact Center Select
About this task
You must stop the Avaya Contact Center Select system before changing the server name or IP 
address.
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Procedure
1. Log on to the Avaya Contact Center Select server.

2. On the Windows System Tray, right-click on the System Management and Monitoring 
Component (SMMC) system tray icon, and select Stop System.

Avaya Contact Center Select services begin shutting down. When all services are shut 
down, the SMMC icon in the Windows System Tray changes to the stopped state.

Changing the contact center subnet IP address of the Avaya 
Contact Center Select server

About this task
You must perform the following steps to update the Avaya Contact Center Select server IP 
address references.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click System Control and Monitor Utility.

3. On the System Control & Monitor Utility window, click Shut down Contact Center.
4. On the Start screen, click Control Panel.
5. Click Network and Internet  > Network and Sharing Center.
6. Click Change adapter settings.

7. Right-click the LAN connection of the contact center subnet network interface card and 
select Properties.

8. Select Internet Protocol Version 4 (TCP/IPv4) and then click Properties.

9. In the IP address field, type the new IP address and click OK.

10. Click Close.

11. Restart the server.

12. From the Start menu, in the Avaya area, click Server Configuration.

13. In the Server Configuration dialog box, click Apply All.
14. If you are using a Domain Name Service (DNS), contact your local network administrator 

to update the DNS with the new IP address.

Verifying the server IP address change
About this task
Verify that the Domain Name Service server or network has the correct server IP address.
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Procedure
1. On the Desktop screen, right-click on the Windows icon and select Run.

2. In the Open box, enter cmd.

3. In a Command line window, type ping <server name>.

Where <server name> is the name of the Avaya Contact Center Select server.

4. Verify that the IP address matches the new IP address of the server.

Synchronizing the operating system IP address with the Avaya 
Contact Center Select server IP address

About this task
Synchronize the operating system IP address with the Avaya Contact Center Select server IP 
address to ensure that the Contact Center suite uses the new server IP address.

Important:
Ensure that Avaya Contact Center Select services are stopped before you run the Computer 
Name Synchronisation Utility.

Procedure
1. Log on to the Avaya Contact Center Select server as an administrator.

2. Close the System Control and Monitor Utility if it is running.

3. From the Start menu, in the Avaya area, click Computer Update Utility.

4. Verify that the new Avaya Contact Center Select server IP address appears in the New IP 
Address box.

5. Click Apply and click Yes to confirm.

6. After the synchronization process is complete, click Restart to restart the server.

Note:

The Computer Name Synchronisation Utility provides information about the success of 
the synchronization process for each of the components: Avaya Contact Center Select, 
Avaya Aura® Media Server, and Avaya IP Office. If you want to view the log file for the 
synchronization process, click Open log file before you click Restart.

Configuring Avaya Aura® Media Server name resolution
About this task
Configure Avaya Aura® Media Server to resolve the hostname and Fully Qualified Domain Name 
(FQDN) of the Contact Center Manager Administration server. The Contact Center Manager 
Administration (CCMA) software is installed on the Contact Center server.
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Procedure
1. Log in to Element Manager with administrative privileges.

2. Navigate to EM > System Configuration > Network Settings > Name Resolution.

3. Click Add.

4. In the IP Address box, enter the Contact Center Manager Administration IP address.

5. In the Hostname box, enter the Contact Center Manager Administration hostname.

6. Click Save.

Updating Avaya Aura® Media Server trusted node IP addresses
About this task
After you change the Avaya Contact Center Select IP address, you must update the Avaya Aura®

Media Server trusted node IP addresses in Element Manager (EM).

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Navigate to EM > System Configuration > Signaling Protocols > SIP > Nodes and 
Routes.

3. Click Add.

4. On the Add SIP Trusted Node page, in the Host or Server Address field, type the new 
IP address of the Avaya Contact Center Select server.

5. Click Save.

6. In the navigation pane, click System Configuration > Network Settings > General 
Settings.

7. Click SOAP.

8. In the Trusted Nodes box, type the new IP address of the Avaya Contact Center Select 
server.

9. Select Enable Trusted SOAP Nodes.

10. Click Save.

Updating the HOSTS file for clients
Before you begin

• Determine if you need to update the HOSTS table on your client.

Important:
Incorrectly modifying a host table can cause extensive network problems. Before you 
modify host tables, review the information about hosts in the supporting documentation 
for Microsoft Windows.
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About this task
If you do not have a DNS server, you must manually update the HOSTS file on each client in your 
contact center with the new computer IP address. This ensures that all clients can interpret the 
new server name.

Procedure
1. Log on to the client computer.

2. Browse to the HOSTS file in the Windows installation directory, 
C:\Windows\system32\drivers\etc.

3. Right-click the HOSTS file and open the file with a text editor such as Notepad to modify 
the host tables.

4. Update the HOSTS file to reflect the new Avaya Contact Center Select server name or IP 
address.

5. On the File menu, click Save.

6. Close all windows.

7. Repeat this procedure on each client computer.

Avaya Aura® Media Server name change
Change the server name of Avaya Aura® Media Server and update the Avaya Contact Center 
Select server to reflect the changes.

Changing the name of the Avaya Aura® Media Server on Linux
Before you begin

• Stop Avaya Contact Center Select using System Control and Monitor Utility (SCMU) or 
System Management and Monitoring Component (SMMC).

About this task
Perform the following procedure if you need to change the host name of a Linux-based Avaya 
Aura® Media Server.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager (EM).

2. Navigate to EM  > System Status  > Element Status.

3. Click Stop.

4. Click Confirm to proceed with the action.

After a few seconds, the system updates the status fields and activates or deactivates the 
buttons based on the new state of the media server.
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5. On the Linux server, edit the file /etc/hosts.

6. Update the host name wherever the host name appears in the file.

7. Save the file.

8. Edit the file /etc/sysconfig/network.

9. Update the host name wherever the host name appears in the file.

10. Save the file.

11. Using a Linux shell, enter the following command to apply the host name change to the 
system:

hostname <new_hostname>
Where <new_hostname> is the new name for the server.

12. In Element Manager, navigate to EM  > System Status  > Element Status.

13. Click Start.
14. Click Confirm to proceed with the acti

Updating the Avaya Aura® Media Server details in CCMA
About this task
Update the media server details configured in Contact Center Manager Administration to match 
the new Avaya Aura® Media Server changes. Avaya Contact Center Select uses Avaya Aura®

Media Server media processing capabilities to support conferencing, announcements and dialogs.

Procedure
1. Log on to Contact Center Manager Administration with administrator privileges.

2. On the Launchpad, click Configuration.

3. In the left pane, expand CC.

4. Select Media Servers.

5. On the Media Servers window, in the Server Name box, type the server name of the 
Avaya Aura® Media Server server.

6. In the IP Address box, type the IP address of the Avaya Aura® Media Server server.

7. In the Port Number box, type the port number.

Important:

The port number must match the Avaya Aura® Media Server port number. The default 
is 5060.

8. Click the next row of the grid to save your changes.
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Avaya Aura® Media Server IP address change
Change the IP address of Avaya Aura® Media Server and update the Avaya Contact Center Select 
server to reflect the changes.

Changing the Avaya Aura® Media Server IP address on Linux
Before you begin

• Stop Avaya Contact Center Select using System Control and Monitor Utility (SCMU) or 
System Management and Monitoring Component (SMMC).

About this task
Perform the following procedure if you need to change the IP address of a Linux-based Avaya 
Aura® Media Server. The network adapter names and network configuration file names can differ 
to the names on your server.
After you change the Avaya Aura® Media Server IP address, you must update the Avaya Aura®

Media Server IP Interface Assignment in Element Manager (EM).

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Navigate to EM  > System Status  > Element Status.

3. Click Stop.

4. Click Confirm to proceed with the action.

After a few seconds, the system updates the status fields and activates or deactivates the 
buttons based on the new state of the media server.

5. On the Linux server, edit the file /etc/hosts.

6. If the hosts file contains an existing entry for the Avaya Aura® Media Server, remove the 
entry. Do not update the entry or add an Avaya Aura® Media Server entry to the hosts file.

7. Save the file.

8. Edit the file /etc/sysconfig/network-scripts/ifcfg-eth0.

9. Update the IP address wherever the IP address appears in the file.

10. Save the file.

11. Using the local Linux console shell, enter the following commands to apply the IP address 
change to the system:

/etc/init.d/network stop
/etc/init.d/network start

12. Log on to Element Manager using the new IP address in the URL for the EM login.

13. In the navigation pane, click System Configuration > Network Settings > IP Interface 
Assignment.
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14. IP Interface Assignment fields show errors, as a result of the IP address change. Select 
valid IP addresses from the drop-down menus for each field showing Invalid.

15. Click Save.

16. Click Confirm.

17. Using the local Linux console shell, enter the following commands to restart Avaya Aura®

Media Server:

reboot

Updating the Avaya Aura® Media Server details in CCMA
About this task
Update the media server details configured in Contact Center Manager Administration to match 
the new Avaya Aura® Media Server changes. Avaya Contact Center Select uses Avaya Aura®

Media Server media processing capabilities to support conferencing, announcements and dialogs.

Procedure
1. Log on to Contact Center Manager Administration with administrator privileges.

2. On the Launchpad, click Configuration.

3. In the left pane, expand CC.

4. Select Media Servers.

5. On the Media Servers window, in the Server Name box, type the server name of the 
Avaya Aura® Media Server server.

6. In the IP Address box, type the IP address of the Avaya Aura® Media Server server.

7. In the Port Number box, type the port number.

Important:

The port number must match the Avaya Aura® Media Server port number. The default 
is 5060.

8. Click the next row of the grid to save your changes.
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